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Welcome to BLS-2021

Congratulations on choosing BLS-2021 for your bowling league needs for the

2020/2021 bowling season. Managing leagues can be a demanding and difficult job.
Doing it by hand or with ancient software, can make the task even more difficult. BLS-
2021 provides features capable for mostleague secretaries to run typical leagues as

well as some non-typical options.

System Requirements

The system requirements for BLS-2021 are as follows:

Operating System

Windows 10, Windows 8, Windows 7
Service Pack 1, Windows Server 2016,
Windows Server 2012, Windows
Server 2008 R2 or Windows Server
2008.

Computer Processor
1 Ghzor faster 32-bit or 64-bit
processor

Memory (RAM)
1 GB of System Memory. Additional
RAMis always encouraged to provide

better system performance minimizing
caching memoryto the hard drive.

Storage
Hard drive required with minimum 250
MB free space

USB Drive or removable storage
suggested for data backups

Keyboard/Pointer Device
Keyboard and a mouse or some other
compatible pointing device

Graphics card / Display device
DirectX 9-Class graphics card with 32
MB of graphics memory and display

resolution of 1024x768 or greater at
small fonts (100% Font Scaling).

Color quality/depth of 16-bit color or
greater

Optical Drive [Optional]

CD-ROM (8xspeed) or DVD-ROM
drive to install from CD-ROM (not

USB Port [Optional]

USB port to install from USB Flash
Drive (not needed for installation via
download) or to store backups on a
USB removable media device

Windows Installer 4.5 or Higher

Microsoft Windows Installer
technologyis used to install the
software on a computer. Normal use
of Microsoft's Windows Updates
should update the Windows Installer
for the operating system to meet the
supported versions. Updates or
installers for Microsoft Windows
Installer technology can be found on
Microsoft's website. To be redirected
to this Microsoft update, visit

http:/ftinyurl.com/6camd
MSVC++ 9.0 Runtime Libraries

Microsoft VC++ 9.0 libraries are used
in portions of the program. This is
typically installed on most computers,
but if not, an "application configuration
is incorrect" error will be displayed. For
32-bit versions of Windows, visit
http://www.microsoft.com/en-
us/download/details.aspx?id=29 and
for 64-bit versions of Windows, visit
http://www.micros oft.com/en-
us/download/details.aspx?id=15336

Internet [Optional]

Internet connection is recommended,
but not required. Internet connectivity is
suggested for updates and online
support

needed for installation via download)
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System requirements are subject to
change without notice.

Software License
ATTENTION: PLEASE READ THIS DOCUMENT CAREFULLY BEFORE INSTALLING THIS SOFTWARE. THE
INDIVIDUAL OR ENTITY USING THIS SOFTWARE OR MANUAL (THE "END USER") AGREES TO BE BOUND
BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT USE
THE SOFTWARE AND PROMPTLY RETURN THE PACKAGE WITHIN 30 DAY S OF PURCHASE IN ORIGINAL
CONDITION, AND THE LICENSE PRICE WILL BE REFUNDED.
The enclosed computer program(s) and the accompany ing documentation are provided to the End-User by CDE
SOFTWARE ("Licensor") for use only under the following terms. Licensor reserves any right not expressly granted
to the End-user. The End-User owns the disk on which the Software is recorded, but Licensor retains ownership of
all copies of the Software itself. The End-User assumes sole responsibility for the installation, use and results
obtained from use of the Software.
1. License.
End-User is granted a limited, non-exclusiv e license to do only the following:
A. Install and maintain the Software on one computer at any time for use only in the End-User's home or own
business.
B. Make two copies in machine-readable form solely for backup or archival purposes for the computer which the
Software is installed. Software is protected by copyright law. As an express condition of this License, the End-
User must reproduce the Licensor's copy right notice and any other proprietary legends on the original copy
supplied by Licensor.
C. Transfer the Software and all rights under this License to another party together with a copy of this License and
all written materials accompanying the Software, provided (i) the End-User gives Licensor written notice of the
transfer (including in such notice the End Users name, address, phone number, customer number and program
serial number as well as the transferee’s name, address and phone number), and (i) the other party reads and
agrees to accept the terms and conditions of this License and to pay any nominal fees charged to issue new
unlock codes to reflect name or serial number changes.
2. Restrictions.
The End-User may NOT sublicense, assign, or distribute copies of the Software or manuals to others. The
Software contains trade secrets. The End-User may NOT decompile, reverse engineer, disassemble, or otherwise
reduce the Software to a human readable form. THE END-USER MAY NOT MODIFY, ADAPT, TRANSLATE,
RENT, LEASE, LOAN, RESELL FOR PROFIT, DISTRIBUTE, OR OTHERWISE ASSIGN OR TRANSFER THE
SOFTWARE, OR CREATE DERIVATIVE WORKS BASED UPON THE SOFTWARE OR ANY PART THEREOF,
EXCEPT AS EXPRESSLY PROVIDED IN SECTION 1.C. ABOVE.
3. Protection and Security .
The End-User agrees to use its best efforts and to take all reasonable steps to safeguard the Software to ensure
that no unauthorized person shall have access thereto and that no unauthorized copy, publication, disclosure or
distribution in whole or in part, in any form, shall be made. The End-User acknowledges that the Software contains
valuable confidential information and trade secrets and that unauthorized use and/or copying are harmful to
Licensor.
4. Termination.
This License is effective until terminated. This License will terminate immediately without notice from Licensor if
the End User fails to comply with any of its provisions. Upon termination the End User must destroy the Software
and all copies thereof, and the End-User may terminate this License at any time by doing so.
5. Limited Warranty .
The Licensor shall have no liability or responsibility to the End-User or any other person or entity with respect to
liability, loss or damage caused or alleged to be caused directly or indirectly by this product, including but not
limited to any interruption of service, loss of business or anticipatory profits or consequential damages resulting
from the use or operation of this program.
If a defect in manufacturing, labeling or packaging is found within 90 days from date of purchase, End-User shall
return the Software to Licensor and Licensor’s only obligation shall be to replace the defective Software, providing
that the End-User provides proof of purchase or the warranty card is on file. The End-User agrees that the
foregoing constitutes the End-User's sole and exclusive remedy for breach by Licensor under any warranties
made under this Agreement. This warranty does not cover any Software that has been altered in any way by
any one other than Licensor. Licensor is not responsible for problems associated with or caused by incompatible
operating sy stems or equipment, or for problems in the interaction of the Software with software not furnished by
Licensor.
The Licensor guarantees the accuracy of results and reports for one year from the date of release of this
program. If End-User discovers an error in calculations from the way the program is designed to work, the Licensor
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will correct that error and provide a correction to the Licensee providing it is reported, in writing, to Licensor based
on the following:

a. Within 90 days of the date of Software release (not date of purchase) - At no charge.

b. Within one year from the date of Software release (not date of purchase) - At no charge other than shipping and
handling.

c. Beyond one year from the date of Software release (not date of purchase) - Purchase of upgrade at current
pricing.

The user reporting the error will be required to supply to Licensor, at no charge, whatev er materials are required to
document and trace the reported error. If materials are requested to be returned to End-User, there will be a
shipping and handling fee.

No oral or written information or advice given by Licensor or its dealers, distributors, employ ees or agents shall in
any way extend, modify or add to the foregoing warranty .

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE END-USER ASSUMES ALL RISK AS
TO THE SUITABILITY, QUALITY, AND PERFORMANCE OF THE SOFTWARE. IN NO EVENT WILL LICENSOR,
OR ITS DIRECTORS, OFFICERS, EMPLOY EES OR AFFILIATES, BE LIABLE TO THE END-USER FOR ANY
CONSEQUENTIAL INCIDENTAL, INDIRECT, SPECIAL OR EXEMPLARY DAMAGES (INCLUDING DAMAGES
FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR BUSINESS
INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE OR
ACCOMPANYING WRITTEN MATERIALS, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. LICENSOR'S LIABILITY TO THE END-USER (IF ANY) FOR ACTUAL DIRECT DAMAGES
FOR ANY CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF THE ACTION, WILL BE LIMITED TO,
AND IN NO EVENT SHALL EXCEED, THE AMOUNT ORIGINALLY PAID TO LICENSOR FOR THE LICENSE OF
THE SOFTWARE.

7. Enhancements.

From time to time Licensor may, in its sole discretion, advise the End-User of updates, upgrades, enhancements
or improvements to the Software and/or new releases of the Software (collectively, "Enhancements"), and may
license the End-User to use such Enhancements upon pay ment of prices as may be established by Licensor from
time to time. All such Enhancements to the Software provided to the End-User shall also be governed by the
terms of this License. IN ORDER FOR THE END-USER TO BE ASSURED THAT IT WILL BE ADVISED OF AND
LICENSED TO USE ANY ENHANCEMENTS TO THE SOFTWARE, THE END-USER MUST BE SHOWN IN THE
LICENSORS DATABASE.

8. General.

This License will be governed by and construed in accordance with the laws of Washington State, and shall inure to
the benefit of Licensor and End-User and their successors, assigns and legal representatives. If any provision of
this License is held by a court of competent jurisdiction to be invalid or unenforceable to any extent under
applicable law, that provision will be enforced to the maximum extent permissible, and the remaining prov isions of
this License will remain in full force and effect. Any notices or other communications to be sent to Licensor must
be mailed first class, postage prepaid, to the following address: CDE Software 14220 Interurban Ave S STE 140,
Seattle, WA 98168

This Agreement constitutes the entire agreement between the parties with respect to the subject matter hereof, and
all prior proposals, agreements, representations, statements and undertakings are hereby expressly canceled and
superseded. This Agreement may not be changed or amended except by a written instrument executed by a duly
authorized officer of Licensor.

9. Acknowledgment.

BY INSTALLING THIS SOFTWARE, THE END-USER ACKNOWLEDGES THAT IT HAS READ THIS LICENSE,
UNDERSTANDS IT, AND AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. Should you have any
questions concerning this License, contact Licensor at the address set forth above.

10. Clipart and Fonts.

Upon paid license of BLS-2021 Standard, BLS-2021 Pro or BLS-2021 A/S, the licensee shall be granted use of
included clipart images for use with this software only. Use of included clipart images are prohibited from use other
than with the use of this software. At no time may the images be transferred electronically, modified or
incorporated into any item that is for distribution or resale.

11. Patches and Updates.

CDE Software will periodically make av ailable minor revisions and improvements to the program in the form of
patches or updates.

While CDE Software encourages the updating of its products to the most recent release, updates or patches are
provided "as-is".

Neither CDE Software nor its suppliers makes any warranty, express or implied with respect to the content of
these materials or the accuracy of any information contained herein, including, without limitation, the implied
warranties of merchantability or fitness for a particular purpose. Because some states/jurisdictions do not allow
exclusions of implied warranties, the abov e limitation may not apply to you.

Neither CDE Software nor its suppliers shall have any liability for any damages whatsoev er including
consequential incidental, direct, indirect, special, and loss profits. Because some states/jurisdictions do not allow
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exclusions of implied warranties, the abov e limitation may not apply to you. In any event, CDE Software and its
suppliers' entire liability in any manner arising out of these materials, whether by tort, contract, or otherwise shall
not exceed the suggested retail price of these materials.

12. Automatic Scoring Editions.

The Automatic Scoring Import and Export specifications and formats are copyrighted and owned by CDE Software
and may not be used, in original or modified form, disseminated or reverse engineered without the express written
consent of CDE Software.

13. Intellectual Property .

You shall not reverse engineer, decompile, disassemble or otherwise attempt to discover the source code of the
Software without express written permission from CDE Software.

14. Data Files.

You shall not reverse engineer, decompile, disassemble or otherwise attempt to discov er the data format or
specification of the data files generated by the software, nor will create or use third party tools to access,
manipulate or generate data files without express written permission of CDE Sof tware.

15. Acknowledgment.

BY INSTALLING THIS SOFTWARE, THE END-USER ACKNOWLEDGES THAT IT HAS READ THIS LICENSE,
UNDERSTANDS IT, AND AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. Should you have any
questions concerning this License, contact Licensor at the address set forth above.
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Windows and You

Is it required to have a masters degree in computer science to run this software? No.
BLS-2021 is designed to be managed by those with little experience with computer
software, yet have the power and flexibility to be used by those with a lot of experience.

However, itis assumed that there is a basic level of understanding how to use the
operating system that BLS-2021 is installed on, how to point, click, double-click, right-
click and drag. Itis also assumed you know how to select options in dialog boxes, list
boxes and how to enter, select and edit text.

If you feel you do not understand these concepts, we suggest visiting the local library for
simple and easybooks or guides on how to do basic tasks with your particular operating
system.

Definitions Used

Itis beyond the scope of this manual to teach the Windows operating system. Itis
assumed that you are familiar with a basic understanding of Windows.

We have provided a few common definitions of terms used in this user guide. You are
probably already familiar with each of these terms, but may not know its technical name.

Select

Choosing an item that will be used for an action you are doing, such as choosing a
reportto set up or a check boxto turn on or off.

Click
Use the mouse to select an option and click with the left mouse button. (If you have

changed the button layout in the Mouse settings, under Control Panel, this maybe a
different button).

Right-Click

Use the mouse to select an option and click with the right mouse button. (If you have
changed the button layout in the Mouse settings, under Control Panel, this maybe a
different button).

Drag and Drop

The concept of drag and drop is a simple one that gives a lot of power and flexibility
using a couple simple steps.

An item on the screen, such as a bowler or style element can be dragged from one
place to the other by holding down the left mouse button and “drag” the item to the
desired location. Once placed, let go of the mouse button to “drop” itin its place.

Bubble Help

Rather than guessing what a button or control does or looking it up in the manual, the
program uses a feature called Bubble-Help. As the mouse pointis parked over the
control, a bubble pops up with a brief description what it does.
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Context Sensitive Help
Another great feature of BLS-2021 is context sensitive help. Clicking help from within the

program will open the program'’s help guide to the appropriate section that you are at.
Spend less time, getting the answers you need.
Check Boxes

¥ Print bowlers' names

Check boxes are square boxes that are selected or cleared to turn on or off an option.

Command buttons

B

Buttons that initiate an action. Such as OK, Yes or No.

Drop-down list boxes

Fall Season v

Indicate Season Here
Winter Season

Spring Season
Summer Season

Fall Season

Year-Round

If a text box has an arrow nextto it, itis called a drop-down list box. Clicking the arrow
opens the list. If the listis large, scroll bars might appear. If this is the case, click the up
or down arrows to scroll through the list. If the listis large enough, scroll bars appear.

Drop-down combo boxes

Adrop-down combo boxis the same as a drop-down list box with the exception that you
can either type or select data.

Group box
Access -s"ett'i-ngs
User Name:
Password:
Host Name:
Upload Path:
Port: 21 E SFTP v Passive Transfer
SSL FTP: No -
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Aboxor frame that encloses a set of related options.

List box

Data items in current style:

Place

Lane Number Next Week
Team Number

Team Name

Points Won

Points Lost

Average (used for HDCP)
Handicap

Total Pins (scratch pinfall only)
Total Pins (all scores + HDCP)
High 10 & 30" scratch

High *10 & 30" HDCP

Atype of boxthat contains a list of items that you can select.
Option buttons

" Default folder for leagues

Round buttons used to select one of a specific choice of options.

Slider

| IO (T A T T D T B T e T [ (1 I |
ey
| .|

Indication on a gauge that displays and sets a value from a continuous range, such as
lighten or darken, shadow depth, etc.

Spin box
B 1 .|

Text boxwith up and down arrows that you can click to move through a set of fixed
values. You can also type in values directly.

Tabs
Weekly Fees I Fines  Payments League Funds] Bank Ledger  Reports Utilities

Labeled group of options used for many similar kinds of settings. Such as the League
Rules tabs.

Text Box

CDE Software

Arectangular boxin which you can type text. If the box already contains text, you can
select the default text or delete it and type new text.
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Additional Help

If you are uncomfortable or unfamiliar with the Windows operating system, there are
several resources such as books and classes available for people of all ages and

abilities. IDG produces several books on how to use your computer or more about using
Windows.

Windows and You
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Product Features
This program has several features listed below. Features and specifications are subject
to change without notice.

Product Feature List
The following section describes some of the many features found in BLS-2021 with
limits noted as necessary.

Manage as manyleagues as you wish (Why pay more for each league or # of teams)
Supports 6 games of bowling - why be limited to 47
Manage men, women, mixed and youth leagues

Installers and applications are digitally signed to provide assurance that the software
you install is from CDE Software

Handles Scratch or Handicap Leagues - No extra fees

Handles Bowler and Team Divisions - No extra fees

Supports individual and team match points for game and series - No extra fees
Support up to 99-week league seasons

Adjustable Score Entry font sizing

Team roster sizes up to 12 bowlers per team

Handles USBC Vacant Team Draw System providing a fairer alternative, to BYE
teams

Handles USBC 300/900 Handicap cap to scratch
Manage up to 200 teams per league

Back up your data directly to CD-R, CD-RW, DVD-R, DVD-RW, DVD+R or DVD+RW
using Microsoft Image Mastering API builtinto Windows Vista, and newer.

Supports the major awards changes with the 2020/2021 bowling season, from USBC,
CTF and TNBA.

Supports Playing rules for 2020/2021 USBC. CTF and TNBA.

Easyto use score screen that allows for rapid score entry. Screen is easyon eyes,
easyto read, and looks like a recap sheet

Multiple Reports are managed with customizable league standings, detailed reports,
season histories, and more - No Extra Charge

Add graphics and watermarks from our bowling clipart CD-ROM's or your own
creations. You control size, position, and effects

Sort team lineups by low to high average or high to low average

Fonts customizable on multiple reports. Change font style, size, and color.
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Print plain paper recaps
Print on available laser, inkjet, and dot matrix printers

Simple management of prebowls and makeups, to ensure averages for handicap is
properly handled

Give your bowlers FREE access to INTERACTIVE standings with
LeagueSecretary.com, to dynamically show positions, rosters, histories, and more

FREE uploading standings to LeagueSecretary.com, for certified USBC/CTF leagues
AND non-sanctioned leagues

FREE backup storage on LeagueSecretary.com, to securely back up leagues for
emergencies (One Click!)

FREE uploading of your standings to USBC's own Bowl.com, for certified leagues

FREE uploading of your standings to websites hosted on BPAA Web Services (Pro or
A/S edition)

FREE uploading of your standings to websites hosted on BowIRx platform (Pro or A'S
edition)

Supports USBC, CTF and TNBA Certified Leagues for 2020/2021 season, with award
detection and forms, membership forms, sanctions forms, and more for the
2020/2021 bowling season.

USBC Youth Pepsi Tournament qualifications processing for the 2020/2021 bowling
season.

Record payments and manage treasurer duties with the built-in treasurer module, to
manage league finances, to track by bowler or by team (why pay extral)

Ultimate Bowling League support - No extra charge

Indicate a change in Lane Assignments if a league switches lanes mid-season.
Send notices to Twitter when standings are uploaded (Pro Edition)

Print Mailing Labels

Print name labels

League Rules Wizard

Remove Teams Wizard

Financial Setup Wizard

Easy score entry for vacancy scores, dummy scores, absentee scores, pacer scores
and baker scores

Tie management has long been available to BLS customers addressing how to
manage ties for standings and individual awards

Individual and Team Awards managed by priorities for game or series or scratch or
handicap or combinations within
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e Web uploads - Have your own site too? Upload to both LeagueSecretary.com and your
own website. Supports FTP, FTPS and SecureFTP

e Social Media updates

e Support - CDE provides the largest opportunity for support for your program via online
chat, message boards, email, fax, mail and phone

e Automatic Scoring Edition available with all major scoring systems including
QubicaAMF Conqueror, QubicaAMF Boss, Brunswick Vector, Vector Plus, Classic and
Centermaster, Steltronic Focus and WINS, Twelve Strike Central Desk Window and
Central Desk DOS, Purrfect Score, ComputerScore, AK Microsystems, Switch and
more

e Alotmore features... We'll be updating additional features here after the program has
been released.
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Installation

As with any software, the first step is to get the program installed. In this chapter we will
cover instructions on initial installation procedures, as well as installing updates. These
same procedures also apply when purchasing a new computer, transferring the
program to a different computer, or when the drive has to be formatted.

Before installing the program, make sure your computer meets the minimum
requirements. Operation and changing weeks will be quicker on computer processors
with large amounts of physical RAM.

See "System Requirements" on page:lTBﬁ

Installing from CD ROM
To install the BLS-2021 using a CDROM, follow the instructions below

1. If your computer has multiple user accounts, log on as using a user account with
Administrator privileges.

2. Insertthe CD. The installation menu should appear. If the installation menu does not

appear automatically, see What if the Installation CD does not start automatically on

page[3)

Click Install a CDE Software Product.

Click League Software from the list of available product categories.

Click Bowling League Secretary 2021.

6. Click Install BLS-2021 Standard/Pro/Autoscore to launch the program installer.

o R w

As an alternative, to bypass the installation menu, see Installing EXE directly from CD
on page [38%and directly install the software.

What if the Installation CD does not start automatically
If the installation menu does not appear automatically, follow the instructions below:

1. If your computer has multiple user accounts, log on as a user with Administrator
privileges.

2. Insertthe CD.
3. Follow the appropriate steps for the version of Windows installed.

Windows 10. 8 or Windows Server 2012
1. On the Windows Taskbar, right-click on the Start button and click Search.

2. Typéis PC in the search window and then click This PC.
3. In the This PC windows, double-click the CD drive icon.

4. Ifthe User Account Control window opens, click Continue.

4. Click Install a CDE Software Product.

5. Click League Software from the list of available product categories.
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6. Click Bowling League Secretary 2021.
7. Click Install BLS-2021 Standard/Pro/Autoscore to launch the program installer.

As an alternative, to bypass the installation menu, see Installing EXE directly from CD
on page [38%nd directly install the software.

Installing EXE directly from CD
To install the BLS-2021 using a CDROM, bypassing the menu system, follow the
instructions below

Windows 10, 8 or Windows Server 2012

Insert the CD.

On the Windows Taskbar, right-click on the Start button and click Search.
Click File Explorer, click This PC, and then click the CD drive.
Double-click the BLS2021 folder

Double-click the BLS2021INSTALLER.EXE file to install the program.

If the User Account Control window opens, click Continue.

oakwn =

Windows 7, Windows Vista or Windows Server 2008

Insertthe CD.

On the Windows Taskbar, click Start, and then click Computer
Right-click the CD drive icon and click Open in a new window.
Double-click the BLS2021 folder

Double-click the BLS2021INSTALLER.EXE file to install the program.
If the User Account Control window opens, click Continue.

oakwN =

Installing from USB Flash Drive

CDE Software, LLC is currently providing customers the option to purchase the program
on USB Flash Drive as opposed to CD-ROMdisk. There are several advantages to
having the installation programs available on USB Flash Drive including the following:

¢ Significantly more compactthan a CD ROM, you can take the drive anywhere.

¢ Increased storage capacity (4 GB) including a large amount of free disk space
(approx. 2.5 GB) to store important data such as league backups. Configure BLS-
2021 to automatically back up the league directly to the USB flash drive.

¢ Ability to update program installers as new updates are downloaded from CDE
Software, LLC.

To install:
1. If your computer has multiple user accounts, log on as using a user account
with Administrator privileges.
2. Insertthe drive into an available USB port. After the drive has been detected, it
will be assigned the next available drive letter.
3. The installation menu should appear. If the installation menu does not appear
automatically, see Whatif the Installation USB does not start automatically on

page%
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Click Install a CDE Software Product.

Click League Software from the list of available product categories.

Click Bowling League Secretary 2021.

7. Click Install BLS-2021 Standard/Pro/Autoscore to launch the program installer.

ook

As an alternative, to bypass the installation menu, see Installing EXE directly from
USB on page [38%nd directly install the software.

What if the Installation USB does not start automatically
If the installation menu does not appear automatically, follow the instructions below:

1.

o o &

7.

If your computer has multiple user accounts, log on as a user with Administrator
privileges.

Insert the drive into an available USB port. After the drive has been detected, it will be
assigned the next available drive letter.

Follow the appropriate steps for the version of Windows installed.

indows 1 r Windows Server 2012

1. On the Windows Taskbar, right-click on the Start button and click
Search.

2. Type This PC in the search window and then click This PC.

3. Inthe This PC windows, double-click the USB drive icon.

4. Ifthe User Account Control window opens, click Continue.

indows 7 or Window rver 2

1. On the Windows Taskbar, click Start, and then click Computer
2. Double-click the USB drive icon.
3. Ifthe User Account Control window opens, click Continue.

Click Install a CDE Software Product.

Click League Software from the list of available product categories.

Click Bowling League Secretary 2021.

Click Install BLS-2021 Standard/Pro/Autoscore to launch the program installer.

As an alternative, to bypass the installation menu, see Installing EXE directly from USB
on page [3and directly install the software.

Installing EXE directly from USB

To install the BLS-2021 using a USB memory stick, bypassing the menu system, follow
the instructions below:

Windows 1 r Window rver 2012

Insert the drive.

On the Windows Taskbar, right-click on the Start button and click Search.
Click File Explorer, click This PC, and then click the USB drive.
Double-click the BLS2021 folder

Double-click the BLS2021INSTALLER.EXE file to install the program.

abko0b =
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6. Ifthe User Account Control window opens, click Continue.

Windows 7 or Windows Server 2008

Insert the drive.

On the Windows Taskbar, click Start, and then click Computer
Right-click the USB drive icon and click Open in a new window.
Double-click the BLS2021 folder

Double-click the BLS2021INSTALLER.EXE file to install the program.
If the User Account Control window opens, click Continue.

oakwhn =

Installing from Internet
To install the BLS-2021 from the Internet, follow the instructions below:

1. Have your serial number with the product registration information available.

2. IfWindows is not currently logged in under a Windows account with Administrator
privileges, then log in as Administrator or as a user with Administrative privileges.
Connect to the Internet, then go to http:/www.cdesoftware.com

From the home page, click Download > Download League Software

Selectthe BLS-2021 tab

Locate the BLS-2021 Program Installer and click on the download button.
Depending on your Web browser, you may be presented with an option to Run or
Save. For Simplicity, select the option to Run. However, by using the Save option,
you will be able to keep a copy of the installation program as a backup or to
transfer to another computer.

N ok

8. Ifthe Run option is selected, the InstallShield Wizard will automatically start when
download is complete. If the Save option was selected, locate the
BLS2021INSTALLER.EXE file that was downloaded and double-click to start the
InstallShield Wizard.

Follow on screen instructions to complete BLS-2021 installation.

Moving to a New Computer
Moving BLS-2021 to a new computer is not much different than installing the program
on the original computer. Simply select the installation method, CD-ROM, USB Flash
Drive or Internet, and follow the instructions provided earlier in this chapter.

Getting BLS-2021 installed on the new computer is the first step. Next, you will need to
get the data transferred from the original computer to the new one. We recommend
using the back up and restore functionality discussed under the chapter on Back up and
Restore and Transporting League Data on ;ﬁgglzﬁ.

Registering Product
After BLS-2021 program has been installed, an icon shortcut to Launch BLS-2021 will
be placed on the desktop. When you launch the program for the firsttime, you will be
prompted to Run as a DEMO version, Register/Activate this Program or Purchase a

Program License.
Installation
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This screen will continue to appear everytime BLS-2021 is launched until valid
registration information is entered. These options are fairly self-explanatory. The
Purchase a Program License option will lead to our secure, Online Store.

Click on Register/Activate this Program to complete BLS-2021 installation so the
program can be used with the features enabled. Follow the prompts to fill out the user
registration. The Serial Number must be entered first before any other fields can be
edited.

If you are using a temporary registration code to use while waiting for your permanent
registration code, see Using a temporary code on page [38)

Enter the Serial Number, select the correct product using the Drop-down List, then enter
the First Name, Last Name, Company (if applicable) and League Name if registered to a
League. These fields, along with the registration key MUST be entered EXACTLY as
shown on the invoice. If the software is registered to a league, this field will also have to
be entered as shown on the invoice. For the Automatic Scoring edition, use the Drop-
down Listto selectthe scoring system and number of lanes. Finally, enter the address
in the required fields to complete registration. If the first or last name, company name
and/or league name are misspelled on the Invoice, enter the data as misspelled, to
continue registration. Report any misspellings to CDE Software, LLC so thatitcan be
corrected and updated registration information can be issued.

When all the data is correctly entered, the red Registration is NOT Correct! button will
turn green and change to Registration is Valid! The firsttime BLS-2021 is activated, you
will be prompted "To Save a NEW Registration". The Email and Postal Addresses may
be changed without requiring updated registration. In addition, if the registration had to
be entered with misspelled information, corrected registration data would be emailed.
Under these circumstances, upon making the corrections, the button will read "To
Update Current Registration" which will save the changes to the current registration.

Example 1: If the confirmation email and/or the invoice has "Jonathan" for the first name,
then "Jonathan" must be entered into the First Name text box. DO NOT enter nicknames
or shortnames, such as "Johnny" or "Jon".

Example 2: If the confirmation email and/or the invoice says to leave the
Company/Bowling Center text box blank, the text box MUST be left blank.

Tips and Tricks

e Copy your email to the Windows clipboard then use the "Paste from Clipboard" button.

e Save your email as a text file then use the "Register from File" button.

Using a temporary code

Registering using a temporary code vs a permanent code is the same process. All
information must be entered EXACTLY as it appears. The biggest difference is that for a
temporary code, the Company field must have TEMPORARY CODE ###### entered.

As an example:
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------ TEMPORARY Registration Information - - - - - -
PRODUCT NAME: BLS-2021 PRO

SERIAL NUMBER: 123456

FIRST NAME: John

LAST NAME: Doe

COMPANY: TEMPORARY CODE 54321

REGISTERED TO: Company

SCORING SYSTEM: Not an Automatic Scoring Version
E-MAIL: help@cdesoftware.com

ADDRESS: 14220 Interurban Ave S STE 140

CITY: Seattle

STATE: WA

POSTAL CODE: 98168

REGISTRATION KEY: abc1xn-cde005-efgyuc-hijom17-vj12

Notice the example says Temporary Code 54321 in the companyfield. If 54321 was the
only thing typed in that field or Temporary Code was the only thing typed in that field, will
not be registered..

Updates
During the course of the BLS-2021 lifetime, CDE Software, LLC will update the software
to enhance minor features and address any bug fixes. Updates are free of charge and
can downloaded when prompted to check for updates, or you may download directly
from CDE Software, LLC's website. CDE Software, LLC can provide updated CD-ROM's
or USB Flash Drives for a nominal fee, however the updates available online are
generally newer than what is available on the CD-ROM or USB Flash Drive.

The process for downloading and installing Program Updates from our Web Site is
identical to the steps outlined under Installing from Internet earlier in this chapter.
However, there are also options available when the program is running:

On the Main Menu, click Help > Check for Program Updates

As previously noted, updates can be downloaded manually by visiting our Web Site at
https://Iwww.cdesoftware.com

Note: If BLS-2021 is installed on a computer without access to the Internet, the update
can be downloaded on another computer, then copied to a CD, USB flash drive, or
similar removable device capable of holding 75-100 MB of data.
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Upgrades
CDE Software, LLC releases a new version of BLS every year for the new bowling
season, which starts in August.

Installing or removing older versions before upgrading:

Itis not necessary to install or remove older, previous versions of BLS before installing
BLS-2021. Upgrades are simply full version products that qualified for special discounts.
Itis not necessaryto install every version that you have. Simplyinstall BLS-2021.

Upgrading from previous version:

Previous versions of BLS do not need to be removed or uninstalled. The installation
program will install necessaryfiles into the default BLS-2021 directory. League files are
not overwritten during installation nor removed during the uninstall process.

Note:  The installation program will not automatically remove older versions of BLS. To
conserve a small amount of extra disk space, uninstall the previous versions of BLS
then delete the previous BLS folders and their contents after converting the older
leagues.

Using League files from previous versions of BLS:

Leagues created in BLS-2017 and above can be opened in BLS-2021.

Can | Install on Multiple Computers?
No. The Software License Agreement grants you the right to "Install and maintain the
Software on one computer atanytime, for use onlyin the End-User's home or own
business." Contact CDE Software to obtain information on multiple license
arrangements. For details, please review the Software License on p_agngﬁ.

Can | exchange data between the bowling center?
This depends on what version of BLS the center and the BLS you have.

If you have the Standard, Professional or AutoScoring version of BLS-2021 and the
center has either the Standard, Professional or AutoScoring edition of BLS-2021, then
the data can be exchanged between each other. When exchanging, it's recommended to
have the person receiving the data to back up their copy of the data (if they have it
already) and then delete the league prior to restoring the backup of the league from the
other person. This way data does not get mixed up.

If the person receiving the data has a version of BLS priorto BLS-2021, then the data
can not be exchanged as the data can only be converted forward to same or newer
version of BLS, not backwards to an older version of BLS.
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Changes to BLS 2020

While there are a number ofimprovements, bug fixes and changes far to many to list, the
following are highlights of some of the changes in BLS from past versions. This edition
is compliant with the 2020/2021 USBC rules and regulations as well as with CTF and
TNBAfor the 2020/2021 season and includes support for the new Under 17 division
Pepsi qualifying.

New Themes in BLS

BLS-2021 now offers several differentthemes to chose from. Here are examples of
them.

CDE Light

CDE Med Dark

CDE Dark

Glow

Golden Graphite
Windows 10 Office Light 2

New Menu's
BLS-2021 main menu’s have changed in looks. Theyhave been separated into
different sections. Clicking on a topic with an arrow to the right, a sub menu appears
with several options to select from. These options will then open the program to that
window directly.

In the Weekly menu, in the Back Up option, we have added a ‘send’ to option. In there,
the options are to back up to a specific drive/network drive, a cloud backup, and new
send to a person backup. Note: In this feature the email for the secretary and treasure
must be included in the bowler’s profile information.

Opening League Screen
The league main screen now includes a dashboard highlighting important information.
For example, if bowler birthdays are entered, a display of this week/month's birthdays
will appear in a scrolling message. Clicking on it will open the Statical screen. Clicking
on the Lanes dash board, opens the lane assignments screen. The Dash Board is a
quick visual or a shortcut to the actual menu item.
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BLS-2020/PRO - Version: 32.00.05 Release Date: 6/3(2019 Licensed To: CDE Suftware
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Lane Assignments
We have had manyrequests to show the what the week is when not bowling, i.e.
Holiday, etc. We have enhanced our lane assignments to be able to show what week(s)
are a holiday or special day that the league will not bowl. If choosing this option, entering
the total number of calendar weeks the league is to bowl; a 34 week league that has 2
holidays, 36 weeks must be entered in the league rules, How and When we bowl
section.
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Certifications
USBC now requires the BAand WBAto be merged. If the local association requires the
Final Average list to be separated, an option when going to that report will print separate
pages for each association.

Pepsi Tournament
The Pepsi Tournament has added a U17 division. BLS-2021 now has that division in
the tournament set up.

Perfect Secretary Leagues
We have made it possible for you to import your team names and bowlers into our
program to help alleviate the extra time of entering all the names and addresses.
However it does notimport the rules or averages or any bowler or team data such as
scores, points, etc.
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Program Overview and Opening Screen

Now that the program has been installed, it would be best to review some of the
program functionality and features. There is a logical order for running the program to
get the job done easily and quickly.

To start the program, do the following:
e From the Windows desktop, double-click the BLS-2021 shortcut
Or

e Click the Start button on the task bar. From the Start Menu, select Programs (or Apps
for Windows 8 or newer) > CDE Software BLS-2021

The opening screen offers a variety of options. On top of the screen contains pull down
menus to access functions for the program.

The program help is one of the mostimportant functions to be aware of, as it opens the
Help Section of the software. The Help Section is designed to guide you through the
program should you need assistance. From anywhere within the program you can select
HELP > Program Help or push the F1 key. Clicking on the Help menu, then Help will
display the section of Help thatis relevant to what you are working on. The Help Section
is more thorough than the product manual and is periodically updated when program
updates are made available.

Another important HELP feature is the program's Frequently Asked Questions, which
contains a list of the most common questions and situations asked about the program
and functionality. Select Help > Frequently Asked Questions or press F2 or Ctrl + F1 to
bring up the Frequently Asked Questions.

The electronic edition of the BLS-2021 program manual can be viewed by selecting
Help > Program Manual. This is in a .pdf format so the free Adobe Acrobat Reader or
other programs capable of opening these types of documents needs to be installed.
This typically should not be a problem as Adobe Reader or similar programs, are
required elsewhere in the program.

When BLS-2021 first opens five menu selections are available, Fle, Options,
Maintenance, Certify and Help. This is a departure from the prior generations of the
software and was changed to make it quicker and easier to navigate within the software
to get to the appropriate features.

Options Menu
This menu section is designed to provide access to common program options. As such,
itis further sub-divided into the following categories:

Registration: These menu functions allow registration and unlocking of BLS-2021.
Preferences: The menu functions allow for program operation preferences.

Multiple Users: The menu functions allow switching program registrations.
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Registration
The options in this section are provided to setup the initial features in the program.
These settings are globally available to all leagues managed in the program.

Program Registration
Views information about the product registration or makes changes to the registration,
such as correcting spelling or modifying registration. When upgrading from BLS-2021
Standard to PRO, enter the new information on this screen. If Activation is required, enter
the Activation Code on this page as well.

When program is running in Demo mode, initial registration can be entered on this page
without having to restart program.

The serial number, first and last name, company, automatic scoring and registration key
MUST be entered exactly as shown on the invoice. If the software is registered to a
league, this field will also have to be entered as shown on the invoice. Finally, enter the
address in the required fields to complete registration. The Registration is Valid! button
will remain grayed out until all the information is entered accurately with regards to what
was provided on the Invoice. If the first or last name, company name and/or league
name are misspelled, enter the data as misspelled to continue registration. Report any
misspellings to CDE Software, LLC so thatit can be corrected and updated registration
information can be issued.

Preferences
Preferences for general areas of the program.

Automatic Scoring Setup
This feature is only available in the Automatic Scoring Editions of BLS-2021. For

information on setting up or configuring the Automatic Scoring features, please see the
chapter on Automatic Scoring on page[27.

Local Awards Sefup
This menu option provides access to the Awards configuration screen when there are

no league files open. Once configured, these awards will be available for all leagues
managed in BLS-2021. These awards can also be configured when a league is open
by going to Options > Preferences > Local Awards Setup. For more information on
configuring these awards, see the Local Awards Setup on page[2+3)

Multiple Users
When using multiple registrations, this allows switching to a different program
registration.

Switch Users
There are some situations where a secretary who owns BLS-2021 to manage a league,
takes over a different league that also owns a license for BLS-2021. The license
information from the second league can be entered into the program and then use the
switch user function to change between the registrations.
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To switch registrations, select the appropriate listed registration and click Select This
Registration.

To delete registrations no longer being used, select the appropriate registration and
click Delete Registration.

Passwords
(Pro and & A/S feature only) Functions used to set a password to use this program.

Set / Change Program Password
This feature is only available in the Professional and Automatic Scoring Editions of BLS-
2021.

This option allows the ability to setup or change a password to allow or deny access to
the program.

If a password has been set for the program, it must be entered in order to change the
password to a different password. If NONE is entered for the new password, then the
password protection for the program will be disabled.

Passwords can not be retrieved will require re-installation of the software.

Maintenance Menu
This section provides various options to be used for maintenance of your league files.
These options represent different tasks that can be performed on the league data or
system files. Generally, these items need to be performed when there is no open league
files which is why they are only available when the league files are closed. Again, this
section is sub-divided into the following categories:

Back up: Menu functions pertaining to backing up BLS-2021 data.

Restore: Menu functions pertaining to restoring BLS-2021 data from backups.
Delete: Menu functions pertaining to deleting BLS-2021 data.

Copy: Menu functions pertaining to copying BLS-2021 data.

Find: Menu functions pertaining to finding BLS-2021 data.

Utilities: Menu functions pertaining to various functions.

Back up Data: This section provides the option to back up league and system files.

Restore Data: Provides the ability to restore previously backed up league and system
files.
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Backing up data is a veryimportant process that should never be neglected. Should a
computer disaster ever happens, the chances of recovering from that disaster is greatly
improved, providing backups are readily available. In addition, using backup files is a
convenient way of transporting league data to another computer. Due to the importance
of this subject, we have devoted an entire chapter on the subject. For more details
backing up and restoring data, see the chapter on Back up/Restore and Transporting
League Data on page[2s3.

League File Maintenance: This section includes options to delete league files, copy
older league files, copy existing league files and to search the hard drive for all league
files. Additional information on these options is available later in this chapter.

Updates and Support: Provides and alternate location to Email League to Tech Support
and Check for Program Updates.

Assorted Utilities: This utility will provide a drive and directory listing that can be used for
file maintenance. This can be used as an alternative to Windows Explorer.

Additional information on these options is provided later in this manual or in the Help file
included with BLS-2021.

Maintenance > Backup
Back up: Menu functions pertaining to backing up BLS-2021 data.

See page 263 for more information.

Maintenance > Restore
Restore: Menu functions pertaining to backing up BLS-2021 data.

See page 267) for more information.

Maintenance > Delete
Important Note: Be sure to make a backup of the league before deleting as this process
can not be recovered.

If a league is no longer needed, select Delete Leagues from the League and Fle
Maintenance menu. This can be helpful to remove older leagues that get copied from
one version of BLS to the next version during the upgrade installation.

Select the league to be deleted and click Delete League. Confirm your choice for the
league to be permanentlyremoved. This data does not go to Windows Recycle Bin, so
make sure you have a backup or that you are deleting the correct league.

Maintenance > Copy
This menu section has options to copyleagues, definitions or styles.

Copy BLS 2020 league to somewhere else
Select Copy BLS-2021 league to somewhere else from the League and File

Maintenance to duplicate a current league. This utility can also be used to rename the
file when the original file name is greater than 8 characters.
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Helpful Tip: Make a copy of your league to test alternate rules and settings.
Use the following procedure to make a copy of your current league:

1. Click on Maintenance > Copy > Copy BLS-2021 league to somewhere else
2. Selectthe league to duplicate, then click the Copy a League button.

3. Enter a unique name for the new league file, select a destination folder the click OK.
Be sure to limit the number of characters to 8 if the computer system or automatic
scoring system has this limitation.

4. Click Cancel to exit back to main screen.

o

Open newly copied league and confirm all settings.

6. Once the league data in new file name has been verified, delete the league stored
using the original file name (Optional)

Copy Older Leagues to use with BLS 2018
If a league was used in an older version of BLS, select this option to locate and copy the

league to this program. Only leagues created with BLS-2016 and newer are supported
using this option. To copyan older league:

1. Under Currently selected drive and directory, navigate to the folder that contains the
league to be copied.

2. When the correct folder is selected, the league should appear in the list of leagues
on the upper portion of the window.

3. Selectthe league and click Copy a League.
4. Create a new filename.
5. The new league will be copied to the default folder for league files.

As an alternative, if you have a backup of your league created by your previous version of
BLS no earlier than BLS-2016, you can restore that backup into BLS-2021. For more
information about restoring league files, please see Restore League Files on page[2f.

Search hard drive for leagues
Maintenance > Find > Search Hard Drive For League

These are 16 league files found
Gt oun [ ¢

Complated Laagues. Search Curent Tres v

Use this option to locate league files on the computer. Selecting this option will initially
perform a search of the Default folder for leagues in the BLS-2021 program. This option
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is also available on any screen when opening existing league files or performing
previously discussed maintenance (backup league, delete league, copy league, etc.).

If the league file is not listed on this screen, BLS-2021 provides additional options to
expand the search.

Search Current Tree: This option will search for league files in the folder selected under
Currently selected drive and directory including all subdirectories. To change the
location to start searching, select the folder to the right.

Search Current Drive: This option will search the entire drive selected under Currently
selected drive and directory including all subdirectories. Depending on the size of the
drive and the number of files, this may take a significant amount of time.

Once the league file is found, use the Copy Leagues to BLS-2021 button in the upper
right corner to copy the league to the Default Folder so that it can be readily available to
BLS-2021.

Library of bowling forms
Select Ale > Forms Library from the Main screen, or the Utilities menu with the league
opened, to access.
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This section provides access to all the forms available in BLS-2021. This screen
provides quick access to Average Charts to display handicaps associated different
averages based on the configured settings. This chart can also be printed and handed
out. Various printing options are also available on this screen. These options will vary
depending on which form is selected to be printed.

Select the desired form and click the Preview Selected Form button.

Help Menu
This menu section is designed to provide access to program help and assistance. As
such, itis further sub-divided into the following categories:

Help: The menu functions relate to the BLS-2021 documentation and help.
Support: The menu functions allow contact with CDE Support.

Internet Links Section: Various links with CDE and other websites.
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Program Functions
General help for the software.

About BLS-2020
This option provides the information about the current program. The important
information on this page is the program version and release date as these items
determine if the most current update is installed.

Program Help
This function accesses the help file for BLS-2021.

Frequently Asked Questions
This function accesses the Frequently Asked Questions file for BLS-2021. This file
contains various questions or situations that frequently occur during a bowling season.
We strongly recommend viewing this file when a problem or situation occurs to see if the
answer has already been placed there.

Program Manual
This function accesses the electronic version of the BLS-2021 manual. During the
season the electronic version of the manual is updated. The free Adobe Acrobat Reader
or compatible utility is used to view the manual. The electronic manual is handy for
reference and can be searched.

Check For Program Update
Selecting this menu item will check the CDE Software web site for the currently available
product version for BLS-2021 and provide notification if a newer version is available.

Support
Get support from CDE Software's technical support for the software.

Support, Forums and Downloads
This function provides a screen with Internet links for CDE Software, LLC product
support, message boards and downloads.

Contacting CDE Software
Provides support phone numbers and mailing address as well as a linkto send a
question to CDE Software, LLC's support staff.

Email Tech Support
Create an email to be sent directly to CDE Software, LLC's technical support staff. If you
have a question on BLS-2021 or require the support staff to examine a league, select
this option to bring up a built-in support email form. For more information, see the
Support Functions section under League Utilities on page/[2s3.

Remofe Support
Opens your default browser to CDE Software's remote support page. During a support
call or chat, the technical support team mayrequest you visit this page so the staff can
view your computer to help troubleshoot an issue you may be having.
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Internet Links Section
This section provides a few useful internet links which may not be affiliated with CDE
Software, LLC.

Custom Menu
When a league is opened, the custom menu (My Menu) is available to add frequently
used main menu features in an easyto access list. The Standard edition allows for a
limited number of items in the menu, whereas the Pro and AutoScoring editions allow
for more items in the list.

The Custom Menu is designed to be a shortcut to items in the pull-down main menu.
For many, itis a way to organize steps to run a week of league in a specific order.

Managing Menu

To manage the custom menu, click item #1 - Manage/edit "My Custom Menu". ltems
alreadyin your custom menu will appear. By selecting an item in the menu, it can be
moved down in the list, higher in the list or removed.

Adding an ltem

To add an item to the custom menu, , click item #1 - Manage/edit "My Custom Menu".
Select an emptyline that does not have a menu associated. Using the main menu at
the top of BLS, selectthe menu item to be added. After selecting, click the "Click to add
this item to My Menu" button. The item will now appear in the list. It can then be moved
up or down as needed or removed if an item was added accidentally.

Removing an ltem

To remove an item to the custom menu, , click item #1 - Manage/edit "My Custom Menu".
Select the menu item to be removed and click Remove Item.

Clearing the Custom Menu

To add an item to the custom menu, , click item #1 - Manage/edit "My Custom Menu".
Click Clear My Custom Menu.

Program Overview and Opening Screen E
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How to be a great league secretary

The following section provides insights into the ways BLS-2021 will help you be a great
league secretary. Once getting acquainted with the basics of BLS-2021, you can
advance to the more powerful features of the program.

Before your league begins
The first step is to obtain the League Secretary packet from the local association. Many
times the association will send the packet to the bowling center, so check with them first.
It will contain all the necessary forms to complete, including pre-printed membership
cards, league applications, average books, and rule books.

If you were a secretaryin past seasons, spend extra time going over current USBC rules.
Regardless of number of years the league has been in existence, league bylaws must
not conflict with rules as defined in the current season's USBC bylaws.

If unsure about the legality of certain league bylaws, please check with the national rules
committee.

Organization Meeting
One of the mostimportant steps in running a successful league begins at the
organizational meeting. At this meeting, three critical areas are discussed and then
agreed upon:

1.League Awards: The awards determine the competitiveness of a league. There are 2
types of awards and the league must decide what awards are dispersed and if the
prizes will be in the form of cash, trophies or both. Be sure that a prize committee has
been elected at this point.

o Team Awards - Awards given out for the top team scores for a game and/or series.
Can be based on handicap and/or scratch. (For sanctioned leagues, check the current
rule book for only awarding scratch awards.)

¢ Individual - Awards given out for the top individual scores for a game and/or series,
can be based on handicap and/or scratch. (For sanctioned leagues, check the current
rollback for only awarding scratch awards.

2. Financial: At the meeting, the nightly fee needs to be established. Go over the lineage
amounts (fees charged by the center), secretary and treasurer fees, and the amount
contributed to the prize fund. Try to make the nightly fee an even dollar amount so there
won’t be the extra burden of making change each night.

Discuss and vote on any sponsor fees collected for team or league sponsors. Vote on
anyfines imposed and make sure thatitis included in the league rules. The league
must also establish a bank account and bonding, or use the in-center banking service.

3. Playing Rules: Establish the rules of league as per the Suggested League Rules
section of the USBC Rule Book. Print a copy of the league rules from BLS-2021.

Go over the league rules before the meeting and carefully check for discrepancies
againstthe USBC Rule Book. If unsure about a set of rules, contact the association
rules committee, to check its validity. The rules from USBC do change from year to year.
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Arule that the league voted in 10 years ago may have been legal then, but may not be
legal this year.

Verify Handicap rules and points awarded.

Itis recommended you print a league rules worksheet to take to the meeting. One of the
benefits of using the worksheetis that when rules are established and approved, simply
plug the information directlyinto BLS-2021 after the meeting.

To print the league rules worksheet, open BLS-2021 and click the Library of bowling
forms[5ficon. Click Generic League Forms and select Blank League Rules
Worksheet. Click on Preview Selected Form and print the report. Blank Team Sign-up
Sheets and Average Charts for handicap reference are available to print.

How to be a great league secretary



The First Night of Bowling

There are many things to tend to, the first night.

e League rules

e Recap Sheets

e Standing sheets showing bowlers, entering averages and lane assignments
e League and bowler’s sanction applications

All these documents from within BLS-2021 may be printed and taken to the first night of
bowling. The standing sheet and recap sheets would only be done, after the teams and
roster members are set.

Arrive at the bowling center ahead of everyone else and introduce yourself to the center’s
manager. Establish what the center’s job includes. For example they may distribute
forms or pay envelopes. You should also try to set up a table in an area where you can
conduct league business during that opening session and let the center staff know
where is itis.

Hold a briefing prior to the starting time of the league with the team captains and officers.
Keep in mind that although many bowlers know each other, there maybe a new face
amongst you and a shortintroduction would be appropriate.

This is also a good time to review with the captains, their duties, which mayinclude
completing and submitting the following:

e Recap Sheets
e PayEnwelopes

Be sure each team captain has a copy of the league rules and bylaws. Your job is to
delegate the work to the team captains, because you have a lot of other responsibilities
that need your attention. That's why it's important to communicate with the team captains
up front, on what you will be expecting from them.

At the end of the first session
Collect the pay envelopes and recap sheets from the team captains.

o Ifyou are also the treasurer, verify the money collected matches the pay envelope.
e Paythe bowling center lineage.

e The balance of money should be deposited into the league account. Sometimes
bowling centers offer in-house banking. You will need to check with your bowling
center, and make arrangements with them.

o Complete the sanction applications and mail a check to your local association for
sanction fees.

If the center’'s automatic scoring participates in the interface with BLS-2021, download
them to a flash drive or disk, with the scores, to take home.
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Responsibilities each week
e Postthe standing sheets at the bowling center and upload the Standing Sheets to the

LeagueSecretary.com and Bowl.com web sites. This allows the league bowlers to
verify the accuracy of the scores and calculations. Aithough BLS-2021 is 100%
accurate, a different score or average may appear because a rule was setup
incorrectly...or if an incorrect score was entered. If a discrepancy exists, refer to Reprint
of Scores Report to resolve the dispute. Make notes of any errors that need to be
corrected.

e Hand out a copy of the standing sheet and recap sheets to team captains.

e Collect payenvelopes byend of the 1st game. (Better yet, have the team captains
bring the pay envelopes to you). Remember that your job is to delegate responsibility!)
If you designated yourself as the secretaryin the Bowler Maintenance screen, the
standing sheets will say “Your League Secretary Dawn Bean is on Lane 12" so
everyone knows where to find you.

e Collectrecap sheets atthe end of bowling.

e Poststandings online to LeagueSecretary.com, Bowl.com and SportBowling.com.

Mid-Season

e The local association usually requires an average list as of January 1, for sanction
and tournament purposes. Print the Average Report from the TaskMd/End Season

Reporting menu > Final Averages. Print a copy, save itto a USB or disk file, or
transmit it electronically.

e Check with the center to see if they also need a copy for tournament purposes.

Before the season ends
e Check with the local association to see when the Final Averages reportis due. The
report may be due even if the league season has not been completed.

¢ Ifthe league hands out trophies, allow sufficient time to get them ordered.

o Ifthe league has a banquet, assign a banquet chairman to arrange a location and
reserve the space.

e Also, when using the League Planner, be aware of important deadlines such as the
league’s qualifying windows for the Youth Pepsi Championships. This can help
bowlers notto miss out on special tournaments and events.

End of season
¢ Printthe final reports and final standing sheets.

e Print Bowler and Team History and Final Average List and distribute to each bowler.
o Verify that the awards listis correct.

e |fawards are in cash, use the Prize Fund Calculator to determine denominations of
bills needed for the cash prize envelopes.
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e Restarting a league. Many leagues operate season after season with little or no
change to teams or rosters. With BLS-2021, it's easyto restart a league with the
same teams and rosters used the previous season. Make a back up of the league
before restarting.

o [fthe league won’t bowl next year, it can be deleted. Itis always a good idea to make
back ups of data before erasing any of it. If a bowler complains or if the final average
report gets lost before the local association receives it, it can be restored.
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Using Program for Season

The following chapter gives an idea on how to use the program during the entire bowling
season. There may be exceptions that occur during the season depending on your
league.

Home League Secretaries
The following is a basic flow chart on how a league secretaryathome would use BLS-
2021 from the start to the end of the bowling season. There are certainly situations that
may occur during the season that may cause a need to deviate from the below schedule,
butin general, this is the normal day to day operation.

1. Prepare the league to start the season

a. Create a new league file.
Setup the rules in BLS-2021 to match the bylaws that the league has adopted.
Setup the lane assignment schedule to match the schedule that the league has
bowled.

d. Printa signup /roster sheet for bowlers to include their information.
Set up the teams and the rosters of who is bowling on which team.

f. Enter/edit bowler information as needed, such as address, phone number, email
address, book and/or entering averages.

g. Designate bowlers who are officers of the league.

h. Setup the standing sheet to match the appearance desired and has the
information desired.

i. Setup the certification fees for the local association, ifa USBC or CTF league.

j. Setup the league fees, if also doing financial duties.

k. Setup the league for online standing sheet viewing with LeagueSecretary.com -
a free service to sanctioned and non-sanctioned leagues.

2. Prepare for the week

a. Adjustrosters as needed
b. Printrecap sheets for bowlers to write their scores on

3. LEAGUE BOWLS
4. Process the week

Adjustrosters to match how league bowled

Enter scores for the week

Check for awards earned and print awards.

Print Standing Sheet

Upload standings to LeagueSecretary.com

Process payments, if managing financial duties

Back league up to an external USB Drive or Hard Drive
Advance to next week in BLS

@ "0 o0 oo

5. Repeat Steps 2, 3 and 4 for season.

6. Prepare league for finish of season
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Print Final Standing Sheet

Print Bowler and Team Histories

Print Final Average Sheet and return to association managers

Print Returning Bowler list and have bowlers and teams complete

Make a final backup of the league and place on an external USB drive or Hard

Drive.

7. Enjoythe break

Center League Processors
The following is a basic flow chart on how a league processor at the bowling center
would use BLS-2021 from the start to the end of the bowling season. There are certainly
situations that may occur during the season that may cause a need to deviate from the
below schedule, butin general, this is the normal day to day operation.

1. Prepare the league to start the season

a.
b.

Create a new league file.

Setup the rules in BLS-2021 to match the bylaws that the league has adopted.
Set up the lane assignment schedule to match the schedule that the league has
bowled.

Printa signup / roster sheet for bowlers to include their information.

Set up the teams and the rosters of who is bowling on which team.

Enter/edit bowler information as needed, such as address, phone number, email
address, book and/or entering averages.

Designate bowlers who are officers of the league.

Set up the standing sheet to match the appearance desired and has the
information desired.

Set up the certification fees for the local association, ifa USBC or CTF league.
Set up the league fees, if also doing financial duties.

Set up the league for online standing sheet viewing with LeagueSecretary.com -
a free service to sanctioned and non-sanctioned leagues.

2. Prepare for the week

a.
b.
c.

Adjustrosters as needed
Printrecap sheets for bowlers to write their scores on
Export rosters to AutoScoring System

3. BOWL LEAGUE

4. Process the week

a.
b.

Import Scores

Edit/Enter scores that were notimported or need to be changed for whatever
reason.

Adjustrosters to match how league bowled

Check for awards earned and print awards.

Print Standing Sheet
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Upload standings to LeagueSecretary.com

Process payments, if managing financial duties

Back league up to an external USB Drive or Hard Drive
Advance to next week in BLS

5. Repeat Steps 2, 3 and 4 for season.

6. Prepare league for finish of season

©® oo o p

Print Final Standing Sheet

Print Bowler and Team Histories

Print Final Average Sheet and return to association managers
Print Returning Bowler list and have bowlers and teams complete

Make a final backup of the league and place on an external USB drive or Hard
Drive.

7. Enjoythe break
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Creating a New League
Itis bestto have a copy of the printed league rules and bylaws available for reference
when creating a league for the veryfirsttime.

Open BLS-2021 program, click on Fle > New > Create a New League or Create from
Perfect Secretary League.

BLS-2020/PRO - Version: 32.00.11 Release Date: 7/16/2019 Licensed To: CDE Software

i | Options Maintenance Certify Help
Exit Program

New » Create New League

Create from Perfect Secretary League

.Open League for Current Season
Open Other
Open Recent League

Program Preferences
Utilities ’
Tile Settings

PROFESSIONAL

Creating a File Name
The first window that will open when creating a league is the File Name window. Enter a
file name thatis easyto remember such as MonMix2019, or just use the default name
thatis alreadyin the space provided.

This is the name that the computer will associate all the league data with. Itis not the
league name. Once this has been decided and entered, click on the OK button
(green/white check mark).

Note — Do not change the Drive and Folder for Data Files, unless this information is
going to be stored in a different location.

Rules Wizard
After entering the file name, BLS-2021 will ask if you want to use the Wizard. The Wizard
makes setting up the basic league rules much simpler and will go through the basic
rules. Once the wizard is finished, if the league has any additional rules or the league
changes a rule(s), this can be modified/changed by going to Setup > Rules, then adjust
or make any changes necessary.

Creating Perfect Secretary Leagues
Open the program, click on File, then Create from Perfect Secretary League. Awizard will
come up that will help with converting the PS League to BLS. Read the instructions and
click Next. To find the directory for the PS leagues, click the browse button, click on the
local C drive, find the PSD folder and click Select. Click Next. The next screen will have a
list of the leagues byfolder, League01 etc. Select the correct folder, click Create League.
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Another window opens to designate a file name for the league. See Creating a File
Name| 66).

Amessage boxwill pop up asking if you would like to use the rules wizard, itis
recommended to use it.

Once the wizard is complete, it will open the General Rules section. Verify that everything
in the Rules setup is correct, make any changes necessary. Click Done when finished.
The Lane assignment screen will open and remove any dates (weeks/sessions) the
league is not bowling. Click in the Type of Week column, use the Drop-down arrow to
select your position rounds, etc. Note, BLS 2018 does not support putting in a Holiday,
like PS did, but this will be supported in BLS-2021. When the lane assignments are
done, click Main Menu. To verify the bowlers and teams, click Setup, Teams, Rosters. All
the Teams and bowlers will be there. By clicking the Drop-down arrow at the top,
Averages and High scores, and selecting all information, the addresses, phones
number, etc., will show.

Creating a New League
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Handicap Leagues
If there are any questions regarding any of the rules, please refer to our Help Manual, or
our FAQ’s. Also, our Support Forum may be of help at http://support.cdesoftware.com

This section will cover each section in the Rules > General Rules

General Rules
WHO WE ARE

Enter a description or the name of the league in the space provided which is yellow. This
will copy to the title of the league to show on the reports. If a different name for the
reports is desired, this may be changed.

Note — if the program is registered to the league, the registered name of the league will
show on all the reports.

When entering the number of teams in the league; it must be an even number. Should
there be an uneven number of teams, an extra team must be added (vacantteam) to
make it even.

Enter the number of bowlers on a team that bowl each week.

Enter the number of games the league bowls each week.

HOW AND WHEN WE BOWL

Using the date picker (Select Date button). Select the date the league is to start
bowling.

Note - Single arrow changes the Month, Double arrow changes the year.
Click the check mark to confirm this.

The program will select the season.

Enter the time the league starts and the approximate ending time.

Itis veryimportant to enter the correct number of weeks/sessions the league bowls. Do
not count weeks that the league may take off for holidays, etc. Include any fun nights or
roll-off nights. Note - if using the new feature for holidays, etc., the entire number of
weeks will need to be setincluding the sessions/weeks not bowling.

If the last week of bowling is a fun night/roll-off, then make the final night of bowling the
week before. Example: A 33 week league with the 34th week a fun night, the final night of
competition will be week 33.

LEAGUE FEATURES

The section contains main options for the league and what will be displayed will depend
on these settings.

If the league is anything other than Standard 10 Pin bowling, use the Drop-down arrow
to select the type of bowling the league is playing.
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Indicate the type of bowlers in the league. Use the Drop-down arrow, select the proper
option.

If this is a handicap league, make sure that the type of league option is set to handicap.

The next section, change the No to Yes on any option the league will use, otherwise
leave them at NO.

Individual Match points — additional points for individuals bowling against the opposing
bowler in the same position on the team roster (See Creating an Individual Match Point
League)

Bowler Divisions — Separating bowlers to compete only within their division, such as
men, women, etc.

Team Divisions — Generally used in specialized leagues, such as a sports type league
(See Creating a League with Divisions)

Bumper Bowling — Generally used with the young junior bowlers, or the physically
disabled bowlers’ league

Drop-In Singles League — Aleague that has only one bowler on a team or used for an
organized open bowling group (See Creating a Singles/Drop-In League)

This next section designates whether the league is Certified/Sanctioned by an
organization, so that BLS-2021 can track awards earned by the bowler. If the league is
Certified/Sanctioned, select the correct organization from the Drop-down list.

WHERE WE BOWL

To have the center name where the league bowls on the reports, click on Edit
Information, and add the center to the list. Click on Enter a New Name, type a Shortcut ID
code and enter all the information for the center. In the Special window, click in the option
boxfor bowling center, and enter the Lane Certification number, and using the Drop-
down arrow, select the number of lanes. Click Select to close this window.

Split Season

Change the option that applies to the league, i.e. a regular league will be No.
Ifthe league is a Split Season, change the option to Yes.

There will be another section that will appear when this is setto Yes. These options are
setaccording to the league rules.

SPLIT SEASON SCHEDULE

If the option is setto Yes in the last section, these options are veryimportant to have
correct according to the league rules.

Enter the number of splits/sessions the league is to bowl in the spin box provided.
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Depending on how manyweeks the league is set to bowl, BLS-2021 will fill in the week
number(s) of the new start of the next session/split(s). This can be changed if the league
wants a different start of the split.

According to the league rules, change the option to the correct position (Yes or No) for
the options that are to be reset back to zero at the start of the new split(s).

TEAM STANDINGS DETERMINATION

Generally this option is set for the Current Split so standings are ranked in order of the
wins and losses for just that split.

Change this option to entire season if the standings are to be determined by the entire
season and not the current split.

**This option only shows up if the league is a Split Season League.

Legal Lineup
WHAT MAKES A LEGAL LINEUP

This section defines the actual number of players that bowl on each team each week.
This is sometimes referred to as playing strength. Using the spin box provided, select
the correct number of actual players that are on a team, such as 3 for a trio league, 4 for
aregular league, etc.

Enter the number of bowlers who must physically be present to bowl each week,
according to the league rules.

Of those bowlers physically bowling, how many players must be a regular member of
the team (not substitutes)

When advancing to the next week, select what order the bowlers are to bowl from the
Drop-down list box.

The bylaws should state whether a vacancy position should be considered toward a
legal line up and for how many weeks.

ADDITIONAL LEGAL LINEUP REQUIREMENTS

If the league is a mixed league, select the correct requirement from the Drop-down list
box, according to the rules, as to how many of each gender mustbe on a team.

Individual Averages
BOOK AND ENTERING AVERAGES (Standard average Rules)

Determine from the league rules/bylaws whether the bowlers will establish a new
average or use their book average (last years’ average) when starting this league.

If establishing a new average this year, in the ‘Use average for how long’ set the number
of games to 0 (zero).
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In the section where a bowler has no Book or Entering average, leave the Use bowler’s
first night average and enter the number of games the bowler is to use this average, i.e.
3 games.

The next section referring to the Book Average requirements, these options can be left at
zero.

NON-STANDARD AVERAGE RULES

These rules are non-standard which few leagues use and should not be changed for a
basic league.

Individual Handicaps
BASIC INDIVIDUAL HANDICAP RULES

The league rules/bylaws should have a section that defines the handicap percentage
and the base average. Ifitis the same for all sexes in the league, change the switch to
YES. Ifitis different for each gender, than change the switch to NO and type the correct
percentage and base average in the spaces provided.

This information is veryimportant to be correct because BLS-2021 uses this to calculate
individual handicap for teams and awards.

When a league deems thata game score with handicap can not exceed 300, change the
option Maximum Hdcp score to 300. The same for Max Hdcp Series, setto 900. If the
league does not have this rule, then leave the values as the default.

NON-STANDARD INDIVIDUAL HANDICAP RULES

These rules are non-standard which few leagues use and should not be changed for a
basic league.

Team Handicaps
BASIC TEAM HANDICAP RULES

There are 3 different options to choose from when setting up the team handicap. Refer
to the league rules to determine which option the league has chosen and selectit from
the Drop-down list.

e Sum of Bowler handicaps — Each bowler has an individual handicap and they are
added together to create the team handicap

e Based on the Difference of the Team Averages — A percentage of the difference of both
teams bowling averages (Team averages of all the bowlers’ averages (on the team)
totals the Team Average)

e Based on Team Average — A percentage of the difference of the team average and a
base
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Once the correct option has been chosen, if there are anyrequired other options, such
as the percentage and the base, complete this information according to the
rules/bylaws.

NON-STANDARD TEAM HANDICAP RULES

These rules are non-standard which few leagues use and should not be changed for a
basic league.

Absentee Players
ABSENTEE SCORE RULES

Most leagues have a rule that when a player/bowler does not show to bowl the match,
and the team does not get a substitute, the team is penalized by taking a certain amount
of pins off the absent bowlers average and used that score for the games not bowled.
Note — does not affect the handicap.

Most leagues will use the average minus 10 pins for an absentee score. This is default
in BLS-2021, but can be changed if the league uses another value using the text box
provided.

Change the option to YES if the information is the same for all sexes in the league. If the
league has a different value for each gender, the change the option to NO, and enter the
various values for each gender.

An absentee score is average less a percentage, which is a non-standard rule and is
discouraged from use. If the league is sanctioned and or certified by USBC, the league
cannot use this rule.

ABSENTEE PIN DROP RULE

Ignore this section because most basic handicap leagues will not use this option. Itis
generallyused with a league thatis a very highly competitive type of league.

Vacant Players
VACANT PLAYER RULES

In the case of a league that either has a player drop out and can’tfill that position right
away, or the position on a team does not have a permanent bowler, the league will use a
Vacant player for that spot and assign a vacancy score to be used. (This score would be
for all vacant players’ on the league.) Enter the correct score, (if different from the default
in the program), in the text boxes provided. The vacancy score is a fixed score that will
have handicap added to the team handicap.

If the league has a different vacancy score for each gender, change the option to No, to
show all genders and enter the score to be used in the appropriate text box.

ADummyscore is a fixed score that does not add handicap to the team handicap. If the
league uses this option, then enter the score to be used in the text box provided.
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Forfeits
OPPOSING A FORFEITING TEAM

AForfeiting team is a team that does not show to bowl in a particular week. This rule is
how to award the points. Select the correct option according to the league rules from the
Drop-down listbox:

e The team bowling must bowl within a certain number of pins of their average to earn
the points

e No Wins or Losses are awarded

e The team bowling automatically gets all the points

Bye Teams
WHICH SYSTEM USED

Set this option up even if the league has an even number of teams at the start of the
season. This rule is used when there is an uneven number of teams with actual bowlers
in the league.

There are two types of systems:

1. The Bye System — this is used when a team bowls a vacantteam (a team with no
players). Most basic handicap leagues will use this system and the team must bowl
within a certain number of pins of the team average (the total of the bowlers’
averages).

2. The Draw System — Ateam bowling against the vacant team will bowl against the
scores of another actual team in the league, bowling the same night. Not generally
used in a basic handicap league.

Clicking on the option will change from the Bye System to the Draw System.

BYE SYSTEM

This is the more popular of the two systems when deciding how the team will earn the
points. Check the league rules/bylaws to determine one of the following:

1. The team must bowl within a designated amount of pins within the team average to
earn the points

2. No Wins or Losses will be awarded

3. The team gets all the points

The next statementis how the Bye team should affect the standings:

1. The Bye team will receive neither wins or losses

2. The Bye team will receive points earned but will remain in last place

3. The Bye team will appear in the standings like every other team
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The most common option is #2. Check the rules to see which option the league
requires.

BYE TEAM NAME

This section is not available in the Standard version of BLS-2021. Onlyin the Pro
version or AS version, can the name be customize for the vacant team, which by default
is called BYE. Note — when setting up the teams, and there is a vacant team, make sure
to change the Name of the Team to BYE.

Team Points
POINT SYSTEM

Determine the point system the league is using, Standard team points (used by nearly
all leagues) or Points issued based on bowling above or below the team average (also
known as Performance Points). Select the correct option.

Note — most common leagues will use the Standard team point’s option

STANDARD TEAM POINTS

Referring to the league rules, verify the number of points that are awarded for each game
win with handicap and points awarded for series wins (total pins for all games).

Enter the number of points per game in the ‘With Handicap’ the text box after this option.
Repeat for the Series points awarded.
Note — Scratch points are awarded to scores with NO handicap.

Standings can be determined either by a percentage of wins to losses or absolute
points. Select the correct option setting, that the league prefers to how the teams are
ranked on the standing sheet.

If there should be a tie in the standings, how does the league want to break the tie to
determine which team is higher in the standings? Select one of the following from the
Drop-down list box:

1. Total pinfall then Actual Games won (not points)

2. Actual Games Won, (not points)

3. Total pinfall with Handicap then Actual Games won (not points)

4. Actual games Won (Not points) then Total pinfall WITH HANDICAP

Note — Actual Games won is the game only, not the points associated with the win.
Example: Tm #1 wins games 1 & 3, Team #2 wins onlygame 2, this would be for Team
#1,2 games won and 1 game lost, where as Team #2 would have 1 game won and 2
games lost. Series/total wood is notincluded and is not considered an actual game.
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NON-STANDARD TEAM POINTS

The basic handicap league will not use non-standard team points. For more information
about them, check our Help documents.

Do notchange any of these options.

Point Summary
SUMMARY OF POINTS

This section is an overview of the points each team could be awarded. Make sure that
these are correct. If not, they are not correctly set up the Team Points correctly. Go back
and correct the errors.

Special Recognition
BLS-2021 will calculate the awards and prizes properly when all these items are set
correctly.

SPECIAL LEAGUE RECOGNITION

This section is probably one of the mostimportant sections to make sure everything is
setup according to the league rules. Ifitis not setup correctly, bowlers may upset as to
why they did not receive an award that was earned.

RECOGNIZED ITEMS BY LEAGUE

This section refers to what awards/prizes the league will be recognizing and awarding to
the teams and players.

Change the options to the appropriate answer either Yes or No, according to the league
bylaws.

INDIVIDUAL ELIGIBILITY FOR SPECIAL RECOGNITION

These options address the individual eligibility of the individual bowlers for special
recognition. Change the option on the ones that the league deems appropriate to YES
and leave the option on the others to NO. If unsure of what each one means, itis
probably bestto leave it at NO. These can be changed later, but best to have them
correct now.

e Permanent Substitute — A person that only subs on one particular team during the
season

e Temporary Substitute — A person that can sub on anyteam during the season
(sometimes called Roving Substitute)

¢ Pre-Bowl/Make-ups — Games not bowled on a scheduled night of bowling but are
bowled at another time
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The next sub-section is determining the final week of competition. If the league has a
Fun Night or a Roll Off on the last week of the league, then the final night of completion
would be the week prior.

Example: A34 week league — on week 34, a Fun Nightis scheduled, then the final week
of competition would be week 33. If the week 34 is a position round or the last week of
competition, than this number would be 34.

Enter the last week of competition in the box provided.

Generally, a bowler mustbowl 2/3’s of the scheduled games, in order to receive any
special awards/prizes. BLS calculates that automatically, but it can be change itif the
league wants less number of games to qualify.

The next option is whether a temporary sub that joins a team is eligible for any special
awards/prizes for games bowled while being a substitute. Use the option to answer this
question either YES or NO.

BLS determines if a player cannot complete the required amount of games by the end of
the season. Players not meeting this requirement may be displayed on the standing
sheet for the Season High Scores based on the setting.

INDIVIDUAL SPECIAL RECOGNITION

The rules for individual high handicap game and series recognition are going to be
determined by the following options. Consult the league bylaws for this section.

Rules for individual high handicap and series recognition:

Determine when the handicap scores are going to begin being tracked. Enter the
number of games that a bowler must bowl in the box provided. This means that the next
games bowled will be tracked for handicap awards/prizes. Example: Abowler must bowl
12 games and beginning game 13, then handicap will be applied.

According to the bylaws, when reaching this number of games by a bowler, select either
YES or NO if wanting to back-apply the current handicap to previous bowled scores. This
means that the handicap the bowler has as of their 15th game of bowling, this handicap
will be added to the scratch scores for previous bowled games to determine the
handicap scores.

BLS will not process scores for handicap awards until the specified number of games is
reached, do not change this option. If according to the league rules, the league is using
a Book Average or Entering Average (which most basic leagues do not), then choose the
correct option from the Drop-down list.

In accordance with the rules/bylaws, set the option to the correct setting if the league is
going to include scores with zero (no) handicap for recognition of handicap scores.

Determine how many games a bowler must complete before being eligible for the most
improved average award. The same is for an individual high average award.

If the league only allows a bowler one special recognition award for season high scores,
select the option from the Drop-down list.

e SS - Scratch series, HS — Handicap Series
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e SG - Scratch game, HG — Handicap Game

If players are tied, select how they should be listed; 1. Occupy two or more positions, 2.
Share the same position.

TEAM RECOGNITION

This section follows the same concept as the Individual Special Recognition.

Enter the week number to begin tracking the handicap scores. Decide if a score with
zero handicap is to be included in the recognition of handicap awards.

Use the switch to determine if a game or series with an absentee or vacancy score is
eligible, and if a game or series score with a substitute score is eligible for league high
score recognition.

STATISTICAL INFORMATION

This information is used generally for the end of season reports. If the league is a low
average league, then enter lower numbers for the games and series. Ifitis a higher
average league, increase these numbers. Otherwise, leave them as they are.

Handlicap Match Point League
See Basic Handicap League[ 7®for the basic rules.

This chapter will cover the additional rules that will need to be set up for an individual
match pointleague.

Individual Match Points for Absentee Bowlers
Rules > Absent Players

INDIVIDUAL MATCH POINTS FOR ABSENTEE

This rule pertains to individual bowlers, bowling against the bowler in the same position
on the opposing team.

According to the league bylaws, how are the match points awarded when a bowler that
is present bowls againstan absent or vacant and selecting from the Drop-down list:

1. Ifthe absent player wins the match, points go onlyto the absent players team (no
individual points awarded)

2. No points are awarded when a player is absent/vacant

3. Ifthe absent player wins, points go to the team winning the game

4. The absent play/vacant maywin and lose points just as if they were present
Click on the correct option from the Drop-down list.

Match points are awarded when the present player bowls againstand absent score,
choose from the Drop-down list:
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1. Player mustbowl their average less indicated amount
2. No points are awarded

3. Bowler automatically gets all the points

4. The bowler mustbeat the absentee score

If the option is #1 above, then enter the number of pins a player must bowl! within their
average to earn the point.

Determine how the points are awarded when Absent score versus Absent, Vacancy or
Dummy score:

1. Team winning the game
Player with the highest score

Split the points

> w0 N

Winning player’'s team only

ABSENTEE PIN DROP RULE

If the league rules/bylaws state the league uses the Absentee Pin Drop rule, set this up
in this section up accordingly.

Enter the number of weeks a player is absent more than the designated number of
weeks.

Choose from the Drop-down list whether the absences will be in a row, or for the entire
season.

According to the league rules, select the option of either a specified number of pins per
week, or a flat number of pins thereafter.

Enter the number of pins the average is to drop per week.

Individual Match Points for Vacants
Rules > Vacant Players

INDIVIDUAL MATCH POINTS FOR VACANTS

This rule pertains to the vacant bowlers, bowling against the bowler in the same position
on the opposing team.

Refer to the INDIVIDUAL MATCH POINTS FOR ABSENTEE[79 section.
Opposing a Forfeiting Player
Rules > Forfeits

When a player bowls against an opponent that forfeits, select the correct option from the
Drop-down list:

1. Player mustbowl their average less indicated amount (pins)
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2. No Points are awarded
3. Player automatically gets all points

If chosing the first option above, then enter the number of pins a player must bowl within
his average to earn the point. (Bowling the exact number is considered a win and nota
tie.)

Points not won are considered a loss.

For reference and to help in determining point prize money, wins are recorded as
'‘Unearned’ points.

Match Point vs BYE Team

Rules > Bye Teams

When a player bowls againsta BYE team, select the correct option from the Drop-down
list:

1. Player mustbowl their average less indicated amount (pins)
2. No Points are awarded
3. Player automatically gets all points

If chosing the first option above, then enter the number of pins a player must bowl within
his average to earn the point. (Bowling the exact number is considered a win and nota
tie.)

Select how the Match Points are awarded when an Absent or Vacant player bowls
againstthe BYE team:

1. No Points are awarded, they are considered 'Unearned' points.
2. Points onlygo to the team if it wins the game. Bowler gets none.

3. Bowler and Team automatically get all points.

Individual Points
Rules > Individual Points

Decide which individual point system the league is going to use. Click on the
appropriate option from the Drop-down list:

1. Standard match point system used by nearly all leagues

2. Issue points based on which bowler bowls most over (or closest to) their own
average

3. Issue points based on bowling above or below bowler's own average (aka
Performance points)

4. Difference between the bowler’'s averages (figured with handicap)
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STANDARD MATCH POINTS

Once the number of points (generallyone) is determined, enter it in the appropriate spin
box. There is an option for scratch points and handicap points. Handicap points are the
individuals score plus their handicap.

If the league is also giving points for the individual for series, enter that number, also.

Handlicap League with Divisions
See Basic Handicap League[7®\for the basic rules.

This chapter will cover the additional rules that will need to be setup for a league using
Bowler and/or Team divisions.

Team Divisions
If the option in the General Rules is changed that the league has Team Divisions to YES,
this section will be available. If left it at NO, then this section will be hidden.

The league rules should define how manyteam divisions the league is to have. Enter
that number in the spin box provided.

Use the switch to select the correct option pertaining to Team standings are separated
into divisions, YES or NO.

Weekly and season high scores are separated by division, YES or NO.
Who assigns teams to divisions:

Depending on what you have the switch set to, will depend on whatteams are in what
division.

You Do It - You can type a division name in the table provided, i.e. Div. 1 East, Div. 2
West. When entering teams in the Rosters, division numbers mustbe manually
assigned. There must always be an even number of teams in each division, if bowling
within divisions and use the division lanes assignments. If not bowling within divisions,
this does notapply.

Let BLS Do It— You can change the Division Name, and the number of teams in each
division. BLS-2021 will putin the team numbers for you for each division. These team
numbers will be sequential order, i.e. 1-10, 11-20, etc. This option will automatically put
an even number of teams in each division.

Bowler Divisions

BLS-2021 automatically separates the bowlers by gender, so according to the league
rules/bylaws, configure your divisions only when bowlers must be separated by a
different method, such as age, average, etc.

Enter the number of divisions the bowlers are divided by.

Use the switches to determine what special recognitions are going to be separated by
the divisions.
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Select the correct option according to your rules/bylaws, how the bowlers are separated
into divisions:

1. Manually set each bowler’s division (the division number will have to be manually
entered when setting up the bowlers on teams)

Book average

Current average

2
3
4. Age as of August 1 (birth dates must be entered in the bowlers information)
5. Gender & Book Average

6. Gender & Current Average

7. Gender & Current Age (birth dates must be entered in the bowlers information)

Depending on which option you select, the table provided will change and expand to type
in the ranges, and genders if one of the gender options is selected.
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Drop-In Singles League

This is also known as a substitute league, where every player is considered a
Temporary sub. This allows the bowlers to bowl on their choice of a pair of lanes and
with anyone they want to bowl with every week. Itis generally used with an organized
open bowling group that doesn't want to have specified teams to bowl on, but have more
than one bowler on each lane.

See Basic Handicap League[7®for the basic rules.

This chapter will cover the additional rules any addition rules that will be needed to in
setting up this type of league.

Legal Lineup
The number of people who bowl on a team is going to be the number of singles that will
be puton a lane.

Example: Sixteen people have decided they want to bowl in this league, and only have 4
lanes available, put4 people on a team.

Use the spin boxto put the number of people who must physically bowl each game as 1
- the minimum number of players.

Note - BLS-2021 requires atleast 1 person to bowl on a team, in this case on a lane.

Of the players bowling, how many must be from the regular roster, this is going to be 0
(zero).

Because this is a Drop-In Singles league, there are no vacancies, leave the switch to
No. Also, there is no requirement as to who makes up a team.

Team Handicap
Leave the team handicap as Sum of Bowlers Handicaps.

Absent, Vacant Players
ABSENTEE SCORE RULES

Most leagues have a rule that when a player/bowler does not show to bowl the match,
and the team does not get a substitute, the team is penalized by taking a certain amount
of pins off the absent bowlers average and used that score for the games not bowled.
Note — does not affect the handicap.

Most leagues will use the average minus 10 pins for an absentee score. This is default
in BLS-2021, but can be changed if the league uses another value, using the text box
provided.

Change the option to YES if the information is the same for all sexes in the league. If the
league has a different value for each gender, the change the option to NO, allows
entering the various values for each gender.
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VACANT PLAYER RULES

Being this is an organized open bowling singles league, there are no vacant players.
Leave this as a default value.

Setting up the Rosters

Next click on Setup > Rosters

Entering the players, puta ‘T’ in the “?’ column, to designate that they are temporary
substitutes’.

3500

l-lﬁﬂ i e N R
_mr@s&ﬁarmlchael 120

2 Carly Coreley W T 120 72

B: |on Mead BT 120 72

4 Marianna |Dodge w|T 120( 72

Do this for every player entered in the league.

Example: If there are 8 players going to bowl, and are using only 4 lanes, put 2 players
on each lane.

Recap Sheefts
When printing recaps for this type of league, there will be no names printed, only the
name of the league, lanes and date at the top.

The bowlers will fill in their own names on the lanes that they decide to bowl on, each
week. Itis suggested to have them know their bowler ID number and put that on the
sheet with their name. Note - the bowlers ID # can be added to the standing sheetto use
referencing their ID numbers.
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Sample League 19-20 -Lonesi2 @660

Secretary/Treasurer: Ann Simmons is an 4 ) B
Week 1 @) Date D8/16/12
Week 1 Lane | Week 1 Lane 2
Avg | Mame poce | 4 S 3 Total Awg| Mame HOCP| 1 i 3 Tots
|
|
|
Won, Total Won Total
Handicap Handicap
Lost, HDCP Total Lokt HDCP Total

aogo 0 goo

Approved:
Captains: Tum in to your secretary after signing
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Schedule and Lane Assignments

This is the final step when creating a new league. However, if changes need to be made
to the schedule or team pairings during the season, this option can be opened using the
following selections:

Setup > Rules > Lane Assignments

The rotation schedules must be entered. This is the onlyway BLS-2021 will know which
teams play together, for computing wins/losses each week. The program includes
schedules for mostleague sizes according to the USBC schedules. Schedules maybe
entered manuallyifitis notincluded in the program, or if the league uses a special
schedule.

Lane Assignments: Firstinsert the position rounds and delete any dates that will not be
bowled. The program automaticallyfills in all the dates based on the starting date

entered on the League Rules screen. Change the starting date here by typing in a new
date for Week 1. Click Show > Schedule to display additional lane assignment options.

Adding/Removing a date: Weeks can be inserted or deleted atanytime. Be sure the
cursor is on the correct week.

To add a date, select the date to be added in the calendar and click Insert This Date.

To remove a date, select the date in the schedule and click Remove This Date. This
option will onlyremove the date, and moves all remaining dates up, it does notremove
team pairings. For example, if the league is going to skip the week between Christmas
and New Years, click the date and click Remove This Date.

As soon as a date is removed, all other dates will move up into the next position. Itis
also possible to type over a date when bowling on a different day due to some conflict.

Weather Cancellations: If the league is forced to cancel a week of bowling due to
weather or other reason, simply select the week that is canceled and click Remove This
Date. Normally, the league will extend the date of the end of season and bowl the full
number of weeks in a season. This is done automatically when removing the date as
described above.

However, if the league decides to shorten the season, then go to the Setup > League >
Rules and reduce the number of weeks of the season. After making that change, return
to the lane assignments and make any position round or other adjustments.

Position Rounds: Change the Type of Week option for each week thatis a position
round or fun night. Position rounds may be inserted and deleted at anytime. When doing
this, the remainder of the lane assignments move up or down accordingly. When
entering a Position Round, the program will automatically put the first and second place
teams, on the firstlane pair in the league. To change the pair of lanes the first place
team will bowl, put the new lane number under the 1st PR Lane column. Team Pairings
will be automatically assigned when advancing into the week of the Position Round.
After advancing to the week after the Position round, the Team Pairings will be change to
Manual to avoid accidental re-setting of the schedule.

If the first and second place teams bowl on a pair of lanes other than the first pair,
configure the starting lane under 1st PRLane column. By default, BLS-2021 assigns
the remaining pairings (3rd vs 4th, 5th vs 6th, etc.) on the next pair of lanes to the right.
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Reverse Lane Assignments: The column labeled <> will show the lanes assignments
direction as forward or reverse. Reverse lane assignments places the teams in a
reverse order so that the last place is the first team, working its way to the first place
team on the end. To use reverse lane assignments, change the direction to <-- instead
of -->.

Pos. Rnd: 1st Place Lockout: This option can be used when the first place team is so
far ahead in points that it would not be possible for the second place team to overtake
them. Using this option would assign the 1st place team versus the last place team,
then assign the 2nd place vs. 3rd place, 4th place vs. 5th, efc...

USBC Roll-Off Scores Count: New USBC Rules for the 2015-2016 bowling season
dictate that scores bowled in roll-offs, playoffs or special contests need to be included in
the calculation for the final average. In a Split Season league, a roll-off at the end of the
season between the winners of the splits may already be configured in BLS. However, if
there is a tie after the roll-off, or if a tie exists after a position round mid-season, a roll-off
is required to determine the final winner. In BLS-2021, this roll-off is handled by adding
an additional week/session to the schedule.

To configure Roll-Off where scores count toward final average in BLS-2021, select the
week the roll-off games will be bowled and click the Insert a USBC Roll Off after the
selected week button. This function will automatically add a week to the schedule, add
the USBC Roll-Off Scores Count week and keep the rest of the schedule intact.

UBL Position Rounds: BLS-2021 feature support for various UBL (Ultimate Bowling
League) position round formats. Some of the formats include:

¢ Divisional Playoffs - Div. 1 vs. 2, 3 vs. 4, etc.

¢ Divisional Playoffs - Div. 1 vs. 3, 2 vs. 4, efc.

¢ Divisional Playoffs - Div. 1 vs. 4, 2 vs. 3, etc. - This is an outside-in method.

e Combined Division Playoffs - Div. 1+2 vs. 3+4, etc.

e Combined Division Playoffs - Div. 1+3 vs. 2+4, efc.

e Combined Division Playoffs - Div. 1+4 vs. 2+3, etc. - This is an outside-in method.

Holiday: Click on the Holiday tab over the calendar to select the type of Holiday or other
session reason for not bowling.

Adding/Removing Pairings: Team parings can be inserted or removed atanytime. Be
sure the cursoris on the correct week of bowling.

To inserta line of lane assignments, press F9 or click the Insert Pairings button.
To remove a line of lane assignments, press Shift+9 or click the Remove Pairings
button.

NOTE: These options are only available when Show > Dates & Lanes is selected.

Reloading the USBC Lane schedule:

If changing the number of teams on the league, then reload the USBC Lane schedule.
Once reloaded, the default schedule beginning with the current week of bowling will be
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loaded. Doing it this way preserves the schedule for previous weeks when a different
number of teams existed.

To reload a schedule, press F5 or click Reload at the top menu.
Random Lane Assignments:

This feature is available for Pro and A/S editions. Pick any number between 1 and
65,000 to use as a reference and click Random. The lane assignments will be
randomized appropriately. This provides an alternative to using the USBC lane
assignment schedules.

Travel Leagues

BLS-2021 features the association of a center to a specific week to accommodate
traveling leagues.

To use this feature, the league must be configured as a Traveling League in the Main
section of League Rules. Once configured as a traveling league, a new column for the
Bowling Center will be included on this page. Adrop-down list of previously configured
bowling centers will be available to select for each week bowled. For more information
on configuring traveling leagues, please see section on defining the league rules on
Page[ .

Printing the schedule for distribution

Once the schedule has been configured, it can be printed by clicking the Printer button at
the top of this screen.

Change in Lanes Mid-Season
BLS-2021 supports different starting lanes for the league during the season. This
feature is useful in situations, such as when a league bowls on lanes 1-16 for the first
18 weeks and then bowls on lanes 17-32 for the remained of the season.

To switch the starting lane mid-season, open Setup > League > Lane Assignments and
select Show > Schedule to view lane assignments.

Click on the Week/Date that the league will switch lanes. At the top of the screen, click on
the column header for the first pair. Aprompt will appear allowing the reassignment of
the starting pair. Indicate the new starting lane. The remaining lanes will be reassigned
to the new set of lanes.

Multiple Shifts and Multiple Teams per lane
Occasionally there may not be sufficient lanes available to accommodate the number of
teams in the league due to the size of the center or the number of lanes is limited. To
allow for this occurrence, BLS-2021 provides the ability to configure multiple shifts
and/or assign multiple teams per lane. This can also be used for singles and doubles
type leagues where multiple teams may be necessaryto limitthe number of lanes used
for the league.

To configure multiple shifts or assign multiple teams per lane, click on the Weeks,
Lanes, Shifts tab:
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Number of Weeks Bowling: This option represents an alternate location to change the
number of weeks to be bowled.

Number of Teams per Lane: Specify the number of teams to assign per lane. This
change the lane assignments to put the specified number of teams on the first pair of
lanes. This process will be repeated until all the teams have been assigned to a lane.

Multiple Shifts: Use the Drop-down list to specify the number of shifts to be bowled in
the league. BLS-2021 supports up to 5 different shifts. When multiple shifts are
specified, configure the number of teams to bowl each shift, starting time and the lane
number the shift will start on.

Daies Weeks/Shifts Schedule
@ Accept Changes

Number of Weeks Bowling 430 (v

Final season standings and prizes
determined after week concludes

4290y

Number of Teams per Lane  [+] 2 [»

Starting Lane |4/ 1 [»

Starting Time {6:00 pm S
Ending Time |8:30 pm =

League bowls 1 shift 5

League bowls 1 shift

League bowls B shifts

Split Lane Assignments: Some establishments are built with two sets of lanes,
extending in opposite directions from a central concourse. In this style of house, a large
league may be half on one side and half on the other side. This results in the lane
assignments not being consecutive butin two sets. A 16-team league might not be
assigned 16 lanes atone end of the house. Those lanes might be 1 through 8 and 24
through 32.

Use the Multiple Shifts Drop-down list to specify this type of configuration. The option to
configure the number of teams to bowl on each set of lanes as well as the starting lane
number can then be setup.

Important: The Accept Changes button that appears after making a change on this
screen MUST be clicked for the changes to take effect.

Lane Assignment Options
Lane Assignment > Show: Clicking the Show Schedule will change the screen to
displaythe lane assignments for the league:
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(& Dates & Lanes
[ schedule
[ Lane Conditions

[ show Reordered Pairings

The following options can be performed after clicking the Show > Schedule:
Manually assigning lanes

Situations may arise where itis necessaryto manually configure lane assignments. To
manually change team pairings, click on the Change menu item. This will unlock the
team pairing grid and allow the team pairings to be manually configured. Enter the team
numbers under the lane columns they will be bowling.

This is useful for special roll-offs or for position rounds affected by make-ups bowled
after a position round.

Lane Assignments
Lane assignments are where the type of week, add or remove a date, change the lane
numbers the league is bowling on, etc.
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The section will show how to setup the lane assignments.

Dates
BLS-2021 automatically configures the dates for the number of weeks of the league
entered in the rules.

Should the league be scheduled to bowl on a holiday or is not bowling on a specific
week, highlight that week/date, click on Remove Date under the calendar. BLS-2021 will
add another week/date at the end of the current schedule keeping the league bowling
the correct number of weeks/sessions thatare setup in the rules.
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Points Awarded
In this column, when clicking on the Normal Points, a Drop-down arrow appears, click
on the arrow to see the list of options for that week of bowling.

This is generallyleft at Normal, but if the league is bowling a Fun Week or a Roll-off
week.

P
Awarded
1 | 08/16/2019 = 'Normal

Zero Points

N 08/23/2019 Normal
EEN 08/30/2019 Normal
09/06/2019 {Double Points | Normal
IER 09/13/2019 ; Normal Points: Normal
B 09/20/2019 : Normal Points: Normal

For the different types of week, see Type of Week[93\.

Type of Week
To change the type of week, click on Normal, a Drop-down arrow will appear, click on
the arrow and select the correct type of bowling for that week.

Below are the different types of weeks to chose from:

Normal — Regular, scheduled pairings. (Sanctioned by USBC, TNBA, or CTF or other
organization / or unsanctioned in any organization)

Position Round — Teams bowl against teams according to their current Win/Loss
standings

PR within each division — Same as a Position Round, except only bowling teams within
their own division

Division Playoff (1-2, 3-4) — The standings order of each division, play the standing order
which opposes each other

Division Playoff (1-3, 2-4) - The standings order of each division, play the standing order
which opposes each other

Division Playoff (1-4, 2-3) - The standings order of each division, play the standing order
which opposes each other

Combined Div. (1+2, 3+4) — The combined standings of each division, play each other

Pos. Rnd. - 1st place Lockout - If the 1st place team cannotlose its’ position, then they
will play the first team that cannot move up in the standings

USBC Roll-off Scores count — Aroll off generally between the winners of the leagues
splitseason’s, scores to count toward averages and awards

Schedule and Lane Assignments m



Roll-off Scores don’t count — Aroll off generally between the winners of the leagues
split seasons, scores don’t count toward averages and awards

Fun Nite — Nothing counts (Bowlers are still eligible for awards as long as the bowling is
the same standard used in regular season.

Tie Breaker Scores Count - This type of week would be used for a tie for generally first
place and only those teams are bowling

Holiday - To have a holiday or another type of week printed on the Lane assignments

Skip & Move back 1 week — Skipping a week and adding another week to end of the
schedule (extending the league by 1 week)

Skip - not bowled, no makeup — Skip that week of team pairings, and is included in the
original number of weeks

Bowling for average only — No points will be awarded. (No season individual special
recognition until bowling normal)

Changing Lane Numbers
There have been times when a league has been moved from a set of lanes to another
set of lanes, and the league wants to match the center's lane assignments.

There are several ways to do this.

e Go to the Rules > General Rules and change the starting lane
e Go to Lane Assignments and follow the steps below:

1. Click on the Lane number

2. Inthe to Lanes text box, type in the correct starting lane. BLS-2021 will automatically
enter the even lane number.

3. Make sure to check one of the options, This week only, or This week and future
weeks.

4. Click the OK button

The lane numbers will change accordingly for all lanes.

Bowling on 2 Different Sets of Lanes

Splitting the lane assignments to use 2 different sets of lanes atthe same time for a
league, follow the direction for Changing Lane Numbers[ 98 with the exception on
clicking on the second set of lanes starting number.

Example: The league has 12 teams and they starton lane 5. The program will show
lanes 5 through 16, but the center wants them on lanes 5-8 and 15-22.
Click on the lane number 9 on the top of the grid to change Lane 9 to Lane 15.

Remember to check "This week AND future weeks" or it will change them just for one
week. The rest of the lanes will then be in numerical order. Note — the lanes mustbe
sequential, going low to high, when doing this.

E BLS-2021 by CDE Software, LLC



= 'I'I

Eﬂﬂlﬂﬂlllﬂllﬁ
Team 5

Change Lane Humhers

Change Lanes 9-10

to Lanes -

This week only
[# This week AND future weeks

oK .9 Cancel % Help

Select One;

Bowling Every Other Week

BLS-2021 has an option to automatically create a schedule for a league that bowls
every other week.

Setup > Lane Assignments. Click on the tab above the calendar, Schedule. Use the
Drop-down boxto select the correct option the league is bowling, i.e. League bowls
every other week, etc.

The dates will now reflect the option chosen.

Note - This is onlyavailable the first week of the league.

See Dates[ 94

Schedule and Lane Assignments
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Quick Reference Tabs

When the league is opened, the league screen will contain several quick reference tabs
on the lower portion of the screen:

Main Status Officers Notes Options Database Support Tech2

Main
This tab serves two basic functions. First, it displays current league file data, such as the
Center, dates for the duration of the league, which league the league file is in, and
notes/status pertinent to the current week of the league.

The second function is to change weeks. There are four buttons available to navigate
between weeks. The buttons on the right and left side advance the league one week or
return to the previous week, respectively. The other two buttons will allow the user to Go
to any week to make adjustments, or Go to Current Week. Selecting the Go to any
week option will display the Change Week dialog which provides additional options to
go back one week, advance one week, go to Airst Week, or go to Specific Week.

Stafus

{Lo Week 10i 28 — Sample Lesgue 19-20 — 08/16/19

Instructions, Game Status and a Reminder of Your League Rules
Scare Color Legend

Return 1o Score Entry Screen

Your league rules regarding minimum legal lineup

ine the team will forfen. Of those

Here is the status of each game for the current pair of teams

65500 === Game 1
More! You need fo enter more soores. You set the rules for 4 people bawling but you entered only 3 scares

or 4 peaple bawling but you entered only 3 scores

GS500 === Game 3

More! Younead to enter mare scores. ¥ou 2t the rudes for 4 peaple bawling but you entered enly 3 scores
5 Series not included in seasan highs because you do not allaw a series with a forfel or an incarrect number of scares

== Team Grand Vitara === Game 1 =
eed o enter more scores. You set thy

wling but you entered only 3 scores

The status screen displays the list of team(s) that potentially need attention. The
following are some of the reasons, but not all, why a team may be listed here:

There are too many or too few scores entered for the current week.

The team may not have a full complement of bowlers.

Bowlers may not have a gender entered.

e The team is a BYE team and should be empty.

Clicking on the listed team will open the Show Other Information screen for thatteam
which explains why the team was flagged.
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Officers
This tab displays the current officers for the league. To assign the league officers, click
on the Bowler Maintenance button or hit the F8 key. For more information, please see
Setting up League Officers in the Bowler Maintenance section on page[s3\

Noftes
Allows short and simple notes regarding special situations for a week thatis a
reminder, such as "Needed to drop Misfits team and Bye team". These notes also help
technical support understand why some steps were done during the week.

Option
The league options tab is where some helpful settings can be configured. Be sure to
use the change the options to indicate whether to be reminded to back up your league
everytime you close it. In addition, set the "August 1st" date to be used, to determine the
date for Aug 1stbased rules. Set also whether the treasurer functions should be
available or if the league is a Sanctioned league to open up the sanction functions for
usage.

Database
This tab will be displayed for Pro or Automatic Scoring editions of BLS-2021.

Indicators will be displayed pertaining to the status of the Master Bowler Database and if
the league is currently linked to the MBD.

MBD-2021 Installed Indicator - The orange status indicator button will display if the
MBD-2021 was actually installed on the computer or not. If the status indicates that the
MBD-2021 was notinstalled. There is a separate installer for the MBD.

Master Bowler Database Server - This indicator button will display if the MBD-2021
server program is running or not. The MBD-2021 server runs in the system tray and

shows as a square green icon. [fitis not running, start the server by going to Start >
Program Fles > CDE Software BLS-2021 > MBDII Server.

Master Bowler Database Status - This indicator button will display the status of the
MBD-2021 in regards to the connection from BLS to the MBD.

Master Bowler Database Skip - If the league has been linked to the MBD, to temporarily
disable the connection of the league to the MBD, click this button.

Master Bowler Database Use - If the league link to the MBD has been skipped and to
re-enable the connection of the league to the MBD, click this button.

Will this league be linked to the Master Bowler Database? - Selecting yes will link the
league to the MBD. Selecting NO will unlink the league.

Quick Reference Tabs
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Program File Menu
This menu section is designed to provide access to leagues, close program and other
utilities:

Close: The menu functions relate to the BLS-2021 documentation and help.
New: The menu functions allow contact with CDE Support.

Open: Various links with CDE and other websites.

Recent Leagues: Various links with CDE and other websites.

Utilities: Various links with CDE and other websites.

Program Preferences [103): Options for the program.

Close
This menu group focuses on closing the league or program:

Close Program: The option is available when a league is not open. Selecting will close
BLS-2021.

Close League and Program: This option is available when a league is open. Selecting
will close the league and then program.

Close League: The option is available when a league is open. Selecting will close the
league, but not close BLS-2021.

New
This menu group focuses on creating new leagues:

Create a new league: The option is available when a league is not open. Selecting this
option, a file name must be created by using the one the program provides or entering a
specific file name of your choice. Once this is completed, an option to use the rules
wizard will appear to create a new league with BLS-2021. Note: This is optional.

Open

This menu group focuses on opening league files:

Open league for current season: The option is available when a league is not open.
Selecting will bring up the league open screen, listing all leagues that are currently
bowling at this time.

Open league from past seasons: The option is available when a league is not open.
Selecting will bring up the league open screen, listing all leagues that have completed
their bowling season.

Open any league: The option is available when a league is not open. Selecting will bring
up the league open screen, listing all leagues.

Open league from older BLS and copy to BLS-2021: The option is available when a
league is not open. Selecting will allow locating a league created with an older version of
BLS and copying to BLS-2021 for use.
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Recent Leagues
This menu group contains a limited list of most recently used leagues.

Utilities
This menu group focuses on available utilities within BLS:

Calculator: Opens a specialized calculator designed to help do basic calculator
functions as well as calculate handicap.

Forms Library: Opens a list of forms available for printing, such as blank membership
cards or awards forms.

Program Preferences: Opens difference preferences for associated with various
options.

Program Preferences
This section defines the general settings for the BLS-2021 program as well as allowing
customization of the program to suit individual needs. Configurations contained in this
section are global to the program and will be applied to all leagues. The various options
are detailed on the following pages.

Program Operation Defaults
When going into Preferences and Program Setup the following screen appears

Program Appearance and Operation:
This section provides configuration options to select which side of the screen the menu

is on, and to specify whether or not to display the help "pop-up bubble ", when the
hovering the mouse over various buttons and screens in BLS-2021.

Sounds can be enabled or disabled from this screen by toggling the switch. BLS-2021
provides additional capability of enabling/disabling or modifying individual sound effects,
such as Close, Confirm, Delete, Done, Error, OK, Question, Startup. This can be done in
Windows by going to Control Panel and opening the Sounds and Audio Devices
Properties. Please see your Windows help documentation, on changing sound
schemes.

The level of expertise can be set which controls the amount of informational and warning
dialogs that are displayed.

3 = Most warnings will not appear at all

2 = Most important warnings will appear just once then not again

1 =Warnings will appear often

Finally, BLS-2021 provides the following support on systems with multiple monitors:
e Re-startthe program on the monitor it was last started on

o Always start the program on the Main monitor.

o Always start the program on the secondary monitor.
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Open File Options:

These options configure actions that can be used when the program is opened. When
opening the program, BLS-2021 can be configured to automatically open the last
league file that was used. This is convenient when managing a single league so that the
league file opens when BLS-2021 started.

Select the default directory when opening a file--

This option allows for different directories/folders to be opened when selecting the Open
League File options. Itis strongly suggested that this option be kept at the Program's
Default Directory.

The Last Directory Accessed option will open the folder where the last league file that
was opened is stored, and this specific directory allows users to designate a specific
folder/directory where league files are located. These latter two options can be
convenient, if the league files are stored in a different location other than the Default
directory/folder.

Back up Your Data:

BLS-2021 can be configured to automatically back up the league everytime the league
file is closed.

Default Backup Directory: This option configures the default location for the backups.
This can be set for another directory on the hard drive or different drive(s) attached to the
system. Itis stronglyrecommended that league data be backed up to removable media,
such as USB flash drive, memory stick, thumb drive or similar device. Make sure the
drive is plugged in prior to setting the removable device as the Default Backup Directory

CD/DVD Backup:

BLS-2021 supports backing up directly to most CD/DVD writable devices. However,
when this type of supportis also provided by Windows, there may be a conflict between
BLS and Windows resulting in the backup failing. This option allows BLS-2021 to be
configured to use its own internal support for backing up to CD/DVD, or to turn that
functionality off and allow Windows to provide this support. There may be occasions
where neither setting will work, in which case itis recommended to backup to the Local
Hard Disk Drive first, then copy the file to CD/DVD.

Automatically back up to Dropbox: Dropboxis a cloud based file storage service. The
service is free for a basic account . To sign up, go to www.dropbox.com.

Restore Your Data:

Itis strongly advised to restore the league(s) into the default location. Only change this
option if the league data is to be stored in a user defined directory.

Configure Automatic Scoring:

This option is accessible in the A/S Edition of BLS-2021 and is used to access the
Automatic Scoring configuration screen. For more information, please see the chapter
on Automatic Scoring on page[273\.

Internet Settings:
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This section contains settings that will be utilized by BLS-2021 to communicate with the
Internet. Email and Personal Web Page settings can be configured.

Internet and Updates tab
Internet & Uploads tab

In this section, if you have internet connected to your computer you can take advantage of
uploading the standing sheets or emailing the bowlers, the option mustbe set to Yes.

Intern in
Click on the Change Internet Upload and Email Settings.

This section is used to configure the Internet settings. If you do not use Internet features,
then leave this screen at the default settings. Outgoing email to the bowlers requires that
you have an email account on a server that accepts email via SMTP.

Your Identity
Provide your First Name, Last Name and Email Address.

Your Email Server

This section is used to configure your E-mail settings. Email server settings are required
to utilize the E-mail features of the program.

SMTP Server: This is the name of the Outgoing Email server. Contact your Internet
Service Provider for this Server Name.

User Name: The user name used to login to your email account.
Password: The associated password to for your email account.

Login using User Name and Password: If your email server requires you log in with the
user name and password, select Yes.

Send Test Email: Click to have the program send a test email. If you do not receive an
email in the next few minutes, please check your settings and try again. You may need to
adjust some of the Advanced Settings.

Note — these are required fields if you plan on emailing your bowlers
Advanced Settings

Use advanced settings to set SMTP Server Port: If your email server does not use the
default port of 25, then select YES and enter the port number of your SMTP server.

Use SSL for sending email: Change this switch to Yes if your email server requires
email to be sent over Secure Socket Layer (SSL).

Use SMTP STARTTLS: Change this switch to Yes if your email server requires email to
be sentusing Transport Layer Security (TLS)

Use advanced settings to set HTTP/FTP? If you are behind a proxy server, select Yes
and enter the information provided by your network administrator. Normally this should
be setto No.

HTTP Proxy Server: Enter the name of the Proxy Server used to access most Internet
sites. This name will be provided by your network administrator.

FTP Proxy Server: Enter the name of the Proxy Server used to access FTP servers on
the Internet. Again, this name will be provided by your network administrator.
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FTP using passive transfer mode: Sometimes uploading files mayfail unless passive
transfer is used. Leave settings at default values unless instructed to change by your
network administrator

Program Updates

You can choose how many days that you are reminded to check for updates to your
program. Use the Drop-down list; select the best option for you.

Dropbox

Dropbox is a cloud based Internet service that can store your backup files. You will be
able to access your files from anywhere. Dropboxis currently offers free and premium
accounts. For more information visit www.dropbox.com and register for an account.

If you already have a Dropboxaccount and wish to use it for your league(s) backup file,
click on ‘Add Dropbox Access’ button. Sign in to your Dropbox account. If you don't have
an account, from this screen, you can also create an account.

le Drivi
Use Google Drive Access to store your backup files, so you can access your backups
from anywhere. Visit Google.com/drive.

Printing, Fonts & Graphics

This screen configures Printing and Graphics Options that will be used by the program.
These options will be used for all leagues opened in the program and will take
precedence over similar settings configured in the league files, with the exception of the
Default Paper Size. Frequently, the Standing Sheet may need to be printed on different
size paper so these settings are configured when setting up the Standing Sheet. For
more information, please see Standing Sheets > Page Layout on page[sh.

TIP: Itis common that when reports stop printing in color, the setting on this screen has
been toggled to Black.

The options for "...omit artistic text effects...", "Remember printers..." and "l have an
antique printer..." are intended for troubleshooting purposes only and should not be
changed unless you are encountering problem with printing reports.

Current Defaults

This section is provided to set the Windows default program associated for PDF Files.
Typically, this setting should not have to be changed as the BLS program will retrieve
this information from Windows. However, this option is provided for potential problems
with generating Sanction Cards, Applications and National Award Forms.

Default Settings for New Leagues
This screen defines the defaults when new leagues are created. This section should be
self-explanatory.

Data Entry Settings

Entering information in this screen will reduce entering of repetitive data, because this
information is automatically inserted into text boxes when adding new bowlers to a team.
This can be a time saving feature when entering information for many bowlers who live
in the same geographic location and have certain information in common.
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Date, Time & Phone
This is especially useful for international leagues where formats for date, time, or phone,
are different than the defaults usually used in the United States.

Master Database

This option is only available in BLS-2021 Auto-Scoring and Professional Editions. Use
this section to Enable the Master Bowler Database for use with BLS-2021 after the
database has been installed. For more information on installing the MBD-2021, see
Installation of the MBD on page| 25\

To license and enable the MBD, please do the following:

1. Install the Master Bowler Database, on the computer the server will reside on.

2. Make sure the Master Bowler Database server has been started.

3. Ifthe Bowler Database is located on the same machine running BLS-2021, skip to
step 6.

4. Ifthe Bowler Database is located on a remote computer, the information will need to
be entered for BLS-2021 to utilize the database. Under MBD Il Server Location,
toggle the "Is the database server based on this machine" switch, to No. Enter the IP
Address for the computer where the bowler database is located.

5. Enterthe server port number that will be used to access the MBD-2021 . By default,
this port number is configured for 16210. As such, unless a change was made on
the MBD-2021 Server, nothing else will be necessary on this screen.

6. Click Activate MBD License. Internet connection not required.

7. Toggle the switch under MBD Details to Enabled. The database is now ready for use.

The MBD is not required for normal operation of BLS, but can enhance the operation of
BLS when working with multiple leagues.

Kiosk Options

Ifusing BLS-2021 Pro or A/S Editions in a center that has installed CDE Software’s
Bowling Kiosk, then the kiosks can be updated with the currentinformation presentin
the league.

BLS-2021 can be configured to update automatically by going to File > Program
Preferences > Kiosk Options. Under the Kiosk Options, change the option to
Automatically update the CDE Bowlers’ KIOSK's to Yes.

Furthermore, indicate how much time before games that the the kiosk is to displaylane
assignments and then set the total amount of time the lane assignments to be
displayed.

Define the correct drives

Typicallywhen assigning the kiosks a drive they should begin with the drive name M.
Then increase the drive letter for each kiosk at the center.
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Import Section
This section includes different options for importing bowler information from different
formats. These features are designed to import bowler information into newly created
leagues. Importing bowlers into existing leagues, could resultin duplicate names, if the
bowler being imported already exists in the league.

When creating a new league, BLS-2021 will populate all the teams with VACANT
bowlers. These can be over-written with actual bowler names as teams are created. To
remove these VACANT bowlers so that the Bowler ID numbers will start with the number
1, we suggest performing the following prior to importing names and addresses:

Utilities > Teams > Clear Team Rosters
then

Utilities > Bowlers > Delete "Quitters" and unused VACANTs

Import People From Bowler TRAC

Fle > Import > From Bowler Trac
This option is only available in the Automatic Scoring version of BLS-2021.

Bowler TRAC is a Database Management application designed to provide bowling
centers the ability to capture and manage information on their customers. This program
is only available to centers that are members of the Bowling Proprietors Association of
America (BPAA).

Since Bowler TRAC is a customer database, itis a convenient place to gather customer
data for use in bowling leagues. The Bowler TRAC program has an option to Export
bowler information to a file, which can then be Imported into BLS-2021 through this
menu option.

Selecting this option simply brings up an Open dialog, to locate the BITS Person File that
was created by the Bowler TRAC program. This file will be in XML format.

Read Bowl101 "NamesAddresses.txt" file

BLS-2021 supports importing names and addresses form leagues created by the
Bowl101 program. Follow these steps to import to bowler names and addresses from
Bowl101:

Note: Anew league file will need to be created in BLS-2021 prior to importing the
names.

1. Go to Utilities > Teams > Clear Team Rosters

2. Go to Utilities > Bowlers > Delete " Quitters" and unused VACANTs

3. Go to File > Import > From Bowl101 File

4. Click the Open File button.

5. Navigate to the location where the NamesAddress.txt file is stored.
Note: This file is created by the Bowl101 program. Please consult the Bowl101
documentation on how this file is created and where it would be stored.

6. Click Import Names.

7. Go to Weekly > Prepare this week > Adjust Team Rosters
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Import Names, Addresses from any Text file
This feature is only available in the Pro and A/S Editions of BLS-2021.

This option allows bowler information from text files, to be imported into BLS-2021.
Supported formats include Comma + Quote, Comma + Quote if necessary, TAB
delimited, Bowl 101 "NameAddress.txt" and CDE Address Text Fle. The latter two
options are predefined so they cannot be changed. These two options also have their
own menu items under Setup > Import.

Use the following procedure to import Names, Addresses, and additional data from text
files:

1. Go to Utilities > Teams > Clear Team Rosters and then Utilities > Bowlers > Delete
"Quitters"” and unused VACANTs

2. Go to Ale > Import > Import from Text Fle

Identify the fields contained in the text file and make note of the order.

4. Selectthe firstfield from the Available Felds column and click Add Iltem to List. This
will copy the field name to the Selected Felds column.

5. Continue adding fields to the Selected Felds column until all the data fields in the
text file are accounted for. Use the Skip this field option if the text file has a field that
is notin the list of Available Fields.

6. Click the Open File button and navigate to the location where the text file is stored.

7. Selectthe correct File Format. The Parsed Record column should display the first
record of the text file. This should display the data fields as they are related to the
Selected Felds. If this is not the case, there is a problem with the items in the
Selected Fields or File Format.

8. Ifthe first record identifies the data fields in the text file, add a check mark to the
appropriate boxto the right of the File Name.

9. Click Import Names

10. Go to Setup > Teams > Rosters to set up the teams and rosters.

o

Import from CDE Name, Address Text File

BLS-2021 supports importing names and addresses form leagues created by older
versions of BLS. This is especially useful for leagues that were created by BLS-2010
and older versions. Leagues created by BLS-2011 and newer can be opened and
converted in BLS-2021 as described in the section on Opening Leagues. Follow these
steps to import your bowler names and addresses from previous versions of BLS.:

Note: Anew league file will need to be created in BLS-2021 prior to importing the
names.

Go to Utilities > Teams > Clear Team Rosters

Next go to Utilities > Bowlers > Delete "Quitters" and unused VACANTs

Go to Ale > Import > Import from CDE Text Fle

Click the Open File button.

Navigate to the location where the text file from the older version of BLS was saved.
Click Import Names.

Go to Weekly > Prepare this week > Adjust Team Rosters to set up the teams and
rosters.

Nooa koM~
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Export Section

This section of the menu features options to export information for the program.
e Export Averages to WinLABS

e Export People to Bowler TRAC

e Export People to Bowler TRAC

o Export Names & Addresses to a Text File

Export People to Bowler TRAC

This option is only available in the Automatic Scoring version of BLS-2021.

Bowler TRAC, is a Database Management application designed to provide bowling
centers the ability to capture and manage information on their customers. This program
is only available to centers that are members of the Bowling Proprietors Association of
America (BPAA).

Selecting this option allows the bowling center to save a BITS Person File that can be
imported by the Bowler TRAC program. This file will be in XML format.

WinLabs: Export data file for WinLabs
Win-LABS is designed to import league information, saving time and increasing
accuracy in entering bowler information.

At this time, Win-LABS requires that your league is very complete in bowler information;
Names, addresses, birthdays, social security numbers, and sanction information, must
be completed for every bowler. Anyincomplete item mayresultin the Win-LABS software
not properlyimporting the league.

How to make a disk for your association

After verifying that the association is using the Win-LABS software and you have verified
their needs regarding removable media and format, do the following:

1. Have the right size and type of removable media for each association.

2. Create a file on the removable media with the information required for Win-Labs.

3. Click the Win-LABS: Export Final Averages.

4. Insertthe removable media that will go to the association and select the location of
the file.

5. Click Export.

The league file will be exported. Remove the removable media.

Export to Text File
Export Names and address to a text file to use in another application. Save file to desired
location.

Export Average to TBrac

Export this weeks Names and averages to a file, to be imported into TBrac.
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Setup

BLS-2021 menu’s have changed in looks. Theyhave been separated into different
sections. Clicking on a topic with an arrow to the right, another menu appears with
several options to selectfrom. These options will then open the program to that window
directly.

4. BIS-2020/PRO - Version: 32.00.06 Release Date: 6/5/2019 Licensed To: CDE Software

Brackets Reports Tasks Utilities Help
Rules

Lane Assignments
Officers

Planner
| Print

My Menu

1: Manage/edit "My Custom Menu"
2: Change League
3: Adjust Team Rosters
4: Statistics

5: Signup Sheets
5

7

8

Edit Any Bowler
Awards

Fees
Reports
Internet

: Enter / Correct Scores
: Preview & Print Weekly Standing Sheet

' Passwords

11 Print Recap Sheets

6/19/2019

Mon, 17 Jun 2019 17:43:42 PDT

BLS-2020 version 32.00.07

New beta update available.

Birthdays in the next ...

Carly Coreley - 8/19
Marianna Dodge - 9/1
Celeste Lusk -9/9

Brackets

Anee Ehan Week 1 of 28 [08/16/2019]
August 2019

ﬂﬂ
Sun  Mon Tue Wed Thu Fri Sat
a4 2 3
4 8 3 i 8 9 10

11 12 13 14 15
Go to any week
18 19 20,0 071 2

Today's Date - 6/19/2019

TWes)

Main Support Tech2

This menu section focuses on the configuration and setup of the league itself.

e Leagues

o Teams

e Bowlers

o Awards

e Fees

e Reports

e Internet

e Passwords

Setup > Leagues
The Leagues section of menu items focuses on the most critical parts of the league.

Rules - See Page [118)
Schedule - See Page [90)
Officers - See Page [RE:
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Planner - See Page [+19)
Print Rules Worksheet - See Page [9)
Print Rules - See Page [+A

League Planner
Setup > League > Planner

The league planner is used to make special days for the league's season, such as
reminders to order trophies, reserve the banquet hall, when to turn in reports, etc.
Simply select the dayin the calendar and add one of the special labels.

The league planner can also display your bowlers' birthdays.

Rules Worksheet
Setup > League > Rules Worksheet

The rules worksheet prints a basic blank league bylaws questionnaire to assistin
developing the league rules. Take this to your new league meeting at the beginning of
the season, to help lay out your league bylaws.

Print Rules
Setup > League > Print Rules

After the rules have been configured in BLS-2021, it's a good idea to print the rules and
stick in your league binder for reference. The report will contain the majority of the bylaw
settings.

Print Financial Worksheet

The Financial worksheet prints a basic blank fees sheet to record any payments that will
be required by your bowlers. Take this to your new league meeting at the beginning of
the season, to help set up your fees.

Print Prize Fund Worksheet
The blank Prize Fund worksheet will help with distributing the league funds at the end of
the season.

Setup > Teams

Rosters - See Page [

Print Roster Sheets - See Page [19)
Team Captains List - See Page [19)
Blank Signup Sheets - See Page [118)
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Print Roster Sheets
Setup > Teams > Print Roster Sheets

If the league currently has bowlers entered, printing the roster sheets will printa report
with each team's members, as well as the information known. Use this to give to the
team captain's to update anyinformation and then return to you, to update the league.
This is handy when bowlers move, change phone numbers, or email addresses.

Team Captains List
Setup > Teams > Team Captains List

This reportis handyto keep or to hand out to each team captain to have a list, in case of
a board meeting or emergency action that requires approval of team captains.

Blank Signup Sheets

Setup > Teams > Blank Sign-up Sheets

Prints a blank team sign up-sheet to give to the team captains, to enter bowler
information

Standings
Configures the league standing sheets. For more information see Standing Sheet
Setup| e,

Web Uploads Setup

This section configures the uploading of your standings to the web. For more
information see Upload Standings [259

Passwords
This feature is only available in the BLS-2021 Professional and Automatic Scoring
Editions. These options allow a password to be set, on the league or Treasurer data to
prevent unauthorized access.

Please do not lose the password. Password protected leagues and treasurers, may
possibly be recoverable, but there is a minimum fee of $25.00 per league to reset and
remove the password.

Setup > Passwords > League

Setup > Passwords > Treasurer
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Setting up the League Rules

BLS-2021's power is the ability to handle how most leagues operate. This includes
divisions, handicaps, points, league awards, etc. While no program can cover every
unique league rule, BLS-2021 covers most.

By default, the rules are set to typical settings which are common for the way a majority
of handicap leagues operate.

If you do not understand a rule or it does not apply to your league, DO NOT TOUCH IT!

The setup of your league rules is veryimportant when starting a BLS-2021 league.
Spend extra time looking at the options available for each section of the rules. Avast
majority of technical support questions are the result from improper rules setup.

When starting a new league, BLS-2021 initially will set each rule to the suggested
settings according to USBC guidelines when applicable. The rules are also organized to
place uncommon rules into separate sections identified as "Non-standard". Be very
careful when changing each rulyou do not understand a rule, leave it alone.

As you begin your league and notice improper handicaps, points or other items, first look
atthe scores to see if scores were entered incorrectly or a situation such as overrides or
forfeits exist. If you still believe that there may be a problem, come back to the rules and
carefully examine the settings again. Many times, you will catch the problem here.

If the league runs into a situation that can’t be covered, feel free to contact technical
support. We may be able to provide suggestions to work with your situation, or we can
log your unique situation for further review.

Rules Templates: BLS-2021 has the ability to save different Rules configurations, which
can be used when creating new leagues. If a specific configuration for the Rules is
utilized for multiple leagues, itis advantageous to save the initial setup in a template so
that it can be used for future leagues. Once the Rules have been completely configured,
click on the Save Template button, change the name of the template to something more
descriptive and click Save the League Rules to a Template File.

When creating a new league, an option to select a Rules Template will be presented.
Even if a template is notinitially selected, the option to load an existing template will still
be available when configuring the rules by clicking Load Template. However, the option
to Load Template will no longer be available after closing the League Rules for the first
time. When exiting the Rules for the first time, a prompt to SAVE the template will be
presented.
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General Rules = Overview

available until General Rules are configured. This is due to the
fact that basic parameters for the league should be defined prior
to configuring the majority of rules. In addition, some of these
sections may never be available if the league does not require
them. For example, "Division" categories are not necessary if the
league does not have Divisions.

Individual Points
Points Summary
Special Recognition
Special Options
Additional Rules

::‘:::mmwesm The League Rules are divided into different categories which will
ecpusilel be displayed on the left side of the Rules screen. Each of these
Split Season . categories will provide different options, relative to the selected
Legal Lineup « category and provide quick navigation to the section of the Rules
Individual Averages = needing to be configured. The categories listed here represent
Individual Handicaps = the possible options. However, depending on the League

Team Handicaps * Features selected, some of these categories may not be
::::::E::::: * available. For example, for Scratch Leagues, the Handicap

o . options will not need to be displayed.

Bye Teams = When creating a new league, most of these categories will not be
Team Points ¥

General Rules
The General Rules section covers the general description of the league such as number
of teams in the league, starting date, etc. When creating a new league, the majority of
options on the left will not be displayed until the General Rules have been completely
configured. Most statements are self-explanatory, and provide all that's needed is to fill
in the blank where a value or answer is required.

Who We Are: This group of information relates to the name of the league. Pay special
attention to the following:

Description or Name of the Leagues: Enter a description or the name of the league
in this section. This must be a unique name describing the league so that if multiple
copies exist, it can readily be identified from the recentleagues list or the Open a
League dialog. Itis recommended using an abbreviation of the league name and
simply use the year of the bowling season at the end of the season.

League title shown on standing sheet: This is where a different name can be entered
it the league name if different than the name entered in the description.

Number of teams in the league: Enter the number of teams that are bowling or use
the left/right arrows. This must be an even number, so an empty or BYE team will
need to be included if there are an odd number of teams. The maximum number of
teams is 200 and minimum is 2.

Number of bowlers per team: Represents the Playing Strength or number of people
that will bowl each game on the night of bowling. Enter the number of bowlers or use
the left/right arrows to configure this value. Do notinclude extra roster members.

Number of Games Bowled Each Week: Select how many games bowled each week.
Unless a 2+2, 3+3 league, this determines the number of games in a series.
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o 2+2 3+3 League Formats: If the league bowls two opponents each night, enter either
4 (2+2) or 6 (3+3) games bowled each week and click Teams will bowl games
against two opponents.

How and When we Bowl: This group of information relates to the starting dates, the
number of total weeks bowled and which lane is the firstlane.

o Frst Night of Bowling: Use the Select Date button to select the first night of bowling.
This can also be done later in the Lane Assignments screen.

o Season: Select what part of the bowling season is being bowled. Typically, this will
automatically be configured based on the Start Date.

o Starting Time and Approximate End Time: Start time for bowling and the approximate
end time into these 2 fields. These must be entered in an AM/IPM time format.

o Weeks of Bowling: In the Number of weeks box, enter the actual number of weeks (or
sessions) the league will bowl. Do notinclude nights skipped due to vacations or
holidays. The message areas of the standing sheet may be used to advise bowlers of
upcoming nights that will be skipped. Always be sure to include position rounds in the
number of weeks to bowl. The maximum number of weeks is 99.

« Fnal week of competition: Typically, this will be the same as the Number of weeks
previously configured. However, if the final week(s) of bowling will not have any
bearing on the outcome of the league, adjust this value accordingly.

o Starting Lane: In the Starting lane box, enter the first lane used for this league. This
can be changed after the league starts.

¢ If schedule repeats: When the schedule repeats due to the number of weeks being
greater than the number of teams, BLS-2021 will shift the teams by 1 pair so theydo
not bowl on the same lanes the second time around. However, in some cases the
center may not have this capability, or chose to keep the teams on the same lanes
when the schedule repeats. Under these circumstances, toggle this switch to No to
be consistent with the center.

« Creating a league Mid-Season: If the league is being created in the middle of the
season, whatweek in BLS-2021 is the league starting? This is commonly used when
changing league software in the middle of the season and not having to re-enter all
the scores for previous weeks that were bowled, or if all the data for the league was
lost and there was no backup to restore.

League Features

These options define the rest of the basic rules configurations. Choices and settings on
this screen will determine what additional categories will be available. Here is a list of
the settings for the various toggle switches to briefly describe when and how they may
need to be set.

Type of bowling: Use the first Drop-down list to identify the type of league (i.e. Standard
10 pin, 9 pin - no tap, efc...)

Type of bowlers: Use the second Drop-down listto select the sexes and age groups
that participate in this league.
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Type of League: Use the toggle switch to select either scratch or handicap. If this is a
scratch league that will be running handicap brackets, still select Scratch.

Individual match point league or a "U.B.L." league: If anyindividual points are awarded
to bowlers, then select YES to enable those options in the rules. This is associated with
leagues that award points for head to head competition amongst bowlers. As an
example, the lead off person for the team on the left lane, would bowl against the lead off
person for the team on the right, second player vs second player, etc.

Manage treasurer duties: This will hide or enable all the treasurer functions of BLS. If
you do not manage the finances for your league, this feature should be disabled.

Use Internet features - Upload standings, E-mail, etc.: This will disable/enable all
Internet functions of the program, such as uploading standings to LeagueSecretary.com,
Bowl.com or SportBowling.com

League has Bowler Divisions: If bowlers are separated by divisions, indicate so by
selecting YES. If either bowler or team divisions are setto YES, the configuration options
would become available on the Divisions tab. One use of bowler divisions, would be to
separate weekly and/or season highs based on average, or age of a bowler.

League has Team Divisions: If the teams are divided into divisions indicate so by
selecting YES. If either team or bowler divisions are set to YES, the configuration options
would become available on the Divisions tab. Team divisions could be used to
segregate teams into a NFL / NBA/MLB style league where certain teams are in the
"west" and "east" division, as an example, for standings and/or weekly or season highs.

Bumper Bowling: Set this to indicate that this is a bumper bowling league. This feature
only affects centers with the A/S edition, so that autoscoring systems with automated
bumper control can be raised and lowered, as needed.

Drop-In Singles League: This enables the correct settings for this type of league.
Normally only affecting centers with the A/S edition, this option accommodates leagues
that are not so much leagues, but an informal get-together that bowl on a set number of
lanes. Each week, BLS-2021 will remove each player from the team rosters. Bowlers
that come the next week would be placed on the team (lane) that they bowled. This type
of league does not have teams and only keeps track of average or high scores bowled
that week or during the season.

Will be sanctioned in the selected association: Set to YES if the league is sanctioned,
(also known as certified). Use the Drop-down List to indicate the association that the
league is a primary member of, USBC, USBC Sport or CTF. If the sanctioning
organization is notlisted, select "Other".

Youth League Type: For Youth leagues, use the Drop-down list to identify the type of
league.

What Center(s) League Bowls at
Where We Bowl: Defines the bowling center where the league bowls. Traveling leagues
can also be configured in this section.
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Where does the league bowl:

Center Name: |CDE Software ‘ i Edit Information

. No League is a Traveling League or bowls in multiple centers:

Split Season
Split Season Schedule

The season will be divided into 2 or more parts (Split Season): Toggle the switch to
YES if the season will be splitinto more than one part. This will enable split season
settings. Fall leagues are commonly broken up into 2 - 4 parts, where the team points
are reset back to zero, then, at the end of the season, each split winner would roll off for
league champion title.

Once the splitseason has been enabled, enter the number of splits the season will be
divided into. BLS-2021 will automatically configure the starting week for each split,
based on the number of splits and the number of weeks in the league. For example, if
the league has 2 splits, the total number of weeks will be divided by 2 to determine the
start of the second split. The first split will always start with week 1. Subsequent splits
can start at the default week number, or they can manually be configured by entering the
week number in the appropriate box. BLS-2021 allows up to 8 sessions.

Use the option switches to configure what data will be reset at the split.

Standings based on split or entire season: Typically, the Team Standings on the
Standing Sheet are based on the wins and losses for the current split. However, at the
end of the season, it may be desirable to base the standings on the whole season to
see how teams placed for the year.

Legal Lineups

Setting up the gender makeup, the playing strength, and minimum lineup, is very
important for the proper calculation of handicap and points. Settings will affect whether a
team will forfeit, based on who bowls each week.

Number of people who bowl on a team each game: This is the number of players who
bowl each week, or Playing Strength. This option should already contain a value
previously configured in the League Basics category when setting up the Rules. For
example, 2 would be entered for a doubles league, and 3 would be entered for a trios
league. Do not confuse this with the number of players allowed on a team roster, (for
those who allow extra members to be listed on the team).

Minimum Lineup: Indicate how many players are required to be presentand bowl on a
team in order to maintain a legal lineup. Unless otherwise specified byleague rules,
USBC Playing Rule 109a provides the following minimums:

3 bowlers if playing strength is 5; 2 bowlers if playing strength is 4; 1 bowler if playing
strength is 3
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This value should not be changed unless the league has a specific rule, which over-
rides these options.

EXAMPLE: If this is a 5 person league, typically 3 players mustbowl each game to
prevent a forfeit . If only 2 players, or 1 player showed up to bowl, then the team would be
considered as forfeit, for that week.

Required team members: Identify the number of players that are required to be from the
current team roster, for the number specified in the Minimum Lineup.

Using the above example, if the league is a 5 person league and the minimum number
of people who bowl is specified as 3, and the number of regular players required is 2,
then a legal lineup could be 2 absent players, 1 substitute and 2 players from thatteams
rosters. If, using the same rules, the team lineup included 2 absent players, 2 subs and
1 regular team member, then the team is considered as forfeit.

Reordering the team roster members for next week: Select how to reorder the bowler
lineup when advancing to the next week, by using the drop-down list box. This option will
typically be used for leagues with Individual Match Points configured. The available
options are to leave bowlers as they just bowled (Default order), sort bowlers from
low to high average, sort bowlers from high to low average, and return to the "Fixed"
roster as set on team rosters screen. This last option is designed to allow the
secretary to configure a "default” roster based on the Team's preference. When allowed
in the League Bylaws, itis common for teams in match pointleagues, to re-arrange the
roster in an effort to produce easier individual match-ups. More information on this
feature is available in the next chapter.

VACANCIES: Indicates whether or not vacancies count towards a legal lineup. When the
option is switched to Yes, the number of weeks where vacancies will count toward the
minimum lineup, can be re-configured. The default will be for the entire season.

Mixed League requirements: When setting up a mixed league (Adult Mixed, Youth
Mixed or Adult/Youth), set up the appropriate rule regarding the gender minimums for
each team. For example, if a 4 person team mixed league is set up, the league may
require that each team have atleastone man and one woman on a team, to prevent all
men or all women teams. By setting this rule, vacancy reports will accurately show how
many men or women are needed for the league. BLS-2021 will check for teams that
break this gender rule and assign a forfeit.

Team Average Cap: This option is available in the Pro and A/S editions of BLS-2021. It
is designed as an advanced Average Cap rule, targeted at scratch leagues that want to
enforce a cap, but do not utilize features available in the team handicap rules.

When configuring this rule, the Average Cap can be based on Book/Entering Average or
the current average to be used for the night. By default, the value used for the Average
Cap will be 200 per bowler bowling that night, but can easily be changed using the spin
box next to the value.

When the team average exceeds the configured Average Cap, there are two options
available. First, BLS-2021 can simplydisplay the fact that the cap has been exceeded,
on the Enter/Correct Current Scores screen. Alternatively, BLS-2021 can be configured
to forfeit the games when a team exceeds the average cap. If additional options or
needed, such as the team exceeding the average cap loses pin count, then the league
will need to be configured as a Handicap league and the Team Handicap rules are
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applied. For more information on Team Handicaps, see the section on Team Handicaps
later in this chapter.

Additional text for Legal Lineups for written Bylaws: The section is provided to include
additional text or notes written into the League's Bylaws that may not have already been
included in these rules.

Individual Averages
Book and Alternate/Entering Averages

When a bowler begins the league, an average may be temporarily assigned to the
bowler for the purposes of individual and team handicap purposes. This average is
used for a designated time. Manyleagues use a form of this rule in order to level out
scores and averages for returning bowlers. Off season breaks usuallyresultin scores
for the first part of the season being below a bowler’s potential. By using a previous
average for a shorttime, the results tend to be a bit more realistic and fair.

The other important aspect about Book Averages is they can be used for eligibility
requirements for Association awards. Leagues that are certified with National
organizations, can use the Book Average to qualify for average based awards until the
required true average is established, as defined in the organization's rule book.
Because of this, even though Book Averages may not be used for League purposes, itis
suggested that they are entered when inputting bowlers.

The Book Average is defined as the returning average from the previous season in the
same league. Bowlers joining the league for the first time will use the highest average

from the previous season. Again, for national award recognition, itis recommended to

configure Book Averages.

The Alternate/Entering Average is provided for leagues requiring a different average
other than Book Average for starting average. For example, some leagues adopt a rule
to use the highest average from the previous season from all leagues.

Book and Entering Averages

Average used for handicap purposes: Use the Drop-down list to select which average
(Book, Entering or both) to use for handicap at the start of the season. If the league does
not use these averages to start the season, keep this setting at the default value.

Use average for how long: Use the Drop-down list to identify how long the Book or
Entering average will be used. Pay careful attention to the statementwhen a bowler has
such an average. The statement can either read "Bowler completed specified number
of games." or "League completed specified number of weeks". While they appear to
mean the same thing, they greatly differ in how the program works. The first statement,
which is the most common, will use the book average for each bowler’s specified
number of games, regardless of what week the league is at. However, when the second
statementis used, the entire league will stop using their book averages after the
specified week and use their true average. As such, bowlers entering the league after
the specified number of weeks, will not use their book or entering average at all. If your
bowlers use their true average right from the start, enter zero for the number of games or
weeks.
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When bowler has no Book or Entering Average: Configure the rule for zero number of
games or weeks. Use the Drop-down box to identify what average will be used, first
night's average or a fixed average. When using fixed average, configure this average on
the Individual Handicaps screen as discussed later in this chapter. Identify how many
games this average will be used for.

New bowlers without a Book or Entering Average should: Configure to use vacancy
average or show zero. This indicates what average to display until a true average is
established. This affects standing sheets and recaps for bowlers without book
averages.

Book and Entering Average must be based on a minimum

Set the number of games the Book Average and/or Entering Average should be based
on. When setto a value other than zero, this option will force the program to ignore
book/entering averages based on fewer games than the number specified. If the value is
set to zero, the rule is ignored and any book/entering average entered, will be used.

If the number of games for the bowler's book average is unknown, setitto zero in the
Bowler Maintenance screen. BLS-2021 will recognize it as a valid book average and
will applyit to the rules, as configured.

Note: While a book average is still based on 21 games, the new USBC standard is to
use a book average onlyfor the first 12 games, for association awards which are based
on average, not 21 as in the past.

Non-Standard Options

The following rules are non-standard rules, which few leagues use. For detailed explanation of these rules,
Do not change the following items unless certain they apply to the league bylaws.

Maintain same average throughout the night. The average used for the first game will be used
. No ™ for all games bowled in each session even if it changes due to book average or other league
rules.

. No Book/Entering average shall be added as a "cushion average" for games or weeks shown
above.

. No ™ Use a 3-6-9 average format for first 3 weeks when Book Average is not used.

. Mo Using a "pin-drop" rule to limit the amount a bowlers average may drop.

Individual Handicaps
Individual handicaps are used for determining individual handicap awards and match
play. In addition, manyleagues determine team handicap using the sum of individual
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bowler handicaps. While manyleagues include individual scratch awards, USBC
strongly encourages handicap leagues also include individual handicap awards. After
all, thatis the whole idea of a handicap league.

If using a different handicap for men, women and/or youth, toggle switch for gender
accordingly. Enter the Handicap percentage and BASE in the appropriate boxes in the
table. The column Other, applies to bowlers not assigned a gender. The Other column
is also used for non-standard vacancyrules, see the section on Vacant Players later in
this chapter.

NOTE: Handicap rules CAN be changed mid-season. For example, there may be
occasions where the Handicap BASE is initially configured at one value, buttoo many
bowlers have higher averages than the base, thus giving them an advantage. Under
these circumstances, the league may adopt a new rule to increase the BASE to keep the
league competitive. Therefore, changes made to these rules will be effective in the week
they are modified, so if these changes need to be applied to the entire season, you must
return to Week 1 to make these changes.

Capping of Handicapped Scores
USBC now allow the capping of Handicap Scores to 300 and series to 900.
Capping of handicapped scores - USBC Rule 100g-5

h 999 j Maximum handicap game score (with handicap)
(Default value is 999)

—_

(Default value is 9999)

Non-Standard Options

These options reflect non-standard rules. Do not change any of these rules unless you
completely understand the complete ramifications of changing these options.

Above the Base: If the league does not give handicap when the bowler’s average is
above the base average, then leave these set to zero. If the league uses a negative
handicap method, enter the appropriate percentage figure to be used where the average
is above the base. This maybe a positive or negative value.

Note: Using a negative handicap tends to create a less enjoyable season for higher
average bowlers. No one likes “pins taken away" . Simply raise the base instead.

Most scoring systems do not support negative handicap, so this handicap rule is not
recommended for the A/'S Edition of BLS-2021.

Maximum Handicap per game: If there is a maximum or cap to individual handicap,
enter that value. If no maximum, enter 999. If set to zero, bowlers will not receive
handicap.

When non-standard options are used, this screen will have a "Reset to default" option
that can be used when handicap scores are not correctly calculating.
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Additional Individual Handicap Rules: This section is provided to include
additional text or notes, written into the League's Bylaws, that may not have already been
included in these rules.

Team Handicaps
This tab is only available in Handicap Leagues. Handicap for each team is calculated by
the following:

¢ Sum of bowler handicaps - This is the simplestand most popular method of team
handicapping. Handicaps for each team member or sub is added together for a team
handicap total.

+ Based on team average - Another popular method of team handicapping. The
averages for each team member or sub is added together. This sum is subtracted
from the handicap base and multiplied against the handicap percentage to create the
team handicap. This does, however, require more work for the team captain when a
roster change is made.

« Based on difference in team averages - Averages for each team member or sub are
summed. This is also done with the opposing team. The lower average team receives
the difference between averages multiplied against the handicap percentage as the
team handicap. The opposing team receives zero handicap. Note: This team
handicap method is strongly discouraged. Handicap awards are not consistentand
all electronic scoring systems do not support this method!

The USBC strongly discourages the use of handicap methods that are based on the
difference in team averages. There is no real basis for team handicap awards because
the handicap a team receives is based on whom they bowl against. Since only one team
receives a handicap, the opponent would not receive any to their scores to qualify for a
league award. For handicap awards to have any meaning and value, all teams need to
be handicapped from a common figure; therefore, using the difference in team averages
is strongly discouraged.

In addition, not all scoring systems support difference in average for team handicaps. If
changes are made at the lane, bowlers will need to manually calculate handicap.

As per the Rule Book, the Team Average is the sum of the averages of the players who
bowl that night.

Maximum team handicaps: If there is a maximum number of pins handicap per game,
change the Maximum team handicap list to Maximum Team Handicap. If there is none,
the defaultis set to Handicap is not limited.

Percent and base average: This option is available when handicap is based on team
averages. Enter the proper values used for figuring the team handicap. These values are
not required where the team handicap is the sum of the bowler’'s handicaps. A negative
handicap can be configured where the team average is above the BASE average.
However, as with Individual handicaps, using a negative handicap tends to also create a
less enjoyable season for higher average teams. No one likes “things” taken away from
him or her. Simplyraise the base instead.
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Non-Standard Options

The following rules are non-standard rules, which few leagues use.
For detailed explanation of these rules, click HELP.
Do not change the following items unless certain they apply to the league bylaws.

. In a handicap league, the first night will be bowled SCRATCH (without any handicap) rather
than with handicaps.This will give an automatic advantage to the higher average teams.

Minimum team average
4 9999 |+ | Maximum team average

BASE Team Average for the following rules shall be:
Percentage above the base received when opponent is above the base average

Percentage of team average difference the lower average team receives when

both team averages are above the base

If the league does not use special options listed in this section or you do not understand
them (which mightindicate you don’tuse them), leave these values set to default.

First night handicaps: If the league bowls the first night scratch, select the First nightis
Scratch in a handicap league check box. Normally, handicaps will always be computed
beginning the first week.

Average Cap Rules when team handicap based on Team Average: These rules are
based on the current average.

+ Team average may not go below: Minimum average for the league.

« Ateam may not have a team average higher than: Average cap imposed on the
teams in the league.

+ The BASE team average for the following rules shall be: Configure a BASE average
for the next two rules when a team exceeds the average cap.

« If one team average is above the BASE, opponent receives X% of the amount above
the base: Amount of pins opposing team receives when base average is exceeded
where X' is a percentage of the number of pins.

« If both team averages is above the BASE, the low average team receives X% of the
difference in team average: Handicap to be awarded when both teams exceed the
average cap.

NOTE: Handicap rules CAN be changed mid-season. There may be occasions where
the Handicap BASE is initially configured at one value, but too manyteams have higher
averages than the base, thus giving them an advantage. Under these circumstances,
the league may adopt a new rule to increase the BASE to keep the league competitive.

Additional text for Team Handicaps Rules: The section is provided to
include additional text or notes written into the League's Bylaws that may not have
already been included in these rules.
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Absent Players
This section is used to configure the score that will be used for Absent Bowlers.
Leagues will typically use one of the following 2 rules:

Absentee is average less pins: Used when a player was not present, and an absentee
or blind score is used. The default setting is 10 based on USBC Rules unless League
Bylaws have a different value. An "A" would be entered in the score entry screen to use
the average of the player minus the number of pins indicated for that gender of bowler.

Absentee is average less a %: If the league subtracts a percentage of the absent
players average rather than a fixed number of pins, enter the percentage; however, this
option is strongly discouraged by USBC. Itis unfair to the bowler with a higher average,
who loses more points with this method than a bowler with a low average. Remove the
default values from Absentee is average less pins when using this option.

Individual Match Points for Absentee

This option will only be available when the league is configured for Individual Match
Points in the previously discussed League Features section. This rule is divided into 3
parts:

1. When Opposing an Absent Player (or Vacant): Use the Drop-down Listto configure
how Individual Match Points are awarded when the Absent bowler wins the game
based on the nextrule.

2. Match points awarded when present player bowls against an Absent score: Use
the Drop-down List to indicate requirements for the player to earn points when
playing against an absentee. When requiring the player to score within a certain
range of their average when bowling against an absentee or vacancy, enter the
number of pins within the bowler’s average in order to receive points. Atie is
considered a win for the player who is present. When configured where the present
bowler must beat the absentee score, the Individual Match Points can be split.

Note.: The USBC rule 114c states that a bowler must bowl their average less 10 pins
unless the league rules state a different number of pins. To be compliant with USBC
Rules, leagues that base on a percentage basis should consider changing the rule fo
specify a specific number of pins.

3. Match points awarded when Absent score vs. Absent, Vacant or Dummy score:
Use the Drop-down Listto configure how Individual Match Points are awarded under
these circumstances.

Absent players: Indicate if absent players are allowed to earn points. If not, indicate
where the points won should go.

Choose where points should go if an absent player is opposing another absent player.
USBC strongly encourage that the points won should go to the team winning the game.

Absentee Pin Drop Rule

In a few leagues, there is a penalty for players who are frequently absent. This “pin drop”
is a specified number of pins thatis deducted from the absentee score as configured
abovwe. If the league uses this Pin Drop Rule instead of the Absentee Rule, remove the
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values from the Absentee is average less pins table. This deduction can be taken
based on accumulation of absences or a consecutive number of absences.

Example: The first night a player is absent, the absentee score is their average minus
10 pins. The same method would apply if the player were absent further consecutive
weeks. With a pin drop rule, the second consecutive absence would deduct the
absentee amount plus the pin drop amount, such as 5. This gives the absentee score a
value of average minus 15. Ifitis the third consecutive absence, the absentee deduction
would total 20. That is the average minus 10, minus an additional 5 pins for each
succeeding week.

Additional Absentee Rules: The section is provided to include additional text or
notes written into the League's Bylaws that may not have already been included in these
rules.

Vacant Players
This section is used to configure the average/score that will be used for Vacant Bowlers
when a team has an incomplete roster. There are two types of scores that can be
entered, depending on if handicap will be applied to the Vacant Scores:

Vacancy Scores: A Vacancy Score is used when a team does not have a complete
roster. Handicap for the vacant bowler is calculated, based on the vacancy score. In
addition, bowlers absent on the first night of bowling should use a Vacancy score, even if
itis known that the bowler will be bowling for the season. A"V" would be entered in the
score entry screen to use the value of the vacancy score for that gendered bowler.

NOTE: If the league uses a different HDCP for Vacant scores, BLS-2021 has the option
to configure a separate Handicap Rule for Vacancies. Simply toggle the switch in this
section, then configure the Individual Handicaps rules under the "Other" column.

Dummy Scores: This is similar to a vacancy score, however, handicap is assumed to be
included or can be assumed to be scratch. A"D" would be entered in the score entry
screen to use the value of the dummy score for that gendered bowler.

Note: For handicap leagues, using a Dummy Score'is not recommended, as is it will
artificially inflate the scrafch team scores, which may affect league team awards and
prizes. In addition, you should consult the USBC Playing Rules (Rule 105) to ensure
your rules are in compliance.

Individual Match Points for Vacants

This option will only be available when the league is configured for Individual Match
Points in the previously discussed League Features section. This rule is configured as
follows:

1. When Opposing an Vacant Player (or Absent): Use the Drop-down Listto configure
how Individual Match Points are awarded when the Vacant bowler wins the game
based on the nextrule.

2. Match points awarded when present player bowls against a Vacant score: Use
the Drop-down List to indicate requirements for the player to earn points when
playing against a Vacant. When requiring the player to score within a certain range of
their average when bowling against an absentee or vacancy, enter the number of
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pins within the bowler’s average in order to receive points. Atie is considered a win
for the present player. When configured where the present bowler must beat the
vacant score, the Individual Match Points can be split.

Note.: The USBC rule 114c states that a bowler must bowl their average less 10 pins
unless the league rules state a different number of pins. Leagues that base on a
percentage basis must specify a specific number of pins.

Additional Vacancy Rules: The section is provided to include additional text or
notes written into the League's Bylaws that may not have already been included in these
rules.

Forfeits

Team Bowling Against Forfeit: Enter the number of pins within the team average, in
order for a team playing a forfeiting team, to receive points.

The USBC rule 110b states that a team must bowl the team average less 10 pins per
player unless the league rules state a different number of pins. As such, Leagues that
use a percentage basis are not supported because a percentage is illegal.

Bowling the exact amountis considered a WIN, not a tie.

Opposing a Forfeiting Player: This option will only be available when the league is
configured for Individual Match Points in the previously discussed League Features
section. Use the Drop-down Listto select the appropriate rule for individual match
points, when a player is bowling against a forfeiting team.

The USBC rule 110b states that a bowler must bowl their average less 10 pins, unless
the league rules state a different number of pins. Leagues that base on a percentage
basis, must specify a specific number of pins, as the percentage basis is notan option
for certified/sanctioned leagues.

BYE Teams

This section addresses situations where a league has an uneven number of teams. It
will also explain adding and removing bye teams as well as the rules that may need to
be addressed with the use of byes.

What is a BYEteam?

Because of the use of a pair of lanes, rather than one lane, team bowling is always
associated with an even number of teams. However, situations can occur when a
league starts the season with an uneven number of teams or a team is dismissed or
withdraws, and is notreplaced. In this situation, a non-existentteam must be created to
keep an even number of teams for competition.

There are several nicknames we have seen for the non-existent team. Afew, for
example, are; Dummy Team, Ghost Team, Vacant Team and Absent Team. However,
the standard term used for a non-existentteam is BYE. In BLS-2021, the empty team
must be called BYE in order for these rules to be applied. Otherwise, the rules for
bowling against a forfeit would be applied.

How does the BYE Team work?
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According to Rule #114c of the USBC rule book, a team and/or individuals that are
scheduled against the BYE team must earn the points for the games, unless the league
board has voted to use the BYE System (No points awarded) or the Draw System
instead. More on the BYE System and Draw System later.

To earn the points: In order for a team and individual that opposes the BYE Team to
earn points, an individual must bowl their average less 10 pins and/or the team must
bowl the team average less 10 pins per player. According to Rule #114c, the only
modification to this rule that the sanctioned league board can vote on, is the number of
pins that a playerfeam must bowl within. Leagues may not use a percentage of the
average. Any points not won by the team are considered "unearned points" for statistical
purposes. The team not winning will still be receiving a loss.

The BYE System: The BYE System was developed for leagues that do not want any
score competition to take place againsta BYE team. In this situation, the team thatis
scheduled against the BYE team must field a legal lineup and bowl, but points are
neither won or lost. The standings for the league must be then based on a percentage
basis.

If the league is not sanctioned, another available modification to the BYE System, is the
awarding of all points to the team opposing the BYE team. This rule is notin the spirit of
competition and should not be used in sanctioned league competition.

The Draw System: The Draw System allows for the team bowling the BYE, to compete
againstthe scores of another team in the league. The scores from that team are pitted
againstthe unopposed team. The "drawn" team will receive no points from this pairing
as thatteam is already bowling against a true opponent. Configuring the Draw Team is
discussed in a later chapter on Entering/Correction Current Scores.

Starting the season with a BYEteam: Once itis time for the first night of bowling and
there will be an uneven number of teams, make small changes in Set Up your Team. Go
to the team number that will be used for the non-existent team. Simply rename this team
to BYE, and exit Set Up your Team. Enter scores as normal for all teams, EXCEPT for the
BYE team. The program will automatically calculate wins and losses.

In most cases, itis not necessaryto add any bowlers to the roster for a BYE team.
However, when using BLS-2021 Automatic Scoring Edition, vacant bowlers may need to
be added to the BYE team in order for the scoring system to work properly. Check with
the scoring company for more details.

The following section describes how to setup the rules in BLS-2021 to address BYE
teams and how to use BYE’s throughout the season.

Setting BYE Rules: First select the BYE system or the Draw System by using the toggle
switch.

When a Team is bowling against a BYE Team:

Using the Drop-down List, select the option for what occurs when a team bowls against
the BYE. The default setting is "Team must bowl within a designated amount". Enter the
number of pins the team must bowl! within their average. Initially, the number of pins are
setto 10 pins per bowler as identified by the Playing Strength (i.e. 4 person teams)
need to bowl within 40 pins of the Team Average). Do not change these defaults unless
your league uses a different rule or number of pins.
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The second Drop-down can be used to identify what happens to the points when the
team does not bowl the required score.

Individual Match Points When Bowling against a BYE Team:

For Individual Match Point leagues, identify the requirements a bowler would need to
earn their Match Point. Typically, the bowler would need to bowl within 10 pins of their
average to earn the point. However, this rule can be configured differently if the League's
Bylaws identify a differentrule.

Use the second Drop-down list to identify how match points are awarded when an
Absent of Vacant Bowler is bowling against the BYE team.

Draw System: When the DRAW method is selected using the toggle switch, the only
option is a Drop-down list, to select what happens to the points that are lost by the team
bowling the BYE. The remaining configuration for this system is done on the
Enter/Correct Current Scores screen. When entering scores, select the BYE team and
use the drop-down list to select the drawn/scheduled team.

Setting Name for BYE teams: The setting of different names for BYE teams can only be
done with BLS-2021 Automatic Scoring or Professional Editions. The BLS-2021
Standard Edition requires using the name "BYE".

Additional BYE/Draw Team Rules: The section is provided to include additional
text or notes written into the League's Bylaws that may not have already been included in
these rules.

Team Points
Team Points: This section is designated for the assigning of team points. If the league
is setup as a handicap league this section will include points awarded for scratch or
handicap wins.

Select the Team Point System

Configures the type of point system used in the league, Standard Team Point System or
Performance Points. \When Performance Points is selected, an additional section to
configure the Performance Points will become available after the Non-Standard Point
Options section.

Standard TEAM Points

Points per team game and series: Enter the number of points for each team game won
(with and without HDCP). As a separate parameter, enter the number of points for the
series (total pins with and without HDCP). In case of a tie, the points will be split
between the two teams.

Standings determined by percentage of wins to losses: Use the toggle switch to
indicated of standings will be determined by absolute points won or percentage. If all the
teams bowl the same number of games, there will be no difference between these two
methods. However, when a team joins the league later in the season, itis
recommended to base the standings by percentage of wins to losses so that the new
team has a fair chance of winning the split or the season.
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Team Standings: Ties
If a tie occurs in the team standings for position rounds, ties are broken by:

« Total Pinfall then actual games won - If a tie occurs in the team standings, the tie will
be broken by pinfall. If a tie still exists, the tie will be broken by the number of actual
games (not points) won.

¢ Actual games won then pinfall - This is very rare and should normally not be used. If
a tie occurs in the team standings, the tie will be broken by the number of actual
games (not points) won. If a tie still exists, the tie will be broken by pinfall.

o Total Pinfall with HDCP then actual games won - This is the most common setting
for handicap leagues. If ties occur in the team standings, ties are broken by total
pinfall with handicap. If a tie still exists, the tie will be broken by the number of actual
games (not points) won.

¢ Actual games won then Total pinfall with HDCP - This is veryrare and should
normally not be used. If a tie occurs in the team standings, the tie will be broken by the

number of actual games (not points) won. If ties still exist, ties are broken by pinfall
with HDCP.

There is a drastic difference in the results. Make sure the correct method is selected
according to the league rules. If the league rules do not have a provision for breaking
ties, USBC rules dictate that ties for position pairings shall be determined by total pinfall
without handicap.

NOTE: These procedures can only be used for determining team pairings for a position
round. If a tie exists atthe end of the season or at the end of any segmentin a spit
season, a playoffis required to determine League Champion or the winner of the split
season segment. Procedures for playoffs in BLS-2021 are explained in the chapter on
Weekly League Duties on Page[ 73\

Non-Standard Point Options

This section addresses uncommon team points and standings options and should not
be changed unless the league bylaws specifically indicate these point systems exist.

HDCP points awarded based on team with most pins over average: Use the toggle
switch to enable this rule.

Bonus Points: Bonus Points can be awarded to the team with the high game.

Regressive Team Points: This is a point system where everyteam bowls against every
team. The points configured are based on the number of teams, and are awarded with
the highest point value going to the team with the highest score. For example, suppose
the league has 6 teams. The points are awarded based on all teams; therefore,
whatever team bowled highest the first game would get 6 points, the team that came in
second would get 5 points and so forth.

Itis nota common point system. If you don’t understand it, you are likely not using it, so
leave it alone! Leave it set to zero.

Additional Team Point Rules: The section is provided to include additional text or
notes written into the League's Bylaws that may not have already been included in these
rules.
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Team Performance Points

Performance Points (UBL): Performance Points are a more recent addition to the sport
of bowling, that has brought more of a challenge to the individual while bowling with a
team.

Performance Points are solelybased on the performance of the individual’s scores each
week. If a player scores above their average, they earn points. If the player scores below
their average, theylose points.

This feature is enabled by selecting the option on the Team Points and/or Individual
Match Points tab. From the Team Point System and/or Match Point System, choose
the Performance Points option. Anew section will appear on the associated Team
Points tab to configure the Rule.

Adding a point range

To add a point range for Performance Points, simply enter the number of pins that the
bowler must come to, within their average. Next, indicate if this is above or below the
player's average. Finally, select how many Performance Points are earned. After the rule
is set, click Add this point range.

Removing a point range

To remove a point range for Performance Points, select the pointrange in the
Performance Points list and click Remove selected point range.

Individual Points
155

Select the Match Point System You are Using

Standard match point system: Enter the number of points for each individual game
won. As a separate parameter, enter the number of points for the series (total pins with
handicap). In case of a tie, the points will be split between the two players.

¢ Pins over average: If the league’s match point rules are such that the match points
are awarded to the bowler who bowls most over their average, select We issue points
based on which bowler bowls most over (or closest to) their own average from the
Drop-down text box.

¢ Performance Points (U.B.L.): If performance points are awarded/detracted by the
league, select We issue points based on bowling above or below one’s own
average (aka Performance Points) from the Drop-down text box. This will add an
additional Performance Points(UBL) tab on the screen.

+ Match Points handicap is difference of averages: If handicap match points are
calculated as a percentage of the difference between bowler averages, select this
option from the Drop-down lighis is very rarel/ Do not select this unless you
really know you do it this way! This is not supported by any electronic scoring
system.
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Non-Standard Match Point Rules

Add Match Points to Team Points: Some leagues keep track of match points for
statistical or award purposes. If the league does notinclude match points in the team
points total, toggle this switch to No.

Peterson Points: Out of the millions of different definitions, one seems to prevail. Thatis
where a player receives one point for every xx pins. Usually, it's for every 25, 50 or 100
pins of total scratch pinfall. Some people say theyfigure it each week but carry the extra
pins to the next week. It still comes out as taking the player’s total pinfall for the season
and dividing it by something (25, 50 or 100) and those are points the player has in
addition to the match points won.

Bonus Points: Configure the number of points awarded to the bowler with the high
scratch game for each match.

Add Peterson and Bonus points to team: BLS-2021 provides an option to include these
non-standard points to the Team's total. Toggle this switch to Yes if the league includes
these points.

Rotation: BLS-2021 has the ability to "rotate” opponents for Individual Match play so
players can bowl against a different player on the opposing team for each game. When
enabled, the bowlers will compete in game 1 normally. For example, in a Trios league,
Game 1 would have 1vs 1,2 vs 2 and 3 vs 3. Game 2 will rotate to where 1 will bowl 3, 2
will bowl 1 and 3 will bowl 2. Finally, Game 3 would be 1vs 2,2 vs 3and 3 vs 1.

Match play with a different lineup each game (Pro and AS feature only): Click on the
Options menu at the top of the screen and click in the Show Positions check box. Click
update form. Aps column will appear behind the game score column for each game.
This option does not support a individual series poinf(s).

I-rﬁll-m[ﬂlﬂrﬁllm

180 1% 177 3 165 2 % 522 507 %

82 2 84 2% 95 3 261 267 528 ‘fz
112 3% 125 4% 112 4 349 216: 565 2
185 4 186 1 172 1 543 15 558 0

Additional Individual Point Rules: The section is provided to include additional
text or notes written into the League's Bylaws that may not have already been included in
these rules.

Individual Performance Points

Performance Points (UBL): Performance Points are a more recent addition to the sport
of bowling that has brought more of a challenge to the individual while bowling with a
team.
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Performance Points are solelybased on the performance of the individual’s scores each
week. If a player scores above their average, they earn points. If the player scores below
their average, theylose points.

This feature is enabled by selecting the option on the Individual Match Points tab. From
the Individual Points section, Use the drop-down list under Individual Point System and
choose the option for Performance Points. The Individual Performance Points will be

added to the screen below "Rotation”.

Adding a point range

To add a point range for Performance Points, simply enter the number of pins that the
bowler must come within their average. Next, indicate if this is above or below the
player's average. Finally, select how many Performance Points are earned. After the rule
is set, click Add this point range.

Removing a point range

To remove a point range for Performance Points, select the pointrange in the
Performance Points list and click Remove selected point range.

Points Summary
This page displays a summary of the points that will be awarded on a weekly basis for
this league. This page is not configurable and is based on the previously discussed
Team an Individual Points sections. As such, if the points listed on this page are
inaccurate, go back to the previous tabs to identify the discrepancy.

Divisions
Divisions can be used to segregate standings, or weekly/ season highs for teams
and/or bowlers. This category will be available only when divisions are configured in the
League Options category discussed on page[28\

Note: For mixed leagues, BLS-2021 will automatically separate high score statistics for
the different sexes, so itis not necessary to create divisions for this functionality.

The screen is divided into Team and Bowler sections.
Team Divisions

BLS-2021 supports up to 16 team divisions. Configure the number of divisions, then
use the toggle switches to identify which team oriented results will be divided.

Team divisions are notthe same as the divisions for the bowlers. Large leagues are
sometimes divided into 2 divisions for purposes of team awards and team points.

Who assigns teams to divisions: Configure whether team divisions will be assigned
(You do it), or by the program (BLS does it). If assigned by BLS-2021, the teams are
assigned in order of the team numbers. Disperse the team numbers amongst the
divisions. If the program automatically assigns divisions, it can only be consecutive team
numbers.

If manually assigning the teams into divisions, go to Set Up your Teams and assign
each bowler a division number.
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Bowling within your division

If teams bowl only within their own divisions, except special position nights, click this
option. This option is only available if configured to have BLS-2021 assign teams to
divisions.

Team Division Assignments: Identify how many teams will be assigned to each division.
Optionally change the division labels to identify each division, for example, Eastand
West.

Bowler Divisions

Some leagues divide bowlers into separate divisions for individual awards and points. If
dividing players into separate divisions, use the lower half of the screen to establish this.
BLS-2021 supports up to 16 bowler divisions. For mixed leagues, Bowler Divisions do

not need to be configured, as BLS-2021 will automatically divide the bowlers by gender.

Configure the number of bowler divisions for the league, then use the toggle switches to
identify which bowler results will be divided.

Bowler divisions determined by: Indicate how the divisions will be determined, either
manually or automatically by average or age. Additional options are available to divide by
gender when combined with average or age.

Note: When configuring Bowler Divisions by Current Average, itis possible for a bowler
to change divisions based on the games bowled. This change in divisions will NOT be
reflected on any reports until advancing to the next week. Bowler divisions are
determined based on the bowler's average when entering any given week.

If assigning a division based on age, current average, or book average, then the bowlers
will automatically be placed in the divisions per the settings. You will not be able to
manually change a bowler’s division assignment.

If manually assigning the bowlers into divisions, go to Set Up your Teams and assign
each bowler a division number.

Bowler Division Assignments: Use this table to change bowler division labels and to
configure the parameters to be used to assign divisions. The parameters available will
be based on the previously configured rules to determine the divisions, average, age,
gender and average, or gender and age.

Additional Division Rules: The section is provided to include additional text or
notes written into the League's Bylaws that may not have already been included in these
rules.

Special Recognition
This section of the Rules allows for the configuration of the Team and Individual high
score prizes. In addition, the option to enable/disable the detection of local and bowling
center awards, is provided in this part of the rules.

Using the toggle switches, identify which team results will be recognized at the end of
the season or split. Options include High Scratch Game & Series and High Handicap
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Game & Series. These will be the data items displayed under Weekly and Season High
Scores on the Standing Sheet.

Similarly, configure the bowler results to be recognized at the end of the season, or split.
In addition to high game and series recognition, individual bowler options can be
configured for High and Most Improved Averages as well as Game and Series over
average.

Any option set to No will not be displayed up on the Standing Sheet. This can be
changed at anytime without losing data. The USBC urges all handicap leagues to have
individual and team handicap recognitions, scratch recognitions are optional.

Priority for Recognition: The league may specify a different priority for recognition for
weekly high scores and for season high scores. Quite often, leagues have no priority for
weekly highs, just for season highs.

Justwhatis Award Priority? With no priority, it means a player or team will get each and
every award it qualifies for. One team or player could take first place in all categories.

This is not fair to most players; therefore, a priority is established so if a player qualifies
for more than one award, the bowler gets one award of the highest priority or value and
becomes ineligible to win the other awards (and consequently will not be listed).
Selecting the proper priority will determine which award a player will get when that player
qualifies for more than one award.

BLS-2021 groups the awards in priority order when using a drop-down list box. There
are 12 different priorities. Select the one appropriate to the league rules. Selecting the
wrong one or the league changes the awards,these can be changed to reflect the
priority. Changing priority does resultin the loss of scores from the list. Trying different
priorities and do a “what if’ scenario and compare results. Here’s a brief explanation of
how to interpret each grouping of codes:

One Award: SS, SG, HS, HG- In this example, a bowler can only receive one award. The
first award qualified for would be Scratch Series then Scratch Game followed by
Handicap Series and Handicap Game. If the player won SG and HG, then they would be
eliminated from HG. If a team or bowler qualifies for more than one (IE 2nd place for SG
& HG) that player/team will only get the 1staward in the list (reading from left to right).

Two Awards: SG, SS and HG, HS - In this example, a bowler can receive two awards
(one from each category). One with the priority of Scratch Game then Scratch Series, and
the second award with the priority of Handicap Game then Handicap Series.

No HDCP or Scratch awards: This typically appears when Scratch and Handicap
awards are disabled elsewhere in the Rules. If the league awards these prizes, ensure
they are enabled.

Additional Special Recognition Rules: The section is provided to include
additional text or notes written into the League's Bylaws that may not have already been
included in these rules. There are separate sections available for Team and Individual
special recognition and prizes.
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Individual Eligibility for Awards
Subs and pre-bowl/make-ups

Indicate if temporary subs qualify for awards. Also indicate if pre-bowled games or
make-up games qualify for league and association awards.

Note: The USBC has a rule that prevents individuals from earning certain USBC awards
when pre or post bowling unopposed. This rule can be over-ridden on this page so that

awards not affected by this rule, can be detected. However, this also enables detection
for the National awards
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Include perfect scores in season high scratch game recognition

This option will remove 300 games from the high game awards and list them separately
on the Standing Sheet.

Most Improved/High Average exclusions

It may be desirable for the league to exclude the high average or mostimproved average
bowler from winning other individual league awards.

Games for Award Eligibility: indicate the number of games required for a player
to bowl to be eligible for individual awards. At the completion of the league, most
leagues require that a bowler completes two thirds, or 66% of the season in order to
receive an individual award. Indicate the proper number of games that a bowler must
bowl.

Once a bowler has reached a point where they no longer can complete the required
games or percentage, BLS-2021 will remove them from the individual awards. However,
there is a switch that will allow the ineligible bowlers to be displayed, even though they
do not qualify. All bowlers will be included in the weekly highs.

During the season, the occasional bowler may be prevented from showing up on the
awards list by indicating what percentage of games that must be bowled, in order to be
listed. Arecommended figure for this is 50% to 60%.

Helpful Tip: These eligibility rules might explain why bowlers do not show up on the
Standing Sheet for league awards.

Individual Special Recognition
Fill in the requirements for the Individual Awards of the league.

Individual High Handicap Game or Series

Identify the number of games the bowler must complete, before being eligible for
handicap awards. For a league that bowls 3 games a night, to begin tracking handicap
scores beginning with the veryfirst game, this value mustbe setto 0. If setting this to 3,
the first 3 games will be ignored and would start tracking handicap scores with the fourth
game.

BLS-2021 will allow handicaps to be back applied, when reaching the above referenced
number of games. Itis important to note that the handicap thatis back applied, is based
on the average at the time the configured number of games is reached and not the
average at the time the games are bowled.

Until the above number of games is reached, BLS-2021 can use the Book or Entering
average to qualify bowlers for these awards. The handicap for the book average will be
used and it will not back-apply the handicap at XXgames. Bowlers without a book
average will have their handicap games tracked beginning with a specified number of
games, with that handicap, back applied, to previous games if indicated.

The USBC recommends that scratch scores be included in handicap scores, for
bowlers whose average is so high that they receive no handicap. It makes makes more
sense saying “Abowler has a zero handicap” rather than saying “Abowler has no
handicap.”

Most Improved Average
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Be sure to enter the number of games the mostimproved average is based on. If 12
games is entered, then the average at 12 games will be used for determining the most
improved average. This is normal for League Achievement Award from the USBC.

If deciding to use the book average for mostimproved, indicate so. If a bowler does not
have a book average, then the mostimproved average will be based on that bowler’'s
actual average when the required number of games is reached.

Note: When changing this option mid-season, go back to Week 1 and return to current
week to re-calculate all the scores, otherwise the results maybe inaccurate.

High Average Recognition

Indicate the number of games necessary for a bowler to be eligible for high average
recognition.

Weekly and Season High Awards

Select the priority for the Weekly and Season High Score Recognition. For more
information on priorities refer back to the Priority for Awards section on page/[ 38,

One Award: Six options are available for this option, depending on which score
recognition has the higher priority, Scratch Series (SS), Scratch Game (SG), Handicap
Series (HS) or Handicap Game (HG). The additional 2 options are available to set the
second recognition priority, SS, HS or HS,SS.

Multiple Awards: These additional options allow individuals to be recognized in 2
categories, a combination of handicap and scratch, or series and game. Different
priorities can be set.

Note: Scratch Leagues will have fewer options to configure, as the handicap awards will
not be an option.

Team Special Recognitions
Team Prizes or Recognition Observed by League

Using the toggle switches, will indicate which prizes will be available for the teams to
earn in the league. Any option set to No will not be displayed up on the Standing Sheet.
This can be changed at any time without losing data.

Track handicap scores beginning with week number: Specify the week that team
handicap scores will be tracked and show up on the standing sheet.

Include scores with zero handicap... Toggle this switch to indicate that scores with a
zero handicap that qualify, are included with the high handicap scores.

Weekly and Season High Awards: Select the priority for the Weekly and Season High
Score Recognition. For more information on priorities refer back to the Priority for
Awards section on page[ 38\

One Award: Six options are available for this option depending on which score
recognition has the higher priority, Scratch Series (SS), Scratch Game (SG), Handicap
Series (HS) or Handicap Game (HG). The additional 2 options are available to set the
second recognition priority, SS, HS or HS,SS.

Multiple Awards: These additional options allow Teams to be recognized in 2
categories, a combination of handicap and scratch, or series and game. Different
priorities can be set.
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Note: Scratch Leagues will have fewer options to configure as the handicap awards will
not be an option.

Absentees, Vacancies and Substitutes

Configure whether or not teams with absentees, vacancies or substitutes, are eligible
for league team awards.

Helpful Tip: These eligibility rules might explain why teams do not show up on the
Standing Sheet.

Statistical Infomation
The following options are available for statistics to be listed on the standings.

Game/Series counters

BLS-2021 can keep track of up to three ranges of game and series achievements. For
example, the number of 200, 225 and 250 games can be tracked.

Enter the minimum score required to increment the counter for that score. This should
be done before scores have been entered for the league.

If a counter value is changed mid-season, return to week 1 and back to the current week,
in order to properly count the new values.

Statistic base

The statistics are normally based on a typical 10-pin, 3 game series. If the league is
different, then select the appropriate options.
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Adding counters to Standing Sheet

To add these counters to the standing sheet, the Style for the Team Rosters will need to
be modified to include this information. From the Standing Sheet, click on Change
Layout and select the Team Rosters data item in the Order of ltems on the Standing
Sheet section. Click the Change Style button, then To hide this panel so you can
change this style... button. Add the appropriate Game and/or Series counter data items
listed under the Statistics section.

For more information on the standing sheet styles, please see the Report Styles section
on page/[ o)

Additional Rules
This feature allows entering text for rules that may not directly affect scores and
statistics, to be printed as part of the League Rules. For example, mostleagues have
policies that describe what frame a tardy bowler would be considered absent, leagues
with complex playoff systems maywant to add this information to the section, and
various committees, (such as the prize fund committee), can be designated.

This page provides for a central location for all text based rules that were previously
available when configuring the rules that do affect scoring.

Special Options

This section provides additional options unrelated to previously configured rules.

Special Award Groups: This section will determine whether or not BLS-2021 will track
additional recognition such as local and state association awards and bowling center
awards. When toggled to Yes, these awards will be tracked on a weekly basis. These
awards are configured under the section on Defining Your League > Awards: Local and
bowling center awards discussed later in this chapter.

Brackets / Pro-Am: These features are only available in the Pro and A/S Editions. Use
the toggle switches to enable these items

League Templates: This screen will identify if a League Template was used to configure
this league, or if the League Rules were saved to a template.

Date for Age Calculation: Click Select Date to set the August 1 date where ages are
determined of a specific date.

Master Bowler Database: This feature is available in the Pro and A/S Editions. Use the
toggle switches link the league to the Master Bowler Database.

KIOSK Options: This feature is available in the Pro and A/S Editions. Toggle the switch to
indicate of the league results should be exported to the Center's KIOSK.

Print Your League Rules
Acopy of the League Rules is typically submitted with the League Application. In
addition, itis beneficial to the teams in the league to have a copy of the League Rules.
BLS-2021 provides different options to accomplish this task.
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To printthe League Rules, click the Print Rules icon at the top of the Setup League
Rules screen. Alternatively, the league rules can also be printed from the following menu
option:

Setup > League > Print Rules
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Setting up Teams and Bowlers

The next step in setting up a new league is to configure the teams and bowlers. Since
this information may not be available until after the League Meeting, BLS-2021 provides
a couple of reports that would be useful for the meeting.

Preliminary Paperwork
This section provides for two options:

1. Print Blank Sign Up Sheets: This allows sheets to be printed for bowlers to
complete so that they can be entered.

2. Print League Rules Worksheet: This is a worksheet that can be used when
defining the league rules during the league meeting or with the other league
officers.

These options are also available in the Library of bowling forms previously described
on page[5f.

Setup Team Rosters
This screen can be opened from the following menu options:
Setup > Teams > Rosters or Weekly > Prepare this week > Adjust Team Rosters

The Team Rosters screen allows for the setting up of the following:

e Team names e Addresses e Bowler sanction numbers
e Bowler names e Phone numbers e Gender
e Sub lists e Bowler lineups e Book averages

Select what you want to see:

The first Drop-down boxis used to select the team. Use the Drop-down list, up/down
arrows or the PgUp/PgDn keys. The second Drop-down list provides different options for
what information is displayed and can be entered or modified for the bowlers on the
team roster.

Enter/Rename Team: Click in the text area in the Team Name column. Delete the
existing Team Name, then enter the new one.

Divisions: If the league has Team Divisions, enter the Division number.
Bowling Team Roster

Bowlers maybe added or removed as required from either the Team Roster screen or
the Score Entry screen. This is also where changes to the order of the players can
occur. Even ifremoved, a bowler remains in the database and may be added to a team
anytime or used as a sub. The total pins, games and averages are always kept (even if
the bowler rolls only 1 game all season).

Team Roster Screen Options

BLS-2021 provides the option to designate which fields to display on the screen.
Different data fields can be added or removed depending on the information to be

m BLS-2021 by CDE Software, LLC



entered. To open the Team Roster Screen Options, select View > Rosters > View
Options.

TIP: This can be very useful for entering book averages on the Team Rosters screen. If
the option to enter book averages is not available on this screen, it can be added by
clicking this button and selecting the option.

Entering bowlers on the Team Roster screen: When setting up the teams in a newly
created league, all the roster positions (based on the Playing Strength) will be
configured as a VACANT bowler. To enter the bowlers, over-write the VACANT and enter
the bowler's name. Do not drop the VACANT bowler so you can add a new bowler. The
new bowler will just show up as another VACANT with a high Bowler ID number.
Continue entering gender, book average, L/R hand and/or phone number.

To change the information that can be entered for a bowler, use the second Drop-down
list to select different data options.

Reordering a team roster

To change a team’s roster quickly, use the Up or Down arrow on the right side of the
screen or use the mouse to drag and drop the bowler into the appropriate position. The
following Function keys are also available:

e To move a bowler up the list, select the bowler and press F3 or use the up button.
e To move down the list, select the bowler and press F5 or use the down button.
e To drop a bowler, select the bowler and press F4 or use the Drop button.

Finding abowler

To search for a bowler and the team they are on, click the Find Bowler control. Locate the
bowler bylast name and the team number would be displayed. To go to the bowler's
team, click on the Show This BIr's Team button. The bowler's team will be displayed
with the bowler’s information highlighted.

Add existing bowler

To add a bowler from the sub list, enter the Bowler ID# in the ID column. BLS-2021 will
give a warning if that bowler is already on another team, since they can only be on one
team atatime.

NOTE: If you are wanting to Move the bowler to a different team, you will need to first Drop
the bowler from the roster of the current team. This needs to be performed in a week
where scores have not been entered.

If the ID# is unknown, click Add . The Add a New Bowler screen will appear. Locate the
bowler, click Add Bowler to Team.

Adding new bowler

Anew bowler or sub is someone who has never bowled before and has never been
entered into a league. First, select the desired team using the drop-down list box or the
arrow buttons next to it. To add a new bowler, enter Nin the ID column instead of a
number and press Enter, click the New button or Add button and then click Create New
Bowler. Each of these options assigns a new bowler ID# and VACANT will be supplied
as the bowler name. Type over or delete this name and enter the name of the new

Setting up Teams and Bowlers



bowler. Itis also required to enter a gender into the sex column and a substitute status
(either a blank for a normal team member, S for Permanent Sub or T for Temporary Sub)
into the ? column. Continue to enter the information about this bowler as needed.

Itis also possible to enter a new bowler by selecting Enter a New Bowler from the
Bowler Maintenance screen and entering the bowler’s information. Once entered in the
Bowler Maintenance screen, the team the new bowler will be on must be selected.

Dropping a bowler

Abowler is removed from a team by placing the cursor anywhere on the line for that
particular bowler and pressing F4 or clicking the Drop button. Removing a bowler does
notremove them from the database, therefore that bowler can be used on another team
oras asub.

Flagging a bowler

Sometimes it may be helpful to flag a bowler who needs to speak with the secretary or
treasurer. To do so in the team rosters screen so that this alertis visible on all printouts,
click the Alert (I**) button.

In order for this to reflect on the Standing Sheet, use the Page Layout tab on the
Standing Sheet Setup screen to Indicate Bowlers with Pending Notes

Permanently removing bowlers
To permanentlyremove a bowler from the league, go to the Bowler Maintenance screen
and locate that bowler. Click the Quit the League button at the bottom of the screen.

Adding asub

BLS-2021 allows for two types of substitute bowlers, Temporary and Permanent.
Substitutes are designated on the team roster under the ? column using a T for
temporaryor 8 for permanent. Leaving this field blank designates a full time member of
the team. When advancing to a new week, the bowlers designated as a Temporary
substitute are automatically removed from the teams and placed back on the substitute
list. To reuse the substitute on the same team enter the bowler as a Permanent
substitute by inserting a letter 8 into the ? column.

Loaning bowlers

This can occur when a team has extra members and allows one of their players to
substitute on another team. The loaned bowler should show up on the original team and
not appear on the substitute list.

To loan a bowler:

Go to the team you are loaning the bowler to. Add the bowler as you would any
substitute. BLS-2021 will warn you that this bowler is already on another team and asks
if this team wants to loan this bowler. Answer Yes to loan the bowler to the other team.

If a bowler is loaned by mistake, remove bowler from the team they were added to and
the player returns to the original team.
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When advancing to the next week, the loaned bowler will be returned to the original
team.

Default Roster

BLS-2021 supports setting a default roster. This feature allows teams participating in
Individual Match Pointleagues to re-arrange the roster in an effort to create more
favorable match-ups, then return to a default roster order when advancing to the next
week. By default, when advancing to the next week, the rosters would remain as they
were re-configured.

The default roster is initially enabled in the League Rules as documented on page/ 2\
When the rule is enabled, the default roster is set based on the roster order at the time.
However, if the team captain would like to set a different roster order as the default, this
can be done on the Adjust Team Rosters screen as follows:

1. Advance to the next week where no scores have been entered.

2. Go to Weekly > Prepare this week > Adjust Team Rosters

3. Selectthe team wanting to change the defaultlineup and make the adjustment.
4. Click the Save as Default Roster Order button.

The new default roster order is new set.

When in any week where scores have been entered, to review the default roster order,
go to the Adjust Team Roster screen and click on the Show Default Roster button.

Bowler List

The Team Roster screen also provides a unique feature by displaying all the bowlers on
screen together, versus broken up byteam. This can make things faster in pre-
registering bowlers for the league or doing address or phone number entry.

Go to Setup > Teams > Rosters, click on the View menu. Click on Bowler List. (The
program defaults to Teams.) The team display will be removed and the entire league will
be displayed.

Sorting the bowlers: Click the Sort drop-down list box to change how the Bowler List
screen is sorted.

Information displayed: The second list boxis the Display options. Click this list box to
change the information that is displayed and can be modified.

Enter Bowlers NOT on team
Selecting Setup > Bowlers > Edit Bowlers Not On a Team will open the Bowler
Maintenance screen. Add the bowler names and information for bowlers who may not
be assigned to a team, but may be available as substitutes throughout the season.

Bowl/er Maintenance

The Bowler Maintenance provides for an alternative location to enter bowler data. The
Bowler Maintenance screen contains important information such as bowler names and
addresses, bowling center and financial institution information, as well as the local,
state and national association information.
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Entering important addresses: Names on this tab would not be any of your bowlers.

Click the Contacts, Centers, Bank, Associations button and select the address to
change from the list of important addresses. To add an important contact, click Enter a
New Name... Specify a unique Shortcut ID Code to identify the contact, then enter the
name, address, phone, etc. information in the provided space. Add a check mark next to
any of the listed options to identify the new contact. Information entered on this screen
changes the database on the fly. The new contact will not show up on the list of contacts
until you click away from the data entry screen, for example, click on one of the other
existing contacts.

Adding a new bowler: Must be on the A-Z tabs. Add any bowler on anytab and BLS-
2021 will automatically re-sort them.

Anew bowler can be entered in the Bowler Maintenance screen by clicking on the letter
representing the first letter of the last name of the bowler. Then, click on Enter a New
Name... located in the alphabetical listing in the lower left part of the screen. Enter the
new bowler's name and information. The new bowler defaults to being a substitute. As
with the Important Contacts, the new bowler name will not appear in the alphabetic list
until clicking away from the data entry screen. The Bowler ID will be assigned when the
new bowler is added.

Changing an address or phone nhumber

To change a bowler’s address or phone number, locate the bowler in the Bowler
Maintenance screen and click the bowlers’ name. The bowlers’ information will appear.
Simply type over the existing information.

Removing a bowler

Abowler can be removed from league reports and standings by selecting the bowler to
be removed and selecting Quit the League from the Drop-down list. Abowler can be
completely removed from the database using the Utilities > Bowlers > Delete " Quitters
and unused Vacants menu option . The bowler will be removed from the league
database permanently, provided scores have not been entered for the season. If there
are no scores or financial data entered for the bowler, there will be a Delete this Entry
button at the bottom of the screen.

Finally, if you want to prevent a bowler from showing up on the Standing Sheetas a
substitute, but still keep them the league database in case they mayreturn in the future,
you can set the status to Not part of the league.

Setting up team captains

To configure the team captain, select the bowler and put a check mark in the boxnext to
Team Captain. This can also be done from the Adjust Team Rosters screen.

Finding a bowler

Bowlers are sorted by the last name in alphabetical order. Click on the alphabetical
index buttons in the book to locate the bowler. If a last name was not entered, the
bowlers will be located in the No Last Name button.

Show Bowler Information
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To get a quick listing of a bowler's statistics, click on the Show Bowler Information
button. This will provide statistical information for the selected bowler with regards to
Pins, Games, Average, High Scores and Age.

Printing a bowler’s history

When viewing a bowler’s entry in Bowler Maintenance, click History to view and print
their current history information.

Remind Bowler to See Secretary

To make an indication on the standing sheet for a bowler to see the secretary, check the
Remind bowler to see me check box. If the standing sheet printing option of "Indicate
bowlers with pending notes" is enabled, then the standing sheet will place a couple
stars next to their name indicating that they should see the secretary.

Setting up league officers

The Bowler Maintenance screen will display a list of league offices on the right side of

the screen. The officers that have been assigned are Bold, and unassigned officers are

not bold. Clicking on an Officer that has been assigned will provide the following options:

» Show this Officer: This option will open the record for the currently assigned officer.

¢ Un-assign this Office: This option can be used to un-assign the office from the
currently assigned bowler.

To configure a league member is an officer:

1. Selectand display the bowler record to be assigned to the office
2. Select the office to assign to this bowler
3. Click Select as This Officer

Note - if the office is in Bold, show that officer. Ifitis notthe correct person, click the
unassign this office menu option. Then select the correct person, click on the office and
then on the Assign Name as This Officer.

Rerating Bowlings

While highly unusual, there may be a situation that calls for a bowler to be rerated during
the season. To rerate a bowler, select the bowler in the Bowler Maintenance screen and
select RERATE from the menu.

Click New Re-Rate and then enter the week that the rerate is effective and the rerated
average.

To remove a re-rate, select the re-rated average and click Remove.

Enftering Officers
Setup > Officers

This option represents one of several methods to view or enter League Officers. It will
open the Officers Quick Reference
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Team Capftains List
Setup > Teams > Team Captains List

This option will display a report that will list each team and provide the Team Captains
name, address, email and phone number.
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Certify

BLS-2021 provides full support for USBC, CTF and TNBA national organizations. In
addition, the program allows for any certifying/sanctioning organization to be configured
and the membership fees tracked.

IMPORTANT: If the league is certified/sanctioned through a national organization, it will
be necessaryto configure some options in this section in order for Award Forms and
Final Average reports to be correct. If individual bowler certifications are not going to be
tracked, please review the section on Certification/Sanctioning Fees later in this
chapter.

The following section covers the options available that normally manage certification
duties necessary for leagues certified by USBC and other organizations.

Certification/Sanctioning Fees
League and bowler certification is an important part of defining the league to be
compliant with the organization under which the league is sanctioned. This option can
be opened from either of the following menu options:
Setup > Fees > Certification
Selecting either of these options will open the following screen:
Entering Financial Information

Use this option to indicate whether or not you will be tracking financial information for
bowler certification. This setting will only apply to certification/sanction funds and has no
bearing on the weeklyleague funds. This setting will determine what options are
available when certifying the bowlers.

() Close ##" Reset To Default &2 Help

League Information USBC YOUTH THNBA

Information for Sample League 18-19
Will You be entering Financial Information?

Indicate below if you will be tracking the financial information for
individual bowlers. If you indicate YES, you will be asked to enter
detailed information for each bowler. If you indicate NG, then you will
only be able to indicate which organizations a bowler is a member of.

v

Sanctioning Organization & League Type

Indicate here the organizations that your league is certified/sanctioned in and the type of
league if appropriate.

Your selections here will affect the Awards given by your Ieague and the
certifications/sanctions you can indicate for your bowlers

League Certification Information Type of League Type of Lane Conditions

, Bl .
This League Sanctioned: Segiog -rﬁ. . House/Standard
USBC < Traveling .Wﬁ

This League is also Sanctioned by:
TNBA
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Note: If the League Application Form is to be printed from BLS-2021, this will need to be
answered Yes so that financial information is included with the application.

For Bowling Centers that do not need to track financial information or bowler
certifications, or for secretaries that track certifications using a different method, BLS-
2021 provides a method to automatically certify all the bowlers in the league at one time.
Selecting No for entering financial information will provide an additional option for
Certifications that will allow all bowlers to be considered Sanctioned. Answering No to
this second toggle switch will require each bowler to be individually Certified/Sanctioned.
Toggling this switch to Yes will automatically consider all bowlers entered into the
league as certified.

Will You be entering Financial Information? Certifications
Indicate below if you will be tracking the financial information for If you are not tracking Bowler Money,
individual bowlers. If you indicate YES, you will be asked to enter doyou wish to auFomat;callgconsmler
detailed information for each bowler. If you indicate NO, then you will Bowlers as Sanctioned

only be able to indicate which organizations a bowler is a member of.

- I

League Certification Information

Select the primary organization the league is certified through. If bowlers can be certified
through additional organizations, select that organization. Specifying additional
organizations displays additional tabs.

These settings will initially be based on the organizations configured on the Default
League Setup TAB. Additional sanctioning options will only be available if TNBA or Other
Bodies is selected on the Default League Setup screen. The League Certification
Information section on this TAB allows the sanctioning options to be re-configured for
the specific league thatis currently open.

Type of League
Specify if the league is a Seniors and/or Traveling league.
Type of Lane Conditions

Use this section to identify the oil patterns used by the bowling center for the league.
This is a program implemented by the USBC for the 2020/2021 bowling season to help
"fill the void" between the house shot and Sport League conditions. The Red pattern can
be considered the current "house shot" and will continue to be the standard for most
non-Sport Leagues. For this reason, the Red pattern is selected as the Default, so if the
lane conditions are unknown (in non-Sport League), then do not change anything.

The lane conditions will get progressively more difficult with the White and Blue oil
patterns, respectively.

Default League Setup

Enter the default settings that will be used for all new leagues created in BLS-2021.
These settings will determine what national awards will be earned as well as provides
the data that will be printed on some of the forms.

League Certification Information
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Specify the primary organization the league(s) will be certified through. This setting will
be used as the default for all newly created leagues, but can be changed for individual
leagues on the League Information TAB previously discussed.

Additional Organizations

This option allows certification for additional organizations to be configured. The most
common scenario is certifying with the TNBA, however, BLS-2021 includes the option
for other organizations to be added. Selecting the Other Bodies option will display an
additional Other Associations TAB at the top of the screen.

USBC Options

Managed: Specify if the USBC Leagues are Managed. This setting will affect the current
league as well as future new leagues, but will not change other existing league. For
more information on Managed Leagues, please see Rule 100m in the USBC Playing
Rules.

Note:lf the leagues are Managed, a Manager will need to be identified as a League
Officer in order for the USBC forms to contain the correct data.
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CTF Options

When the Default Certification Information is configured for CTF: Canadian Tenpin
Federation, the only option listed here will be English or French.

Fee Setup-USBC

League Certification Information

Enter the Leagues Application Number and indicate if the league is Managed. This
latter setting will initially be based on how BLS-2021 was configured on the Default
League Setup TAB.

Local & State Associations

The options that can be modified on this screen will be different depending on how the
league was configured on the Default League Setup section previously discussed.
However, if the status of the Local & State Associations are incorrect, they can be
modified on this screen without having to go back to the Default League Setup TAB.
However, these settings apply to all leagues, so changes made on this screen will be
applied to all leagues.

Leagues that belong to local associations that have Merged will have the option to
change fee amount under the Adult column.

Leagues the belong to local associations that have NOT Merged will have the option to
change fee information for Adult and WBA columns.

State fees will be similarly configurable based on the status, Merged or Not Merged.

CTF Leagues will have the single option to enter National, Sport, Provincial and Local
fees.

To change the fees, click the padlock located right above the fee entry table.

Fee Setup-Youth

League Certification Information: Enter the League's Application Number and configure
if the league is Managed. Click the Padlock to unlock the fee table to enter fees for
Youth, Youth Standard and Youth Basic.

Fee Setup-CTF

League Information

Enter the League's Application Number and designate whether the application,
membership cards and award forms are printed in English or French.

CTF Leagues will have the single option to enter National, Sport, Provincial and Local
fees.

To change the fees, click the padlock located right above the fee entry table.

Fee Setup-TNBA

League Information

Enter the League's Application Number.

TNBA Certification will have the single option to enter National, State and Local fees.
To change the fees, click the padlock located right above the fee entry table.
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Other Associations

When the league is certified through an organization other than the USBC, CTF or TNBA,
either as a primary or additional sanctioning, BLS-2021 provides the option to enter the
name of the organization and configure the membership fees. When Other Organization
is selected on the League Information TAB, the following option becomes available:

Use the Create New button to enter the Association into BLS-2021. Assign an
Organization Code for the Association. This code should be representative of the name
of the association, but cannot exceed 8 characters. Enter the Organization Name in the
appropriate text box, then Save the record. To modify the records, select the Association
from the list, then click Edit Association.

Other Fees
To access this screen, configure This League is also Sanction By to Other on the
League Information tab. Use this screen to specify additional certification fees and other
sanctioning organizations. Enter the Organization Code previously configured on the
Other Associations TAB. To enter the fees, click the padlock to unlock the fee table.

Sanction/Certify Your Bowlers

Certification > Bowler > Membership

This section allows entering certification information for the bowlers in the league. This
step will typically be done after the first night of bowling as the following items will need
to be collected from the bowlers:

Membership applications: These applications are called different names depending on
the national or local league thatis being applied for. For example the USBC uses an
application called the APPLICATION FOR USBC MEMBERSHIP. Itis a simple form that
the bowlers need to fill out and give to the league secretary.

Membership Payments: These payments usually come when the membership
applications are submitted. There may be situations where payments are not required.
For example if a bowler plays on other leagues and has already paid for this national
membership, then they will not have to make a payment.

NOTE: To keep the Treasurer reports accurate, itis important to enter Bowler
Certifications in the same week they are paid by the bowler. Itis just as important to go
back to the week the bowler paid certifications to make any adjustments to those fees.
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\\ Sample League 18-19 — Certifying Bowlers

— | ) [ T o _—
5 th,“,,, - J Bowlers 3 Forms Sg Reports .‘}_7:5 Utilities &5 Help
Bowler Infi ion Reports Certificati ksh Utilities
Emmerson __ Carmichael DontKnow =
Team Name z 9821 NW 115th Ave
o o e | C3S Seattle WA 98003
1-Emmerson Carmichael 08/13/1399 [ THEA $
2-Carly Coreley
3-Lon Mead e~ | g o | CTFIDE
4-Marianna Dodge M Eee 2] 0 0 USBCID # |123-6541
- Team #2 - Team Grand Vitara S
& Team #3 - Boulevard C109RT USBC Adult Certified
@ Team #4 - Kizashi
@ Not On A Team payments in: [JUSBET Memberships TNBA Extra
Clear All Payment
ization: | Adut [} :
USBC Organization: ul Information
Card Group USBC Certifications
@® Standard ) National Dues
Additional
Discousts “Paid I Information
Total This Organization: Total All Organizations:
Amount Due:  §15.00 Total Due: $15.00
Total Paid: Q1500 Total Paid: §15.00
Total Due: Total Due:
Payment Method: |Cash/Check : Check Number:

With this information, begin certifying the bowlers. On the Certify Bowlers screen, there
is a section to enter the National ID Number. Entering an ID number here does not
automatically configure the bowler as certified. Bowlers keep the same USBC ID
number from year to year, so while the bowler may have been certified in the previous
season, the bowler may not be certified for the current season, but still have the ID. The
section at the bottom of this screen must be completed to configure the bowler as
certified. There are fields for Additional # and TNBA# that can be used for multiple
affiliations.

There are different options available depending on if the Local and State Associations
are Merged or NOT Merged and whether or not financial information is being tracked. As
such, itis important to have this information, as well as the Certification Fees correctly
configured before proceeding with Certifying the bowlers. For more information, see
Certification/Sanction Fees previously discussed on page[ s\

If tracking financial information

When BLS-2021 is configured to track financial information with regards to certification,
specific application card information will have to be completed for the USBC
Certifications and Sanction payments to be accurate.

This screen is designed to provide the same options available on the membership
cards. This allows for more flexibility when bowlers bowl in leagues sanctioned in
different local associations. The Total Due will be based entirely on how the fees we
originally configured in the Certification/Sanctioning Fees section.

This section is divided into 2 parts, Card Group and USBC Certifications. To certify the
bowlers, first select the Card Group which applies to the bowlers membership card.
These Card Groups are defined as follows:

e Standard: This option is available for non USBC Sport Leagues. This Card Group is
for complete, full memberships, so each choice made under USBC Certifications will
charge the full amount required for the complete membership, National, Local and
State. Select the National Dues option to certify the bowler(s).
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¢ Sport: This option is available for leagues configured as USBC Sport Leagues.
Similar to Standard, this option is for complete, full Sport memberships and each
option under USBC Certifications will charge the full membership dues for all
associations, National Sport, Local and State. Select the National Dues option to
certify the bowler(s).

¢ Other: Select this option when the bowler will only be paying Local, Local and State or
Sport Upgrade. Use this option when National membership is paid through a different
league. Select the appropriate option under USBC Certifications to complete the
process. Options on this screen are based on the status of Local and State
Associations previously configured.

¢ None/Discounts: Select this option when the bowler has already paid complete
membership fees in a different league. This option is also used for Local Association
Discounts. Note: To apply discounts, the bowler would need to initially pay for full
membership using the Standard option.

Once the Card Group is selected, an option needs to be selected under the USBC

Certifications section to complete the sanctioning process. Until a USBC Certifications

option is selected, the bowler is not considered Certified nor will the bowler be charged

membership fees.

Enter Total Paid if it is different than the Amount Due. Use the Drop-down Listto select

Payment Method. If paying by check, enter Check Number.

When selecting None (Already Paid), BLS-2021 offers the option to identify which

league the memberships fees were paid. Click the "Paid In" Information button to enter

the league where membership fees were paid:

Association Dues Paid in Return

League:
League Number:

Center:
Center Number:

Association:

Association Number:

Enter the League Name, Center and Association where the dues were paid. When
through, click the Return button.

The USBC Certifications will have to be entered for every bowler in the league. BLS-
2021 provides options for USBC Memberships by clicking the Membership button on

this page. If any of the bowlers have a life ime membership either at the National level or
with the Local Association, click on the Memberships button and toggle the appropriate
switch. In addition, there is an option to configure USBC Hall Of Fame Membership.

TNBA or Other Association: If the league is certified through the TNBA or Other
Association, there should be an option to change to the additional fee table to enter the
registration fees. If this option is not available, then the TNBA or Other Association fees
have not been configured correctly.

Important Note: If a certification payment needs to be removed, itis important to be in
the week that it was entered so thatit gets correctly applied.

If NOT tracking finances
E BLS-2021 by CDE Software, LLC




When not tracking financial information with regards to Certification, this section
becomes less complicated:

Certifying Information

Bowler is Certified -

. Dues Already Paid

To Certify the bowlers, simply change the Bowler IS: option to Certified and specify Dues
Paid: Already Paid/This League.

League Officers & Application
This section provides additional League Certification Information, then prints the
application. There are four tabs in this section as follows:

Certification Numbers: This tab should already be configured based on previous data
entered in the Certification/Sanctioning Fees section including the Type of League
options. Bowling Center Information should already be listed based on information
entered in Setup > League Rules. However all of these fields may be edited.

League Officers: This tab will display the League Officers that are required for the
Certification Application. Again, these should already be pre-populated with data entered
when setting up the league. However, changes can be made by clicking Change/Update
Officers which will open the Bowler Maintenance screen.

Association Addresses: Provides information about the local association the league is
affiliated with. To modify this information, click Edit Information which will open the
Contacts, Centers, Bank, Association screen Bowler Maintenance utility. Select the
Association to use or Enter a New Name and add the necessaryinformation. Then click
Select to add to the application and link the Association to the league.

Note: The Association Addresses need to be correctly configured on this screen in order
for them to appear on the Awards Forms.

Printing Application: This tab provides an option to print two important forms, USBC
Certification Form and Print your league's bylaws. The league's bylaws are required to
be submitted with the USBC Certification Application.

Print Application
Once the bowlers’ sanction payments have been entered the league sanction
application can be prepared. This option will display the same screen that was available
in the League Officers and Application > Printing Application tab described in the
previous section.

All the necessary components are prepared and printing may now proceed. Select the
Printing Application tab and select the application to print.
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Print Membership Application Cards

Print Sanction Membership Cards

¢ 28 oo 25! =
() Close ‘ 5 ¢ .55 Print Blank Cards ED Help
Print Certification Membership Cards
ID Bowler Name Sex Team Samel Sanc2 Select bowlers

1 Camichael, Emmerson ’ 1 8 @® Manually select bowlers
2 Coreley. Caily W 1 B ) ;
3 i 2 1 p All sanctioned bowlers
4 Dodge. Mananna 1 g All non-sanctioned bowlers
5  Elis. Robert 7 2 All bowlers on a team

B Lusk, Celeste ? 2
7 Abel Brendan

8 Cumie, Maiinda
9 Carsle, Lucsano
10 Colfman, Elena
11 Galo, Benio

12 Duger. Josala
13 Cobb, Monte

14 Simmons, Aon
15 Daley, Stephan
16 Friedman, Janine
17 Sub. Sammy

All bowlers not on a team
Select & Who?
® UsBC & Men
CTF & Women

n Association

TNBA
Other

ussc

@® Adult Youth

T U ) o

Print Options
Preprinted USBC Cards
@ Plain Paper

BLS-2021 features the ability to generate bowler sanction application cards that are
filled out with the bowler's information and can be returned to process and forward to the
local associations.

This screen can also be displayed by clicking Certify > Bowler > Bowler Membership
Applications. Membership cards can be printed for the entire membership or for specific
members.

Note: BLS-2021 does not support printing membership application cards on the pre-
printed forms. However, there have been no reported problems with submitting
membership cards printed from the BLS program on plain paper.

To print membership cards for bowlers in the league database:

1. Under Select Bowlers, indicate how the bowlers will be selected for printing.

2. Under Select an Association, click the specific association whose membership
cards will be printed.

3. Under Who?, select which sexes will be included.

Under USBC, select the appropriate membership choice.

5. Manually select bowlers under Select Bowlers, select the bowler by clicking the
bowler's name under Bowler List printindividual cards.

6. Click Print to display a preview of the membership cards. Click Print to print the
membership cards.

P

To print blank membership forms:

o Click Print Blank Cards to display a preview of the blank membership cards.
e Click Print to send the blank cards to the printer.

Print Certified/Sanction List

This report will generate a report containing a list of Certified Bowlers in the league as
defined in the Sanction/Certify Your Bowlers section.

m BLS-2021 by CDE Software, LLC



Weekly Menu

Chapter




Weekly Menu

Once league rules have been set, by default, BLS-2021 will enter into the Weekly
League Duties menu each time the league is opened. The choices under this tab are
designed to follow a logical sequence of how weekly duties are typically completed.

Adjust Team Rosters
This provides a convenientlink that will open the Team Rosters screen. This is the
same section that was used when entering the bowlers and teams for the firsttime. For
more information, please see the section on Setting up Teams and Bowlers > Setup
Team Rosters on Page[ 4

Auto-Scoring: Import scores from Front Desk
The option is specific to BLS-2021 Automatic Scoring Edition. For more information,
please see the chapter devoted specifically to Automatic Scoring on pagelz_srﬁ .

Auto-Scoring: Import Log
The option is specific to BLS-2021 Automatic Scoring Edition. For more information,
please see the chapter devoted specifically to Automatic Scoring on pagemﬁ .

Enter/Correct Current Scores

\-. Week 30f 28 --- Sample League 18-19 — 08/30/18

9, MainMenu 57 Prim %) Options || Scores U Ovemdes O oBowler 8 Team | Fees G Hep

@ |Lanes 1-2 2-Team Grand Vitara .vs. 3-Boulevard C109RT = | [

| TeamGramdViera Boulevard C109RT

Enter the scraich score or: A=Abs

Youth Vacancy D=Dummy P=Pacer (doesntcount) X=Counts Click for Diagnostics,
d to team tolal) K=Baker Score L_lJ’ Status, Info & HELP

IIII]IEIEI IIII-IIIIEIIIII

.5 Robert 165 % 522 75 597 % 3
B¢ Celeste Lusk w :m sq 82 84 95 261 267 528 %
Ei7  Brendan Abel M 119 720 112% 125% 112 | 349 216 565 2
ns Malinda Currie M 194 5 185 186 172 543 15 558 0
a
6]
9]
10}
1]
586 559 572 544, 1675
w | ¥ 191 191 19 573
£ &2 5ub 750 763 | 735 2248
v R = O
e 1 0 0 0
2| &Drop| 1 1
2| DAttn 3 1% 1 1. 6n
S RN TR 4
-

UnEarned Points

Entering scores is the heart and soul of BLS-2021. Score entryis located in Weekly
>Process this Week > Enter / Correct Current Scores. Notice the displaylooks similar
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to a recap sheet. This is designed to help speed the entering of scores, matching what
is printed on the recaps.
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Keyboard Shortcuts for use in the score entry screen

F1 - HELP P9 - Go to Team Rosters

Ctrl-F1 - F.AQ. F10 - Enter weekly fees

F2 - Bowler Maintenance 12 - Switch game sets of team bowls against2
opponents

F3 - Move bowler up ESC - Exit Score Entry screen

F4 - Remove bowler from team Page Up - Next pair of teams

F5 - Move bowler down Page Down - Previous pair of teams

F6 - Information about the scores Home - Flip to opposing team

entered

F7 - Re-Print of scores entered Shift-F7 - Print Screen

The blue bar above the teams displays differentinstructions depending on the active
field that the cursor is on when entering data.

Entering scores

When entering scores, pick a team and fill in the scores. If a score is unreadable, come
back and enter it later.

Scores can be entered with the numeric keypad to the side of the keyboard or the
number keys above the letters. If using the numeric keypad, the numlock key must be
on.

If special scores need to be entered (absentee, blind, vacancy, etc.), then enter the
appropriate code in its place. For more information, please see “Types of scores to
enter” later in this chapter.

Itis importantto remember that while scores are entered, the program is recalculating
the results. Initially, the team forfeits their game and series since no scores are entered.
The forfeit symbol will appear under each game and series column and the team score
will not be calculated and remain at zero. As scores are entered, the game will remain
as forfeit until the minimum lineup (as defined in the League Rules) has been entered.
At this point, the total team points will be calculated and displayed as the rest of the
scores are entered for the team. Also note, that the column header for each game will
change colors based on the number of scores entered. The legend of the colors are
located on the screen. The colors will change, based on lineup rules, to reflect if more
scores need to be entered.

Once scores have been completed for this team, notice the point totals. Because the
opposite team scores have not been entered, the points awarded for this team are
based on the rules when playing a forfeit (as setup under the Points tab in League
Rules).

Now enter scores for the opposing team. After scores have been completed for the
opposing team, the points will reflect the actual wins and losses for this week.
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Repeat entering scores for the remaining teams, double-checking the scores, pin totals,
and point totals. If there is a discrepancy, check for any typing errors made. If there still is
a discrepancy, check for any errors on the recaps.

Refer to the Frequently Asked Questions for any other question or resolutions. There
fopics for wrong averages or handicaps, ifthe handicap changes mid-series, and so
forth. Click the  FA&utfon or press F2

Question Mark (?) column: This column is used to identify substitute or loaned bowlers.
Valid options are is follow:

e T-Temporary Substitute: Default option when new bowler is added to the team. This
type of bowler will only be available for the week they are added, then dropped to the
Substitute List so they could be assigned to another team in future weeks.

e S - Permanent Substitute: This type of substitute will remain on the team they are
assigned to.

e L -Loaned Bowler: When a permanent bowler from one team is assigned to another
team, that bowler will become "Loaned" to the new team. This value will be added by
the program when the bowler is added to the new team. The bowler will temporarily
be removed from their original team until the next week.

Troubleshooting Forfeits and Score Discrepancies

BLS-2021 provides tools to assist with diagnosing why a team is forfeiting the game as
well as identifying problems with match or team points after scores have been entered.
These tools can be opened from the Command Buttons located on the Tool Bar of the
Enter / Correct Current Scores screen. Averbose reason for a forfeit can be found if by
clicking on the big, yellow Click for Diagnostics, Status, Info & Help button.

Program preferences and default settings, what columns to display

Selecting the Options button in the menu bar enables or disable different columns to be
displayed on the Score Entry Screen. There are several data items that can be displayed
using this option including, but not limited to, average and handicap used each game,
handicap scores and opponent's score information. The bestway to understand and
appreciate these options is to play with them. They only show on the enter score screen
and do not affect any actual scores.
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Score Entry Screen Options and What to Show

rst Nam Opposing Team's Scores Heading for Totals
(¥| Nickname Opponent's Names Team Average
(¥ Middle Initial Opponent's Points Over/Under average
& Je/Seiill Above/below average (¥ Handicap
Last Name Game number [# Team Points
ill Name Handicap each game (¥ Match Points
L/R Hand Handicap scores (¥ Opponent Points
Entering/Book Average Average each game (¥ Unearned Points
True Avg Before Bowling Lost match-game icon Position for each game

\») Show AVG and HCP columns when there are overrides

Font Scale: Medium -
Always show this options selector

Remember these settings o cancel B ResettoDefault o/  Update Form

Instructions, Game Status and a Reminder of Your League Rules

Use the Click for Diagnostices, Status, Help or Info option button, to identify what the
heading colors for the game labels mean. As scores are entered, the headings for the
game numbers will change colors depending on the number of scores entered. In
addition, this page will display the League Rules with regards to the minimum legal
lineup as configured in Defining Your League > Rules. Finally, this option can be used to
determine why a team is being considered forfeiting, or to provide information about
other problems that may exist with the games as entered.

Zero Scores

Although uncommon, sometimes a bowler just never hits any pins and the resulting
score is zero.

To indicate this is the case, enter 0 (zero) for the score.

NOTE: Do not enter 0 (zero) if a player does not bowl. Leave the space blank. Enter a
zero onlyif a bowler rolls a zero score.
Score Symbols

Symbols will appear for match pointleagues next to the appropriate individual
game/series or team game/series indicating if points have been awarded. This is based
on settings in the Point section of the League Rules.

Team Won/Lost section

Red circle The game/series has been forfeited. This is mostlikely due to the
team being unable to field a legal line-up as specified in the league rules. (Note: Itis
always assumed that team(s) have forfeited until scores have been entered.)

Green Xinbox Game or series points have been won.

Blank box Game or series points have been lost.

Types of scores to enter

Entering scores for a player who was present and bowled is done by entering the score
for each game. There would be no letter prefix for the score. Scores for absentees,
blinds, vacancies, injuries, pacer, and dummy scores must be entered differently.

Letter codes are used in place of scores or as a prefixfor a score to indicate that the
scores are derived differently. The following score codes are as follows:
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Code Feature

A

Absentee/Blind Score. Used when this player was not present and his absentee
or blind score was used. The absentee score is calculated based on the bowler's
average and what you putin the league rules. Typically this would be the average
less 10 pins.

Vacancy. This is the fixed vacancy score designated in the league rules. Handicap
for the individual and team is calculated based on the vacancy score.

Dummy Score. This is the fixed vacancy score designated in the rules section.
Handicap is not added to the score or team handicap.

Youth style vacancy. This works exactly like the vacancy score, except you can
enter a custom value. Handicap for the individual and team will be based on the
score entered.

Pacer Score. Indicates that the score will be recorded on the bowler history, but
does not count towards anything else, nor will this score type increment average.
This score type does not qualify for awards.

An eXtra Score. Indicates that the score will count towards the bowler’s history and
average calculation, but not towards the team scores. This type of score will be a
valid qualifying bowler score for the purposes of awards and will count for
Individual Match Points if the bowler is in position. If you do not want these scores
to be used for Individual Match play, ensure the bowler is moved to a position after
the lastroster member.

Injury Score. If a bowler cannot complete a game and an injured score was
calculated for a game, use this code. Enter the 'I' where the score would normally
go. After entering the "I" code and hitting Enter or Tab, the cursor will move to the
next field so the score can be entered. It will count towards the team total but not
the bowler's average.

Baker Score: Use this code on anybowler name to enter a score for the Baker
game. However, please see the notes for Baker Games below.

Tip: Use an Xtype score for a "Best 4 of 5" type league. The low bowler for each game
will use the eXtra type of score.

Entering Scores for Baker Games: The following guidelines should be used when
entering scores for Baker Games:

Configure the number of games in the Rules to include the Baker games.

Configure the Legal Lineup rule such that atleast 1 bowler must actually bowl. Since
only 1 score will be entered for the Baker game, this is required so that the game is
not considered forfeit. If a team does not have the required number of bowlers based
on the League Bylaws, the games can be over-ridden to reflect the forfeit.

For HDCP leagues, the handicap used will be based on the bowler used for entering
the score. Use the Over-ride option to enter the correct handicap that should be used
for the Baker games.
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e Baker games entered using the 'K' designation will not be applied to the bowlers
record, nor will the scores be tracked for any averages or high score statistics.

For more information on over-rides, please see the section on Overriding Points,
Averages and Handicaps later in this chapter.

The injury code can also be used for an absentee that does not follow rules or when a
bowler needs a valid score that does not go towards bowler’s record.

Note: The Injured scores can be configured in the rules to count towards a legal lineup.
For more information, see Legal Lineup & Forfeits one page[2A\

Changing Teams
Changing teams

One pair of teams is addressed at a time, displaying the odd lane team first. To change
pairs, press the Page Up or Page Down keys on your keyboard, the Previous/Next Pair
buttons on the screen or select the lanes from the lanes list box. To change the display
to the opposite team, click the team name

The following keyboard shortcuts are available to speed the display of teams:

Page Down = Next Lane Pair

Page Up = Previous Lane Pair

Home Key = Toggle between teams on any given pair of lanes
Esc = Exits score screen.

Changing Lineups

Changing lineups

When entering scores, pick a team and examine the team line-up and the scores. The
line-up can be changed in either in Team Rosters or in the Score Entry screen. All
functions dealing with adding, moving, replacing or removing bowlers operate the same
on the score entry screen and the team roster screen. To change the line-up, the
following keyboard shortcuts are available:

F3 or the Up button = Move selected player up.

F5 or the Down button = Move selected player down.

F4 or Drop button = Remove selected player from team.

Add button = Add new player to team.

#HHE = Under the ID column, in a blank row, enter a bowler’s ID# to add a bowler from
your league database.

aaa = Under the ID column, in a blank row, enter the last three letters of a bowler's name
to search the league.

NEW = Under the ID column, in a blank row, enter NEW to insert a new bowler that does
not existin the league.

Note: If this league does not use individual match points, then adjust the team line-up,
onlyifa permanent change needs to be done. Ifitis nota match pointleague, it makes
no difference what order the bowlers are in.

Individual match points
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Ifindividual match points are used, careful attention to the line-up must be made.
Individual match points are awarded based on scores from direct opposing players.

BLS-2021 does not base this individual competition on the physical line-up. The
program bases on competition on the position of the scores. The first score from the left
team is matched with the first score from the right team. The second score is paired with
the second score on the right team. The second score might not be the second bowler!
The second score could be the third bowler's score if the second bowler did not have a
score.

Anew feature introduced in the Professional and AutoScoring editions is the ability to
changed to designate the match point lineup for each player for each game. This
requires the Position for Each Game option be checked in Score Entry View Options.

Adding an existing bowler

To add a bowler on the team click the Add control. This function is justlike the Team
Rosters screen and makes iteasyto add a new bowler. See also the Setup > Team >
Rosters section on page[ 8

Dropping a player

To drop a bowler from the team, click on the bowler to highlight him/her, then click the
Drop control to drop the highlighted bowler. See also the Setup > Team > Rosters
section on page[ 48

Adding a sub or existing player

To quickly add a sub for a particular bowler, highlight the bowler you want to sub for and
select the Sub control. You can use the team roster screen to make changes if you
prefer. All functions dealing with adding, moving, replacing or removing bowlers operate
the same on the score entry screen and the team roster screen.

Editing Scores
All editing is done from the same screen found by clicking on Weekly > Process this
Week > Enter/Correct Current Scores. Keep the following in mind:

e You don't have to enter all of the scores in one session. It's possible to go back to
where stopped, see what was entered, then continue, make changes or stop again.

e Change anyscore, even on teams already completed, just by typing over the score.

e Change the order of the bowlers atanytime. Ifitis a match pointleague, the match
points will be recalculated.

e Go forward or back to review previous work and make any changes or corrections.

e Don’tworry about mistakes. Correct by typing over the error - even after printing the
standings - then reprint standings.

¢ As you make changes, BLS-2021 will automatically recalculate and update all parts of
the program. Itis a one-step process.

Reprinting Scores
As the league secretary, use the Reprint Scores function in Weekly > Process This
Week > Enter/Correct Current Scores to print a report of the scores entered each week.
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Keep them in your notebook with all of your other league information and take them to
the lanes with you each week. It will help resolve disputes againstincorrect averages or
pinfall.

To reprint scores, click Print on the score entry screen. Scores can be reprinted for a
specific pair or all lanes.

Overriding Points, Averages and Handicaps

Occasionally, there are situations where a team or an individual’s points, averages or

handicaps mustbe overridden. Common situations are:

e Team forfeit due to league fee arrearage or use of a suspended player or other league
board action.

o The player had an incomplete series before establishing an average.

e League uses an unusual point system and itis beyond the scope of the program to
automatically calculate.

e Scores bowled were make-up or pre-bowl, but were bowled in the normal sequence
of weeks.

To place an override on a team or individual:

1. From the Enter/Correct Current Scores screen, locate the specific team or
individual and click Overrides.

2. Click the specific bowler or the team in the Select bowler or team list.

3. For Team Game & Series Override, enter W for Win, L for Lost or Ffor Forfeit. If
necessary, or as an alternative, the Team Points can be overridden as well. The
values entered here would represent Total Points Won/Lost including Match Points.
The Points should also be overridden for the opposing team as well.

4. For Bowler Game & Series Override, enter the override values for the game
average(s), handicap(s) and/or points. Use the remaining bowler options to indicate
if the scores bowled would not be eligible for league or association awards or if they
should be considered Prebowl or Make-Up.

Note: If an item is NOT to be overridden, then leave it blank. Entering a zero will force a
zero value.

Special Tip: Occasionally, situations happen when a player is unable to complete a
series due to injury, arriving late or leaving early. If the player has established an
average, this is not usually a problem.

However, if this happens when the player is establishing an average, this can create a
bit of confusion on what to use for averages and handicaps for this player.

The solution is this:

1. Inform the teams that points awarded are not official until this player establishes a
legal average.

2. Nexttime this player bowls, inform the player’s team that the average displayed is to
be ignored. Team handicap and results will need to be determined later.

3. Enter scores for this week. Notice the average for this player changes at the point
enough games have been entered to field a legal average. This becomes the
bowler’s current average.
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4. Complete scores for this week and return to the week that the player could not
establish an average.

5. Go to the scores for this player and click Overrides.

6. Selectthe player and override the average for the games bowled, using the
determined current average.

7. Enter areason for the override or the override will not be saved.

8. Exitthe override screen and reprint the standings. Note on the standings that this is
the corrected official standings.

9. Return to the current week and print the standings.

Everything is now current and correct.

Selecting team for draw teams

If the league has an uneven number of teams, and the League Rules are configured so
that the Draw System is in effect, then when the BYE team is selected a list-box will
appear to select the team whose scores that have been drawn to oppose the
unopposed team. The team selected will onlyreceive wins and losses against who they
actually bowled against. The selected team's scores and handicap will be used by the
BYE team to determine if the real team (Team 2 as shown on this example) wins or
loses a game or series. The team will not receive any additional wins or losses when
selected as the "draw team". Additional information on using the "draw" method can be
found in the USBC rulebook and the USBC league secretary's handbook.

Enter Make-Up and Pre-Bowl Scores

Entering make-up and pre-bowled games in BLS-2021 is very easy, itis done on one
screen. As scores are entered, BLS-2021 updates and calculates everything else for
you automatically. All you have to do is enter the pre-bowled or make-up scores at the
time the scores are bowled.

For example, if a bowler missed the first week of bowling and makes up games right
after week #4 (actual completion of 9 games). The average and handicap for the make-
up games for week #1 are based on the average and handicap of 9 games-not on what
would have been if those games were bowled during week #1.

USBC rules are very specific on when scores are to be entered. The rules state that
average and handicap are figured at the date/time the games are bowled. All games
bowled prior to the pre-bowl or post-bowl shall be included when calculating
averages/handicaps.

When to enter

If a team pre-bowled week #10 games after league in week #5, the average and
handicap used for those games will be the ones included in the league scores for up to
week #5. Handicap normally used for week #10 would not be used. This is whyitis
important to make sure the make-up and pre-bowled scores are entered at the right
time.

If scores for week #5 are pre-bowled after the league bowls week #4 but before week #6
is bowled, enter them with the regular scores for week #5. This is because week #5’s
scores were bowled between weeks #4 and #6 and they were to be bowled in normal
sequence. The score over-ride option can be used to designate these games as pre or
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postbowled. For more information on the score over-ride option, please see the section
discussing Overriding Points on Page|1_u'1

If scores for week #5 were made-up after the league bowled week #5 but before week
#6 was bowled, these would be entered with the other scores for week #5. These
scores, too, were bowled in normal sequence of4, 5 and 6.

Entering the Pre-Bowl & Make-up score

Click on Weekly > Process this week > Enter/Correct Current Score, then Scores >
PreBowl/MakeUp in the menu at the top of the Scores screen.

The following procedure details how to enter pre/post-bowl scores:

1. Ensure you are in the correct week. If the Pre-Bowl/Make-Up games are bowled prior
to League bowling, go back 1 week to enter scores. If the Pre-Bowl/Make-Up games
are bowled after the current week's League bowling, open the score entry screen.

2. Enterthe bowler’s ID# number.

3. Enterthe week that the scores are for.

4. Enterthe scores.

Upon entering the bowler number, the average and handicap for the scores about to be
entered will be displayed. Enter the score’s for the Pre-Bow|/Make-up. Absentee,
Vacancy or Dummy scores can be used.

Should a player bowl more than one week of pre-bowl or make-up games, enter them in
the order bowled.

Fnalizing the Pre-Bowl scores

If these are pre-bowled games, there is nothing else to do after entering scores. BLS-
2021 automatically posts the pre-bowled scores in the appropriate week. Scores can not
be changed in that week. To make any changes in pre-bowled scores, go back to the
week that the games were actually bowled and make the changes on the pre-bowl and
make-up screen. Because scores affect the bowler’s average in the intervening weeks,
changing a score could resultin a change of average. This could resultin a change of
handicap that could change results for future weeks.

Example:

In week #4, a bowler’s pre-bowled scores for week #8 was entered. When reaching
week #8, the scores already entered on the Weekly > Process this week >
Enter/Correct Current Scores screen will be shown. These scores cannot be changed.
If a mistake is made in entering scores, go back to week #4 and make the changes
there. This is because those pre-bowled scores were added into the bowler’s pins and
games for figuring the average for weeks # 5, 6 and 7 as required by the Rule Book.

Finalizing the Make-Up scores

If the scores are for make-up games, there is one more step to take to make the
program calculate the points correctly. For any make-up games, enter all the scores then
exit the Pre-bowl / Make-Up screen and exit the score entry screen. Select Go to any
week and select the week that the make-up week was for. Go into Weekly > Process
this week > Enter/Correct Current Scores and verify the results of the team. If OK, exit
and select Go to any week and proceed to the current week. If not OK, return to the week
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that the make-up scores were entered and recheck the scores entered. Repeat the
steps. It could be that your bowlers computed the wrong averages.

Note: If a substitute were used, the player may not appear in the Scores screen for the
week that was made up. Add the bowler like you would a sub. The scores should then
appear with the bowler.

On the Standing Sheet

Note that when a pre-bowl or a make-up is executed, the average used to determine the
handicap is shown on the standing sheet as it was when the games were bowled.

Entering scores for a team that will make-up later

Do not enter scores in a week a bowler or team misses. If a team missed week #2 and
the team is allowed to make-up the games later in the season, leave thatteam’s score
blank in week #2. When the make-up scores are bowled, enter them as a make-up
game in the week bowled. Then go back to week #2 to ensure thatthe scores are
posted and the points will be recalculated.

Until the team does bowl, you should leave the scores blank and consider the games
forfeited with the points awarded according to your league rules. This is because you
don’tknow that the games will be made up until the team actually bowls them.

To remove a bowler from the Pre-Bowl / Make-Up screen, select the bowler and press
F4. Failing to do so will prevent you from entering actual scores for the bowler on the
week indicated.

Bowling twice for a week
USBC rules prohibit a player from bowling more than once for each league week.

For example, Joe Glean bowled a series as a sub for Team #5 during Week #8. Joe
Glean also bowled a series with Team #1 as a pre-bowl in Week #4 for Week #8. Joe
Glean’s scores for Team #5 would become disqualified, since his scores for Team #1
were bowled first.

Abowler can however, bowl a partial series with multiple teams. As long as each game
for the series is not bowled with more than one team, itis legal.

Notice to see secretary

To make an indication on the standing sheet for a bowler to see the secretary, place the
cursor on the specific bowler and click the ! button. If the standing sheet printing option of
“"Indicate bowlers with pending notes" is enabled, then the standing sheet will place a
couple stars next to their name indicating that they should see the secretary.

Awards Enter Non-Detectable Awards
BLS-2021 can automatically detect awards for USBC and CTF for the 2020/2021
bowling season as well as awards configured in the local awards and bowling center
awards section of the program that are able to be detected based on score. However,
there are awards that the program can not automatically detect, such as Clean Games,
7-10 splits, Dutch 200's, etc.
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() Close E5 Help Previously Earned Awards and Awards Earned Elsewhere
Team Name Award Group Awards assigned this week:
USBC Awards Emmerson Carmichael

Team Grand Vitara TNBA Awards

Boulevard C109RT Loc . Awards

Kizashi State Assoc, Awards
Bowling Center Awards
SCCUSBC

Awards Available in this group

11 in a Row <290
7-10 split
Dutch 200 Game
All Spare Game
Bowlers on selecled team Jha row Eplt
Carmichael, Emmersos
Coreley, Carly
Mead, Lon
Dodge, Marianna
Which score this award applies to:
¥ Assign this award Score Doesn't Matter -
- ! to Selected Bowler
League Awards:| Eligible . L= =

191 Remove this Award
Assoc. Awards: | Eligible - B' kol

To award a non-detectable award to a bowler:

Select the team the bowler participated with

Select the player

Select the award group that the award is part of

Select the award

Click Assign the Award

Indicate which game the award counts towards or click Game Doesn't Matter.

ook wh-=

High Scores, Stats, Standings, Birthdays
From Weekly > Process this Week, select High Scores, Stats, Standings, or Birthdays
to view the results of all the data entered this week. The results are grouped into the
following:

o Team Results: Display team standings, Season High Scores or Weekly High Scores
using the tabs at the bottom of the page.

o Bowler Results: Displays Season High Scores, Weekly High Scores and Match
Points (when applicable). Also provides options to view results by gender for mixed
leagues.

o Birthday list: List the birthdays for all bowlers in the league. Bowlers with birthdays in
the next week will be highlighted so they can quickly be identified.

e Stats: Various league statistics and charts can be printed with these options.
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Week 30f 29 Sample League 18-19 - Bowler Results
49 Main Menu ED Help
Brief Team Results  Enhanced Team Results Individual Bowlers Birthdays Stats Detailed Statistics Statistical Graphs
Scores in gray not eligible for awards, as setup in your league rules. *=Substitute, not eligible +=Not enough games
>=has another award #=has High average $=Has Most Improved average x=Not member of league
Scratch Game Handicap Game Scratch Series Handicap Series
1 205 Malinda Currie 0 Emmerson Carmichael 584 Malinda Currie 0 Emmerson Carmichael
2 203 Monte Cobb 0 Carly Coreley 582 Monte Cobb 0 Carly Coreley
3 2 * San k 0 Lon Mead * Sam I 0 Lon Mead
4 185 Luciano Carlisle 0 Marianna Dodge 543 Luciano Carlisle 0 Marianna Dodge
5 183 Robert Ellis 0 Robert Ellis 522 Robert Ellis 0 Robert Ellis
3 178 Josefa Dwyer 0 Celeste Lusk 511 Josefa Dwyer 0 Celeste Lusk
7 176 Ann Simmons 0 Brendan Abel 500 Janine Friedman 0 Brendan Abel
8 175 Carly Coreley 0 Malinda Currie 494 Ann Simmons 0 Malinda Currie
9 175 Marianna Dodge 0 Luciano Carlisle 494 Stephan Daley 0 Luciano Carlisle
10 175 Janine Friedman 0 Elena Coffman 493 Marianna Dodge 0 Elena Coffman
n 171 Stephan Daley 0 Benito Galio 490 Emmerson Carmichae0 Benito Galio
12 170 Emmerson Carmichael 0 Josefa Dwyer 488 Elena Coffman 0 Josefa Dwyer
13 169 Elena Coffman 0 Monte Cobb 481 Carly Coreley 0 Monte Cobb
14 138 Benito Galie 0 Ann Simmons 376 Benito Galio 0 Ann Simmons
15 127 Brendan Abel 0 Stephan Daley 360 Brendan Abel 0 Stephan Daley
16 125 Lon Mead 0 Janine Friedman 352 Lon Mead 0 Janine Friedman
17 110 Celeste Lusk ammy Sul 307 Celeste Lusk
Men Women Everyone
Season High Scores Weekly High Scores Match Points

Weekly and Season High Scores

If the league limits the number of league awards that the team and/or bowler can
receive, the Team and Bowler result tabs in the High Scores, Stats, Standings,
Birthdays screen can help determine why bowlers are not appearing on the standing
sheet as having earned awards.

The screen will display bowlers or teams in blue if they qualify for the award and gray if
they do not qualify for the award. For Teams/Bowlers listed in gray, there will be an
associated symbol indicating why the score is ineligible. These symbols are defined in
the section above the list of teams/bowlers and can be used to determine which league
rule is preventing the team or bowler from being displayed on the standing Sheet.

Enhanced Team Results

When a tie exists at the end of the season or at the end of any segment of a split
season, USBC rules require a playoff to determine the league champions or the team to
be considered the winner of the split season segment. This playoff will consist of at
least 1 complete game. This presents a challenge with regards to how to track the
results of the playoff and display the winner on the Standing Sheet.

BLS-2021 does not have a separate data entry page to enter scores for a playoff. Since
the playoff will typically only consist of 2-3 teams, we do notrecommend adding a week
to facilitate tracking scores.

Instead, we suggest adding a message boxto the standing sheet to display the results
of the playoff. In addition, BLS-2021 has the ability to re-arrange the team standings.
This can be done by going to Weekly > Process this Week > High Scores and select
New Team Results. Toggle the switch from Calculated Standings to Manually
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Assigned, select the team that won the league championship and use the Move Up
control to place them in first. If a mistake is made or you want to put the standings back
to the original order, simply click the Reset control or toggle the switch back to
Calculated Standings.

Statistical Graphs

1) League Ave. Week by Week: The cream colored bars represent the average for all
bowlers in the league each week. The blue bar represents the amount of pins above or
below the league average for all the bowlers that bowled that night. The red lines show
the league average for that night. The green line represents the average of all the Men's
scores and the orange line is the average of Women's scores for the week. Finally, the
aqua colored bar represents the number of pins above or below the Men's average for
the night versus the Men's average coming into the give week. Similarly, the yellow bar
reflects the same thing for women. Unfortunately, these Men's and Women's average
statistics do notinclude Youth Boys and Girls. The overall league average does.

2) Team Ave. vs. Ave of Scores: This graph will display the team averages going into the
current week in comparison to the scores bowled on the given pair of lanes. The orange
bar will reflect the team average for both teams on the lane pair coming into the current

week. The red square reflects the average of scores bowled on the pair of lanes by both
teams.

3) Ave of Score for Each Game: This graph will display the average for both teams on a
pair of lanes. Each line will reflect the average of all the scores for each individual game.

4) Amount Over/Under Team Average: This graph will compare the combined team
average for each game with the entering average for the give pair of lanes.

Assoc. & Local Awards Earned This Week

The screen is divided into tabs based on each specific award group. For example, the
USBC awards are found in the USBC tab, CTF in the CTF tab, etc. The All Award Groups
tab will include all bowlers qualifying for awards.

Bowlers highlighted in orange have been identified as not being certified in the
Association from which the award was earned. These bowlers will need to be
configured as certified by going to Sanction/Certify Your Bowlers explained on page/[sd)

Displaying specific award groups

To narrow the list of award recipients based on a certain award group, click the specific
group in the Awards Group list. To display every group, click All Groups.

Displaying specific bowlers

To display a certain award recipient, select the intended bowler in the Specific Bowler
list. To display all awards, click All Bowlers.

Printing the awards list

To preview an awards report containing the list of displayed bowlers, click List Awards.
From this preview the report can be sent to the printer by clicking Print. The previewed
report can also be exported to web or a file.
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Printing the awards form

To preview the award forms, select the specific award tab to display currently earned
awards. Click Print Forms.

The awards earned can be printed to be submitted to the association. Blank award
forms can also be printed.

Emailing the award form(s)
BLS Pro and AS versions only, allows emailing the award forms.
Notes:

e Because there are no standards for awards other than at the national level, there is a
generic form available for local and bowling center awards.

e To earn a national award, the league and bowlers must be certified by the national
association. To ensure both the league and bowler are certified by going to Certify on
page/[sd).

e To print Men and Women on separate forms, ensure BLS-2021 is configured as "Not
Merged" by going to Certify > Association > Default fees on page|1_%'1. Under the USBC
Options, there is a toggle switch for Merged or Not Merged.

e BLS-2021 utilizes PDF files to print awards. This type of file is most commonly
opened by the Adobe Reader or Adobe Acrobat programs. Ensure one of these
programs are installed and thatitis the most current version available for the version
of Windows on the computer.

e Ifthe Association Name and Number are not filled in the association has to be linked
to the league. This can be done by going to Certify on pagemﬁ.

o Ifaward forms are viewable in Adobe Reader, but do not print completed information,
the following procedure may work:

1. Generate the award forms in BLS-2021 which will open Adobe Reader to view the
forms.

Select Fle > Print to bring up the print dialog.

Click Advanced.

Check the box Print as image.

Click OK.

Click OK to Print.

ok wn

Printing TNBA Award Forms

Similar to National awards previously discussed, bowlers certified with TNBA need to be
configured in BLS-2021. For more information on please see the chapter on
Certification on page[5e.

Blank Award Forms

This feature allows the generation of blank award forms for the local association awards
secretary. All forms are accepted by the USBC or CTF and do not require special paper.

Weekly Menu




Blank awards forms are printed by clicking Blank Forms. On the BLS-2021 Forms
Library, select the desired form and click Preview Selected Form. National Awards
forms are in PDF file format and require a program, such as Adobe Reader or Adobe
Acrobat, to open and print.

Youth Pepsi Cola Tournament Qualifications
This function is discussed in detail in Maintaining USBC Youth Leagues on page[273\

Preview & Print weekly standing sheet
Standings sheets can be previewed on the screen before printing. One or more copies
can be printed.

BLS-2021 is equipped with predefined report styles. The default styles can be used or
be customized. The program defaults to the most commonly used style for the report to
be printed. To modify or change the Standing Sheet, click the Change Layout button. For
help customizing the standing sheet, refer to Set Up Your Standing Sheet on page|[e2.

Weekly and Season High Scores: Occasionally, a bowler or team may not be displayed
in these sections, even though their scores would qualify. This is occurs when a league
rule is configured that causes the score to be ineligible. To troubleshoot, BLS-2021 will
identify the rule that causes the score to be ineligible on the Results screen previously
discussed on page[ 78

Standing Sheets
Standing Sheets are the mostimportant report to be generated in BLS-2021. The
Standing Sheet can be configured by selecting the following option:

Setup > Reports > Standings

Additionally, when previewing the standing sheet, clicking on the Print > Change Layout
will open the Setup the Standing Sheet screen so thatit can be configured.

The standing sheetis composed of several segments called ltems. ltems displayed can
be rearranged or removed.

The two mostimportant aspects of this screen are the three buttons at the top for the
three configured versions of the standing sheet and the layout of the sixtabs for
adjusting the basic aspects of a standing sheet’s design.

Printed version, Web Upload or Press Sheet

There are three unique standing sheets that can be configured using this screen.
Printed Version is the standing sheet configuration for printed standing sheets to be
handed out to teams and posted at the center. Web Version is the standing sheet setup
for the standing sheet uploaded to the web. Press Sheet is simplythat, a press sheet. It
may be that the Press Sheet should only contain minimal information, whereas, the
Web Version of the standing sheet could have every bit of possible data, and the Printed
Version should be somewhere in between. Use the Select/Edit menu to choose the
version of the report to define.

Designing the Standing Sheet
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The Standing Sheet setup is laid out with tabs to control various aspects of the report’s
presentation. Through these various screens everything about the standing sheet may
be customized. The following is a brief description of these tabs and their features.

Kems

The ltems tab is intended to simply designate what data will be on the report, and in
what order, and using which style. This section can be configured differently for each
type of Standing Sheet, Printed Version, Web Version or Press Sheet.

Adding items

There are two lists of items that can appear on the standing sheets. The firstis labeled
These are NOT on your Standing Sheet, which is simply a list of available items that can
be placed on the Standing Sheet, but currently are not printed or included.

The second is labeled Order of ltems on the Standing Sheet, which contains the items
that will appear on the standing sheet and the order in which they are displayed.

To add an item to the standing sheet, click the item in the These are NOT on your
Standing Sheet list and click Add ltem to Standing Sheet. The added item will be placed
at the bottom of the list on the Order of ltems on the Standing Sheet

Set Up your Printed Standing Sheet

49 Main Men 55 print Preview )D Select/Edit ED Help

Team Standings

Sanction/Certification

High Averages Officers
High Match Points
Alphabetical List of Bowlers
Average List of Bowlers
Match Point List of Bowlers

P Awards Eamed

: High Game Scores

=] Press Sheet Scores

il Common Message Box

J=] Message Box #2

=] Message Box #3

Limit the listing of team standings to | No limit - Print All Teams

s
] Weekly High Scores Print - Brief recap of last week's results after Team Standings
B Season High Scores
bl Website information
-] Prize Fund Verification Line
Team Rosters
Temporary Substitutes
Most/Least Improved Bowler
League Average Statistics

Current Style 202 == Change Report Style

Order of Items on the Standin

A sample of this is shown at the bottom of this form

These are NOT on your Stan

-~ -
"::' @LQ 'D‘:: Where should this item be printed?
Add item to standings g Remove item from | AFTER this item, (if it did not continue onto a
sheets a’ @ standings sheets second page) what should happen?
Set Up your Printed Standing Sheet " oty Poms  Tum Pt Semh  Wghlemh  HehHICP
e lbeteo e oot Do B
I Layow Messages stying raph Temp Expor

Changing the order of items

The standing sheet will print each item in order as identified in the Order of tems on the
Standing Sheet list. To change the order of what is printed, click the item in the Order of
Iltems on the Standing Sheet list and click Move up or Move down.
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Removing items

To remove an item from the standings, simply click the item in the Order of ltems on the
Standing Sheet list and click Remove ltem from Standing Sheet.

Changing item options

The next step is to configure the options for each item used in the standing sheet. These
options are used to change how each of the items will be displayed on the Standing
Sheet. Click on the item to be configure in the Order of ltems on the Standing Sheet list.
Each item will have its own specific options that can be modified. However, each item
will have page break options to Force this item to start on a new page or AFTER this
item, start a new page...

Select or change any available options listed on the right side as needed.

TIP: Acommon setting changed on this screen is to enable/disable displaying the
results from last week's bowling. For the Team Standings data item, there is an option to
display a "brief recap of last week's results".

Changing the Style

If the Change Style button appears as an option, the style can be changed to reflect
information presented. Clicking will display a list of different styles that can be used to
change appearance of the data. On this screen, a sample be displayed in a preview
screen as different styles are selected. Once the desired style is selected, click the Use
This.

Some styles can further be refined with regards to the data they contain by clicking the To

hide this panel so you can change this style button when available. For more

information, see the Setup Reports and Custom Reports > Report Styles section on
age[208.

Typical Standing Sheet Styles

The most common items on the standing sheet where Styles are changed for
customization would be Team Standings and Team Rosters. As such, BLS-2021 offers
a wide variety of styles that can be used to display different data for these categories.

Layout
This tab is divided into 4 sections:

Web Upload Options

This section provides settings that apply to the Web Version of the Standing Sheet. The
first option is to omit phone numbers and other personal information on the Standing
Sheet. This section can be configure BLS-2021 to use either the Printed Version or
Web Version for the Standing Sheet that is uploaded to the web.

Printing Options

This section provides the option to print the date at the top of the Standing Sheet as the
current date or the date bowled. There is also an option to identify bowlers with pending
notes.

Additional Items to Print
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This section provides an option to include land graph page and to include score
statistics based on selected criteria.

.. Set Up the Printed Standing Sheet (also used for Web Uploads) EVX

F; i .
7, Main Meau 5 primt Preview ‘}3 Select/Edit @D Help
Web Upload Options
-VW' On the WEB UPLOAD version, omit afl phone numbers and other personal
Printed - For your WEB UPLOAD, use the WEB setup or the PRINTED version of the standing sheet
Printing Options Additional Items to Print
i .'w At the 1o] he date you hand out the -” e’y P e U
. : stan ¢t rather than the bowling date PSRN nclude lane graph page
Yes - Indicate bowlers with peading notes .”"ﬁ_’ Inchude scare statisticspage based on
Page Layout
-"'W“ Put a little extra space between all areas Page Size |Letter 8-1/2x11
Color -Pr.r...n coloe of biack only Top Indent |« 0,00 (¢
ndent |+ . ight inde !
Yes - All pages nfter page 1 will have & simple page BN L 0.00 WS N IRy
Printer Bottom Indent |+ | 0.00 |+
Microsoft Print to POF 5 selp 7
Hems \ m | Messages Styling Graphics Templates Export
I

Page Layout

Provides options to add extra space between all areas, printin color or black, select
paper length and use simple page headings for pages after Page 1. In addition, a new
feature introduced with BLS-2021 is the ability to change Left, Top and/or Bottom
margins. If the Standing Sheet prints slightly off-center, then this section maybe able to
compensate by changing these Indent values.

Messages
BLS-2021 allows for 3 separate messages to be setup for the standing sheet. This tab
is used to configure each one. Simply click on the message to modify and enter the
desired message. To include any messages in the standing sheet, click on the Layout
tab and move the desired message to the column for items on the standing sheet.

In the PRO and A/S Editions of BLS-2021, an additional option for a global message box
is available to all leagues managed by the program. This allows a single message that
will be applied to all leagues with the Common Message Box data item on the Standing
Sheet.

Graphics can be added to either side of the message boxor both. In addition, the same
graphic file can be used on both sides and they can be flipped horizontally to create a
mirror image.
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Styling

L. Set Up the Printed Standing Sheet (also used for Web Uplaads)

i ;
2.} Main Menu 15 Print Preview ‘,U Select/Edit ED) Help
Icon & Logo
Select Select
e Use Global =
~ League ~ Global
=i i Icon | Logo . =a fogs
Filena | Fllgtame
Watermark
Select Select
2 Use Global =
B e Watermark . =8 el
Logo Loge
Filename T Print Watermark | Yes - Filename]
o - Print n.. r|:: All - Patl
Font Sets
View, change of load League Specific
il Use Global Font Set . 2\ View, change or load Glabal fontset
Hems Layout Messages '% | Graphics Templates Export
—

This tab allows to and/or modify Logos, Watermarks and Fonts to be used on the
Standing Sheet. For each category, there is an option to use Global Settings (for all
leagues managed In BLS-2021) or League Settings (for this league only). To add or
modify any of these settings, click on the associated button to select or examine the
specific settings.

For more information on Watermarks, Logos and Fonts, please refer to Custom Reports
on page| 208 .

Graphics
This tab is used to place and adjust the pictures on the Standing Sheet.

Change the Image Location to the drive and directory where the graphic images are
located. Use images from anywhere on the computer, the current version of BLS or
previous versions of BLS. Use the folder selection under Currently Selected Drive and
Folder to locate the image file. Select the image located in List of available Images. A
preview of the image will appear in the Image Preview area.

When the ClipArtincluded with BLS-2021 is installed, it will copy the graphic files to the
following location:

For Windows 10, 8, Windows 7, Windows Vista or Windows Server 2008: C:
\Users\Public\Documents\BowlingArt

A"shortcut" to the Documents folder is listed under My Computer as Shared
Documents.
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Set Up the Printed Standing Sheet (also used for Web Uploads) Ox

‘fislunu- ﬁ; e P“‘“’“‘ ED Hap

Sample League 18-19 ~

SEEEEREE

Standing Sheet Graphics
‘ First Page Last Page

c:\users\public\documents\bowlingart\10_p - Add Image

-
§ -y,
= =

Include graphics on

e Print

Hems Layout Messages Styling . Graphics Templates Export

Graphic groups
There are currently three groups of graphics that are used for reports. They are:

o Firstpage
o Middle pages
e Lastpage

Each group can designate up to four graphic images.
Selecting the group

In the Graphics Layout screen, select the appropriate image group to modify or add
images. The report preview will change to reflect the settings for that group.

Adding images

Click Add new Graphic to bring up the Image Selector utility. For more information on
adding graphics and applying effects, see Changing Report Graphics on page[2'h.

Moving images

Once an image has been added, the image can be moved by clicking the image and
then dragging to the new location.

Removing images
To remove an image, select the image and click Delete Graphic.
Resizing images

Select the image to be resized. The selected image will be outlined with resizing
controls. Click the appropriate side or corner and drag to resize the image. Clicking the
controls to the sides of the image will enlarge or shrink the image without re-
proportioning the image. Clicking the corner controls to enlarge or shrink the image
proportionally, unless proportional sizing is turned off.
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Graphic Layers

As images are added, they are layered in the order they were added. If the images do not
overlap, the images will completely show. However, ifimages overlap, the image thatis
to the front will overlap images towards the back. To bring an image to the front or back,
select the image and click Bring to front or Send to back.

Graphic Properties

To change the effect of the image, select the image and click Graphic Properties. For
more information on adding graphics and applying effects, see Changing Report
Graphics on page[zh

Additional options

right-clicking on the image file provides the option to Restore original dimensions, Half-
size & Double-size, Proportional sizing or adjust Properties.

Templates
Standing sheet templates can save the appearance and settings of a standing sheet for

use with other leagues.

To save the standings as a new template, enter the name of the template and click save.
The template file will be saved, with the preface of b2018_

To load a template, select a template from the list and click on the standings report to
load the template for.

'\_3 Close E'a Printing | ,ﬁ undo | E] Load or Save C‘_’?‘) Help
Select a Recap Form Printer -
Plain Paper 8.5°x11°- 1 Pair EPSON WF-2650 Series on USBOOT S s
FATT e Copies | 15 PaperSize [JESGRRRH | A4 Week 4
MF e BATE Friday
[& Print bowlers' names Black Ink Only 9/6/2019
Double Space Names Reduce plain paper 95% 6:00 pm

Print Nicknames

Print bowler ID numbers (& Print Lane Numbers
& Print bowler handicaps &l Print team names
[ Print bowler averages (& Print team average
Print bowlers' Total HDCP (& Print team handicap
(&l Print Pre-bowled scores i Print Win/Loss spaces
Print *Lastname, Firstname" | Print officers/officials names

w4 Print position column Use Custom Logo
| Print match points column (i Print team points row
Use True not Computed Avg
This form is printed on plain paper Use condensed font for long names
Use full name, not initials
- Options  Messages
Select Which Lanes o Print
All Lanes Lanes Used None SRR Range of Lanes

12 3 4
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As the league bowls each week, scores are recorded onto recap sheets. Each week,
team captains record the team lineup, write the averages and calculate the handicap for
individuals and teams.

BLS-2021 simplifies the process by pre-recording each team’s information on the
recaps using pre-printed forms for plain paper.

Printing Recaps
Click Weekly > Prepare > Print Recaps to display the recap printing options.

The recaps screen: Click the Print control to print the recaps. If scores have not been
entered in the current week, the program will print recaps this week. Otherwise the
recaps will be printed for the following week.

Changing the Fonts: In the Printing menu, click on Font Setup. Highlight the item to
change. Use the Font Name and Style section to make the changes. To save the style,
click Fle Actions. Click Save Font.

Selecting a Logo: On any of the plain paper recaps, an option will appear; Use Custom
Logo, check the option. Click on tielecf Logo menu, select the image to be used.
This image will replace the pins graphic.

Selecting which lanes to print: Click Print All Lanes to generate recaps for the entire set
of lanes. To only print a partial set of recaps, clear this option and select the lanes to be
printed by clicking on the pairs to be printed.

Adjusting margins: Pre-printed recaps may not properly align with the printer. Under
Margins, use the sliders to adjust margins to fix the alignment of the recaps.

Selecting Recap Options: There are several options that can be used when printing
recaps. Check the options that apply.

Copies: Indicate the number of copies (up to 4) to print. For each copy, instructions for
turning the copies in can be modified by changing the text. Typical settings for most
leagues are listed as default.

Previewing Recaps: BLS-2021 Pro and BLS-2021 A/S versions have the ability to
Preview the recap sheets before printing them. Click the Preview button to preview the
recaps for the selected lanes.

Types of Recap Forms
Recap sheets may be printed using dot matrix, inkjet or laser printers. BRS-4 is the only
compatible pre-printed form that can be used with an inkjet or laser printer.

The following forms are available:

Plain Paper: The program can print on either 8.5” x5.5” or 8.5” x 11” plain paper. Up to 4
copies can be printed when using plain paper.

BRS-1: This form is 5.5" high and has the two teams side by side.

BRS-3: This form is 11" high, but prints the two teams side by side like BRS-1 and puts
the team statistics on the bottom half.
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The team rosters can be printed in any of the bowler report formats. Indicate whether the
bowler names are to be printed on the top half. Match pointleagues often do not want
the player names on top, as the order may change each week.

BRS-4: This form is 11" high and is designed as a multipart recap form for laser printers.
This exclusive design is available only for CDE customers.

The margins can be set to a negative value (-0.05) inches to help align the form. The
maximum amount of negative margin is (-0.10) inches.

Blank Recaps: Any of the above forms can be printed without bowler or team
information. When opening the screen to print recaps, simply uncheck the Print
bowlers' names and Print team names options. Additional team related data such as
Average and Handicap can also be unchecked.

Purchasing Recap Forms
Recap sheets can be purchased on our website at http://recaps.cdesoftware.com.
Phone numbers are also available at that site, or contact Databar at 800-878-4919.

Changing Lineup for Recaps

To place the bowlers in a different lineup on the recap sheets, do not change the orderin
the current week. Changing the order will resultin a different outcome in the match
points. Here is how to do this properly:

1. Advance to the week the recaps will be printed for.
2. Change the lineup in team rosters
3. Printthe recap sheets

Auto-Scoring: Send League fo Front Desk

The option is specific to BLS-2021 Automatic Scoring Edition. For more information,

please see Automatic Scoring > Exporting Leagues 280)

Update Kiosks
BLS-2021 Pro or A/S editions in a bowling centers that have installed a CDE Software’s
Bowling Kiosk product, the kiosks can be updated with the currentinformation presentin
the league.

Web Uploads

This option is to manually upload the weekly league information to specified websites
weekly. For more information, please see the chapter on Web Uploads on page[23\.

Backup this League
This provides a convenient link that will allow a backup of league to be created. For more
information, please see the chapter on Backup/Restore and Transporting Leagues on
age[23)
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Situations

As the league progresses during the season, there are circumstances that may call for
the adding, removing or re-ordering of teams. BLS-2021 provides utilities to make this
simple to accomplish.

Override Next Week's Pairings

This screen is very similar to the Re-Order Teams screen. However, changes made on
this screen will adjust which teams bowl against each other, but leave the team
numbers unchanged. Also, changes made here will be affective for the next week's
bowling only. The rest of the schedule remains unchanged. This can be useful during a
position and/or playoff night of bowling.

To manually set team pairings for Next Week:

1. Select the team that will bowl on a different lane than what they were originally
scheduled for.

2. Use the Move Up or Move Down to change to the lane they will actually be bowling
on next week.

3. Repeatthese steps as necessaryfor each team that will be bowling on a different
lane.

Teams Bowled on Wrong Lanes

This is the same as Next Week: manually set team pairings screen with the exception
that team pairing will be set for This Week. Similarly, the rest of the schedule remains
unchanged.
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Brackets Menu

BLS-2021 Pro and BLS-2021 A/S feature a built-in bracket module to manage brackets
for the league. This module makes it easyto run bowler and team brackets during
league play.

Do not confuse the Tbrac line of products with the built-in brackets module. While BLS-
2021 Pro and BLS-2021 A/S feature similar technology, Tbrac is a separate product
than BLS-2021 and is available as a separate purchase.

What are Brackets?
Over the past years brackets have become a very popular addition to league play.
Brackets have provided added variety to side pots that are typically found in many
leagues. Because of this popularity, CDE Software created a program called TBrac-2018
to handle side pots and brackets as well as small singles tournaments, which has
ewvolved to the current Tbrac-2018 (as of this printing).

An increased need of running brackets within leagues while keeping things simple was
discovered. Because of this need, CDE Software developed a special module included
into BLS-2021 Pro and BLS-2021 A/S.

Just what are brackets?

Brackets are a single elimination system based on scores bowled in a session. Single
elimination systems are found in sports such as tennis.

Imagine a professional tennis tournament such as Wimbledon. Imagine thatitis the
quarterfinals. There are 8 players in four matches played to determine four winners.
Then a semifinal match is played between those four winners to determine the finalists.
The last match between the two players determines the champion.

Back in the bowling world, a typical bracket is eight randomly picked and placed bowlers
setup in a quarter final setting using the first game bowled as a basis to see who
advances to the semi-finals. Those who do advance use the second game bowled to
determine who advances to the finals. The third game bowled determines the bracket
winner. Like the tennis scenario, a bit of luck on where the bowler is placed in the
bracket can determine the bowlers’ fate or fortune.

Bowlers can enter as many brackets as they are willing to pay for as long as there are
enough multiple participants. If there are not enough bowlers to fill a bracket, moneyis
refunded to those bowlers placed in that bracket.

In one example, a tournament has nine bowlers entering brackets, with seven bowlers
entering two brackets and two bowlers entering one. This scenario sets up two brackets
where one of the single bracket entrants will be in the first bracket and the other in the
second bracket. The remaining seven bowlers are in both. Bowlers in every bracket are
randomly positioned.

In another illustration, take the above example except that two of the seven bowlers
wanted to be in three brackets. Since there aren’t enough separate bowlers to fill the
third bracket, those bowlers would get a refund.
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Why Should | Offer Brackefts?
Brackets are a great way to add some extra interest each week. Because of the nature in
how brackets operate, it provides more opportunities for lower average bowlers to win,
where high game pots tend to be paid mostly to higher average players.

Agreatwayto introduce brackets to the league bowlers is to sign up each player to one
or two brackets during the first or second week of bowling and offer a free beverage to
the winners ( a free game card, beer, etc.). They will soon see how things work and can
quickly become hooked.

Do | have to Charge for Brackets ?
Absolutely not! If you simply wantto manage brackets free of charge, go right ahead.
Typically, the person operating the brackets would keep one fraction of the bracketin
order to offset costs of the software, but thatisn't required. For example, ifan 8 person, 3
game bracket is offered for $1.00 each, then the person running the brackets would
keep $1.00 per bracket filled, give $6.00 to the first place winner and $1.00 to the second
place winner.

There are some centers that have taken the opportunity to help their Youth Bowling
program by donating that fraction for each bracket to the center's youth program.
Fundraisers for charities is another greatidea.

Set up Brackets

To configure brackets for the tournament, click Brackets > Setup > Bracket Setup which
opens the Design-A-Bracket screen. This screen is divided into 5 tabs starting with the
Bracket Definition. BLS-2021 supports a variety of bracket formats including, but not
limited to, Monster Brackets, Reverse Brackets, Eliminator Brackets, Double and Team
brackets. Each of these formats can be defined using Bracket Sets.

What is a bracket set?

Abracket setis simplya group of brackets with the same definition, options and
financial setup. For example, Individual Scratch and Handicap brackets would be 2
bracket sets. Adding a reverse brackets or a Team Bracket would require additional
Bracket Sets to be enabled. BLS-2021 supports up to 12 bracket sets.

Enabling/Disabling Bracket Set
Toggle the switch for This bracket set is —-> to Enabled or Disabled accordingly.

Once a bracket set has been enabled, to define a bracket set, select a bracket set to
work with and change the following options:

¢ How many games are bowled in this bracket - Indicate the number of games that
scores are used for this bracket set.

« How many bowlers compete in each bracket - Indicate the maximum number of
bowlers that are allowed in each bracket.

o Bracket Levels - Indicate the number of bowlers that are to advance to the next game.

¢ Using the buttons at the bottom of the page, Indicate Standard Style or Himinator
Type

e Using the green buttons at the bottom of the page, indicate if the bracket set will be
Singles or Team
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Click the Next button to proceed to the Bracket Options section.

Bracket Designer

5 per By Saed =
> 7] no entries | Bracket 1 Singles, Handicap 8 3 1-2-3 2
2 Bracket 2 Singles, Handicap 8 3 123 2
E Bracket 3 Singles, Handicap 8 3 123 2
o) |Bracket 4 Singles, Handicap 8 3 123 2
Bracket 5 Singles, Handicap 8 3 123 2
Bracket & Singles, Handicap 8 3 123 2
gracket 7 Singles, Handicap 8 3 123 2
Bracket 8 Singles, Handicap 8 ] 123 2
Bracket 9 Singles, Handicap 8 3 123 2 v
Definitions Options Financial Setup Handicaps Templates
Favorite Bracket Types Double-Click on a picture to use it This bracket setis > | Enabled -
Current Bracke! Definition: Page 1 of 4 (10 types defined)
# person 3 game HOCP 8 person 3 game SCRATCH * 4 game 16 person

%) Favorite Brackets List

- Delete this Bracket from
s : = Favorite Brackets List

llwlulw - : Next }

Number of games bowled in this bracket |3

Number of

Bracket Options

After configuring the structure of the bracket, options can be set for the style of bracket.

What is the title of this bracket set: Change the title of the Bracket Set to better describe
the type of bracket.

What games are used in this bracket: Indicate which games are used for this bracket
setand the order they will be used. With this option, "reverse" brackets can be
configured by starting with Game 3 and ending with Game 1.

Scratch or handicap brackets: Select which scores are used to determine the winners
in each bracket.

Tie breaking rule: Select what happens if a tie. See the HELP file for information on over-
riding this option.

Limiting brackets: Brackets for each set can be limited to a specific number of brackets
offered as well as the number that a bowler can enter. Set the values appropriately.

Byes: Byes occur when there are not enough bowlers to fill a complete bracket. If byes
are allowed, indicate this here.

Additional qualification options: Brackets can be configured for a minimum/maximum
age as well as minimum/maximum average. This configuration extends to allowing
Adults only, Kids only or both as well as being able to separate by gender. Finally, the
bracket can be restricted to a single division if bowler divisions are configured.
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Click Next to proceed to the Bracket Financial Setup tab.

Bracket Financial Setup
When moneyis charged for brackets and paid out, prices and payouts must be indicated
to create proper payout reports.

Indicate how many places paid and the amount charged to enter this bracket set. The
Total Take In will be listed in the lower row of the table.

Next, complete the table, covering scenario when there are No Byes, 1 Bye, 2 Byes, 3
Byes or 4 Byes. If charging to run brackets, enter the house profit charged to run the
bracket. Enter 1st Place Payout and 2nd Place Payout

If this financial setup will be common, click the Save the current setup as a standard
payout method.

Bracket Handicaps
This screen can be used to configure handicaps for teams, doubles and singles which
may be different than handicaps configured in the League Rules.

Running Brackets for Youth Leagues

USBC Youth members may participate in bracket side pots, however the fees can't be
charged to run brackets and all payouts must go towards the winner's USBC Youth
scholarship fund account.

Print Bracket Signup Sheefts
Signup sheets are used at the center for bowlers to write down their names, indicate
which lane they are on and the number of brackets to enter for each bracket set.

The signup sheet also allows for the secretary to indicate if the brackets have been
entered into the program as well as if the bowler has paid for the brackets entered.

Bracket Registration Screen
After brackets have been set up and bowlers have indicated how many brackets for each
setto enter, it's now time to register them into brackets.

The first step is to ensure bowlers are entered first into the team rosters screen or
Bowler Maintenance screen.

Nextis to indicate the number of brackets that each bowler is participating in for each
bracket set and enter the Amount Paid IN by the bowlers. For example, if Fred Ziffell is
entering into the first bracket set 8 times, an 8 would be entered into the Bwlr -1- column
for that bowler. Repeat the entering of brackets for each bowler thatis participating. If a
bowler is not participating in brackets, simplyignore their entry.

Once bracket registration is complete, go into the Bracket Results to perform the initial
shuffling of the bowlers.

Filling brackets
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The brackets status screen displays currentinformation about the number of brackets
filled, partially filled and available.

As the cursoris moved from one bracket set to another, the status will change for that
bracket set.

When entering bowlers into brackets, take note of the number of full brackets and the
number to fill one more bracket. Optimally, itis bestto sign up enough bowlers to fill one
or more brackets and needing zero bowlers to fill one more bracket. This eliminate
BYES from brackets.

To fill an incomplete bracket, try to bring in bowlers who normally do not participate in
brackets.

Print Score Sheets
Score sheets are used to write scratch scores down for the bowlers to keep track of
bracket scores bowled. In addition, this report can be used to print the scores that have
been entered into score entry. Scores can be also entered from Recaps.

Click Brackets > Manage > Score Sheets to view a preview of the report. The report can
then be printed.

Enter Scores
This option allows entering the scores for the bowlers for the bowlers. Scores entered
on this screen will also be stored for when you Enter / Correct Current Scores in your
Weekly Duties Similarly, scores entered on the Enter / Correct Current Scores screen
will be used for brackets as well.

To reduce the number of displayed bowlers, select the option to Show only those
entered.

Bowler Names Score Data Entry Information

Last - Name Displayed First shnw- Show Scores
-

-[m First Name

-ﬂﬁi‘“ VOIDed Entries I

-m Last Name show- Scores + HOCP w Entry Stats
B Hide vickvame BRI HiDCP Each Game Show [l 0ononent Data
BHIEN Middle nitial H Average Each Game -w Show EVERYTHING
'Hide  vintage SIS Match Points
Show- Full Names
Additional Bowler Information Finance and Brackets Miscellaneous
Show - Left/Right Hand W’ Financial Data -”Iii? Allow editing names
@ vide - "W Brackets ves B Enter scores 1 game at
=mv Book Average w Side Pots atime
5 3 = Always indicate PAID in
Hide 7eam: 'Hid@" House Pots -"W FULL
Allow entry and
Yes - changing of score!
Yes - Manual score entry
Show - This screen next time Registration is opened x Cancel v Save
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Bracket Results
Go to Brackets > Finish > Results to display the bracket results and match-ups. When
entering Bracket Results for the first time, or until the brackets are assigned, BLS-
2021 Pro and A/S Editions opens a message that brackets need to be be shuffled,
simply click the Shuffle Brackets Now button.

Preparing to Shuffle

Shuffle Preparation
Before shuffling bowlers, a couple steps need to be done.

The Shuffle Preparation screen displays the number of full brackets and the number of
people needed to fill another bracket. Use this information to register enough bowlers to
be able to fill all brackets of this type set.

After completing the registration, indicate how Bye’s are used. There following options
are:

¢ No BYEs Allowed - Click to not use byes. If a bracket is not full, then refunds are given
for the bowlers in the incomplete bracket.

¢ Include BYEs to fill one extra bracket - Click to use a bye for the one incomplete
bracket.

e RIl __brackets. Add BYEs as needed - Click and specify the number of brackets and
the total number of brackets to run. Byes are added with registered bowlers to
complete brackets.

Click Assign Bowlers to Brackets to begin shuffling. BLS-2021 Pro and A/'S programs
use the S.S.F.L. shuffle system to reduce the number of times multiple entrants compete
againstthe same bowler.

Opponent View

The opponent view is a quick wayto select a bowler and display that bowler’s
opponents. Displayed will be the number of pending bracket wins/losses as well as the
number of existing wins or losses

Bracket Payouts

The brackets payout screen displays the amount of money to disperse to the bowlers.
Displayed is the amount of money to refund the bowler due in case more brackets were
paid for than offered. Also displayed is the amount of money earned for winning brackets
as well as the total amount to return to the bowler.

Bracket Reports
The bracket reports screen generates reports based on payouts, refunds or bracket
diagrams.

1. Under Select a Report, click and select the report to be generated.

2. Selectthe appropriate report options.

3. Click Preview to generate a viewable report on screen.

4. Click Print to generate a hard copy of the report.
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Forced Bracket Losses

BLS-2021 Pro or A/S will allows forcing a bowler to lose a any game within the brackets.
This can be useful if a different tie-breaking rule needs to be enforced, bowler had to
leave early, etc... Do the following to force a loss:

1. Select Bracket Set

Select Which Bracket

Select Which Game to Lose

Select Which Bowler in that Bracket

Click Force a LOSS in the selected game

To remove a forced loss, click Remove Forced Loss

o0 krwN

Jackpot Tickets and Mystery Score
This menu option has additional features available in the Professional and Auto-Scoring
Editions of BLS-2021.

Mystery Scores

This feature is designed to randomly generate a score that is kept secret. Then, during
league play, if a bowler matches this score, they would be declared the winner.

Configure the minimum and maximum score values and click Generate a Score. The
score can be used for the Overall Bowling Center or for an individual League.

Jackpot Tickets

This option is designed to generate a random number between a range of values based
on the number of tickets sold. Once the all the tickets have been sold, configure the Low
Number (number on 1st ticket) the indicate the number of tickets sold. Click on the Start
Spinning button, and click on Pick a Number to stop the "spinning" and display the
selected number. This number can be kept or thrown back. Multiple numbers can be
generated.
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Reports Menu

Reports represent a major aspect of BLS-2021 to present the data to the bowlers in the
league. Generally, the mostimportant report will be the Standing Sheet as it provides the
results for the season and the previous week of bowling. Additional reports can be found
atvarious locations in the program. However, BLS-2021 provides a section specifically

for creating and generating reports:

Email and Labels
Setup
e Customize Advanced Reportle_Oh

These reports are accessed by selecting the appropriate report from the Reports
Menu. Most of these reports are self-explanatory. However, we will be discussing
Email, Labels & Coupons and Set-Up Reports & Custom Reports later in this
chapter. Once the report appears, some helpful preview controls are located at the
top.

Weekly

In this menu, the following items are listed in the sub menu that are available to be
printed each week.

Financials, Lane Statistics, National Awards, Press Sheet, Standings Pastand Present,
Team Captains.

Common
The following items are listed in the sub menu; Bowlers - Alphabetical, Most Improved,
Reprint Scores, Substitutes.

Labels

The following items are listed in the sub menu; Bowler Names, Address Labels

Mailing Labels
This option allows labels to be printed for all bowlers. For information on sending Email,
please see the section on Email on page[2s3\.

Labels

Reports > Mailing Labels

Use the Drop-down listto select the label type: 3x10, 2x10 or 1 Up Continuous labels.
These settings will work with most labels available on the market. Use the Margins to
make adjustments to where the names and addresses are printed on the label.

View and Print More Reports

This item will open the entire list of more reports.
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Setfup

The following items are listed in the sub menu; Customized Advance Reports, Data and
Custom Exports

Mid Season-End of Season
The following items are listed in the sub menu; Email Final Average Report, Final
Averages, Financial Histories, Team & Bowler Histories

All Awards Earned: Alphabetical
This report will generate all awards earned by every bowler in the league, both local (if
configured) and national. The reportis sorted in alphabetical order. .

All Awards Earned: Week-by-Week
This report will generate all awards earned by every bowler in the league, both local (if

configured) and national. The report will list the awards earned on a week-by-week
basis.

Team and Individual Score Histories

Bowler and Team History

/M Home | 5 prm i Preview . Foms & Graphics P Reset ED Help
1. Select a Team: 2. Select a Team Member: 3. Select what to Print or Preview: Bowler History
1:Emmerson Carmichael @ Selected howler
2 - Team Grand Vitara 2:Carly Coreley Team History
3 - Boulevard C109RT JLon Mead All bowlers on selected team
4 Kizashi 4:Marianna Dodge

Members of all teams

All substitutes

Appearance

... or Select a Bowler:

Statistics Options

Yes - Print Statistical Graph ﬁ Omit graph if extra page required | Yes . Include Averages of Games
m Include graph of each game Yes - Include Game and Series Counters | Yes - Include Highest/Lowest Stats
Include Highest Score for each
w Include average of that week's scores | Yes - I‘wlf Highest Score for e
i Game

Awards Options
Yes - Print awards and recognitions “ Omit local, include national awards
Yes - Show Split Divider Yes - Show Date, Center and Lane Yes - Show Note

Printing Options

Financial Histories
This will print the Weekly Financial Summary report through the week the reportis being
generated. The reportis divided into 4 sections, Weekly Pay Envelope Summary for each
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team, Weekly Cash Receipts, League Funds Summary (distribution of funds) and
individual bowler financial information.

Final Averages

Click Average Report to bring up a preview of the final average report. A copy of the final
averages should be turned in to the local association as well as the bowling center.
Check with the local association on the cutoff date for the final average report.

Note: The final averages should be printed after entering the last scores bowled before
January 1. Give a copy to the local association and the bowling center. Certain
tournaments require averages as of January 1.

Depending on how the league is certified, it can contain up to 3 different sections for
Merged leagues, USBC-Adult, USBC-Youth and Non-Certified Bowler. For NOT Merged
leagues, there can be up to 4 different sections, USBC-BA Certified Bowlers, USBC-WBA
Certified Bowlers, USBC-Youth Certified Bowlers and Non-Sanctioned Bowlers. For
more information and configuration of Merged and NOT Merged leagues, please see

rtify > Association > Defaul [150

Note: If there are a significant number of bowlers listed in the Non-Sanctioned Bowlers
section, ensure the bowler are correctly certified. For Bowler Certification, please see

rtification > Certify Your Bowlers [169)

Setup Reports & Custom Reports

" _ General League Reports: Report Number 1 - 1 Team Captain’s List

p 4 P
() Close 5 Print i vtilities ' Copy &Paste ED Help
m | - v vy
Alphabetical List 1 Team Captainss List ..5 Add report
Contact and Address Information Type of Report: | Team List = b o My Menu
Contact List - = =
Final Average Report Type of Report Heading? |Misc. Report Type =
High Average List = . .~ Change Suggested Style
Most Improved Averages Style I Bt (217 5;5 Style =217
High Match Points
Substitute List
Team Rosters
Birthday List
@ Membership Cards List
& Association Awards This Week Sort By / What order? Lane This Week -
X Local Association Awards This Week -
Pay Envelope Report 5
§_ Weekly Financial Report =
g Bowler ID Number List "]
Pepsi Tournament Qualifiers s
& _Gelow are User Defined Reports— | 3%, -
g ©  File Format (If exported) Comma + Quote : - lly preview after exporting
e H
3 2
i Include a 2nd report section ~>
@ =
@
-
3 &
Black Ink Only 14" Paper Start each part on a new page
More space between lines & Use nickname Include nickname with proper name
Landscape orientation Extra space after every 5names
After page 1, headings will be brief rather than full headings as on page 1
View Style
e e ——— -
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To customize the reports click Reports >View Print More Reports. This screen provides
the following functionality and are explained in the next several sections.

o EditReports Layout e Change Fonts of existing reports
e Change Styles of existing reports e Develop customized reports.
Edit Report Layout

Choosing a report to edit or preview: Highlight the report to edit or preview in the Select
a special league report here column. There are several reports that are predefined as
well as several user defined reports. Depending on the type of report, different options
will be listed. In addition, for the predefined reports, some of the options cannot be
changed.

To change these, create a User Defined Report.

Style used for report: The report style number can be changed to use another style that
reflects the information to be displayed in the report. See “Define Report Styles” for
information on setting up and defining report styles.

Filtering the information: Each report can be adjusted to include bowlers that meet the
criteria wanted. For example, set up a report printing only male subs in division two in
alphabetical order. .

Using font classifications for reports: When printing reports, to use a different
font/graphic set other than the Standing Sheet or default font/graphic set. Select the
report classification using the drop-down list box for Which Font? To change the
fonts/graphics for a report classification, click Fonts & Graphics. See “Edit Report Fonts
and Graphics” on page 157 for information on changing a report classification.

Report Headers

Reports can be customized with different headers. Depending on the Type of Report, the
information displayed in the heading may be different. The following list are some of the
more common headers:

Official Report: Shows date of report, contact info, dates score are included, and league
information.

Misc. Report: Shows date of report and league information.
Standing Sheet: Same as Misc. Report but uses the date bowled.

Report Preview Functions
The preview controls for these reports will help in displaying the information on the
monitor. The following features are available:

Zoom Out: Click Zoom > Zoom Out to Page Dn: Click to display the next page in
compress the report to allow more ofthe  the report.
report to be viewed on the screen.

Zoom In: Click Zoom > Zoom In to expand  Print: Print the contents of the report.
the report to aid in viewing the report
information.

Page Up: Click to display the previous page Export: Exports the report into different
in the report. formats
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Note that by clicking on the Print > Change Layout button at the top of the screen the
Custom Reports and Report Setup screen comes up. (See the next section)

The defaults for all of these reports can be changed. For example, the fonts, styles, and
layouts can be changed by using the Custom Reports and Report Setup functions.

Report Styles

Your Bowler Styles What's a style"

More Bowler Styles
_mwm || Styles are pieces of information put together in a group. BLS-2021
S,

P League

dicap & Match Points
Scores & Most Improved
s & Address
ailPhone List

87 Name & Address

88 Reprint of Scores 1 col

89 Reprint of Scores 2 col

| Pins, Ave, HOCP

91 2ol Pins, Games & Average
92 2-col: Avg and Ave. Change
93 2-col: Pins, Games, Ave & Book
94 Phone/Email/Address List

95 3-col: Bowlers by D#

96 2-col: Average List

97 2-col: Most Improved List

98 Award List w/hverage & Age
99 Awards. Detailed List

100 Match Point List

101 2-col: Weekly & Season Series
102 Treasurer's Repart

103 Pro-Am Tournament Results
104 Pro-Am Check-in Sheet

105 Contact Info, Average

106 Absentee Report

107 Awards: 2 columns

108 Bowler History Scratch

115 Captain's List
116 Name & Parent/Guardian List
117 2-up Mailing Labels

118 Bowler Financial Report

119 Name & Address List

120 3-up Mailing Labels

will use these groups to format each report to reflect the information
needed.

An Example:

Let's take something simple like a birthday list. There are three
important things needed; The name, birthdate and age of each
bowler. These items are just three of a long list of available items
called style elements. When these items are put together in a group,
it becomes a report style such as a birthday list.

If this still doesn’t quite make sense, compare a report style to a
sandwich. Not only can you choose what goes into the sandwich,
but the order itis assembled. This same concept applies to report
styles. Abirthdaylist report style, including the name, birthday and
age of the bowler, could be re-arranged to the order of age, name
and birthday.

Report styles are common everywhere

BLS-2021 offers many bowler and team styles that can be customized based on the
reportinformation needed. Styles in BLS-2021 are shared among all leagues and
reports. This allows manyleagues to share the similar look.

Important note about report styles: Itis important to note that since BLS-2021 shares the
same styles among leagues, if a style is changed, it affects all reports in all the leagues
that use that style. For example, if the team roster style #41 is modified to reflecta
league’s needs, every reportin everyleague that uses that style number will be

changed.

The Styles screen

Clicking the Change Styles button will bring up the Styles screen. Choose a style to view
or edit.

Each style will have a number. Change the style by clicking the Style Group, then clicking
the style name from the Style List list box. A preview of how the style will appear will
displayin the Style Preview area.

There are 3 sets of Styles available for reports:
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« 1-80: Your Bowler Styles These styles are designed for bowler stats or lists and can
be modified individually.

¢ 120-200: Team Styles These styles are designed for team stats and/or lists.

¢ 201-240: Fixed Styles These styles are also provided for bowler statistics and/or
lists. However modifications to these styles is limited to spacing and font size.

Using the suggested style

Some reports have suggested styles. If the report being modified has a suggested style
the Suggested Style button will light up. Clicking this button will choose the suggested
style for the report.

Using the displayed style

When changing style numbers for a report, click Use This to finalize your choice.
(Clicking the green check mark will save the changes made to the style without changing
the style number used for the report.)

Modifying a Style
Modifying Styles
To modify a style, select the specific style to be modified, then click the button: To hide
this panel so you can change this style...

NOTE: Changing styles is a global setting to the program and will change every reportin
every league that uses the style being modified.

The following options are customizable for every style in BLS-2021:

¢ Spacing: This option will slightly decrease/increase the spacing between the data
items making up the selected style. When the selected style has fewer data items,
toggling this option to Wide will spread the data items out so they take up more on the
width of the page. Conversely, when the selected style contains several data items,
toggling this option to Narrow will reduce the spacing between fields allowing more
data printed before BLS-2021 resizes the font to fit between the left and right
margins.

¢ Headings: This option will slightly decreasel/increase the size of the data heading. By
default, the switch will be toggled to Small. If the heading information is difficult to
read, toggle this switch to Large to slightly increase the font size without affecting the
headings for any of the other styles.

o Data Size: This option will slightly decreaselincrease the size of the actual data. By
default, the switch will be toggled to Small. If the data information is difficult to read,
toggle this switch to Large to slightlyincrease the font size without affecting the data
for any of the other styles.

o Set to Default: Clicking on this button will reset the current style to the factory default.
This is convenient if the style is changed to a point where it may be difficult to recover.

As noted in the previous section, BLS-2021 provides two types of styles, fixed and
customizable. In addition to the above options, customizable styles can further be
modified as follows:

Reports Menu 207



Adding elements to a style: Data items can be added to the displayed style in several
ways. Locate and select the item to add from the Data ltems Available to use and do
one of the following to add to the list of Data ltems in Current Style:

e Double-click to add to the end of the list.

e Click Add Item to add to the end of the list.

e Drag-and-drop to the desired position in the list.

The preview of how the style will appear in the Style Preview area, will be updated.

#121-160: Team Stykes: You Can Change

off useTnis

More Team Styles
Fixed Styles

122 HDCP League

123 Serateh League w/Percent Won
124 b League

125 HDCP League w/Scratch highs
2 Col - Points § HOCP

ol - Points & Pins w/HDCP
ol Pts, Last Wis Highs

ol, Seratch highs

30 Highs, Points, Last Wks P1s

31 Full Stats

HDCP w/Last Week's Scores

ol Pis, Ave HOCP, Ping

tch wihighs

s Pts, Games Won

136 Complet; t
137 Captain's List
38 Points for each spiit
HDCP league stats

Team data with Captain

142 Team History Test
143 Last Weel's Scoves 2 col
144 Scratch League

t eck in Sheet
147 Lance's Style - Split Season
148 Lance's Style

149 Team History - HOCP league
150 Team History - Scratch League
151 Team History - HOCP League
152 Team History - Scraich League
153 HOCP League w/Percent Won
154 Team Information with HDCP
155 HOCP high scores

156 Spiit Season Stats

157 Split Season Stats HOCP

158 Spiit Season HOCP, Div

159 Captain's List

160 Last Week's Results

I cancel

Place ¥ Team Name

Data items available to use:

Team Name
Team Name (shortenad)

Team Captain's Name
Team Captain's Phone
Team Captain's E-Mail
Team Captain's Address

Division Number
Place
Lane Number Next Week

Average (pins/games: NOT used for HOCP)

Average (used for HDCP)
Handicap

Total Pins (all scores ¢+ HOCP)
Total Pins (scratch pinfall only)
Total HOCP Pins Y-T-D

Total Scr. Pins ¥-TD

High Scraich Game

High Scratch Series

High HDCP Game

High HDCP Series

High "108 30" scratch

q Style List

Points Points  UnEsrned
Won Lost Point

) Addhem

Q Remove ltem
() Undo Changes
() SettoDefault

O o

Date Modified:
/22018

7 Copy / Paste Style

Y-T-D Yesr-To-Date Y.T-D

Data items in current style:
Flace

Team Mumber
Team Name
Percent points won
Points Won

Foints Lost

Points UnEamed
Year-to-date % Won
Yearto-date Won
Year-to-date Lost

ED Help

Games Scralch Pins e

Won

Style Title: HOCF League w/Percent Won

Games Won (just games, not series of poin

Total Pins (scratch pinfall only)
Total Pins (all scores + HOCP)

% Move ~  Move
./ Iem UP .’ DOWN
Spacing “ Columns

; NeEmr
Headings E

Data Size Large -

Pins. HOCP

Removing elements from a style: Data items can be removed from the displayed style
two ways. Locate and select the item to remove from the Data ltems in Current Style

and either:

e Double-click to remove from the list.

e Click Remove Item to remove from the list.

The style preview will change to reflect the modifications.

Re-ordering the elements in a style: To re-arrange the order of items used in the style,

simplydrag and drop the items in the Data ltems in Current Style list with your mouse to
the new order. As an alternative, you can select the data item and use the Move ltem UP
and/or Move DOWN buttons.

Multiple Columns

Set the number of columns that the shown style will use. If you use multiple columns,
you may need to use fewer items in the style for a readable report.
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Copying a Style
There are times when a particular style includes everything except for an item or two.
View the style that will be copied and click Copy Paste Style > Copy button. Next, view the
style that will use the copied style and click Copy Paste Style > Paste button. Make
changes as needed and be sure to rename the style.

Predefined Styles
To make your choices easier, we have already defined some styles for you and BLS-

2021 will associate the most common styles with the reports you are working on. There
are over 40 styles possible! This means you can skip this section entirely (return to this
later after you become more familiar with BLS-2021).

Printing List of Styles
Click Preview to view the complete library of predefined styles available to you and print
it.

Report Fonts, Watermarks and Logos

BLS-2021 has added new features to give reports a snazzy custom look. Any font
installed in Windows can be used for headings, sections or data in the report. Special
text effects, along with the font size and color, can be applied. BLS-2021 also adds the
ability to bring in your own graphics for report logos or watermarks.

Everything is predefined, so you can skip this until you are more familiar with BLS-2021.

To bring up the Fonts and Graphics setup screen, click on Reports > Customize
Advanced Reports > Utilities then select Fonts & Images.

Fonts & Images
Undo Changes to Report

Reset Selected Report to Default
Reset ALL Reports to Default

This will bring up the Select Fonts, Logos and Watermarks screen.

Each of these sections can use Custom settings specific to the league being worked on
or Global settings which will be applied to all leagues.

Font Sefs
Click Examine and Change League's Font Set

Changing Font Settings: Click the font class, under Select Font here to see a preview of
the font used.

Changing Fonts: Under the Font group, click the Name list and select from the list of
available fonts. After selecting the font, a sample will appear reflecting the changes
made.

Reports Menu @



Changing Font Size: The font size can be changed by clicking the Size list, under the
Font Name and Style then select the font size. The font sample above will reflect the
changes made.

NOTE: The size of the font printed on the report may notincrease to the desired size as
configured in this section. This will occur if the configured font size forces the information
for the selected style to not fit on a single line. In order to prevent overlap of data, BLS-
2021 will always attempt to reduce the font size so all the information used in the
selected style will fit on one line.

For the Data: names, scores, averages and Column Headings fonts, itis suggested
that you consider modifying the style to change data size as explained in the Modifying a
Style section on page/[z0M.

Changing Font Color: To change the color of the item, click Color box, under the Font
Name and Style and choose from the displayed colors or define your own color.

Using Gradient Font Effects: To place a gradient effect on the font, click the Gradient
style list under the Gradient group and select the gradient method.

Select the colors for the gradients by clicking the Color boxes under the Gradient group
and choose from the displayed colors or define your own color.

Using Shadow Effects: The program has a variety of shadow effects to enhance the item
being edited. Click the Shadow list, under the Shadow Effects group, and select the
effect.

The effect can be adjusted by using the Shadow Depth slider control.
After selecting the effect, adjust the shadow colors.

Effects and Printers: Unfortunately, not all printers display the same results when using
effects. Because printers and drivers vary, effects used may appear correct on the
preview, but not on the printed report. Some printers omit the special effects.

If your printer is not compatible with the applied effects, simply remove them.
Font Management:

Managing the fonts used in BLS-2021 is quite easy. Afont set can be saved to be used
for specific reports. Fonts are classified into the many categories that may appear on the
various reports in BLS-2021, such as "Main Heading", or "Section Headings", these
fonts define the look and feel of all the reports. Using the Font Management tab, save a
set of fonts to be used. This can be particularly useful if the standing sheet should look
one way and the bowler/team histories should look another.

After making changes to the Fonts, itis suggested to save the settings so theycan be
used for future reports. To do this, provide a new Name of Font Set and click the Save
button.

To return to this Font Set click the Load button.
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Logos and Watermarks
Change Watermarks, logos and icons

Printing a report logo: Click Printlogo at top/left of heading to include a logo on your
report. Click the image preview to select the image to use.

Printing a watermark: Click Print watermark on each page to include a background
watermark on your report. Click the image preview to select the image to use.

Printing a message icon: Click Printicon to Left of messages to include an image to the
left of the Messages section of the standings. Options to include a mirrorimage to the
right and to flip the image are available. Click the image preview to select the image to
use.

Changing Report Graphics
To change images, click the image preview to bring up the Image Selector utility.
CDE Software has three clipart collections dedicated to bowling.

Change the Image Location to the drive and directory where your graphic images are
located. Select the image located in List of available Images. A preview of the image will
appear in the Image Preview area.

Image Effects
Effects can be added to the selected image. The following effects are available:

Lightening
Adjust the slider to fade or bring out the image. By using a faded image, the information
in the report becomes easier to view.

De-Colorize

Adjust the slider to change the color information of the image from the original color to
gray scale. Images with bright colors can now be muted down so the information in the
report becomes easier to view.

Colorize
Colorize works the same as De-Colorize except a designated color can be chosen
instead of gray.

Remove Effects
Effects are removed by clicking Remove Effects.
Graphics Layout

Another unique feature with BLS-2021 is the ability to import additional graphics into
reports and position and resize the graphics as needed. This flexibility gives your
standings and reports an extra touch of class.

Graphic groups

There are currently three groups of graphics that are used for reports: the FIRST page,
all of the MIDDLE pages and the LAST page.

Each group can designate up to four graphic images.
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Selecting the group

In the Graphics Layout screen, select the appropriate image group to modify or add
images. The report preview will change to reflect the settings for that group.

Adding images
Click Add new Graphic to bring up the Image Selector utility.
Moving images

Once an image has been added, the image can be moved by clicking the image and
then dragging to the new location.

Removing images
To remove an image, select the image and click Delete Graphic.
Resizing images

Select the image to be resized. The selected image will be outlined with resizing
controls. Click the appropriate side or corner and drag to resize the image. Clicking the
controls to the sides of the image will enlarge or shrink the image without re
proportioning the image. Clicking the corner controls to enlarge or shrink the image
proportionally, unless proportional sizing is turned off.

Graphic Layers

As you add the images, they are layered in the order they were added. If the images do
not overlap, the images will complete show. However, ifimages overlap, the image that
is to the front will overlap images towards the back. To bring an image to the front or
back, select the image and click Bring to front or Send to back.

Graphic Properties

To change the effect of the image, select the image and click Graphic Properties.
Additional options

By right-clicking on the image, the following options are available:

e Restore original dimensions - Select option to revert the image back to original sizing
and proportions.

e Half-size & Double-size - Enlarges or shrinks the image by a factor of two.

e Proportional sizing - Click to change the corner resizing controls to act proportionally
or not.

Properties - change the image orimage effects.
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Tasks Menu

Tasks contain features used at the middle of the bowling season and end of the bowling
season for BLS-2021.

Average Report: Click Average Report to bring up a preview of the final average report. A
copy of the final averages should be turned in to the local association as well as the
bowling center. Check with the local association on the cutoff date for the final average
report.

Note: The final averages should be printed after entering the last scores bowled before
January 1. Give a copy to the local association and the bowling center. Certain
tournaments require averages as of January 1.

Team and Individual Score Histories: This option is provided to print summary of the
season for teams and all the bowlers of the league

Season Summary of All Awards: Options to print all awards for the bowlers, either
alphabetical or Week by Week.

Financial Histories: Display and print financial history reports
End of Season Duties

Determine Prize Fund

Assign Winners to Prize Fund

Restarting Your League for Next Season

Copy and Restart League for Next Season

Print Returning Bowler Sign-Up Sheets

Other

Print Returning Bowler Sign-Up Sheets

Internet
Email Bowlers
Tasks > Other > Email Bowlers
Selecting this option will bring up the Email Bowlers screen.

Nofte: Be sure lo set up Internet Seftings with regards fo email servers. For more
information on Internet Setftings, please see Infernet Setup topic.

This screen is similar to common emailing programs. To send an email to one or more
persons do the following:

1. Selectwhich bowlers to email (use check boxes)
2. Type in email address the receiver can reply to
3. Typein atitle in the text boxlabeled "Subject"
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4. Type a Message in the large message box

5. Attach file (if needed) by selecting YES using the toggle switch and the at the bottom
of the screen, click Select File and the follow instructions to attach file

6. Click Send Email

Note: Email addresses must be entered in for bowlers in the Bowler Maintenance
screen in order to be able to send email to those bowlers.

Sending the standing sheet via Email

BLS-2021 features the option to attach the current weeks standing sheet to email to
selected bowlers. To email the standings:

1. Follow steps 1-4 from above.
2. Click Attach PDF of Standing Sheet.
3. Click Send Email.

Upload League

Upload league to Leaguesecretary.com, Bowl.com and personal websites.

Email Press Sheet
Email Press Sheet to local newspapers.

Email Final Average Report

Email Final Average Report to local association.

End of Season Financials

Determine Prize Fund

This provides a convenientlink that will open the Prize Setup screen on the Setup. This
is the same section that was used when setting up the Prize Fund for the firsttime. For
more information, please see the section on Setup > Awards > League Awards and
Prize Fund on Page[2:}

Assign Winners to Prize Fund

This provides a convenient link that will open the Prize Setup screen on the Details tab.
This is the same section that was used when setting up the Prize Fund for the firsttime.
For more information, please see the section on Setup > Awards > League Awards and
Prize Fund on Page[ 2%

Prep for Next Season
The following should be done when ready to prepare a new season's league after the
pastseason has completed.

Make Final Backup

Create a final backup of the league for the season.

Tasks Menu 215



Print Returning Bowler Sign-Up Sheets
This report provides pre-filled sign-up sheets for existing bowlers. It can be used at the
end of the season for bowlers to indicate if they will be returning the next season.

Restart League for Next Season

While it appears to accomplish the same thing, restarting the league is notas simple as
going back to week 1. BLS-2021 provides a special utility to clear the past season and
prepare the league for the next season.

Use the following steps to restart the league for the next season:

1.

Open the league from last season, go to the last week scores counted toward
averages.

Go to Tasks > Prep for Next Season > Restart League for Next Season.

Select the Options for Restarting for the League. The most common Options are
selected by Default. See Restart Options below for more information.

Enter a new league description. This has to be a unique description. We typically
suggest adding the bowling season year at the end. For example, add the season
year at the end of the league name to indicate itis for the new season.

There will be a prompt to enter a new League Title. This name is whatis printed on
the Standing Sheets and other reports generated in the program. This does not have
to be unique.

Read and acknowledge the dialog screens that come up next, but essentially click
OK on these.

Assign a New Filename for the league and click Ok. Note - do not change the default
directory.

Select a new Starting Date. Initially, the Starting Data from last season listed. Click
the double arrow to the right to advance to the current year, then select the correct
Start Date.

Click the double checkmark in the lower right.

10. The schedule for the new season will open to remove any dates the league will not

11.

be bowling and to verify position rounds.

The league for the New season will now be resetand open to week one. Itis now
ready to make any additional changes for the new season.

Restart options

Copy old league to new file name - This option copies the existing league to a new
league file. This option is automatically selected and cannot be modified.

Erase old book averages - This will remove the book averages from every bowler in
the league.

If >21 games, copy current ave. to book ave. - This will setthe book averages for
next season if a bowler has 21 games or more.

Clear sanction payments & assoc awards - This removes all the awards and
sanction payments.

Remove people designate " Quit the League" - Bowlers marked as Quit the League
will be deleted from the database.
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¢ Take all bowlers off of the teams - Clears the team rosters so bowlers can be re-
assigned to new teams next season. Existing personal information for the bowlers
remains in the new league file.

¢ Re-Order teams 1st place to last place - Changes the team numbers of the teams in
order of the standings.

o Clear league planner - Erases the league planner.

« Copy current average to Entering Average - Set Entering Average for next season.
This is only necessary when the league uses an alternate average at the beginning of
the season.

By copying the league to a new league file, the old league file remains untouched and is
available to research anything from the previous season.
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Utilities Menu
The section of the main menu provide some powerful and useful functions to maintain
league files.

¢ Bowling Calculator e Reorder Teams

e Forms Library e Add Teams

e Backup The League e Remove Teams

e Backup League to DropBox e Clear Team Rosters

e Drive & Directory Listing o Reset To Prior week's Reordering

e Delete Future Weeks Data e Delete Quitters & Unused Vacants

e Erase This Weeks Scores e Erase All Association and Local Awards
e Erase All Data & Start Over Earned

o Clear League Planner * Recalculate Sanction Payments

o ResetBowling Shifts ¢ Reset Treasurer & Erase All Financials

e Unlock Treasurer Information

This section is divided into categories Support Functions, Sometimes Useful Functions
and Aids in Repairing Corrupt Data.

Support Functions
Iitem 1: Email League to Tech Support

This option allows sending an email, with or without league files, to Technical Support.
For more information, please see Email League to Tech Support discussed on
page|2s9.

ltem 2: Backup This League

This provides a convenient link that will backup the league. For more information, please
see the chapter on Protecting and Transporting League Data on page[2?)

General Utilities

The following general utilities available are:
Bowling Calculator

Forms Library

Bowling Calculator
The Bowling Calculator that is included with BLS-2021 is a simple calculator with
additional options to assistin calculating handicap.

To calculate a handicap, enter the handicap %, Base and bowler's average.

League Utilities
League specific utilities found to assistin managing the league.
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Delete Future Weeks Data

The Delete Future Weeks Data can be used during the season to remove all weeks later
than the week the league file is in. This is normally only used in situations where
removing and re-entering information is easier than correcting problems. This is
especially useful for problems related to changing team rosters or reordering teams.

Do not use this function to restart the league for each season, use the Restart League
feature.

If the league is not correct, do notimmediately create a brand new league and re-enter
all the information. Go to the last correct week where everything is correct, i.e. standings,
etc., and use this utility. Ifitis only one week or two, itis easier to just re-enter those
weeks information than restarting all over. Note - Creating the league again from the
beginning is usually the last ditch effort.

Erase This Weeks Scores
Using this option will clear all scores entered for this week. Be sure to have the original
recap sheets available for re-entering scores.

Erase All Data and Start Over

When the league season has completed and it's time to get ready for the next season,
use this function

It may be smart to do this when starting a new season as opposed to creating a new
league, so have to re-typing all of the names and addresses again is not required. When
restarting the league, copy the rules and bowlers to a new league file. This allows
makes it possible to keep the previous seasons league file for reference.

There are many options, so be sure to select the options correctly. If unsure about
selecting the right options, make a backup BEFORE resetting the league to week #1. Ifa
selection is made incorrectly, it may be better to re-do the Restart League for New
Season, selecting the additional options, even after resetting to week #1. After resetting
to week #1, it may be necessary to re-order the teams or change the number of teams.

Clear League Planner
Clicking this option will clear the league planner/calendar and erase all entries and data
init.

Team Utilities
Team specific utilities found to assistin managing the league.

Reorder Teams

The re-ordering of teams is typically done in preparation for removing teams. However
there may be other scenarios that may require the teams to be re-ordered. This will
change the team numbers for all teams affected by the re-order. Use the following
procedure to re-order the teams:

1. Be sure the league is in the week the teams need to be re-ordered. If the changes
take affect next week, advance to that week before re-ordering the teams
2. Selectthe team thatis going to change the order
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3. Use the Move Up or Move Down arrows to move the team to the new order.
4. Teams changing position will appear in red with their old team order in brackets after
the name.

Change the team numbers starting with this week x
o Make Changes 98 camcel ED Help

Current Number of Teams | 4 When do changes take effect?

Current Team Numbers New Team Numbers
1 -GS500 To change the order of the teams,
2-Team G Jitar d 6 Move Up select a team then click the
MOVE UP or MOVE DOWN buttons.
V Move Down Teams whose position has changed
will appear in red.

The changes will take effect this
week and for future weeks.

Should you need to change the number
of teams for next week, you will need to:
1. Advance to next week
2. Change the number of teams
3. Return back to this week.

For reference, numbers in brackets
indicate teams original team
number (when the league started)
before teams were ever re-ordered.

Add Teams

) Add Teams to your League:

Select One of the Following. . . . .

Add 1 regular team and a BYE team
Add 2 regular teams
Add 3 regular teams and one BYE team

Add 4 regular teams

@ Cancel Entire Procedure

The adding of teams must be done in even pairs and is done in the following manner:

1. Ensure the league is in the week where the teams are to be added. If the addition is
to take place next week, advance to that week before making changes.

2. On the first screen, select up to 4 teams to be added. As previously noted, teams are
added in pairs. As such, either 2 or 4 teams will be added, including a BYE team if
necessary.

3. The next screen will configure what week the teams should be added. Since Step 1
recommended going to the week the teams are to be added, keeping this at the
default "Add teams starting this week" should be used. However, we do provide
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options to start with Week 1 or start with the week following a split (if configured for
split-season). For any weeks that already have scores entered, the program will
configure the new teams to bowl each other until the week there are no scores
entered.

NOTE: If the league is going to allow the new teams to make-up previous weeks, itis
extremely important that to select the option to add teams for the prior weeks so that
the make-up scores can be applied.

4. Please read carefully and continue the confirmation and informational dialog
messages that appear.

Remove Teams

BLS-2021 has made removing teams and re-ordering the the remaining teams much
simpler this year. When clicking on Utilities > Removing Teams, a message will appear
asking; you want to use the Remove Team Wizard?. This message will only appear if
there are no scores entered for the week. Click on Yes. Another screen appears and
justclick the box or boxes of the teams to be remove. It will automatically put the bottom
teams in the place of the removed team, leaving all the other teams with the original
team numbers. The onlyteams that will change team numbers are the bottom teams
that were moved to the removed team(s). Click the Finish button, and the program will go
to the new order of teams. Verify they are correct and click the Make Changes button at
the top.

Delete one or more teams

Use the checkboxes to mark the teams to delete
Teams at the end of the list will be used to replace the deleted teams

Current Team Order Teams to Delete New Team Order
1-GS500 4 - Kizashi 1-GS500
2 - Team Grand Vitara 2 - Team Grand Vitara
3- Boulevard C109RT
4-BYE
Finish Cancel Help

The removal of teams mustbe done in even pairs. If only one team is being dropped,
simply rename that team to BYE and drop the bowlers from the team

Important Note: Ensure the league is in the week that the teams will be removed and
that no scores are entered for that week.

Utilities Menu E




To minimize the number of Team Numbers affected by the reduction of teams, itis
important to re-order the teams. When reducing the number of teams, BLS-2021 will
bring up the re-order teams screen after the teams have been deleted. However, it may
be clearer to re-order the teams prior to deleting them, the choice is up to the individual
Secretary running the program.

For more information on re-ordering teams, please see the We Want to Re-Order the
Teams section later in this chapter.

Note: Do not attempt to re-order teams by dropping and adding bowlers to different
teams from the Adjust Team Rosters screen.

To remove teams, use the following instructions.

1. Go to Utilities > Teams > Remove Teams

2. UnderIndicate Teams to Remove, select the lastteam and click Delete Team. Then,
select the next to last team and click Delete Team.

3. Click the Make Changes menu.

4. There will be a confirmation dialog box that appears with one last chance to abort the
team removal.

5. This is followed by Informational Dialogs that reveal the schedule and lane
assignments have been a changed and offer a chance to re-order the teams.

6. As previouslynoted, re-ordering of teams is done to minimize the number of team
that will have the Team Number changed. The objective it to move the last team
remaining in the league to the team number of the first team to be deleted. For
example, in a 12 team league where teams 2 and 5 are deleted, move team 12 to
team 2 and move team 11 to team 5 on the re-order teams screen.

Alternatively, if re-order before deleting, replace the teams that are being removed
with the last team numbers of teams that will remain with the league. For example in
a 12 team league where Teams 2 and 5 are dropping, move Team 12 up into Team
2's spotand move Team 2 down to Team12. Then move Team 11 up to Team 5's
spotand move Team 5 down to Team 11.

7. Click the green check mark to save the changes.
8. Verify Position Rounds and other Schedule Information.

Printing Recap Sheets for next week: Once the number of teams has been reduced,
print the recap sheets while in the week that the teams were removed. This will work fine
as long as no scores are entered.

Standing Sheet for next week: After reducing the number of teams, go back to the
previous week to print the Standing Sheets, otherwise the Team Losses will not be
correct due the fact that scores have not been entered yet. The Team Standings and
Team Rosters will still reflect the original teams and team numbers, including the teams
that dropped. However, the lane assignments will reflect the new schedule based on the
new number of teams, with the two teams that dropped at the end (based on the new
team numbers). Make sure the bowlers are aware of the fact that lane assignments on
the Standing Sheet reflect the NEW team numbers.
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Clear Team Rosters
Using this option will remove all bowlers from the teams. The teams will need to be

reassigned by using the Team Rosters screen. This utility is useful atthe beginning of a
season if wanting to re-assign new teams with new rosters.

Bowler Utilities
Bowler specific utilities found to assistin managing the league.

Deleting Quitters

After a bowler has been marked as quitting the league (done in the Bowler Maintenance
screen), their information can be removed from the league by using this option. This
allows for the Bowler IDs used bythese bowlers to be reused.

Erase All Association And Local Awards Earned
This utility will scan each bowler and clear the records for any awards earned.

This utilityis useful when changes were made to the Awards setup and need to clear
any awards that may have been improperly detected.

Treasurer Utilities
Financial specific utilities found to assistin managing the league.

Recalculate Sanction Payments
This option is rarely needed. Should the financial reports not indicate the expected

amounts of sanction money, this option may be used to recalculate the leagues
sanction fund. This may be needed if sanction payments have been edited and
removed.

Erase All Financial Data
This resets all portions of the treasurer to the defaults and erases all treasurer data.

When selected, an option to reset or keep sanctioning information will be presented.
Resetting Sanction payments will not remove National ID numbers, but will mark all
bowlers unpaid.

Utilities Menu ﬁ
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Chapter
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Treasurer Duties
This chapter describes the financial portion of the program. If you do not handle the
treasurer duties or wish to process the financial information manually, skip this chapter.

League finances are just as important as the tracking the scores and league standings.
BLS-2021 provides a treasurer module that can be accessed as a stand alone utility
that can be utilized by a league treasurer, without the need to enter scores. Additionally,
the treasure module can be integrated with the weekly duties of the league secretaries
that also perform treasurer duties. Once configured, the amount of additional time to
enter weekly fees for a secretaryis minimal.

There are four primary sections in BLS-2021 to successfully utilize treasure functions of
the program:

1. Defining Weekly Fees: Configure how much a bowler will pay each week, final
week's payment and additional fees. Additional treasurer configurations:

2. Enter Weekly Bowling Fees: Provides an interface to enter the weekly funds

3. Certification Membership Fees: BLS-2021 can be used to track bowler
membership fees to be paid when submitting the application. Due to the importance
of league and bowler certification, this function is discussed on page|1_56'ﬁ.

4. Prize Fund: Configure the prize fund and assign winners.

Fees: Define the Weekly League Fees

Financial Setup:
To begin setting up the league’s finances click on Setup > Fees > Weekly Fees.
Managing the Finances of Multiple Leagues

Ifusing BLS-2021 to manage multiple leagues with the same financial setup, or just for
the sake of consistency, the financial setup can be saved as a file that can be loaded at
a later time. This will save all the settings in the financial setup, including the Regular
Fees, Discounts, and One Time Fees. To do this select the Save Weekly Fees button
and select a name and location to save the information. To restore a saved fee settings
file, select the Load Weekly Fees button in the top menu bar.

The financial setup is organized with the tabs that are arranged in a logical sequence
and are listed below:

Regular Fees

Each week, a bowler pays a regular fee thatis divided into specific funds, such as
Lineage, Secretary Fee, Prize Fund, etc. Fees in the white cells can be changed or
removed. Enter the amounts in the columns under Regular Fee, Absent Fee, Vacant Fee
and Substitute fee as appropriate for the league.

In addition, four individual User Fees can be configured for different categories a league
may collect money for on a weekly basis. These additional fee categories do not need to
be part of the weekly fees, but by renaming the user fee on this screen, these additional
funds can be itemized in a financial report.
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Note: The General Funds line item is a categoryused by BLS-2021 to hold pre-
payments and to account for arrears. It is not recommended to allocate any of the Total
Weekly Fees to this line item.

There are multiple fee categories based on the type of overall weekly fee paid. For
example, centers may require the league to payreduced lineage for vacant positions. By
setting up a vacancy fee category, there would be one category for regular league
members and one for vacant bowlers. If the league requires subs to pay for lineage, but
not the prize fund, another fee categoryis used.

As the individual fees are entered, the total fee is calculated for the corresponding fee
type. BLS-2021 provides four fee types including regular dues, absent dues, vacant
dues, and substitute dues.

(3 Close 55 Print 7 Utilities | % Help
Weekly Fees and Discounts Setup
One Time Bowler Fees More i i Budget
Regular Fees Discounts Last Weeks Fee Options One Time Team Fees
Regular Weekly Fees Setup
€ 1 &
Account ltem Regular = Absemt  Vacant  Substitute
Fee Fee Fee Fee Changing this table now will change the
ot L fees for week 1 only. Future weeks will
Lingage 58.00 | | 800 remain at what they are currently.
Secretary Fee $0.50 5050
Prize Fund 51.50 $1.50

1
3

3

4 Trophy Fund

BN Treavuer Fon Automatically Fill Payments For:
6 Service Fee
7

8

9

Banauet Fund I | | Regular Fees: Fill
User Fee #1

User Fee #2 | Absent Fees: Fill
10 |User Fee #£3
11 User Fee #4 Vacant Fees: Fill
12 General Funds

Substitute Fees: | Fill
The General Funds line item is used by the program
to hold pre-payments and to account for arrears.

Automatically Fill Payments For: These switches are provided to expedite the process if
entering fees. When toggled to Yes, the program will automatically enter the fees as
being paid in full, including any arrears. If the bowler does not pay, or is absent, the
amount paid can be removed.
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Discounts

Weekly & One Time Fees *

(3 Close 5% Print 5 Utilities I Help
Weekly Fees and Discounts Setup
One Time Bowler Fees More Information Estimated Budget
Regular Fees Discounts Last Weeks Fee Options One Time Team Fees
Discount Amounts by Bowler Type
Chil .
fouomtian ;;:u,:“ m,c::,“ 3“,_’;',;",,‘,.* D’y':;m w:;"m Discounts show the amount
Total Discont that will be subtracted from
Regular Bowler fees. This
1 L
2 g::,x,\, Fee adjustment will also be
3 |Prize Fund applied to absent and
4 | Trophy Fund substitute bowlers.
5 | Treasurer Fee
6 | Service Fee
7 |Banquet Fund
8 | UserFee #1
9 |User Fee #2
10 | User Fee #3
11 | User Fee #4
12 | General Funds
Discount with Fee With With With With with
Type of Senior Child  Employee Discount Discount
Discount Discount Discount  #1 22
1 [ReqularFee$1000__ |  $1000) $1000]  $1000  $1000  $10.00
2 AbsentFee §2.00 $2.00 $2000  $200,  $200
3  |Vacant Fee
4 |Substitute Fee 88,00 $8.00 $8.00 $8.00,  88.00

BLS-2021 has the ability to setup discounts. This may be helpful if not all of the bowlers
in the league pay the same regular fee. For example, if running an adult/youth mixed
league where the younger bowlers pay different fees than the adults, a child discount
can be created that would be applied to specified bowlers. To do this, simply enter the
amount discounted from each individual fee in the Child column and the overall discount
is automatically totaled at the top of the column.

Once a discountis setup, the table at the bottom of the page shows amount due for
each fee type when discounts are applied.

When using discounts, use the first letter or the number of the discount type. The valid
codes will be S (Senior), C (Child), E (Employee), 1 (Custom Discount 1), and 2 (Custom
Discount 2) corresponding to the discount type.
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One Time Fees
These screens are used to define one time fees. Itis simple to use and allows for:

Weekly & One Time Fees =%

(7 Close 5 Print 7 Utilities 5 Help

Weekly Fees and Discounts Setup

Regular Fees Discounts Last Weeks Fee Options One Time Team Fees
One Time Bowler Fees More Information Estimated Budget

One Time Bowler Fees

Description Total MNumber DueBy DueByDate Payment Funds Fees Will Go Into
Amount Weeks Week # Required
1  Final 2 Weeks $20.00 ] 6 9/20/2019 Y
2 | Bir Fee #1
3 |BirFee #2
4 BirFee #3

One Time Bowler Fee Report Headings
Blr Fee #1 Blr Fee #2 Bl Fee 3
Line #1 Eowler Bowler Bowler

Line #2 Feel Fee2 Feed

™ Restore Defaults

¢ One time team fees: Team Sponsor Fee and up to 3 user-defined fees
e One time bowler fees: Last Two Weeks and up to 3 user-defined fees
To setup a one time bowler or team fee, do the following:

Change the description to something meaningful to the league
Indicate the amount

Configure when the fee is due

Whether paymentis required by all bowlers

5. Identify which fund the monies should be deposited into

BN~

If a fee was due by the end of the season, then leave the due date column blank. If there
was no destination fund specified for the fee it will be placed into General Funds.

Several leagues require the final couple weeks of bowling to be prepaid when a bowler
begins the season. Indicate how many weeks must be prepaid and when it mustbe
prepaid by. If this is not enforced for all bowlers, simplyindicate that this is optional.
Each bowler can then be marked as having to prepay. Setting up a team sponsor fee is
very similar, just indicate the amount, when itis due, whether the paymentis required,
and what fund the team sponsor fee will be deposited into.

Last Week Options

This tab provides the option for the last week(s) of the league.

If the league is having a Roll Off the last week of the league and the center is not
charging for it, then set this option to Yes. This can be used to setlimit the actual
number of weeks that will require payment.
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L Weekly & One Time Fees

(73 Close 5 Print i Utitities L Help

Weekly Fees and Discounts Setup

One Time Bowler Fees More Information Estimated Budget
Regular Fees Discounts Last Weeks Fee Options One Time Team Fees

Last Weeks Fees are Pre-Paid: | Yes -
Feeis forthelast | 2 - |- weeks of the League.

Fee is due by week 6 -|- (date) 9/20/2019

Last Week of League is Free (Roll Off): -*ﬂ;‘"‘

Payments caver from Week 28

More Information
This screen allows for some additional settings.

If the league has a grace period before it begins charging for vacancies on teams, it can
be set here. Bowlers paying the vacant fee type will not be charged for the first number of
weeks thatis entered here. For example, the bowling center does not charge the league
for the first 2 weeks for vacancies on teams. Entering the number 2 here sets this
appropriately. If a vacancy or a bowler is charged the vacant fee in the first 2 weeks of the
league, there will be no amount due. In the third week if a bowler or vacancyis charged
the vacant fee the amount due will be whatever is defined for the vacant fee in the
Regular Fees screen of the Weekly Fees and Discounts Setup.

Weekly payments will be recorded:
This section provides 3 options for how weekly fees will be tracked:

As a team only: This option can be used to track team payments without having to track
individual bowler's payments.

As individuals on a team: This option is configured by default since itis the most
common method used byleague secretaries and treasurers. It allows individual bowler
payments to be tracked, which, in turn, provides the overall payment made by the team.

As Individuals Only: This option can be used to track payments made by individuals
without concern for team payment. This feature is only available in the Pro and A/S
Editions of BLS-2021.

Estimated Budget

This screen displays the estimated budget broken down by the amounts estimated to be
collected for each fund. The estimation is purely a calculation of the expected income
based on: one time bowler fees, one time team fees, the number of weeks, number of
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teams, the number of bowlers per team and the cost of the Regular Fee type. Once the
fees have been set these estimations are derived. The adjusted budget column can be
used to adjust the estimated numbers as needed.

In addition, if the league has a BYE team, the Number of Teams can be modified to take
this into consideration and adjust the Estimated Budget accordingly.

Note: Numbers on the screen are an estimate and will not take into account variances
caused by bowlers with discounts or paying anything but the regular fee type determined
in the Regular Fees screen. If the number of teams, number of bowlers per team, or the
number of weeks changes, so will the estimated budget values. General Funds are the
monies notassigned to any specific fund.

Weekly & One Time Fees =%

(3 Close S Print 7 Utilities 2% Help

Weekly Fees and Discounts Setup

Regular Fees Discounts Last Weeks Fee Options One Time Team Fees
One Time Bowler Fees More Information Estimated Budget
Estimated Income
These figures are estimates to help you plan your league's finances.

Reset

Line Item Reg Fee X Num of X Num of X Birs on One-Time One-Time Expected Adjusted
Weeks Teams Team TmFees BirFees Income Budget
Total Collected $10.00 23 4 4 §4480.00 §4480.00
1 | Lineage $8.00 28 4 4 $3564.00 $3584.00
2 | Secretary Fee 050 B 4 4 522400 822400
3 | Frize Fund §150 = 4 4 567200 567200
4  Trophy Fund
§  Treasurer Fee
6 Setvice Fee
7  Banquet Fund
B User Fee #1
9 User Fee #2
10 User Fee 83
11 User Fee #4
12 General Funds
13| Other Income
Total Income $4480.00 5443000

The Prize Fund Setup button will open the screen where the prize fund breakdown is
determined. More information on this screen is provided in the Awards: League Awards
& Prize Fund section on page[29.

Enter Weekly Bowling Fees
Weekly > Process This Week > Bowling Fees

When entering this section for the first time, the Weekly Fees Display Options dialog will
appear. The Drop-down list provides an additional method for configuring which fees
are to be tracked, Team, Individual or Both. These options were previously defined in the
section on Defining The Weekly Fees on page/[z:2)

Itis veryimportant to decide which method to use when setting up the treasure for the
firsttime.

When tracking As Individuals on a Team or As Individuals Only, additional options can
be configured to change how bowler names are displayed on the primary Weekly Fee

screen.
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To begin entering paid fees, select the Weekly > Process This Week > Enter Weekly
Bowling Fees menu option. There are 7 tabs used to navigate through the required
screens to manage the duties of the treasurer.

Weekly Fees Tab

Select the Weekly Fees tab. In this screen there are buttons which will vary the
information displayed. Using these buttons a detailed weekly bowler payment record
can be displayed or an overall year to date bowler payment summary can be viewed.
There is also a button to change the view between regular fees and other fees such as
fines and one time fees.

Note: Onlyuse letter codes that correspond to payment types. These letters are R
(Regular), A (Absent), V (Vacant), and S (Substitute) to signify the first letter of each fee

type.

After entering the fee information for a team, use the Drop-Down List to select the next
team or use the keyboard keys "Page Down" to more to the next team or move back with
the "Page Up" key.

The columns displayed by the table in the Detail view will represent the settings
indicated in the Financial Setup.

To begin entering payments navigate to the correct week using the Drop-down list box
for selecting the week, and then navigate to the first team and begin transcribing the
team envelope payments into BLS-2021.

\-. Week 30f 28 - Sample League 19-20 — 7/17/2019

(7 Close of options | !yi!udnipq I Undo :l Reports 4 Other Screens ED Help

Weekly Fees | Fines | Payments | League Funds | Bank Ledger | Reports | Utilities
INDIVIDUAL PAYMENT RECORD FOR WEEK 3 ( Detail | Summary PayEnvelope Other Fees

Name B Owes Begin |Disc Code| Ama Ama Pme Check| FRe | Finai2 | Finai2 | Bir | Fine

Swumus Sanc  Balance Type Due Paid  Meth ¢ Balance  Wks Amt | Wks B2l Fine Balance

1  Emmerson Carmichael E]
2 Carlv Coreley
3 LonMead
4 Marianna Dodoe

TOTAL ALL BOWLERS

Team Payment Record

up Week | Dsteol  Amout Amout | Team | Team | Tewn Fine  Sanction  Erweiope
Bawling Due  Paid  Arrears Credits  Fined Balance Payment  Total

awn [B7isiz19_| s40.00, $40.00 $40.00, -

82202019 | $4000, $40.00 840,00

8/29/2019

9/5/2019

Actions

w
& D
@ SeeMe

Note: Data can only be entered one week in advance. Example: If the league file is
currentlyin week 2, BLS-2021 will only allow entering treasurer data for up to week 3.
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QuickPay
Itis common for everyone on a team to pay in full each night. The QuickPay option was
created to expedite entering the bowler payments. The quickpay button is found on the
top button bar. The screen shows each team and a checkbox. When a check is indicated
in the box, all arrears for normal weekly bowling fees and, and the current weekly bowler
fees will be marked as paid. For those teams that payin full each week the quickpay
eliminates some extra work by indicating all automatically that the teams have been
charged and paid in full.

Only bowlers with scores will be charged. If bowlers have no scores entered or the team
has not enough scores entered then the program will go from top to bottom in the pay
envelope list until as manybowlers as the playing strength have been charged.

Weekly Fee Discount Codes
Discounts can be entered for a bowler by entering in a discount code under the discount

type column Disc. Type. Entering one of the discount codes from the following table will
setthat bowler to be considered for that discount until such time as the discount type for
that bowler is changed. Example: In a youth/adult league a child pays the child
discounted regular fee. Aletter C would be entered into the Disc. Type and the letter R
would be entered into the fee column labeled Code. The Child discount type would be
carried through the season for every week as the season progressed until the discount
code is changed or removed.
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Code Feature Code Feature

S Senior discount type. 1 User defined #1 discount type.
C Child discount type. 2 User defined #2 discount type.
E Employee discount type.

Weekly Fee Payment Codes

Under the Code column, enter the appropriate fee letter code for each bowler on the
team to indicate the amount owed. Then enter the amount paid ifitis different than the
amount shown.

If only tracking payments by team and not by individual bowler, indicate what the team
has paid by entering the number of bowlers payments under the column of the

appropriate payment type.

Note: Entering a fee code will show the amount outstanding plus the amount owed for
that night of bowling as paid. If the amount paid is differentit must be adjusted to reflect
this or the results will be incorrect. The amount paid is filled automatically unless set
otherwise in Weekly Fees.

The following table shows the available fee codes:

Code Feature Code  Feature
T Each bowler (for the playing A Bowler marked as paid for the absent
strength of the team) has paid bowler fee.

in full, including outstanding

balances. This inputs only for

bowlers with scores input that

week, or who are marked as

Absent or Vacant if these S Bowler marked as paid for the
codes have a fee to pay. substitute bowler fee.
Substitutes will be charged

either as regulars or

substitutes.
R This bowler paid. This will Vv Bowler marked as paid for the vacancy
include unpaid balances. bowler fee.

Ahelp window is provided on the screen to provides hints. If a mistake was made
entering the fees, then correct it and all financial totals will be recalculated.

Payments Made
After the fee code has been entered, enter the amount of money paid by that bowler that

will be used toward weekly fees in the Amt Paid column. If the bowler prepaid for
additional weeks of bowling or for week’s owed, simply enter the entire amount of the
weekly fees being paid. BLS-2021 will appropriately credit the bowler’s account.

Leave the Amt Paid column blank when bowlers do not paying because of previous
credit balance or other reason.
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In the Pmt Meth column a method of payment can be set. There are four codes for
methods of payment: C, CC, CH, and O. These stand for cash, credit card, check, and
other respectively. The default payment type is cash, which will be displayed until
another type of payment is specified. If the payment type is setto CHa column will open
up to allow for a check number to be recorded.

Prepayment for Last Weeks of Bowling
BLS-2021 correctly handles final week’s prepayments. If the league requires the final
weeks to be prepaid and this has been setin the Weekly Fees and Discounts Setup >
One Time Fees, a column will be visible in the Detail and Summary views for the Weekly
Fees view. This column will be called Final n Weeks where "n" is the number of weeks
designated in Weekly Fees and Discounts Setup. To indicate a bowler has paid some
money towards this fee, insert amount paid by the bowler into the respective field.

If the final 2 weeks must be pre-paid by week 6, then a bowler has until week 6 to pay
that amount. When week 6 is reached, any player who has not fully paid the final 2
weeks will show an arrearage. A credit on weekly fees will not be applied to the final
week’s pre-payments. Also, a bowler does not have to pay the amount all at once. Partial
payments maybe made in any week.

Other Fees
. Week 3 of 28 — Sample League 19-20 — 7/17/2019
() Close " options "9 quickPay . 3 Reports A Other Screens ED Help
Team List: | 4 | 1-65500 e 2 — Week: | 4 Week3 SIE 2
Weekly Fees | Fines | Payments | League Funds | Bank Ledger | Reports | Utilities
BOWLER FINES & FEES FOR WEEK 3 Detail  Summary Pay Envelope |Other Fees'

Name Bir  Disc.| Bir  Fine | Fine Amat Fine Paid
St Type Fine Balance

[Emmerson Carmichael E ]
Carly Coreley

Lon Mead

Marianna Dodoe

FfeRre -

Team Payment Record

¥ Up Week Date of Team  Fine Fine Fine.
Bowling Fined Balance Ammt Paid

« Down
@ See Me

Actions

B |
8/22/2019
8/29/2019
9/5/2019

oo [~ on o e [ [pa =

Special Financial Situations
Here are some special situations and what to do:

Absent Bowlers

If a bowler is absent, still indicate the fee that the bowler is responsible for paying. If this
is not done, the totals for bowler fees will be wrong. Indicate the proper fee code and
leave the Amt Paid column blank (unless an arrangement was made to place the
player's moneyin the envelope that week).
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Absent bowler and substitute paid

If a substitute paid for a regular member, but will not be credited for the money paid, the
fee must be applied to the regular bowler. The sub and the regular member can work it
out between themselves. If the sub receives credit for the payment, the fee mustbe
applied to the substitute.

If both bowlers are indicated as owing fees for that week, it will cause one bowler to have
arrears and the other to have a credit.

Subs pay lineage, absent member pays rest

If the league allows this, two separate fee categories must be established aside from
the regular weekly fee. One categoryis set up with only the lineage. This will be the
sub’s fee code. The other fee categoryis set up with the remaining fees. This code is
used for the regular member when absent (with a sub).

When applying codes and fees, indicate sub fee code for the substitute and the amount
paid. Enter absentee (with a sub) fee code and leave amount paid as blank (unless an
arrangement was made to place player's moneyin the envelope that week).
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Abowler quits who has a credit

If a bowler quits and has a credit, remove the credit simply by entering a negative
amount for any of the fees for which the bowler has a credit: weekly fees, final weeks
pre-payments, special fees, banquet fees, etc. The pay envelope for that team might
actually show a negative total - which is OK.

Abowler quits who has arrears

It must be decided to whether those fees are to be paid. If they are to be paid, leave that
player on the team until they are paid. If the bowler had a week or two of arrears but had
already paid the final 2 weeks of bowling, put a negative amountin the final weeks’ pre-
payments (to erase that credit) then enter the amount of weekly fees required to clear the
arrears. Anything left over needs to be given back to the bowler.

Fines Tab
BLS-2021 has the ability to track fines. Use this screen to fine a bowler or a team.

Selecta team

Select to fine that team or a bowler on that team

Select the week of the fine

Select the Add New Fine button and a list of reasons for the fine will pop up
Select a reason then type in the amount of the fine

. Select Add Fine to add the fine.

Note: Abowler can be warned by assigning him/her a $0.00 fine.

oakwh =

At the bottom of the screen is a window labeled Fine Record. Adescription of fines for a
bowler or team is displayed, including the date of the fine, the week of bowling, the
reason, and the amount. This makes it easy to see whether or not a bowler/team has
been fined and the reason. Selecting the team and the bowler in the list of team
members will display a bowlers fines.

Fines can be edited or removed as well:

1. Select the fine to be edited or removed by selecting the team and bowler in question
2. Select the particular fine from the list below

3. Select Edit Fine or Remove Fine

Editing a fine is very similar to adding a fine, just follow the same procedure in the Edit
Fine button. Removing a fine will refund any money paid

Team Payment Summary Tab
View to see a summary of payments made by each team for each fee. The summary can
be viewed by Team or by Week.

League Funds Tab
League Funds

The League Funds tab is very comprehensive. Here is a list of things that can be done
within this tab:

e Gives a rundown of money collected for e Displays the quantity and type of fee
the week and for the year to date codes entered in the active week
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e Displays the adjusted budget and the e Displays the quantity of the various types
current bank balance. of discounts given during the active week.

There are buttons that accommodate deposits, withdrawal, transfer, bank adjustments
and lineage payments.

Money in General Funds reflects extra payments made by bowlers or money not paid. If
all bowlers paid exactly the amount owed each week, this balance in General Funds
would be $0.00.

Week 3 of 28 --- Sample League 19-20 — 7/18/2019

v
4 ick Pa X 5
(3 Close o opti ‘f!a ay Und _jﬂanls A Other Screens ED Help
Team List: 1-GS500 : Week: | & | Week 2 SiE
Weekly Fees | Fines | Payments = League Funds | Bank Ledger | Reports | Utilities
LEAGUE FUNDS as of 8/26/2016
Noel Total 126/21
Line Item Budgeted  Credit Debit Total Credit Debit Total Current | This Week, there were:
Change Change | Funds Deposit
] ssssooo]| s1sa00 so00] s15800| saveoo| $000) sasoo|| saipo |5 Regularbowlers
+ + 1 Absent bowlers
s000,  s000 sooo  sopol  sooo)  sooo| sooo |  s0.00 Withdrawal
1 358400 §12800] S0.00/ 12800 S256.00) 5000 5256.00 525600 1 Substitute bowlers
2 §22400  5800) 5000/  S800) 51600 5000/ §16.00)  $16.00
3 867200  §24.00 $0.00 $24.00 $48.00 $0.00. $48.00 $48.00 dinasfec
4 Trophy Fund $0.00] 5000 5000  $0.00/ s000/ $000) $0.00 50.00
5 Treasurer Fee $000,  $000| 5000,  $0.00) S0.00)  S0.00,  §0.00 50.00
& Service Fee s00o)  s000) soo0  soooll  sooo|  soo0l 000 50.00
just Bank
7 Banquet Fund s000)  000| Soon  soo00| Sooo| $000] $000 $0.00 Adiistha
8 UserFee 71 $000]  S000| 5000,  S0.00/ S000) S000 S0.00|  §0.00
9 User Fee #2 50.00 §0.00 $0.00 §0.00 50,00 $0.00 §0.00 $0.00
10 User Fee £3 5000 5000 000,  S000/  S000) 5000  50.00 50.00 PayLi
11 User Fea 74 soo0!  Somo| Sooo]  $000| $000,  $000| §0.00 5000 ay Lineage
12 General Funds $000/ $200) S000  §200/ $200) 000 §-200 $2.00
13 Other Income s000,  s000) S0.00  so0o so00| S000) $0.00 50.00
14 Final 2 Weeks fund soool  soo0] sooo,  Sooo|| sooo| soo0) 000 $0.00
Total Credils/Debits S4480.00[ $158.00] 5000/ S$158.00) §398.00) 5000 31800 531800
This Week's Net Deposit: | 513800 Current Bank Balance: 5§312.00
.
Deposits

This function is used to make a depositinto a fund for money thatis not accounted in the
payments made in weekly fees. To use this screen do the following:

1. Selecta fund to deposit to.

2. Enter an amountto deposit.

3. Selectthe date the transaction took place.

4. Click Accept button: a note appears in the boxto show what has been done. Multiple
deposits can be entered.

Select the close button and the deposits will be saved.

6. View the Transaction Summary screen to verify the deposits that have been made.

Withdrawal
This function is used to make a withdrawal from a fund for money. To use this screen do
the following:

o

1. Selecta fund to withdrawal from.
2. Entered an amount to withdrawal.
3. Select the date the transaction took place.
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4. Click Accept button: a note appears in the boxto show what has been done. Multiple
withdrawals can be made.

5. Selectthe close button and the withdrawal will be saved.

6. View the Transaction Summary screen to verify the withdrawals that have been
made.

Transfer
This screen is similar to both the Deposit and Withdrawal screens butis used to

transfer money between funds. To make a transfer do the following:
1. Selecta fund to transfer from by selecting a checkbox

2. Enter the amountto be transferred

3. Selecta checkboxfor the fund to transfer to

Note: While this screen, unlike the Deposit and Withdrawal screens, can only make one
transfer, itis possible to make a transfer from multiple funds to a single fund. Example:
Atransfer can be made from lineage and from the secretary fund to the treasurer fund.

Adjust Bank
This screen is used to make adjustments to the various funds as necessary.
1. Selectthe fund to adjust then type in an amount.
2. To decrease a particular fund, put a minus sign (-) in front of the amount of the
adjustment.

Pay Lineage
This button will deduct lineage from the lineage fund for the amount of lineage to be paid
to the center that week. This value is calculated based on the total of bowlers with fee
codes entered less their discounts, if any.

This screen will also show how much lineage has been paid during the current week as
well as how much has been paid for the whole season.

If there appears to be a discrepancy between the calculated amount and the amount
actually paid to the house, debit only the actual amount paid to the house.

Note: It is best to wait until all bowlers' payments have been entered before using this
function to adjust the lineage fund.

Bank Ledger Tab

The Bank Ledger is a summary of all transactions made. There are various Sort Options
buttons as well as a Drop-down list that can be used to display only transactions for a
specific week, date or type depending on the Sort method selected.

Treasurer Duties m



\-. Week 30f 28 - Sample League 19-20 — 7/21/2019

(3 Close o’ Option 5 quickpey 3 | o] Reporte | G OtherScreens ED Help
Team List: G550 : Week:
Weekly Fees | Fines | Payments | League Funds Bank Ledger Reports | Utilities
Income & Expenses Summary
Sorted by: Date Week Type Show Only:  Currently Selected Week
F Date ‘wmk |Descnpuon |Transac-|nnType |Payments | Income Interest/ ‘
No | Adjustment Deposit
1 B/19/2016 WkD1 Weekly Fees Received Weekly Fee §160.00
2 B/26/2016 WkO2 Weekly Fees Received Weelkly Fee $158.00 _
Withdrawal
Transfer
Adjust Bank
Pay Certifications
Line Note:

On this screen are the buttons:

o Deposit o Transfer
+ Withdrawal o Adjust Bank
¢ Pay Certifications o Delete

There is also a window which displays any notes attached to a specified transaction. For
example, a deposit would have a line note describing the deposit byamountand
destination of the deposit.

Deleting items
If a mistake is made, delete transactions is used. Deposits, withdrawals, transfers,
adjustments made from League Funds or Bank Ledger sections can be deleted. In
addition, Lineage Fees and Certification Payments may be deleted.

ltems that cannot be deleted include Weekly Fees and Certification Collected
transactions is sources of Income. To remove or modify these items, go to the section
where the Income was entered and make the changes from there.

To delete a transaction, simply highlight the specific record of the transaction and select
the Delete button.

Certification Payments
Selecting the Pay Certifications button will bring up the screen to pay out from the

certification fees fund.
To use this screen do the following:
1. Type in the amount that has been paid if the amount shown is not correct
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2. Selectthe Pay or the Pay and Close button (if finished entering payments.)

Treasurer Reports Tab
After team rosters are verified, bowling scores entered, and treasurer details complete,
this screen prints necessary treasuryreports.

Week 3 of 28 —— Sample League 19-20 — 7/21/2019

- -
» -
Team List: | 4 | 1-6S500 : /| Week: | 4 Week3 I8 2
Weekly Fees | Fines | Payments | League Funds | Bank Ledger Reports | Utilities

Treasury and Financial Reports

1 Worksheet " Print Options

3 Team Pay Envelope Yes Pay Envelope Summary

4 Amears Report

5 Bowler Financial History Repert Yes -wmt, Cash Recuipts

6 Payment Record

7 Bank Deposit Yes League Funds Summary
Fonts & Yes -Tum Pay Envelopes
Graphics

@5 Print Selected
Report

To print financial reports, select the list and any appropriate options displayed, then click
on the Print Selected Report button.

This Week's Worksheet

Selecting this option will generate a report for all bowlers listed by teams. After the
treasury data for the week has been entered use this function to view an overall
summary of what was collected from bowlers, and whatis outstanding.

Next Week’s Worksheet

This worksheet is helpful for next week's bowling. Itis intended to provide an organized
form to log money received from bowlers.

Print Treasurer’s Report

The treasurer’s reportis the comprehensive report of what transpired with the league’s
finances for the specified bowling week.

Print Team Pay Envelope

Team pay envelope report prints separate pages for each team showing what was paid
and owed for each bowler for that week.

Print Bowlers Arrears - Teams

Printing the bowler’s arrears will show who owes, how much, and is separated by what
team theyare on.

Print Team Arrears

Printing team arrears will display which teams have bowlers in arrears and how much
the team owes in arrears.

Treasurer Duties ﬁ



Treasurer Utilities Tab
This screen allows for the recalculation of league funds if they appear incorrect or there
have been changes to the fees.

\. Week30f 28 — Sample League 19-20 — 7/22/2019

= [
Team List: 1 ) : Week: | 4 | Week3 /|
Weekly Fees | Fines | Payments | League Funds | Bank Ledger | Reports  Utilities

Recalculate League Funds and Treasurer Utilities

If your League Funds seem to If you are in need of reseting
be off or if you made a change part or all of your Weekly Fees
to your fees, use this button. information.

Reset Fees Information
Clear Treasury info for -l'*,““
Week 4 and later.
Completely Reset -ww"f
Treasurer:

j Recalculate League Funds

Recalculate
League Funds for
Week 3

Recalculate League Funds

Every time Weekly Fees are changed for any given week, by adding, removing or
modifying payment information, a new transaction is added to the Bank Ledger. To
consolidate these multiple transactions into a single one, use the Recalculate League
Funds option. If there is a discrepancy in bowlers counted for purposes of lineage or
perhaps amount of money collected based on number of fee codes entered, this button
will tabulate all bowler payment records for the week selected.

Reset Fees Information

This section provides a method to reset the treasurer information for the entire season
or for future weeks based on the week selected in the upper right corner of the screen.

Additional Treasurer Functions
The following represents additional utilities or functions available for the treasurer:

« Setup > Fees > Bank Account Information: This option opens to the Important
Contacts page on the Bowler Maintenance screen so that the Bank Information can
be entered.

¢ Reports > Weekly > Finances: Generates a weekly financial report.

o Utilities > Treasurer > Erase ALL Financial Data: Allows treasurer to completely
erase fees entered so data can be re-entered.

o Setup > Passwords > Treasurer: This feature is only available in BLS-2021 Pro and
A/S Editions. For privacy, this function can be important when exchanging data with the
center or other people running BLS.

o Utilities > Treasurer > Unlock Treasurer Information: This options is provided for
customers running BLS-2021 Standard Edition that need access to password
protected treasury information.

Note: When a password is entered to access the treasurer information, it will not need to
be re-entered until the league file is closed.
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Awards

A major part of bowling are the improvements of a bowler’s skill and average. In order to
reward bowlers for reaching these goals, national, state and local associations as well
as bowling centers offer award recognition programs. Awards are based on game and
series achievements, as well as special occurrences, such as split conversions, clean
games, etc.

In addition, mostleagues offer League Awards for Individual and/or Team high score
achievements, high average as well as prizes for team place and championship and
point money. After all, these achievements are what the Prize Fund is for.

Awards: Local & bowling center awards
Local, State and Bowling Center awards can be configured by going to Setup > Awards
> Local & Center.

() close 3 unilities ED Help
USBC Awards USBC Sport Awards CTF: Canadian Tenpin USBC Team Awards TNBA Awards
Local Assoc. Awards State Assoc. Awards Bowling Center Awards SCc usec

Enter the name of the award group here

d- 275 Game

Local Assoc. Awards

SeG Award Applies To

rd- Game = (& Men Boys

Frequency: |Once per season oy S

on: Score between a range
5 to: |Any eligible score this week

morethan|0 | |[Current Age
re than 209 |

r || can use book average if less

be equal to of below [300

Awards in This Group

Pre-bowl and Make-Up scores may eam this award | Yes -

34 Add Remove
Award Award

BLS-2021 contains a powerful and customizable awards system used to detect
national, state and local awards as well as items that should be included in press
releases.

National association awards from USBC, CTF and TNBA are pre-programmed,
eliminating the need to set up national awards. These awards are printed using built-in
forms provided by USBC. CTF: Canadian Tenpin and TNBA awards are also pre-
programmed.

Note: USBC, USBC Sport, CTF and TNBA awards can not be modified, nor can they be
extended for additional awards. If the league is not using the award from USBC, they will
need to be processed manually or setup using one of the customizable options.
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BLS-2021 provides several user defined award groups if the league belongs to a
different national association or has state, local association or in-center awards. These
award groups can also be used if the bowling center offers its own awards program.

Viewing available awards: Click Setup > Awards > Local Awards.

Each association is designated to a specific award group and each award group has a
tab with its name on it. There are five tabs dedicated to the National Certification
Organizations, USBC, USBC Sport, CTF: Canadian Tenpin, USBC Team and TNBA.
These awards are defined by the National Organizations and cannot be modified.

In addition, there are four tabs available to configure custom awards. These tabs are
initially labeled Bowling Center Awards, Local Assoc. Awards, State Assoc. Awards
and Other Awards.

To view awards that are available for a specific award group, simply click that award
group's tab. Awards that have been set up for this award group will be displayed in the
Awards in This Group list box. To view a definition of a specific award in this group, click
the award name in the Awards in This Group list box.

Note: The Other Association tab is a special tab to be used for leagues that are
sanctioned/certified through an organization other than USBC or CTF. These awards are
only available when Other Organization is configured under Setup > League > Rules >
League Features > Will be sanctioned in...

Adding an award
There are several methods to add an award(s).

Adding an award manually: Click the award group that the new award will belong to and
click Add Award. Anew award will appear in the Awards in This Group list boxnames
Undefined Award. The first step is to enter the description of the award.

1. Defining an award: Once the award has been added, the next step would be to
define the parameters of the award. Each award has some basic definitions to
determine who qualifies for the award, the type of award and the frequency that it can
be earned. Awards should be defined in the following order:

a. Association required: From the Drop-down list, select the association thatis
required to qualify for this award.

Award applies to: Select the genders that qualify for award.

Type of Award: Select the type of award from the Drop-down list.

Frequency: Select the frequency that the award can be earned.

Finally set up the rules required to qualify for this award. The rules will vary based

on the type of award.

©ao o

2. Miscellaneous award type: This is used when an award cannot be detected by a
specific game or series score. Splits and clean game awards, for example, cannot
be detected. In the Award Categorylist, select the appropriate description for this
award. If the award categoryis a split or spare, a pin display will be shown. Click the
pins to highlight which pins are needed.

3. Game or series award types: This type is used when an award is based on a score.
From the Award is based on list, select from:

a. Single exact score - Score must meet or exceed the specified score.
b. Score between arange - Score must fall between the specified scores.

Awards 247



c. Pins over average - Score must be the specified range of pins higher than the
bowler's average.

d. Next, specify which scores the award applies to. (This option is not available for
single exact scores). Enter anyrequirements for age, average and games bowled
to qualify for this award. Finally enter the score(s) or range of pins needed to
qualify for this award.

4. Triplicate or Stepladder award type: This award type is used when a bowler's
scores are the same for each game, or the scores fall in a stepladder pattern of
equal increments.

a. Enter anyrequirements for age, average and games bowled to qualify for this
award.

e For the Triplicate Award, the Minimum and Maximum Increments must remain at
zero (0).

5. For the Stepladder Award, change the Minimum and Maximum Increments to
indicate the values for which the award will be earned. For example, setting the
Minimum Incrementto 1 and the Maximum increment to 10 will detect any scores
that progress by one pin (e.g. 200, 201, 202) up to scores progressing by 10 pins
(e.g. 200, 210, 220) including all values in between. For reverse stepladder awards
(202, 201, 200), set the Minimum Increment to a negative number.

a. Enter minimum score needed to qualify for the award. If a step ladder award,
enter increments the scores must follow.

Progressive award type: Used when an award is based on a bowler’s score falling
within an average class. For example, a progress award is given for a 600 series when
an average is 150 or less, 650 series when an average is 165 or less, etc.

a. Enter anyrequirements for age and games bowled to qualify for this award.
Finally enter the pairings of award score and maximum average allowed to earn
the award.

Note: Setting age restrictions for any award will require that birthdays are entered for
each bowler. Bowlers that do not have birthdays configured will not be eligible for these
awards.

To automatically add the USBC Awards, Obsolete Awards, Old USBC Youth Awards
click the Local Association tab, then click the Utilities menu. Select which awards to add.
Answer the warning message accordingly.

Modifying an award

To modify an award, click the award group and select the award in the Awards in This
Group listbox. The settings or name for this award can now be changed.

Removing an award

To remove an award, click the award group that the award belongs to and select the
award in the Awards in This Group list box. Click Remove Award. The award will then
be deleted from this group.

Previously Earned Awards
BLS-2021 can flag awards previously earned, whether from a summer league extended
beyond Aug 1, or from a different league. To configure an previously earned award, go to
Setup > Awards > Previously Earned.
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To assign previously earned awards, select the team the bowler is on, the bowler's
name, the Award Group, then finally "Assign this award to Selected Bowler".

Awards: League Awards & Prize Fund
The Prize Fund Setup feature can be opened from several locations. The Prize Fund can
be configured by clicking Setup > Awards > League and Prize Fund.

The Prize Fund Setup is where the budget for each trophy and cash prize is established.
The number of prizes the league distributes or the amount per prize may be unknown
until your prize fund committee meets. Once the league prizes have been determined,
return to this screen and enter that information. This screen will show the details of the
total amount budgeted for trophies and cash prizes.

NOTE: The League Awards & Prize Fund feature can be used for the league even if BLS
is not being used for treasurer duties.

The Prize Setup is used to indicate prizes awarded for high game, series and/or bonus
point monies. This section is divided into 3 tabs, Setup, Details and Winners.

League Prizes setup
This screen establishes how many places to assign different league awards.

Adding a prize: To add a prize, such as a High Scratch Game, click | Want A New Prize.
From the Prize is for: Drop-down list, select the predefined prize or Custom Prize. The
list of league awards listed in the Drop-down listis based on which prizes or
recognition are configured in the Rules. If an award is notlisted (high game, high series,
etc...), verify the league is configured to recognize these awards by going to the rules
listed under Setup > League > Rules > Special Recognition described on page|[ 33

After selecting the prize to be configured, enter the number of places paid and then
indicate if the award is a season or splitaward. If the league is configured for bowler or
team divisions, use the Division Drop-down list to identify the division for the award. In
addition, for Mixed Leagues, use the Sex Drop-down to identify if the award is for Men,
Women or Anyone. Click Add Prize to add the award to the list of prizes.

Note: The Add Prize button will be unavailable until all the options have been configured.

Deleting a prize: Place the cursor in the prize to be removed and click Delete Selected
Prize.

Awards m



i Prize Setup -- Sample League 19-20

¢ ]
{3 Close 55 Print

Setup Details Winners

- | Want A New Prize

Prize Description
Prize is for: | Team Place {Standing) %! Time Frame Split 1

: Team
Prize Description: Team Place (Standing Event

Number of Places:| 4

< Delete Selected Prize
Prize Description Time Frame Event Type MNum Sex Trophy § | Cash Total
Places Total

1 TeamPlace (Standing  Split Team Team Place (Standing) 4 [ 1 s300.00
2 Team Place (Standing Split 2 Team Team Place (Standing) 4 $300.00
3 |individual Handicap Game  Season individual  |Individual Handicap Ga. 1/Boys $5.00
4 |Individual Handicap Game  Season Individual  |Individual Handicap Ga 1 Girls $5.00
5 |Individual Handicap Serie  Season Individual Individual Handicap Se 1 Women $6.00
& Individual Handicap Serie  Season Individual Individual Handicap Se 1 Men $6.00

Modifying and existing prize: Once a prize has been created, the onlyfields that can be
modified are the amount of money allocated to the Trophy and Cash payout.

League Prizes detail
This screen assigns payout amounts and winners to each award.

Prize and Trophy Funds Total: This section will display the amount of money allocated
to the Prize Fund and Trophy Fund. The Estimated funds are based on the original
budget created when Weekly Fees were originally configured. The value represents the
Number of Weeks X Number of Teams XBowlers on Team X Weekly Prize Fund per
bowler. The Actual funds represent the true amount of money received for the Prize
Fund; up to the current date. If not tracking finances, these fields will be blank. However,
the Estimated Prize Fund and Trophy Fund values can be modified. As such, even when
not using the Treasurer module in BLS-2021, the Prize Fund can be configured.

Assigning Prize Amounts: Enter the amount of money in the Cash Prize Amt column to
allocate to the first prize on the list, and enter Trophy Budget (if any). If awarding
trophies, enter Yunder S, T and/or B to identify the trophies to be awarded to the
Sponsor, Team and/or Bowler, respectively. If the prize amounts are not known, leave
this section blank and return at a later date.

Assigning Winners to Prizes: Click the Assign Prizes button to have BLS-2021 detect
and assign the prizes. This will need to be done after the last week where scores count
is bowled.
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Prize Setup -- Sample League 19-20

(3 Close i Utilities

Setup Details Winners
Assign Prizes Prize and Trophy Funds Total
Available Prizes Dejate This Blacs, Prize Fund: Trophy Fund: llbll:claled. :::“;::”'“9
All Prizes . Add One Place Estimated $672.00 | 4 = $672.00
i P Actual $48.00 + = §672.00 $-624.00

Currently Selected Prize:

Team Place (Standing-- Place #1

Prize Description Spiit Division/Sex Prize | S T B | Trop  Trophy CashPrize WinnerID WinnerName | 1c 5c 10¢ 25¢ S0c 81 §5 8§10
Ko, Place Cni Budget Amt
1 Team Place (Standing st 1 [ 1 s15000 4 8 4 .
2 Team Place (Standing st 2 $100.00 | 4
3 Team Place (Standing 15t 3 $50.00 4 8
4 Team Place (Standing 15t 4 $25.00 4 4 4
5 Team Place (Standing 2nd 1 $150.00 4 3 4
&  Team Place (Standing 2nd 2 $100.00 4
7 Team Place (Standing ond 3 $50.00° 4 38
8 Team Place (Standing 2nd 4 $25.00 4 4 4
9 Individual Handicap Game Year Boys 1 §5.00
10 Individual Handicap Game Year Girls 1 §5.00
11 Individual Handicap Serie Year Women 1 [ $6.00 K
12 Individual Handicap Serie Year Men 1 $6.00 | K
< >
Assigning Point Money:

After the individual and team prizes have been defined and all other fees have been
deducted, then the point money can be calculated

Most leagues give money per point, won at the end of the season. BLS-2021 has a
Point Money Calculator to generate some calculated numbers based on total un-
allotted prize fund, teams and weeks in the league, and points won in a night.

Point moneyis defined as an additional prize for each place. So if a team gets bonus
money for 1st place, then there would be a prize for 1st place and then a second prize
assigned to the team for Team Points.

These numbers are just guidelines. Input the numbers that reflect the correct values to
calculate the point money.

This should be done at the end of a season or split when point moneyis awarded.

Click on Utilities at the top of the screen, select the Point Money Calculator option. This
can be used as a starting point to divide the remaining prize fund and the number of
teams based on number of points earned.

Click on View Team Winners to view the calculated earnings for point money. To assign
the point money as prizes, click Assign.

Money denominations: Use the scroll bar at the bottom of the screen to view the
denomination breakdown of how many specific bills ($100.00s, $50.00s, $20.00s, efc...)
are required for the prize payout. For Team Awards, BLS divides the Prize Amount by
team playing strength to determine money denominations. Use the 2nd Printer icon to

printthe Money Denomination Report.
Awards E




League Prize winners
Prize Winner List

To view a list of winners, select the Winners tab. The list of individuals and teams will be
shown along with the monies due. Areport can then be printed for distribution purposes.
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Internet and Email

Users with Internet connection can upload league standing sheets to a variety of web
sites, including LeagueSecretary.com, Bowl.com and SportBowling.com. BLS-2021\
provides the option to configure uploading to 2 separate personal web sites as well as
personal web page on AOL. Finally, the Auto Scoring edition of BLS-2021 allows BPAA
member bowling centers to upload standing sheets to the BPAA hosted website.

In addition, BLS-2021 provides email options to send email to any or all bowlers in the
league that have email addresses entered.

Internet Upload and E-Mail Settings

This section is used to configure the Internet settings. If not using the Internet features,
then leave this screen at the default settings. Outgoing email to the bowlers requires that
you have an email account on a server that accepts email via SMTP.

If you are not sure about your email settings, please contact your Internet Service
Provider or Network Administrator. While CDE Software can assistin entering the proper
information, we do not have access to the information needed to be entered.

This screen can be accessed by going to File > Program Preferences then click
Change Internet Upload & E-Mail Settings button. Additionally, this screen can be
accessed from the Web Uploads and Email & Labels screen discussed later in this
chapter.

Your Identity
Provide your First Name, Last Name and Email Address.
Your Email Server

This section is used to configure your E-mail settings. Email server settings are required
to utilize the E-mail features of the program, whether you are sending email to your
bowlers.

SMTP Server: This is the name of your Outgoing Email server. Contact your Internet
Service Provider for this Server Name.

User Name: The username used to login to your email account.
Password: The associated password to for your email account.

Login using User Name and Password: If your email server requires you log in with the
user name and password, select Yes.

Send Test Email: Click to have the program send a test email. If you do not receive an
email in the next few minutes, please check the settings and try again. Adjust some of
the Advanced Settings:

Advanced Settings

Use advanced settings to set SMTP Server Port: If the email server does not use the
default port of 25, then select YES and enter the port number of your SMTP server.
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Use SSL for sending email: Toggle this switch to Yes if the email server requires
Secure Socket Layer (SSL).

Use SMTP STARTTLS: Toggle this switch to Yes if your email server requires Transport
Layer Security (TLS).

Use advanced settings to set HTTP/FTP? If you are behind a proxy server, select yes
and enter the information provided by your network administrator. Normally this should
be setto No.

HTTP Proxy Server: Enter the name of the Proxy Server used to access most Internet
sites. This name will be provided by your network administrator.

FTP Proxy Server: Enter the name of the Proxy Server used to access FTP servers on
the Internet. Again, this name will be provided by your network administrator.

FTP using passive transfer mode: Sometimes uploading files mayfail unless passive
transfer is used. Leave settings at default values unless instructed to change by your
network administrator.

Web Uploads
Setup > Internet > Web Uploads

If the Web Uploads menu option is not available from the main screen, itis possible that
Internet features have been disabled for the league. Go to the Setup > League > Rules >
General Rules > League/ 20 Features (page[20)) section and verify the option to take
advantage of the Internetis Enabled.

Enablin load web si

When opening the Internet Uploads and Settings screen for the firsttime, the web site
configuration tabs at the bottom of the screen will be grayed out. To enable web uploads
to any given site, simply toggle the switch next to the name of the web site to Yes. This
will activate the associated TAB at the bottom of the screen so the upload settings for the
site can be configured.

Twitter: This feature is only available in the PRO and A/S Editions of BLS-2021. This
option allows the program to send a tweet message when the league has been
uploaded. To enable this feature, simply check Post to my Twitter Feed. When the
league is uploaded, a prompt will appear to log into Twitter to give permission for the
program to postto Twitter.

Note: CDE Software cannot guarantee the functionality of third party services like
Facebook and Twitter. Attimes, these services may make changes to their programing
which can affect the functionality of applications and websites that link to their services.

nfigure w i l in

To configure the settings to successfully upload to the web site, click the appropriate
TAB at the bottom of the screen. This will open a screen similar to the following:

NOTE: Configuration screens will vary depending on the web site being configured.

Use Proxy Settings: Select this option of the computer running BLS-2021 is on a
corporate style network with proxy servers for Internet access. When uploading through a

Internet and Email @




proxy server, the proxy server will need to be configured in BLS. For more information,
see Internet Upload and Email Settings on page[2sf

The Internet Uploads and Settings screen has a TAB providing brief instructions for
uploading to the various web sites. The following pages provide more details for
configuring each specific site.

LeagueSecretary.com

LeagueSecretary.com is the premier site for bowlers to view their standing sheets
online. Not only do they see a copy of the official standings, they have access to
interactive standings, bowler histories, statistics and other great features.

Another great benefit of using LeagueSecretary.com is that the last 2 weeks work of
league data is backed up on LeagueSecretary.com, so if a computer disaster happens
and have not been maintaining proper physical backups, there is a place to retrieve the
league data as far back as 2 weeks.

LeagueSecretary.com is available for both Certified USBC, CTF and TNBA leagues as
well as leagues that are either not certified or affiliated with other organizations.

To use LeagueSecretary.com is free and only requires that you have Internet access.

To setup the free LeagueSecretary.com account and register the league, do the
following:

1. Select Weekly > Web Uploads. From the Upload Tab, click Signup/Register League
with LeagueSecretary.com link in the LeagueSecretary.com tab.

2. Ifyou do not have an existing account, click on Register at the top of the web page.
Follow the instructions. Once registered, click on League administration and register
the league.

3. Complete the information.

4. Your accountand league will be readyto use now with BLS.

5. Ifyou are managing multiple leagues, then repeat the steps for each league you
manage.

6. Open the BLS-2021 league and click Setup > Internet > Web Uploads.

The league now configured to use LeagueSecretary.com. Follow the instructions on
Uploading Standings to send the league to LeagueSecretary.com each week.

LeagueSecretary.com Mobile Application

LeagueSecretary.com is the ONLY website that provides game by game analysis
information to bowlers when leagues are uploaded with BLS-2021.
LeagueSecretary.com features a mobile app that can be used to view standings and
bowler information.

Bowl.com
Bowl.com is the official site of USBC and provides the ability to view official standings on
their website.
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Note: If your league was uploaded to Bowl.com for the past season, USBC requires you
to update your league registration at the Bowl.com website in order to view this season's
standings. See Bowl.com's Leagues tab for detailed instructions.

Bowl.com is only available to USBC and USBC Sport leagues and requires that you have
your league certification number before signing your league up for this service.

Bowl.com is free, but requires that you have Internet access.

Because of the feature limitations of Bowl.com, you must sign up also for a free
LeagueSecretary.com account, so that your league backups can be maintained for
protection and that your bowlers can view interactive standings on LeagueSecretary.com
and then view static official standings on Bowl.com.

1. Ifthe league is not alreadyregistered on Bowl.com, visit hitp:/www.bowl.com and go
to Standings > League Standing Sheets.

2. Go to Leagues > Register Your League.

3. Complete the questionnaire to receive your Bowl.com Username and Password.
Please write these down in a safe place.

4. If managing multiple leagues, then repeat the previous two steps for each league

managed.

Open the BLS-2021 league and click Setup > Internet > Web Uploads.

Click YES for Bowl.com.

Click the Bowl.com TAB at the bottom of the page.

Enter the unique LeaguelD number assigned to that league.

. Enter your Bowl.com Password.

10. Click Save Settings.

© N3O

The league is now configured to use Bowl.com.

Personal Website 1,2 and 3

The official standing sheets can be transmitted to a personal or company website
providing that you have FTP access to upload the standings. Contact the Internet Service
Provider or Web Hosting company for the following information:

1. HostName to know what site to access for FTP. (Example - Host Name:
www.mysite.com)

2. User Name for the user account to sign in as.

Password to authenticate during sign in.

4. Path to upload the standings to. (Example - Upload Path: /webdocs/images) Note:
The use of the forward slash (/) in this example is necessary when the Web hostis
a Unixbased server. If the server hosting the web site is Windows based, use the
back slash (\)instead.

5. Open the BLS-2021 league and click Setup > Internet > Web Uploads.

6. For Personal Website 1 and/or Personal Website 2 and/or Personal Website 3,
toggle the switch to Yes.

7. Selectthe Personal Website 1 (or 2 or 3) tab at the bottom of the screen.

8. Enterthe FTP User name and Password assigned to you.

9. Enterthe FTP Host Name.

w
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10. Enter, if needed, the path to upload the standings.
11. Click Save Settings.

Follow the instructions on Uploading Standings to send the league to the site each
week.

BPAA Hosted Website

This feature is only available in the Automatic Scoring and Professional editions of BLS-
2021. Bowling Centers who are members of the BPAA (Bowling Proprietors' Association
of America) have the option to upload league standings to a web site hosted by the
BPAA. Centers can contact the BPAA about memberships and/or their Web Hosting

options at http:/www.bpaa.com.

For BPAAmember centers that have subscribed to the web hosting, configuring BLS-
2021 is pretty straight forward:

Open the BLS-2021 league and click Setup > Internet > Web Uploads

Click YES for BPAA Hosted Website.

Click the BPAA Hosted Site TAB at the bottom of the page.

Enter a unique file name for the league in the Custom League File Name field.
Enter the User Name and Password under Access Settings.

aoprobN=

Changing Web Standings View

To change the appearance of the standings sheets that appear online, simply make the
same adjustments like customizing the printed standing sheet, except select Web
Standings in the Standing Sheet Setup screen.

For further information on how to adjust the standings see Setup Your Standing Sheet
on page/ 12\,

Uploading Standings
After configuring the sites that the standings will be sent to, either click UPLOAD for the
specific site or click UPLOAD ALL to send to all the sites selected for upload.

Email
Tasks > Other > Email Bowlers

Selecting this option will bring up the Emails, Labels & Coupons interface.

Note: Be sure to set up Internet Settings with regards to email servers. For more
information on Internet Settings, please see Internet Setup topic.

This screen is similar to common emailing programs. To send an email to one or more
persons do the following:

Select which bowlers to email (use check boxes)

Type in email address the receiver can reply to

Type in a title in the text box labeled "Subject"

il e

Type a Message in the large message box
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5. Attach file (if needed) by selecting YES using the toggle switch and the at the bottom
of the screen, click Select Fle and the follow instructions to attach file

6. Click Send Email

Note: Email addresses must be entered in for bowlers in the Bowler Maintenance
screen in order to be able to send email to those bowlers.

Sending the standing sheet via Email

BLS-2021 features the option to attach the current weeks standing sheet to email to
selected bowlers. To email the standings:

1. Follow steps 1-4 from above.
2. Click Attach PDF of Standing Sheet.
3. Click Send Email.

Email Tech Support
Help > Support > Email Tech Support

If having questions on BLS-2021 or require the support staff to examine a league, select
this option to bring up a built-in support email form.

Using the wizard, click Next to continue.

Step 1: Enter your customer information so our support staff can locate your customer
information to respond to your request.

Step 2: Answer all the questions in this section. The more details provided, the better
chance CDE Software, LLC has an opportunity to resolve the problem in a timely
fashion.

Step 3: Enter the support question. Please see Getting Good Software Support on
pagelTea on how to make a good question to send our support staff.

Step 4: If sending a league file to support, click the Select League button. This will
perform a quick backup of the tournament.

Step 5: Click Here to Send Email to CDE. This final selection will generate the email and
send it to CDE Staff.

After the email has been transmitted, an automated message with a case number
assigned to your inquiry will be sent. CDE Software, LLC makes every effort to respond
to your supportinquiryin a very timely manner. During peak season (Augustand
September), please allow for additional time to respond to your inquiry as manyalso
request support at thattime.
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Backup/Restore and Transporting League Data
This chapter discusses protecting league data and making it available for transport to
another computer.

Depending on the size, creating a league in BLS-2021 can be verytime consuming and
can be veryfrustrating having to re-enter data. Backing up the league files after each
week is strongly recommended which is why itis included with the Weekly League
Duties. Additionally, BLS-2021 provides the ability to create several custom reports,
custom styles and different font sets. However, these items do not require frequent
backups, onlywhen they are changed. Sometimes things go wrong, through no fault of
the computer operator, and data can be lost. We know from years of customer service
experience that taking a few minutes to backup the data can prevent a whole lot of
headaches later.

In addition, backup files are very useful for transporting leagues between computers. In
fact, backups are the only supported method of accomplishing this task. This feature
allows for a league secretary to create a league and perform league maintenance on
their own copy of BLS-2021, then bring the league to the bowling center with BLS-2021
AS for the importing of scores on the day(s) of the league. More information on this
process later in this chapter.

Traditionally, backups have been performed by writing data to floppy disks for the added
security of keeping the data separate from the computer running the program. While
BLS-2021 does support this backup media, floppy drives are becoming obsolete
technology and most new computers do not even have them. Instead, itis
recommended backing up to alternative removable media such as USB memory sticks,
thumb drives, travel drives or various other memory cards (SD, Flash, etc.). There are
many inexpensive options for storing data away from the initial computer.

Even if removable media is not available, itis still veryimportant to have a backup of the
league. At the veryleast, BLS-2021 be configured to backup to the local hard drive. A
backup on the local drive is still better than no backup at all.

BLS-2021 uses the ZIP compatible compression for backing up data. This allows for
viewing or extracting the files with a ZIP compatible utility, Windows Compressed files or
restored by BLS-2021.

Backup Data
Backing up data is a veryimportant process that should never be neglected. Should a
computer disaster ever happen, the chances of recovering from that disaster are greatly
improved when backups are readily available. Backing up data also provides a handy
method for transporting league and program data from one computer to another. This is
especially convenient when moving to a new computer.

Athorough backup consists of 4 separate sets of data as follows:

1. Leagues: Use this option to backup leagues(s). This is the mostimportant backup
and should be done on a weekly basis.

2. System Hiles: This option will backup various system related files such as font set,
templates, customized styles and other program specific settings. This should
initially be performed after making program specific adjustments while setting up the
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league. Subsequent backups should be made after making any changes that would
applyto anyleagues managed by the program.

3. Local Awards: This option will backup prize configuration for local and bowling
center prizes. Perform this backup anytime changes are made to the local and
bowling center awards.

4. Common Addresses: These are the addresses that are entered in Bowler
Maintenance under the 'Contacts, Centers, Bank, Associations' section. This backup
should be performed anytime after changes have been made to contact names and
addresses that are globally available to all leagues managed by the program.

Splits and end of season backups: At the end of each split and at the end of each
season, make a backup of the league to a separate set of disks. Label each disk clearly
with the name of the league and which split the backup was made orifitis the final end
of season. Keep these backups in a different location. Following this extra step each
season will add an additional means of recovery.
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Using other methods of backing up: Using removable media (such as USB flash
drives, memory sticks, etfc...), recordable CD-ROM or Dropbox.com, can provide an extra
safety margin in not only protecting the league files, but the program itself. When backing
up the leagues, itis still recommended to use the backup function of the program. This
will ensure that all needed files that are associated with each league are included in the
backup. Backing up the partial set of files associated with the league will resultin a
damaged league and lost information.

Another convenient method of backing up league data is to upload the standings to
LeagueSecretary.com. In addition to the league standing sheets, BLS-2021 will also
upload a backup of the league. The LeagueSecretary.com site will maintain backups
from the 3 mostrecent uploads. As such, even if backups are not performed from the
program, you are still protected if you upload the league to LeagueSecretary.com.
Access to these backup files requires logging onto the LeagueSecretary.com site, so
they will only be available to the secretary uploading the league. For more information on
recovering the backup from LeagueSecretary.com, please see the section on restoring
leagues discussed later in this chapter.

For more information on uploading to LeagueSecretary.com, please see the section on
Web Uploads on page[2s3)

Automatic Backups: This feature can be configured under File > Preferences and
Program Setup > Program Operation Defaults tab. Change the Automatic backup
when a league is closed option from No to Backup.

Backup Leagues
Making a league backup

To back up a league take the following steps:

1. From the Opening Screen, click Maintenance > Backup > Leagues. If the
Maintenance menu option is not available, itis due to the fact that a league file is
open. Ifthe league is already open, see Backing up with a League Open.

2. Insertthe backup memory stick, or an appropriate backup media, or specify a backup
folder on the local hard disk drive.
Note: Backing up directly to CDR, CDRW or DVD disks requires specific support
from Windows, the CD writing software and/or the installed CD drivers. Unless you
are entirely sure your Windows operating system supports this functionality, we
recommend that you backup to your local drive first, then burn to CD.

3. The Select League screen will appear displaying all leagues in the current directory.
If the league is notlocated in the current folder, change the drive or folder location in
the under the Currently selected drive and directory section.

Double-click on the league to backup or select the league and click Backup.

The Select Backup Directory dialog will open to the location of the Default Backup
Directory which is configured in the Options > Preferences > Program Preferences
section previously discussed on gagemﬁ. You can keep this location or select a new
location.

6. The defaultfile name will be in the following format:
<LeagueName>_Data_thru_Wk_xx.zip, where <LeagueName> is the filename
identifying the league and xx = the week in which the backup was performed. Our
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League Backup sets contain all the league data from Week 1 up to the week the
backup was performed. We recommend keeping the default file name.

7. Click Save to begin the backup operation.
8. Exitthe Select League screen to return to the Opening Screen.

After backing up the league, the disk can be removed. Exit the League and File
Maintenance screen to return to the Opening Screen.

Backing up with a League open
If the league is already open, to initiate the backup click Weekly > Finalize this Week >
Backup this League

The Select Backup Directory dialog will directly appear since there is no need to select
aleague. The rest of the procedure is the same as described in the previous section.

After backing up the league, the disk can be removed.

Upload league to LeagueSecretary.com site

When uploading the league(s) to the LeagueSecretary.com site, a backup of the league
will automatically be uploaded so that will be an off site backup. This backup is available
to the secretary who has administrative access to the league on the Web site.

Backup System Files
Backing up system files is important to be able to recover the program settings if
program re-installation is required.

Backing up your program system files

Backing up the BLS-2021 program files occasionallyis strongly recommended. This
will help protect report styles and local award definitions.

To back up the program system files take the following steps:

1. Insertthe USB Drive or appropriate backup media, or specify a backup folder on the
local hard disk drive.

2. From the Opening Screen, click Maintenance > Backup > System Files. If the
Maintenance menu option is not available, itis due to the fact that a league file is
open. If the league is already open, close it by going to Menu File > Close > Close
League first.

3. The Select Backup Directory dialog will open and will default to the removable drive.
If backing up to a different drive or folder, navigate to that drive and/or folder. When
the Backup Directoryis selected, click Save. The file saved, by default, will be
BLS2018SYSTEMHALES.BLS2018SYS.

4. After backing up the System Files, the removable media can be removed.

Backup Local Awards

BLS-2021 provides the ability to configure awards that may be earned through the local
bowling associations or even the bowling center itself. (For more information, please
see the section Setup > Awards > Local & Center on page[28)

Depending on the number of awards configured, the amount of data entry can be
substantial. BLS-2021 provides this method of backing up this data once the awards
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have been configured. This will make the data available to be restored in the event that
BLS-2021 would need to be installed or to restore on another computer.

Backing up your program local awards files
To back up the program system files take the following steps:

1. Insertthe appropriate backup media, or specify a backup folder on the local hard
disk drive.

2. From the Opening Screen, click Maintenance > Backup > Local Awards. If the
Maintenance menu option is not available, itis due to the fact that a league file is
open. Ifthe league is already open, close it by going to Menu File > Close > Close
League first.

3. The Select Backup Directory dialog will open and will default to the floppy drive. If
backing up to a different drive or folder, navigate to that drive and/or folder. When the
Backup Directoryis selected, click Save.

4. The default backup file name will be cde_user_defined_awards zip.

5. After backing up the System Files, the removable media can be removed.

Backup Common CDE Data

BLS-2021 provides a location where contacts and addresses and other common data
between CDE applications can be stored which would be available to anyleague thatis
created and/or opened in the program. For example, bowling centers and
local/state/national associations would not be unique to any specific league, so this
information is made available to all leagues. As additional contacts are entered, the time
it would take to re-enter the data could be significant.

Backing up your Common Addresses

1. Insertan appropriate backup media, or specify a backup folder on the local hard disk
drive.

2. From the Opening Screen, click Maintenance > Backup > Common CDE Data. If the
Maintenance menu option is not available, itis due to the fact that a league file is
open. Ifthe league is already open, close it by going to Menu File > Close > Close
League first.

3. The Select Backup Directory dialog will open and will default to the removable
media drive. If backing up to a different drive or folder, navigate to that drive and/or
folder. When the Backup Directoryis selected, click Save.

4. The default backup file name will be CDOEAPPCOMMONFLES.APPCMN.

5. After backing up the System Files, the removable media can be removed.

Restore Data
Restoring data may be necessary if a league becomes corrupt, a computer disaster ever
occurs or if a league is being transported to a different location. This section provides a
method to restore backup data set previously created with the associated backup
functions.
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Restore Leagues

Restoring a league has two different benefits. The main benefitis to bring back a backed
up league that has been damaged or lost on the computer. The other is to transport a
league between centers, or between home and the center.

1.
2.

6.
7.

To restore a league backup, do the following:

Insert the backup USB Drive, floppy or appropriate backup media that contains the
league to be restored.

From the Opening Screen, click Maintenance > Restore > Leagues. If the
Maintenance menu option is not available, itis due to the fact that a league file is
open. If the league is already open, close it by going to Menu Fle > Close > Close
League first.

In the Select File to Restore dialog box, locate and select the ZIP file for the league to
be restored.

In the Select Target Directory dialog box, select the location to restore the league
and click OK. The program will default to restoring the league into it's default league
folder.

After restoring the league, the appropriate backup media can be removed.

Exit the League and File Maintenance screen to return to the Opening Screen.

Recovering backup file from LeagueSecretary.com

If the standing sheets are uploaded to the LeagueSecretary.com site, a backup of the
league will also be uploaded and stored on that site. The following steps can be
performed to retrieve a backup file of the league to be restored using the previous
instructions.

1.

2.
3.
4.

From the Opening Screen, click Maintenance > Restore > Recover League from
LeagueSecretary.com.

Enter your LeagueSecretary.com username, password and LeaguelD.

Save the backup to your desktop.

Use the normal Restore League feature using the backup recovered from
LeagueSecretary.com.

Note: This is a manual way to recover the league backup, which steps are subject to
change since the LeagueSecretary.com site is not maintained by CDE Software, LLC.

1.
2.
3.

No ok

Connect to the Internet and go to http:/www.leaguesecretary.com

In the upper right corner, log in to the site using your UserName and Password.
Scroll down the page to the League Administration (League Secretaries Only)
section on this page.

Follow the instructions to Administer the League.

Select the Backup Files link.

Follow the instructions to download the file.

SAVE the downloaded file and make note of where the file is saved so it can be used
when restoring the file.
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Restore System Files
To restore the program system files, take the following steps:

1. Insertthe backup USB drive or appropriate backup media.

2. From the Opening Screen, click Maintenance > Restore > System Files. If the
Maintenance menu option is not available, itis due to the fact that a league file is
open. If the league is already open, close it by going to Menu Fle > Close > Close
League first.

3. The Select System Files to Restore dialog will open and attempt to locate the
system file backup by first looking in the appropriate backup media, then the
program's installation directory. Locate the BLS-2021SYSTEMFALES.BLS2018SYS
file and click Open.

4. The system files will then be restored and will be returned to the Opening Screen.

Restore Local Awards
To restore the local and bowling center awards, take the following steps:

1. Insertthe appropriate backup media.

2. From the Opening Screen, click Maintenance > Restore > Local Awards. If the
Maintenance menu option is not available, itis due to the fact that a league file is
open. If the league is already open, close it by going to Menu File > Close > Close
League first.

3. The Select Local Awards to Restore dialog will open and attempt to locate the local
award backup by firstlooking in the appropriate backup media, then the program's
installation directory. Locate the cde_user_defined_awards zip file and click Open.

4. The local award files will then be restored and will be returned to the Opening
Screen.

Restore Common CDE Data
To restore the common addresses, take the following steps:

1. Insertthe appropriate backup media.

2. From the Opening Screen, click Maintenance > Restore > Common CDE Data. If the
Maintenance menu option is not available, itis due to the fact that a league file is
open. If the league is already open, close it by going to Menu Fle > Close > Close
League first.

3. The Select Common Addresses to Restore dialog will open and attempt to locate
the local award backup by firstlooking in the floppy drive, then the program's
installation directory. Locate the CDEAPPCOMMONFILES.APPCMN file and click
Open.

4. The local award files will then be restored and will be returned to the Opening
Screen.

Exchanging leagues between computers
Averypopular feature of BLS-2021 is the ability to transport a league between
computers. The most common application is the ability to take a backup of the league
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from home into the bowling center for use with their automatic scoring version of BLS-
2021. The center uses the league to send out the team rosters for the league to the lane
consoles, then retrieves the scores after bowling.

The other important reason for the ability to exchange data between computers is when
switching to a new computer. After installing BLS-2021 on the new computer, the league
data that was backed up on the old computer can be restored on the new computer.

Transferring to new computer:

1. On the original computer, backup league data, system files, local awards and
common addresses.

e Open BLS-2021. Ifthe league is already open, close it by going to Menu File > Close >
Close League first.

« From the Opening Screen, click Maintenance. If the Maintenance menu option is not
available, itis due to the fact that a league file is open.

¢ Backup Leagues: This option backs up the league files. This step is not necessary if
you have already backed up the league(s).

e Backup System Files: This option backs up various system settings such as custom
fonts, custom reportand customs style settings.

e Backup Local Awards: This option backs up local and bowling center award
configurations. This only needs to be done if Local and/or bowling center awards have
been configured.

e Backup Common Addresses: This option backs up the Contact List that contains
contact information that is available to all leagues such as the bowling center, local
association addresses, bank information, etc.

2. On the new computer, restore league data, system files, local awards and common
addresses:

e Open BLS-2021.Ifthe league is already open, close it by going to Menu File > Close >
Close League first.

¢ From the Opening Screen, click Maintenance. If the Maintenance menu option is not
available, itis due to the fact that a league file is open.

¢ Restore Leagues: This option restores the league files. Depending on the version of
Windows, you will need to use the navigation controls on the left side of the screen to
locate the drive these files were backed up to. Typically, you should be able to click on
"Computer", "This PC", or "My Computer" and the drive will be listed.

* Restore System Files: This option restores system settings such as custom fonts,
custom reportand customs style settings.

* Restore Local Awards: This option restores local and bowling center award
configurations. This only needs to be done if Local and/or bowling center awards were
initially backed up.

¢ Restore Common Addresses: This option restores the Contact List that contains

contact information thatis available to all leagues such as the bowling center, local
association addresses, bank information, etc.

Exchange data with bowling center:
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1. Backup the league to a removable media and give it to the bowling center before
bowling.

2. The center uses their BLS-2021 program to restore the league.

3. Ifthe center has an automatic scoring interface version of BLS-2021, they will then
send the league to the consoles at the lanes before bowling starts.

4. Afterleague has finished bowling, the center imports the league scores back into
BLS-2021.

5. The center will then backup the league to the removable media and return it to the
League Secretary.

6. The League Secretaryrestores the league on the home computer.

Note: To prevent overwriting data between the two copies of the league, itis important to
avoid making changes to the league files while the league is bowling. Just as important,
the above process needs to be performed each week.
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Maintaining USBC Youth Leagues

BLS-2021 is designed to not only handle adultleagues, butalso USBC Youth leagues.
BLS-2021 includes forms for USBC Youth achievement awards and will detect awards
earned by bowlers. BLS-2021 also includes the processing of USBC Youth’s Pepsi
tournament qualifying. Simply set up the qualifications and then designate which
bowlers it will accept to advance towards the finals. The USBC has made significant
changes to Youth leagues, specifically youth bowler divisions and age requirements.

e Youth ages for assignment into bowler divisions is no longer based on the August 1.
Instead, the bowler will be assigned to a division based on the age they turn during
the entire season (Aug 1,2013 - July 31, 2014). For example, a bowler named Billyis
8 years old as of "August 1" and will turn 9 on August 5. Under the old rule, Billy would
still be in the "under 8" division (typically referred to as Bantam) Under the new rules,
Billy would be bowling in the 9 - 12 division.

e Pepsi Tournamentis now all Scratch, there are no handicap divisions.

e Youth bowlers can participate in higher division with a waiver signed by the bowler's
parents or guardians.

League Rules
The setting up of league rules is the same as setting up the rules for adults. The main
difference is working with bowler divisions.

USBC Youth Leagues are now broken into the following divisions:

e 6 and Under e 912 e 16-17
e 7-8 e 13-15 e 18-20

Age as of August 1: This date no longer applies when configuring Youth Divisions.

Alternatively, for additional separation of the bowlers and teams, the Youth Director can
create individual league files

Setting up USBC Youth Bowler Divisions

To designate the USBC Youth divisions for the league, go to the Setup > Rules >
General Rules and scroll down to League Features. Make sure that the switch for Bowler
Divisions is setto YES. Next, select the Divisions tab and specify the number of bowler
divisions. Next, using the drop-down list box, select the determining factor for the bowler
divisions.

Setting up USBC Youth Team Divisions

If the bowlers are intermixed among teams and the league does not have specific teams
for each divisions, or there is a separate league file for each team division, leave the
number of team divisions at 1.

If the league covers everyteam’s division, go to the Setup > Rules > General Rules and
scroll down to League Features. Make sure that the switch for Team Divisions is setto
YES. Next, select the Divisions tab and set the number of Team Divisions to the number
of USBC Youth divisions the league offers. Click Teams will only bowl teams in their own
divisions if junior teams will only play junior teams, bumper teams will only play bumper
teams, etc.
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Finally, go to Adjust Team Rosters and designate which division each team is in.

Pepsi Tournament
The Pepsi Youth Bowling Championships is a special tournament for youth bowlers,
which is administered by the USBC Youth. BLS-2021 handles the league level
qualifications.

Birthdays: In order to properly detect which division a bowler will qualify for the Pepsi
tournament, the bowler’s birth date must be entered. This can be entered on the Adjust
Team Rosters or the Bowler Maintenance screens discussed in a previous chapter
(@ggm).. The bowlers age is based on how old the bowler will be when their birthday
arrives between August 1st, 2014 and July 31st, 2015. This is a change from previous
years, which determined a bowler's age by how old they were on August 1st.
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Pepsi Setup

To configure the Pepsi Tournament league qualifying, go to the Weekly > Process This
Week > Youth Pepsi Cola Tournament Qualifications. Configure the Pepsi Tournament
Qualifying Rules as follows:

Qualifying Weeks: Indicate of the 1stand 2nd Period qualifying will consist of 1 or 2
Weeks using the toggle switch. Enter the week numbers for each qualifying period. Note:
If the league has advanced beyond the qualifying periods entered, go back to the first
week of the qualifying period to properly pick up the results.

Enter your advancement ratios and fees. Identify if the league/local tournament will
have "Under 6" Divisions by toggling the switch. Enter the Advancement ratio provided by
the local tournament director. When entering the ratio, just enter the ratio number.
Example: If the advancement ratio is 1:6 (one in every 6) then enter justthe number 6.

Mail Pepsi Tournament Forms To: Click on the Reports for Awards and Pepsi
Tournament tab to identify where the Pepsi Tournament paperwork is to be mailed.
Usually this will be to a tournament director who is not at the same address as the local
or state association. Click Select Address which will open the Important Contacts
section of the Bowler Maintenance page.

Accepting or declining a qualifying bowler

Go to the Weekly League Duties menu and click Youth Pepsi Cola Tournament
Qualifications. Click the First Period Pepsi Tournament or Second Period Pepsi
Tournament tab depending on the qualifying period.

Indicate if the bowler will advance into the scratch or handicap division, by selecting the
bowler and clicking on the Scratch or Handicap buttons. Next click Advanced to indicate
that the bowler will be listed on the Pepsi report form.

If the bowler declines to advance, select the bowler and click Decline.

Aworksheet can be printed to help indicate who will advance or decline by going to the
Reports for Awards and Pepsi Tournament tab and printing the Pepsi League
Worksheet. Take the worksheet when asking the bowlers if they wish to advance to the
next level, mark it on the form. Then enter the information into BLS-2021.

Printing the Report Form

Go to the Weekly > Youth Pepsi Cola Tournament Qualifications. Click the Reports for
Awards and Pepsi Tournament tab. Select the Pepsi League Worksheet form and click
Print.

This form is sent back to the Pepsi Tournament coordinator.
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Automatic Scoring

When automatic scoring was first introduced to bowling centers, there was onlya couple
of companies and models to choose from. As technologyimproved and costs were
lowered, other companies came out with competing systems. Color, graphics, speed
detection became better and faster.

While the equipment that worked at the lanes became better, so did the front desk
computers that controlled the lanes. Original systems used early forms of Unix or Xenix.
While the operating systems are still around in one form or another, Microsoft's DOS
and Windows operating systems became the standard for most businesses. And newer
companies have developed front desk systems using Microsoft operating systems.

Each scoring system typically would have to develop their own software to manage
leagues and tournaments. The drawback was that this left out the majority of league
secretaries and centers that used BLS.

In 1993, Dacos and Heddon decided to provide compatibility with BLS-6. This allowed
the center to set up the rosters in BLS and export the names and handicaps to the lanes.
Once leagues were completed, BLS would read the scores bowled and enter them. The
center then would print the standings and the recaps.

Currently, there are several scoring systems that have followed suit and offer importing
and exporting capabilities to BLS.

In 1999, CDE Software developed a generic import and export method for scoring
companies to use, providing additional functionality to league and tournament programs
such as scoresheets and current score details.

What’s needed?

To use BLS-2021 A/S, the scoring system must be compatible and the scoring edition
of BLS-2021 mustbe purchased. BLS-2021 Standard and Professional Editions do not
feature automatic scoring compatibility.

Most league and tournament functions are handled by the back office computer thatis
networked to the front desk computer. BLS-2021 A/S is compatible with most networks
and uses the network to import and export data. If the center uses one computer for the
front desk and does not have a separate back office computer, BLS-2021 A/S can be
installed on that machine.

Compatible Scoring Systems
At the time of this writing, the following systems are available that are compatible with
BLS-2021 A/S.

Certified Scoring Systems

The following compatible scoring systems participate in CDE Software's Certified
Automatic Scoring program. Each system is continually tested by CDE's technical staff
for compatibility and inter-operational functionality.

QubicaAMF Worldwide Brunswick Bowling & Billiards Corporation
8100 AMF Drive 525 Laketon Ave
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Mechanicsville, VA23111
Phone: 804-730-4000 Fax: 804-559-8650

Front Desk/ Scoring: Conqueror Pro,
Conqueror and Conqueror Universal

A.KMicrosystems International Pty Ltd
Australia
Phone: 617 3201 1963 Fax: 617 3201 1963

** Front Desk/ Scoring: TouchDesk 3

USA
Phone: 248-375-2751

US Bowling

5480 Schaefer Ave
Chino, CA

Phone: 909-548-0644

Front Desk/Scoring: Pulse

Muskegon, Michigan, 49441-2697
Phone: 800-232-2369 or 231-725-3300

Front Desk/ Scoring: Sync
** Front Desk/ Scoring: Vector, Vector Plus,
Classic

Steltronic

4600 E Arrow Hwy

Montclair, CA91763

Phone: 800-942-5939 /909-971-6565

Front Desk/ Scoring: Focus, WINS

Non-Certified Scoring Systems

The following systems have interfaces available to CDE Software products but have not

undergone certification.

QubicaAMF Worldwide

8100 AMF Drive

Mechanicsville, VA23111

Phone: 804-730-4000 Fax: 804-559-8650

Joystick Scoring

1621 McEwen Dr, Unit40

Whitby -Ontario L1N 9A5 - Canada
Phone:888-569-7845 905-432-2832

Front Desk/ Scoring: Boss 9.0 and Boss 9.1 Purrfect Score

28351 S Tamiami Trail

Brunswick Bowling & Billiards Corporationg, it Springs, FL 34134

525 Laketon Ave
Muskegon, Michigan, 49441-2697
Phone: 800-232-2369 or 231-725-3300

Phone: 800-922-9559, Fax: 239-947-6908

Front Desk/ Scoring: Purrfect Desk

** Front Desk/ Scoring: CenterMaster 1.10 + Switch

Bowling Electronic Services &
Technologies

5269 Briarwood Ave
Centennial, CO 80122 - USA
Phone: 720-251-6816

Front Desk/ Scoring:
ComputerScore/Ebonite/Vantage Matrix

Tekeli ITOB Organize Sanayi Bolgesi
Ekrem Demirtas caddesi No:44
35477 Menderes, lzmir

Turkey

Email: info@switchbowling.com

Front Desk/Scoring: Switch 2

Twelve Strike

2231 E Curry Street

Long Beach - California 90805 - USA
Phone: 562-984-6240 Fax 562-428-8114
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Front Desk/ Scoring: Central Desk Pro
(Windows) / Central Desk DOS

** These Front Desk/Scoring systems may require networked computer with compatible
scoring.

Configuration for aufomatic scoring
After installing BLS-2021 A/S, the program must be configured to access the scoring
system.

Itis assumed that the scoring system is currently set up for compatibility with BLS-2021
A/S. If there are any questions regarding the front desk setup or configuration, contact the
scoring company's technical support team.

Unlocking the configuration screen

To prevent accidental tampering with settings, the screen is locked to prevent major
configuration changes.

To unlock the screen, click the lock box under Scoring System. Enter COESOFTWARE
when prompted for a password (all as one word in upper case) and click the checkmark.
The lock should now appear as unlocked giving access to change settings.

Locating the Front Desk

In order to import and export leagues to the front desk, BLS-2021 A/S must be pointed to
where the front desk is located.

Next to the Location/Computer name of Front Desk text box, click the browse button and
locate the front desk computer's main drive.

If BLS-2021 A/Sis installed on a back office computer, itis important that the front desk
computer’s C: drive is mapped to a drive on the back office computer. This is normally
done during the computer installation. Consult your operating system manual or
Microsoft's technical support for details on how to map a drive.

Setting the export directory

BLS-2021 A/S must be pointed to where the team roster files are exported in order for
the front desk to find them. These files, called export files, are used to put bowlers on the
lanes as well as to indicate the bowler handicaps. Each scoring system has its own
particular location. Contact your scoring company for exact locations.

To indicate the location of the export directory, click the browse button next to Export Drive
and Directory.

Setting the import directory

BLS-2021 A/S must be pointed to where score files are saved by the front desk in order
to find files for importing. These files, called import files, contain scores and results
during bowling.

To indicate the location of the import directory, click the browse button next to Import
Drive and Directory.

Software Revision

If new features come along, the revision of the software for support to the scoring system
may need to be incremented or gone back for legacy support.

Definition of and options for scoring system
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Each scoring interface has their own particular set of features. Some features are also
added in newer versions of the scoring system.

BLS-2021 A/'S is designed to integrate these particular options into the export file.

Itis important to remember that certain options may not be available on your particular
scoring system.

The options for the scoring system are fairly self-explanatory. However, a few do need
mentioning.

Lane Movement is supported

Certain scorers feature the ability to move lanes after each game of bowling. Enable this
option if your system supports this.

Scoresheet Available
Certain scorers provide the ability to reportinformation on frame byframe scores.

Best Practices

When using the Autoscoring edition of this software, itis important to do things in the
appropriate order and week, in order to obtain the best results and minimize potential
issues.

The following is the best practice to follow week to week with the assumption week 1

was exported, games were bowled, but scores have not been imported:

1. Importscores for week 1 and note anyissues mentioned in the import log.

2. Go to Weekly > Enter and Correct Scores and verify scores against the recaps.
Enter new bowlers thatimport log detected and manually enter those scores.

3. Printthe standing sheet.

Upload standings to LeagueSecretary.com / Bowl.com , etc.

5. Indicate any nation/local awards earned that can not be automatically detected, such
as 7-10 split, clean game, etc.

6. Printany USBC/CTF/TNBA awards forms

7. Printthe statistics for this week or any other reports (except recap sheets), as
desired

8. Backup the league to removable media, such as a USB Memory device, external
hard drive, network hard drive so that the league can be recovered in case of a
computer disaster that causes the data on the computer this software is installed on
to be lost or corrupted.

9. Advance to the next week (week 2).

10. Make any adjustments to the league if any teams have been added or dropped.

11. Make any adjustments to the rosters, if bowlers have moved in their lineups, moved
to a different team, known subs added to a team, etc.

12. Print the recap sheets.

13. Export the rosters to the front desk.

&

Repeat these steps each week.

Automatic Scoring



Exporting Leagues
Typically, rosters are exported, league is bowled, scores are imported, scores are
verified, standings and reports are printed, recaps are printed, and then rosters are
exported for the next week.

The following section gives more information on exporting features
Preparing to export

Exporting rosters to the scoring system is similar to how recaps work. Export to the Front
desk can either be in the last week that scores are entered or can be in the following
week that scores will be bowled. Either method exports the rosters for the next week. As
areminder as to how our programs work, if scores are entered: export for the next week.
If no scores are entered: export for the current week. We recommend always advance to
the next week before exporting or printing recaps. This allows changes before exporting
or printing recaps. If scores for week 5 are entered, print the standing sheet and other
reports then advance to week 6, make any necessaryroster changes, then export and
print recaps.

Reminder: The league mustbe in the week where scores are entered to print the
standing sheet for the following week.

To export rosters to the scorer, do the following:

1. Click Weekly > Prepare This Week > Auto-Scoring: Send League to Front Desk.
2. Selectthe particular Bowling Options.
3. Click Export to Front Desk.

That's it. The rosters should be available at the front desk for sending to the lanes.

Changing rosters before exporting

If rosters need to be changed before sending to the lanes, simply advance to the week
that will be bowled. Scores should NOT be entered for this week.

Go to Team Rosters and change the lineups, then export the rosters as normal.

Note: Any changes to the rosters or scores after exporting to the front desk, will not be
reflected on the lanes unless the league is re-export and click Yes to overwrite the
existing file before sending the league out to the lanes.

Importing Scores
After scores have been completed for league, they must be imported to BLS-2021 A/S.
This eliminates most manual score entry and decreases the possibility of user errorin
typing in scores. The following section gives more information on importing scores.

Importing scores

When league bowling has completed and the front desk has closed the league, the
scores will be available to be process by BLS-2021 A/S.

If the league is notin the week that scores are imported, change to that week.

Click Weekly > Process This Week > Auto-scoring: Import scores from Front Desk.
The Import Scores button indicates that scores are available to import.

Import Options

There are several options affecting the importing of scores. The following options are
available:
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*Based on scoring system features.
Re-order Team Rosters matching bowlers at lanes:

In order to provide lineup changes that match between BLS and the lanes, select this
option. The roster will be re-ordered to the lineup on the lanes. When advancing to the
next week, the lineup will be the new lineup.

Do not tag new bowlers as subs:

Select this option to import new bowlers on the team as regular members, instead of
subs. Abowler’s status can be changed to a sub atanytime. This feature is simply used
to help automation.

Score Removal during import

The following options affect how scores are imported:

¢ Remove scores before importing: Selecting this option will erase scores currently
entered and import scores from the front desk.

e Don’terase scores: Maintains scores currently entered and will replace scores found
from the front desk.

o Ask before overwriting: Same as above, but will prompt before replacing existing
scores.

o Keep existing scores: Selecting this option will keep existing scores entered and bring
in only the new scores.

Ignore ID numbers

Select to ignore the bowler ID#s used during the import process and import scores
based on bowler's name.

Error Log

After scores are imported, an error file is generated. This error file will show any
problems or issues that need attention before printing standings or advancing weeks.

Typically, scores will appear in the error log due to a bowler being added at the lanes
who does not currently belong to the league. This can either be a real bowler who is new
or a currentmember who has mistyped their name or entered the wrong ID#.

Also, appearing in the error log can be absentee scores that are incorrectly entered.
Use this report to manually entering or correcting scores.

Fefching scores for brackets
Using the Brackets Module for automatic scoring edition of BLS-2021 A/S the program
can fetch the currently completed scores for bracket results.

Most scoring systems provide the current scores while league is bowling, without
closing the lanes.

To grab the latest scores, simply click the Fetch Scores icon in Bracket Results.

Scores can imported from the automatic scoring screen, too. Use the Import Scores
During Bowling button unless all bowlers have finished bowling and all lanes have been
closed.

Automatic Scoring m
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Mid Season Startup

This is commonly used when changing league software in the middle of the season and
not having to re-enter all the scores for previous weeks that were bowled, or if all the
data for the league was lost and there was no backup to restore.

There may be some situations where a league has already started and several weeks
have been bowled prior to any data being entered into BLS-2021. In this scenario, itis
recommended that scores be entered starting with Week 1. However, it may be prudent
and less time consuming to simply start the league from the current week as opposed
to entering data starting with week one. This is whatis referred to as a Mid-Season
Startup.

Starting a league mid-season is identical to starting any new league with the exception
of having to enter year-to-date scoring information. Anew league file would need to be
created, league rules would need to be configured, league bowler information would
need to entered and team rosters established. Once this initial information has been
entered, the mid-season startup is ready to be processed using the most current
standing sheet available for the league.

Mid-Season Startup
There may be some situations where a league has already started and several weeks
have been bowled prior to any data being entered into BLS-2021. In this scenario, itis
recommended that scores be entered starting with Week 1. However, it may be prudent
and less time consuming to simply start the league from the current week as opposed
to entering data starting with week one. This is whatis referred to as a Mid-Season
Startup.

Starting a league mid-season is identical to starting any new league with the exception
of having to enter year-to-date scoring information. Anew league file will need to be
created, league rules will need to be configured, league bowler information will need to
be entered and team rosters established. Once this initial information has been entered,
the mid-season startup is readyto be processed using the most current standing sheet
available for the league.

The recommended procedure for a Mid-Season Start-up would be to have the current
week's standing sheet.

When setting up the rules of the league, Setup > Rules > General Rules, after entering
the original start date for the league (when the league bowled the first session) and the
number of weeks the league is bowling, in the next section, enter the current week
number the league is bowling. Acknowledge the message that come up. Finish setting
up the rest of the rules according to the league rules/bylaws. The program will
automatically take the league to the current week of the league (the one entered in the
Mid-season option).
Once on the current week, go to Setup > Team Rosters and enter the team and bowler
information.
1. Click the Padlock in the lower left corner of the screen.
2. Using the Previous Week's Standing Sheet, enter Team information with
regards to Pins, Points Won/Lost, Games Won/Lost and team high 10/30
scores.
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3. Foreach bowler, enter Pins, Games, individual high 10/30 (High Game/High
Series) scores and Points Won/Lost (Match Point Leagues)

4. Repeatsteps 2 & 3 for each team until all the information for each team and
bowler has been entered.

5. The league is now ready for scores to be entered for the current bowling
session.

Note — For leagues with multiple parts/splits, in order to have each split standings,
the league will need to be taken to the week of the split to enter the previous
weeks’ data from the last standing sheet prior to the splitand manually put the
scores in for the week ending the split/part. All the scores will need to manually
enter for each week until current.

Important Notes:

e Scores cannot be entered for previous weeks. This includes make-up scores for
weeks prior to the mid-season startup or pre-bowl scores bowled prior to the
mid-season start up for weeks after the mid-season start up.

e Previouslyearned National or Local Association Awards will not be available.

e Bowler and Team Histories will be incomplete.

e Scores for League Awards or Prizes maybe incomplete.

o Data that can be entered is limited to data listed on the Standing Sheet.

Method 2:

1. Create a new league, configure the rules, setup position rounds, enter bowlers
and assign team rosters.

2. From the main screen, click on Go to any week then select the last week
bowled.

3. Warning dialogs will be displayed as advancing each week since there are no
scores entered. Simply click OK on these warnings

4. Go to Setup > Rosters

5. Click the Padlock in the lower left corner of the screen.

6. Using the Previous Week's Standing Sheet, enter Team information with
regards to Pins, Points Won/Lost, Games Won/Lost and team high 10/30
scores.

7. For each bowler, enter Pins, Games, individual high 10/30 scores and Points
Won/Lost (Match Point Leagues).

8. Repeatsteps 6 & 7 for each team until all the information for each team and
bowler has been entered.

9. Enter scores from Recap Sheets.

10. Print Standing Sheet. This should match the current Standing Sheet for the
league. If these standing sheets do not match, verify the pins and number of
games were entered correctly as well as ensuring the League Rules have
been configured correctly.

Method 3:

1. Create a new league, configure the rules, setup position rounds, enter bowlers
and assign team rosters.
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From the main screen, click on Go to any week then select the week that will be
bowled next.

Warning dialogs will be displayed as advancing each week since there are no
scores entered. Simply click OK on these warnings

Go to Weekly > Prepare this week > Adjust Team Rosters.

Click the Padlock in the lower left corner of the screen.

Using the Previous Week's Standing Sheet, enter Team information with
regards to Pins, Points Won/Lost, Games Won/Lost and team high 10/30
scores.

For each bowler, enter Pins, Games, individual high 10/30 scores and Points
Won/Lost (Match Point Leagues)

Repeat steps 6 & 7 for each team until all the information for each team and
bowler has been entered.

The league is now ready for scores to be entered for the current bowling
session.
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Master Bowler Database

The Master Bowler Database (MBD) is an add on program, designed as a central
location to store personal information for bowlers. Information stored includes, butis not
limited to, address, phone, email, as well as the National bowler ID. This allows any
bowler to added to anyleague managed by BLS-2021, either as a substitute or regular
team member, without having to re-enter the personal information. This program is only
available for the BLS-2021 Professional and Auto-Scoring Editions.

Installation of the MBD

The MBD-2021 can be installed from CD or downloaded from the Internet. It is not
included in the BLS-2021 installer, as not all customers use the MBD, so we provide a
separate installer.

NOTE: BLS-2021 Auto-Scoring or Professional Editions must be installed and activated
prior to installing the MBD.

Installing from CD ROM
To install the Master Bowler Database using a CDROM, follow the instructions below

1. IfWindows is not currentlylogged in under a Windows account with
Administrator privileges, then log in as Administrator or as a user with
Administrative privileges.

2. Insertthe CD-ROM. If Autoplay is enabled, the menu screen will appear. If
Autoplay is disabled, run the Menu by opening My Computer, double-click on
the CDROM(drive, then double-clicking on the SETUP.EXE file.

3. From the screen that appears, select CDE Software Products.

4. Another screen will appear that lists several different products that are offered
by CDE Software. Each of these products will install when clicked on and will
run in DEMO mode.

5. Select BLS-2021

6. The nextscreen will list several differentitems that are associated with BLS-
2021. To install, click Install MBD-2021. This will run the InstallShield Wizard
which will walk through the installation process.

7. Follow on screen instructions to complete the MBD-2021 installation.

Note: When installing the MBD-2021 Manager on a remote machine that will
connect the database over the network, select Custom when prompted for
Setup Type so that MBD-2021 Server can be deselected for installation.

8. Atthe end of the installation, check the option "Start MBD-2021 Server" before
closing the installer unless it was notinstalled in the previous step.

9. Grantfull permission by anyfirewall security prompts for the server to access or
be accessed by the network.

10. After the installation is complete, exitthe CD-ROM installation menu.

Installing from the Internet

To install the MBD-2021 from the Internet, follow the instructions below
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10.

If Windows is not currently logged in under a Windows account with
Administrator privileges, then log in as Administrator or as a user with
Administrative privileges.

Connect to the Internet and open a web browser to CDE Software's home page
at http://www.cdesoftware.com

From the home page, select Downloads tab.

Step 1: Click on Master Bowler Database. Step 2: Click on MBD-2021
Program. Scroll down to Step 3.

Select the yellow Download button and click on it.

Depending on the browser, an option to Run or Save should be presented. For
simplicity, select Run if this is the destination computer. However, using the
Save option, will facilitate keeping a copy of the installation program as a
backup or to transfer to another computer.

If the Run option is selected, the InstallShield Wizard will automatically start
when download is complete. If the Save option was selected, locate the
downloaded MBD-2021INSTALLER.EXE file and double-click to start the
installation.

Follow on screen instructions to complete the MBD-2021 installation.

Note: When installing the MBD Manager on a remote machine that will connect
the database over the network, select Custom when prompted for Setup Type
so that MBD-2021 Server can be configured to not be installed.

At the end of the installation, check the option "Start MBD-2021 Server" before
closing the installer unless it was notinstalled from the previous step.

Grant full permission by any firewall security prompts for the server to access or
be accessed by the network.

Installing the database:

After the MBD-2021 has been installed, the first step is to create a new database. This
task is performed from the MBD-2021 Manager application. This application can be
launched from the Start Menu in Programs > CDE Software MBD-2021. When running
MBD-2021 Manager for the firsttime, grant full permission by any firewall security
prompts for the manager to access or be accessed by the network.

From the MBD-2021 Manager screen, click on the Database Setup TAB.

From this page, click Install Database. If a database already exists, a prompt will appear
requesting permission to delete it first. Only do this ifintending to clear and reset the
database from the beginning.
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Configuring BLS fo use the MBD

Program Setup and Options
,‘_'13 Bt x Ccancel u} Expert Level 0 ED Help

Appearance
Backup & Restore MBD Details
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Cloud Features
Printing
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Date Entry Settings
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Master Bowler Database|

Kiosk Options

MBD Il Server Connection

127.0.0.1

ort #7 16210

ter the server details so the program can locate and communicate with the Master Bowler Database

License MBD Manager

To license the MBD, please do the following " N

1) Install the Master Bowler Database on the computer the server will reside Activate MBD License
2) Make sure the Master Bowler Database server has been started

3) Make sure the MBD Server Location above is pointing to the IP address of server,

4) Click Activate MBD License. Interet connection not required Deactivate MBD License

Once the database has been installed, use the following steps to configure BLS-2021
to use the MBD-2021:

Launch BLS-2021.

Go to Fle > Program Preferences

Click on the Master Database tab

If the Bowler Database is located on the same machine running BLS-2021, skip to

step 7.

5. Ifthe Bowler Database is located on a remote computer, the information will need to
be entered for BLS-2021 to utilize the database. Under MBD Il Server Connection,
toggle the "Is the database server based on this machine", switch to No. Enter the IP
Address for the computer where the bowler database is located.

6. Enterthe server port number that will be used to access the MBD-2021. By default,
this port number is configured for 16210. As such, unless a change was made on
the MBD-2021 Server, nothing else will be necessaryon this screen.

7. Click Activate MBD License. Internet connection not required.

8. Change the switch under MBD Details to Enabled. The database is now ready for

use.

PODN~

Upon exiting this screen, the Database Status monitor should read MBD Available. It
may be necessaryto exit BLS-2021 and restart program. If the database still fails to
load, verify the configuration settings in the Program Setup and Preferences.

Linking League fo Database
The final step to interface BLS-2021 with the MBD-2021 is to link the league files.

When the league file is opened, there will be another section labeled MBD in the
Database tab. Click on the switch to change the option to YES, for ‘Will this league be
linked to the Master Bowler Database?’ This will add the league to the database and
copy all the bowler information.
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As an alternative, go to Setup > League > Rules > Special Options and link the league to
the database under the Master Bowler Database section.

When league file is linked to the database, all the bowlers in the league file are copied
into the database. If a bowler already exists in the database, a duplicate record will be
created.

1. Click Select Person To Remove and then locate the original person that will be
merged to a different person.

2. Click Select Person To Keep and locate the duplicate person that will remain in the
database.

3. Copyanyinformation from the person being removed thatis necessaryand is
missing from the person that will remain. Ashortcut to copying information is to click
in a field in the removed persons panel and then press SHIFT-CTRL-C.

4. Click Merge Now.

Adding bowlers from database
Now that the league has been linked to the MBD-2021, the database can be used to
enter bowlers who are not currently on the league. This can be done from Weekly >
Prepare This Week > Adjust Team Rosters or Weekly > Process This Week >
Enter/Correct Current Scores. Depending on the nature of the new bowler, click on
Replace, Sub or Add and the following screen will appear to select the bowler:

Add a New Bowler

No Last

Select a bowler to add to
GS500

ID_| Team | Name

¥, VACANT
V , VACANT
V ,VACANT
V ,VACANT
V ,VACANT

>

Abel, Brendan

Carlisle, Luciano
Carmichael, Emmerson
Cobb, Monte

N=<xE<c-4®wo7vVozErxc=—-—Tamnmonown

To add a bowler from the MBD, simply click the Select from Master Bowler Database.
This will bring up a list of bowlers in the MBD from which the bowler name can be
selected, or a new bowler created if they do not existin the database.

Locate the bowler to be added to the league then click Import Selected Person. If the
bowler does not exist, use the Add New Bowler to Database and add the bowler
information.
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Upon clicking the Save New Bowler to Database button, the name will be added to the
list of bowlers where it can be selected to Import into the league.

Master Database Manager
The MBD-2021 Manager is a utility that is installed with the MBD-2021 used to print
reports and to do general database maintenance.
The Manager is only available for BLS-2021 Pro and BLS-2021 Autoscoring Edition
customers.
The Manager utility has its own help file where additional details and help can be found.

Master Database Manager Reports

The MBD-2021 Manager offers several individual and league reports and labels. To print
a report, simply locate the reportin the list and click on the report. A preview will appear
of the report, which can then be printed or exported into select formats.

Many of the reports can be further adjusted by changing the sort or report separation
options.

Editing Bowlers in the MBD Manager

To change details for a person in the MBD-2021, simply click the Edit Bowlers button
located in the Bowlers tab. From here, edit the appropriate information, such as name,
address, email or phone numbers.

The changes will be saved when selecting a different person or clicking Close.

Bowler Trac and MBD
The MBD-2021 Manager supports exporting or importing bowlers from Bowler Trac, a
software product from the Bowling Proprietors of America.

Exporting

To export the persons listed in the MBD-2021, click Export to Bowler Trac found in the
Bowlers tab and select the location to save the file. This file then can be used to import
the people into Bowler Trac.

Importing

To import people from Bowler Trac into MBD-2021, create an export file in BITS format
from Bowler Trac and then click Import from Bowler Trac found in the Bowlers tab to
select the BITS formatted file. Select the people to import.
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Technical Support

CDE Software’s goal is to provide low-cost software to the bowling industry. We have
chosen not to include technical support costs in the price of our software, since doing it
would penalize the majority of customers who do not use our services.

We believe this policy has advantages over the 'pay-for-support of time' - limited support
policies of other companies. Unlike many software companies, CDE Software provides
FREE program support to registered users of BLS-2021; however, you assume costs
for your own long distance phone charges, online charges, facsimiles or postage.

Please note that CDE Software experiences the highest volume of support and sales
inquiries during the peak months of August, September and January. The easiest
method to obtain supportis via our discussion forums on our website or email. We
make every effort to respond to your support questions in a timely fashion.

There are several ways for you to get help:
Support & Updates Function

BLS-2021 includes the ability to use your Internet connection to check for updates to the
software and send our Support department your questions and league files.

Internet

Our website is at http:/www.cdesoftware.com, featuring live online chat with staff during
normal business hours.

Electronic Mail
Our help desk can be reached at help@cdesoftware.com.

Please, always include your name, serial number, or customer number, in all Email
correspondence.

Important: If using a SPAM filter, white list, or other means of detecting email as SPAM,
add help@cdesoftware.com to your list of accepted email addresses BEFORE emailing
CDE, to ensure responses are received. Over time, we have received many calls from
upset customers notreceiving responses, when it was their SPAM protection blocking
responses from CDE Software.

Automated systems requiring humans to enter special codes to allow emails to be
received (i.e. Earthlink's SpamBlocker), will block responses. Add our email addresses
to your list of acceptable emails to remove this requirement.

Phone
Phone supportis limited to the current major versions of the software.

Customer Support hours are 10 AM - 4 PM Pacific time Monday-Friday, with extended
hours Mondays and Fridays until 5:30 pm. If residing in the Eastern Time Zone, subtract
3 hours from your clock.

e BLS-2021 Standard or Professional Editions

If you are an individual league secretary or bowling center with the BLS-208¥andard
Edition or BLS-20Pro___ Edition, which are considered consumer products, then
technical support can be reached at: (206) 937-8927

e BLS-2021 Auto-Scoring Edition

If you are a bowling center with the BLS-2024/S___ Edition (Automatic Scoring Edition that
imports and exports to the scoring front desk) then the Automatic Scoring Support
Division can be reached at: (877) 937-5744 or (206) 937-5744. Automatic Scoring
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Support Division technicians will not answer questions about the Standard or Pro edition
products.

FAX 24 hours per day / (206) 937-6262

Before Conftacting Technical Support
Although we've worked hard to make this program as easy-to-use as possible, the wide
range of computer hardware, software and operating systems available today can be
confusing. Please follow this brief checklist to help trouble-shoot the problem:

READ THE MANUAL

Solutions to 99% of questions and problems can be found within this manual and FAQ.
Our support department has compiled this list to help resolve some of the most
common questions asked by customers.
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CHECK ON-LINE HELP

It will provide specific information to the item you were working on. Click the Help button.
The online help is updated more frequently than the manual and may contain more
detailed information.

CHECK FOR PROGRAM UPDATES

Use the built-in update checker or visit our website to see if you have a current version of
this program. If a problem was discovered, such as a program bug, a fixmay have been
made already.

ONLINE KNOWLEDGE BASE and FREQUENTLY ASKED QUESTIONS

Use your Internet connection to visit our web site at http:/www.cdesoftware.com. From
the home page you can access CDE Software's online Frequently Asked Questions
which mayanswer the questions you have.

ONLINE DISCUSSION FORUMS

Visit our web site at http://support.cdesoftware.com and sign up for free to view posted
messages and interact with CDE staff and other fellow secretaries. Questions you have
may already been asked by other users and the solutions posted.

TRY DIFFERENT THINGS WITH A SAMPLE FILE

Do not be afraid to experiment, but always keep a backup of your file.

Some hints for geltting quality technical support
Include Version and Serial Number Information

Many times we have already addressed an issue you may be experiencing, in the form of
an update. The onlyway we can determine if this is a new problem or if the problem was
alreadyresolved, is for you to include the version number and serial number of the
software you have a question about. The serial number allows us to locate you in our
customer records.

Provide Specific Examples

Tryto include specific examples to illustrate your question. If necessary, provide a step-
by-step description of exactly what you did, exactly what happened, and exactly what you
were expecting. Even if the problem is obvious, itis useful to include a specific example
so that we can be sure that we are looking atthe same problem at which you are
looking.

Provide Complete Information about the Problem

Try to provide enough information to enable us to reproduce the problem. This may
require you to send a backup of the tournament or we may need detailed information
about your computer system, such as hardware specifications, or information about
other software on your computer. If you are not sure what information will be needed, just
send the information that you think is relevant, and we will contact you if we have
additional questions.
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Try to Reproduce the Problem

Problems that can be reproduced in a simple, systematic way are much easier to fix
than intermittent problems or problems that come up only under loosely specified
conditions. In fact, unless a problem can be reproduced on our computers, itis usually
not possible to fixit. Problems not easily reproduced tend to get fixed when a
reproducible example shows up in other testing.

Separate the Problem from Background Information

Separate the description of the problem from a discussion of the situation, in which the
problem came up, and from speculation about possible causes of the problem. Your
speculations about a problem are often very helpful, and there are many problems for
which background information about the problem can be very valuable in coming up with
a solution. While we enjoyreading about unique things you do with our software or your
tournament, for the purpose of answering questions, itis useful to keep that information
separate from a description of the problem itself.

Describe the Problem in Generic Terms

Try to describe your question in language meaningful to someone, with a general
background in bowling and computers.

Check Your Work

Before reporting a problem, verify the problem is in BLS-2021 and not your own
configuration, or elsewhere on your computer system. Of course, some problems, are
obvious. If BLS-2021 gives a conspicuously wrong result or crashes for no apparent
reason, then we certainly want to know about it. If documentation leaves the intended
behavior unclear, we would like to know about that too. If the problem is notin BLS-2021,
then you may need to look to other resources for assistance.

Include Only One Topic in Each Message

For organizational purposes, include only one question in each message. It's easier to
send different questions to different experts and avoids confusion in keeping track of
which response goes with which part of your message.

Identify Your Questions Clearly

If your message involves a question or other remarks requiring a response, make sure
your questions are explicit.

Look to Other Experts

Although we have here at CDE Software are the world's experts on BLS-2021, we do not
have the world's experts on other aspects of running a tournament or your computer
system. If your question is not strictly confined to BLS-2021 butinstead involves other
hardware or software (such as a printer or the operating system), then you maywant to
look to other experts for help. Our online community is a great place to interact with other
users of BLS-2021 and may have more input or suggestions regarding your questions
with BLS-2021 or running a tournament.
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Going fo Contact CDE via Internet?
If you have access to the Internet:

This is the most preferred method of communicating with us. After all, with new
technology at our fingertips, why should you be forced to put up with delayed deliveries
and damaged disks?

You can Email our technical support department. You will be answered promptly and
best of all, you can sign on at anytime of the day, (not just restricted to when CDE's
offices are open).

The current updates to our software can be downloaded off the web, as well as product
information, frequently asked questions, and find other bowling related sites. The
website also features a bulletin board to interact with other users of CDE programs.
Other customers may have already posted and received answers to questions you may
have.

Sometimes the program is purchased by a bowling center. If thatis your situation, the
program should be registered under the name of the organization along with the name
of the person in charge of using the program. Otherwise, the program will be licensed
for use by the individual named and only that person will be eligible for support.

Using BLS-2021’s built-in Internet features

This program includes features such as automatic updating and supportrequests.

Sending Email directly to CDE
The email address to send support questions to is help@cdesoftware.com
Be sure to include in EVERY email correspondence:

e Your real name. We do not know our customers by their nickname, AOL user name or
Email address.

e Your Email address. Always check to make sure you use your correct Email address.

e Program serial number.

e Exactinstalled program version. (Saying you have BLS-2021 is not what we need.
Looking in this manual for the version will not help you or us either. We need the exact
program version installed on your computer which is found when you start the
program and would be in the format of 26.x«.xx.).

e Your customer number (not required, but helps us locate your customer record).

e Computer system, model and operating system (Windows 8.1, Windows 8, Windows
7, Windows Vista, etc.).

e Describe the problem, include any reports which detail the problem. Include the exact
version (Shown in main screen).
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Going fo Contact CDE via Fax?

If you fax, be sure to include in EVERY correspondence:

e Your real name. We do not know our customers by their nickname, AOL user name or
Email address.

¢ Your return faxnumber for us to reply. If your fax shares your voice line, advise us
when is the besttime to fax back.

e Program serial number.

e Exactinstalled program version. (Saying you have BLS-2021 is not what we need.
Looking in this manual for the version will not help you or us either. We need the exact
program version installed on your computer which is found when you start the
program and would be in the format of 26.xx.xx.).

e Your customer number (not required, but helps us locate your customer record).

e Computer system, model and operating system (Windows 8.1, 7, Vista, etc.).

¢ Describe the problem, include any reports which detail the problem. Include the exact
version (Shown in main screen).

Note:

Please do not faxletters asking the technical support department to call you, or telling us
that our phone lines have been busy. While we realize that it may be difficult sometimes
to reach our technical support by voice during peak periods, remember that you are not
being charged by the phone company for a busy signal.

Going fo Contact CDE via Phone?

If you telephone us:

During the start of league season (August, September, January and May), the telephone
is the most difficult ways to reach our support staff. Consider the alternative methods
we've provided our customers to get assistance such as our online chat, community
forums or email.

Do not call CDE Software's orders or customer service phone lines line for technical
assistance as these operators are not trained to handle support questions. They will
instruct you to call our technical support department. Please also do not call these lines
asking why our support phone is busy. If the phone line is busy, it means our staffis
assisting other customers at the time you called.

Please read the following two paragraphs carefully! If you do not know which edition of
BLS-2021 that you have, then start BLS-2021 and click Help > About BLS-2021 . The

PRODUCT EDITION will display if you have the Standard, Professional or AutoScoring
edition.

BLS-2021 Standard Edition

If you have BLS-2021 Standard Edition, support is available by phone at: (206) 937-
8927.

BLS-2021 Professional Edition

If you have BLS-2021 Professional Edition, supportis available by phone at: (206) 937-
8927.
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BLS-2021 Automatic Scoring Edition

Bowling center with the BLS-2021 A/S Edition (Automatic Scoring Edition thatimports
and exports to the scoring front desk) then CDE Software has a dedicated Automatic
Scoring Support phone number at: (206) 937-5744. Automatic Scoring Support Division
technicians will not answer questions about the Standard or Pro edition products.

If the telephone is the only method available to you, please observe the following
guidelines:

e BE AT YOUR COMPUTER. Do not call us when you are not at the physical location of
the computer. The support department may not receive the needed information to help
diagnose the problem.

e Have your program serial number in front of you.

e Have exactinstalled program version in front of you. (Saying you have BLS-2021 is not
what we need. Looking in this manual for the version will not help you or us either. We
need the exact program version installed on your computer which is found when you
start the program and would be in the format of 26.xx.xx.)

e Have your customer number handy, because helps us locate your customer record.

e Whatis your computer brand, model and operating system (Windows 10, 8, 7, Vista,
etc.).

o Be able to tell the support staff the nature of the problem including the sequence of
steps and keystrokes which led to the problem or what you were trying to do and how
the results differed from what you expected.
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Frequent Questions and Answers
The following section addresses some common questions. Please also see the
Frequently Asked Questions section in our online help, as well as our Knowledge base

on our website, at http://support.cdesoftware.com

Changing Secretaries ?
Per the license agreement, in order to transfer ownership of this software, you must
send a transfer of ownership form to CDE Software. This form is installed with the
program or can be downloaded from the CDE Software website at
hitp://www.cdes oftware.com/transfer.pdf. This form mustinclude the currentlicensee’s
(End-User) and the new licensee’s (new End-User) signatures, including both names,
addresses and phone numbers. The transfer will not be considered effective until the
new licensee receives a written confirmation letter.

There maybe a nominal fee charged to the licensee forissuing a new key file reflecting
address or name changes.

When transferring the license, all previous licensees must transfer all materials, disks
and any archives of leagues and previous software versions to the new licensee and
remove the software from their computers.

Itis best to take care of the transfer of ownership form as soon as you are aware you will
no longer be using the software and will be transferring the software to someone else.

Upgrade and Update Policies
CDE Software, LLC has a simple upgrade and update policy. They are not the same
concept, so please read each policy carefully.

Upgrade Policy

CDE Software, LLC releases a new edition of BLS annually, adding new features,
options and improvements the program whenever possible. Each new editions also
supports USBC, CTF, TNBA and other certifying organizations for that season.

When CDE Software, LLC releases a major upgrade, registered End-Users an
announcementis made on our website as to costs and upgrade procedures.
Information maybe sentin a newsletter or email. If you did not purchase your copy of the
program directly from CDE Software, LLC or have moved or transferred your license, itis
important that you notify CDE Software, LLC as to where update notifications should be
sent.

Pricing for upgrades are based on program currently licensed and is generally lower for
those with the most recent software.

Update Policy

CDE Software, LLC periodically will release updates to BLS-2021 to address program
issues or software bugs. There may also be feature enhancements released during the
product lifetime. Updates, however, are NOT designed to transition software to the next
MAJOR edition and will not add capabilities of future seasons for certifying organizations.
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When CDE Software, LLC releases a minor update, the program update is made
available for download on our company website at http:/www.cdesoftware.com. Updates
are available for free, providing the updates are downloaded from our website.

If you do not have Internet access there are two options available.

1) Downloading the update from our website does not require that Internet be available
on the BLS-2021 computer. Anyone from anywhere can visit our website, download the
update and transfer to removable media or device. This feature is particularly handy for
bowling centers that either do not have Internet access or have access on a different
computer. This option is FREE and helps ensure that you have the mostrecently made
update available.

2) Request a replacement CD-ROM with the latest available update made available.
Contact our customer service department or technical support department. There is a
nominal charge to send a CD-ROMto cover materials, shipping and handling. Please
note that CDE Software can not guarantee that the CD-ROM will reflect the most recent
update available on our website. CDE Software, LLC is not responsible for CD-ROM's
that are shipped and a newer update is made while your CD-ROM s in transit.

Installation
The following are topics relating to the installation of the software.

My computer won't read the installation CD-ROM

This can happen in the following situations:

1. The CD-ROMdrive may be too old. There have been several changes to the CD-ROM
format. While the CD’s are made to maintain as much legacy support as possible,
it's possible your device may be too old.

Troubleshooting tips:

e Firstcheck to see if your device can read other CD-ROMS. If not, then service or
replace your device.

o Verifyif the installation CD-ROM is readable on another CD-ROM device on your
system or another system

e Check your device manufacturer's web site or technical support on the availability of
software to upgrade the device firmware(software thatis programmed on the device
itself)

e Check for any updated Windows drivers from the device manufacturer or the operating
system maker

¢ Upgrade your CD-ROMdevice

2. The CD-ROMdevice may be mis-calibrated or have a dirty lens. Both problems can
cause improperly reading some or all CD-ROMS.

Troubleshooting tips:

e Use arecommended CD-ROM lens cleaner to clean the lens
e Service or replace your CD-ROM device

Frequent Questions and Answers M


http://www.cdesoftware.com

Installation program doesn't start or crashes

When the installation CD-ROMis inserted, the device reads the CD and the Windows
will launch the autoplay program. The installation program is simply a helper and is not
required for installation of individual programs.

Troubleshooting tips:

1. Make sure autoplayis enabled for your CD-ROM device. Check your Windows guide
for details.

2. Double-Click on the Sampler.EXE in the root folder of the CD-ROM.

3. Manuallyinstall the program by using Windows Explorer and running the
BLS2021INSTALLER.EXE located in the BLS2021 folder.

| have Windows 10
Yes. BLS-2021 has passed Compatible with Windows 10 certification tests by Microsoft.

| have Windows 8
Yes. BLS-2021 has passed Compatible with Windows 8 certification tests by Microsoft.

| have Windows 7
Yes. BLS-2021 will work with Microsoft Windows 7.

I have Windows Vista
Microsoft discontinued all support and security updates to Windows Vista in April 2017.
BLS-2021 is not compatible with Microsoft Windows Vista without Service Pack 1.

While installation on Windows Vista may work as intended, we are unable to guarantee
continued compatibility due to the discontinuation of Windows Vista. We are not doing
anyinternal testing for compatibly with Windows Vista.

I have Windows XP
Microsoft discontinued all support and security updates to Windows XP in April 2014.

BLS-2021 is not compatible with Microsoft Windows XP with Service Pack 2 or earlier.

While installation on Windows XP with Service Pack 3 may work as intended, we are
unable to guarantee continued compatibility due to the discontinuation of Windows XP.
To find out if your Windows XP has Service Pack 3 installed, right-click on the My
Computer icon on your Windows Desktop and select Properties.

We are not doing anyinternal testing for compatibly with Windows XP.

I have Windows 2012 Server
Yes. BLS-2021 has passed Compatible with Windows 2012 Server certification tests by
Microsoft.

I have Windows 2008 Server
Yes. BLS-2021 has passed Compatible with Windows 2008 Server certification tests by
Micros oft.
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| have Windows 2003 Server

Microsoft discontinued all support and security updates to Windows 2003 Server in July
2015.

While installation on Windows 2003 Server may work as intended, we are unable to
guarantee continued compatibility due to the discontinuation of Windows 2003 Server.

We are not doing anyinternal testing for compatibly with Windows 2003.

Do I need to uninstall older versions first?
No. BLS-2021 will install all the files it needs, and does not care about the older files.
BLS-2021 installs into the BLS2021 folder.

Do | have to install my older BLS to install the new upgrade?
No. Upgrades are full versions of software, discounted in price and do not require older
products to be previously installed.

Will my leagues get moved to this program?
If you have BLS-2017, BLS-2016 or BLS-2015 then BLS-2021's installer will look for the
newest program available and copy all leagues as an option. If you said no to this step,
then leagues will need to manually be copied or restored.

Can |l install AS Edition software at home or other computers?

No. The Autoscoring Edition of BLS-2021 can be installed only at the bowling center on
one computer. Installation at home requires a Standard or Pro edition license. Installing
any of our software on multiple computers requires additional licenses for the software.

If installed from the web, do | reinstall from the CD-ROM?

No. The installer from the website is the exact same installer as the CD-ROM, although
there is a possibility that the installer on the website is newer than whatis on the CD-
ROM, which is desirable.

Is there a different installer for the different editions?

No. They are one and the same installer. The registration for the software will
appropriately unlock specific features of the software depending on the edition
purchased.

Recovery when installed from web download?

If you need to re-install on a new computer, new hard drive or other computer
malfunction, download and install the program from the website. All currently supported
products manufactured by CDE Software, LLC are available for download at anytime.
These programs will install demonstration mode but will be unlocked upon entering the
registration information. Use the following steps to download BLS-2021:

1. Open your Internet connection.

2. Go to hitp://www.cdesoftware.com

3. Select Download Software then Program Demos
4. Selectthe BLS-2021 Program Installer
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Read through the details and instructions, then click on Download Now

When prompted to Run or Save, select Save

Save program to your Desktop, or other location where you will be able to find it.
Once the download is complete, double-click the BLS2021INSTALLER.EXE file that
was downloaded.

o No o

What do | do when the program does not start?

There maybe times when you Launch BLS-2021 and the program will not start. In
addition, when you attempt to launch the program again, you may receive an error: "You
may onlyrun 1 copy of BLS-2021 ata time"

This problem can occur under low memory conditions or when non-standard Windows
options are configured. The following suggestions can be used to resolve this issue:

e Reduce the Color quality from 32 bit to 16 bit

This can be done byright-clicking on the desktop and selecting 'Properties' to bring up
the Display Properties dialog. Click on the 'Settings' TAB and change the 'Color quality
option. You may also want to check for updated video drivers from the manufacturers
web site.

e Ensure BLS-2021 is not configured to be run in any type of compatibility mode.
right-click the 'Launch BLS-2021'"icon and go to Properties. Click on the 'Compatibility
TAB and verify that nothing is selected for the Compatibility mode option.

o \erify a default printer driver is installed

Even if a printer is not attached to the system, at least one printer driver must be installed
and set as default. Open Control Panel, then Printers & Faxes to ensure there is a
default printer driver installed. If no printers are listed, add a new printer and select as
default.

e Clean up the Windows operating environment by removing unnecessary programs
and/or services.

Windows 7 and higher include a utility called System Configuration Utility (MSCONFIG)
which simplifies this process. To access this utility, click Start > Run then type
"MSCONFIG". This utility allows you to select different Startup options as well as the
ability to disable various Startup programs and/or services. For more information, please
consult your Windows documentation or help.

e Check settings for 'Data Execution Prevention' or DEP (Windows 7 and higher)

Windows Vista and higher includes a security feature for Data Execution Prevention or
DEP. To view these settings, right-click 'My Computer' and go to Properties. From the
System Properties, click the 'Advanced’' TAB and select the 'Settings' option under the
Performance section. Click the 'Data Execution Prevention' tab and verify thatitis setto
"Turn on DEP for essential Windows programs and services only

If this section is setto "Turn on DEP for all programs and services except those | select:’,
add BLS2021.EXE to the list of programs.

The computer the software is installed does not have Internet
This is a common situation for bowling centers, where the software is installed on a
scoring system computer thatis not connected to the Internet. The solution is to
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download the software from a computer that does have Internet access and transfer the
installer to a removable media such as a Memory Stick, Thumb Drive or CD-ROM.

To install the BLS-2021 from the Internet, follow the instructions below

1. Have serial number and invoice with the product registration information. Be sure to
place all the product registration information in the front of the manual.

2. If Windows is not currently logged in under a Windows account with Administrator
privileges, then log in as Administrator or as a user with Administrative privileges.

3. Connectto the Internet, then go to http:/www.cdesoftware.com then click Downloads.

4. Selectthe Program Installers and Demos link. All CDE Software, LLC programs
listed in this section are the complete programs designed to function in
demonstration mode until registration information is entered.

5. Nextto BLS-2021 Program Installer, click the Download link.

6. Depending on your Web browser, you may be presented with an option to Run or
Save. Use the Save option, you will be able to keep a copy of the installation program
as a backup or to transfer to another computer.

7. Selectthe Desktop as the destination to save the program installer and click Save.

8. After the transfer has completed, locate the BLS2021INSTALLER.EXE file that was
downloaded and save to removable media.

9. Take the removable media to the computer that the software will be installed on.

10. Double-click on the BLS2021INSTALLER.EXE file to start the InstallShield Wizard.

11. Follow on screen instructions to complete BLS-2021 installation.

Leagues
The following are common questions pertaining to leagues.

Will my leagues get moved to this program?

If you have BLS-2018, BLS-2017 or BLS-2016, then BLS-2021's installer will look for the
newest program available and copy all leagues. Skipping this step will require leagues
to be manually copied or restored.

Can | convert my BLS-2015 or earlier leagues to the new BLS?
No. Because of all the changes made to the league files, you will need to reenter your
leagues.

Does the AS Edition import leagues from other software?

Importing leagues from other software, such as Brunswick or AMF's league record
service is not supported due to the extreme differences in the software. If you are coming
from Twelve Strike's BLS-6 software, you will also need to reenter your leagues as that
edition of BLS is too old and can not be converted.

Is there other software compatible with the BLS leagues?

CDE Software, LLC currently does not support or endorse 3rd party companies that can
read, write or manipulate BLS-2021 data. Itis a violation of the software license to
create 3rd party tools to read, write or manipulate the data files. CDE Software, LLC is

Frequent Questions and Answers 307


http://www.cdesoftware.com

not responsible for data loss or damages to data files from the result of using 3rd party
software.

How do | change the file name for my league?

There are typically two reasons you may want to change the file name for your league:

1. The Default file name initially assigned by BLS-2021 may be cryptic and you want to
assign a more descriptive file name.

2. BLS-2021 A/S Edition is used and initial file names are greater than 8 characters,
unsupported by some Front Desk software.

The recommended method for renaming the file name is to make a copy of the league

and create a new file name as follows:

1. Click on Maintenance > Copy > Copy BLS-2021 league to somewhere else

2. Selectthe league to duplicate, then click the Copy a League button.

3. Enteraunique name for the new league file, select a destination folder the click OK.
Be sure to limit the number of characters to 8 if the computer system or automatic
scoring system has this limitation.

4. Click Cancel to exit back to main screen.

Open the newly copied league and confirm all settings and scores.

6. Once the league data in new file name has been verified, delete the league stored
using the original file name.

o

How do | remove duplicate bowler records?

Each bowler is assigned a unique ID# when added. Occasionally, a bowler can be

mistakenly entered more than once. The following solution resolves this problem:

1. Locate each duplicate bowler's bowler ID# and write it down.

2. Printa bowler history for each of these bowler ID#’s.

3. Examine the bowler histories. Select the bowler that has bowled the earliestin the
season. This will be called the "true" bowler.

4. Look atthe other bowler's history and locate the first week that the scores were

entered.

Change the league to that week.

Go to Scores and locate the "non-true" bowler.

Remove the scores and the "non-true" bowler from the team roster.

Add the "true" bowler to the team and re-enter the scores.

Repeat until your league is caught up.

0. Re-print the bowler histories for the bowlers and make sure that only the "true"

bowler has scores.

11. Go to the Bowler Maintenance screen and locate the "non-true” bowler.

12. Change the "non-true" bowler's name to VACANT and change the status of the
bowler to Quit the League.

S0P N O

Backup or Restore Errors

If you receive a backup or restore errorin BLS-2021 or when uploading to
LeagueSecretary.com, please click on the FAQ button in BLS-2021 and look for FAQ
#214 or search for the word Backup or Restore. This question is frequently posed to our
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support staff and we have a very simple solution to the problem documented in the FAQ
file.

General Questions
The following are general questions asked by our customers.

Another secretary is using a copy registered to someone else

If you believe someone is using a pirated copy of the software or is distributing copies of
the software, please contact CDE Software with as much information as you can. You
can contact us via e-mail at piracy@cdesoftware.com or contact us at 206-937-8069.

Your name and information will be held in strict confidence.

Can | use a hacked version of BLS?

Onlylicense holders of BLS-2021 shown in our customer database are licensed to use
the software. Hacked versions of the software may contain viruses that will destroy your
data and/or operating system.

CDE Software, LLC is notresponsible for damages to league data, computer operating
system or any other damages relating to hacked versions of our software.

In an effort to make sure that you are getting legitimate software from CDE Software,
LLC, installers and programs are digitally signed by Geotrust, Verisign or Comodo,
recognized signing agencies that authenticate software was signed by our company
computers.

If you have found any hacked copies of the software or feel you are using a hacked
edition of the software, please contact our technical support department.

Can the association give secretaries copies of the software?
Providing each computer BLS-2021 is installed uses a unique BLS-2021 serial
number and registration purchased by the association, directly from CDE Software, yes.

Otherwise, No. This is software piracy and a federal crime punishable for up to $100,000
and 1 year in prison per violation.

For example, if the Greater Metro Association purchases 1 BLS-2021 license, then the
software can only be installed on one computer. If the association purchases 20 BLS-
2021 licenses (with each of the 20 being a different serial number), then the software
can be installed on 20 computers.

If you have an association or bowling center and wish to purchase additional copies of
the software, please contact our customer service department for details and discounts
available.

Can a secretary share their software?
No. The software license for BLS-2021 is only for one computer and cannot be shared

among multiple secretaries.
Each installation of this software must have a unique serial number and registration
code that was purchased directly from CDE Software.
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This is software piracy and a federal crime punishable for up to $100,000 and 1 year in
prison per violation .

To purchase additional copies of the software, please contact our customer service
department for details and discounts available.

Transferring Software
The following topics address transferring software to a different party.

How do | transfer the software to the next secretary?
The transferring of BLS-2021 is a simple task, however there are a few guidelines:

1. Printthe Transfer of Ownership form from within BLS-2021 or from our website at

http://www.cdesoftware.com. The form is in Adobe Acrobat Reader format and the

free Adobe Reader is available from http:/www.adobe.com

The outgoing secretary must complete their portion.

The incoming secretary must complete their portion.

The completed form must be mailed or faxed to CDE Software.

BLS-2021 must then be uninstalled from the outgoing secretary's computer along

with any previous editions of BLS as all versions of BLS are transferred to the new

secretary.

6. CDE Software will make sure the form is complete and then revoke the license from
the previous secretary and issue a new license for the new secretary.

AP

The nominal fee of $10.00 (Standard and Pro editions only) is waived providing the
league was originally named as part of the outgoing secretaries license.

Can | transfer the software when the previous owner is

unreachable?
This depends upon how the software is currently registered at CDE Software.

If the software is shown with the league name as part of the registration, then the current
league president must countersign for the outgoing secretary along with a note reflecting
the situation.

If the software is shown as registered to an individual, then the software can not be
transferred until the form is signed and completed by the currently registered owner. The
only exception is if the league can prove that the software purchase was specifically
reimbursed by the league.

Is there a time limit to transfer the software?

BLS-2021's license can be transferred as long as the product has not reached the end
of life as listed on our support website. After the software has reached end of life, only
the named license holder has the rights to use and install the software.

Please note that you can not transfer different versions of this product when it has been
upgraded or is an upgrade from a prior product, unless the whole productline is
transferred together.

For example:

310 BLS-2021 by CDE Software, LLC


http://www.cdesoftware.com.
http://www.adobe.com

If your are the named license holder for BLS-2015 Full version, BLS-2016 upgrade, BLS-
2017 upgrade and BLS-2021 upgrade, then you can not transfer BLS-2015, or BLS-
2016 or BLS-2017 or BLS-2021 without transferring all to the next secretary.

The registered license holder passed away
Unfortunately this has happened before. The process or transferring software from the
deceased secretary to the new one is simple.

If the league was named as part of the software license, then the currentleague
president must countersign for the outgoing secretary along with a note reflecting the
situation.

If the software is shown as registered to an individual, then the software transfer must
be signed by the spouse or executor of the estate and a note must be enclosed
regarding this situation.

Automatic Scoring
The following topics address automatic scoring products.

Technical Support

Customers of the automatic scoring editions of BLS-2021 qualify to contact our
dedicated Automatic Scoring specialists at (206) 937-5744. This number is only
available to the automatic scoring interfaced editions of CDE Software products and is
not available for individuals using the Standard, Pro or any other non-interfaced editions
of our products.

Certified/Sanctioned Leagues and Bowling Centers

While the majority of bowling centers will use the interfaced version of BLS-2021 to
manage the leagues, send rosters to the front desk so that names, averages and
handicaps are sentto the lanes as well as import scores from the lanes after league
has finished.

Because this program is focused on the individual league secretary, there are some
features that typically are not used, such as keeping track of the league financial's, who
has paid for their certification/sanction card, etc. While those responsibilities are done by
the secretary/treasurer, a center usually lets the league manage that on their own.

Awards, however, while the responsibility of the league secretary, are usually also kept
track by the bowling center as well. Over the years we have seen bowlers quitleagues
and/or no longer bowl leagues at a bowling center because the secretary fails to
properly track the awards for that year, leaving bowlers that would have qualified for the
award, be left out or ignored. While the problem lies within the league, many customers
feel thatitis the center's fault.

BLS-2021 is designed to track the USBC/CTF/TNBA awards for the 2020/2021 bowling
season. In order for the program to properly track awards, the following is the minimum
that must be done for EACH league:

1. Indicate the certification/sanctioning organizations and enter, once available, the
league certification/sanction number. This is done in
Certification>Certification/Sanction Fees.
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2. Ifthe league is certified as being a Managed League, select YES to this option. The
majority of leagues are NOT managed. Amanaged league is where a league thatis
completely managed (ran) by bowling center can now be certified, providing that
specific requirements are met as defined by USBC in order to qualify for bonding
purposes.

3. Atthis point, you need to make three choices based on what you would like to do:

a) Keep track of finances in terms of how bowlers paid for their certification card
(national, state, local dues, etc.)

b) Don't keep track of finances, but keep track bowlers that paid for their card

c) Don't keep track of finances and assume that every bowler in league is a paid
member (most common for bowling centers)

Tracking Financial's

Indicate YES to the option that financial's are tracked. Enter the appropriate fees for your
state and local associations after indicating if the association is a merged or non-
merged association. Go to Certification>Sanction/Certify your bowlers and for each
bowler indicate the appropriate membership options and if the bowler has paid those
fees. Bowlers that have not paid their fees will not qualify for certified awards, nor show
on any certified reports.

Tracking only paid/non-paid status

Indicate NO to the option that financial's are tracked and NO to the assumption that all
bowlers are certified. Go to Certification>Sanction/Certify your bowlers and for each
bowler indicate if the bowler has paid for their card or not. Bowlers that have not paid
their fees will not qualify for certified awards, nor show on any certified reports.

Assume all bowlers are members

Indicate NO to the option that financial's are tracked and YES to the assumption that all
bowlers are certified. All bowlers will now be assumed that they have paid for their cards
and will qualify for certified awards and show on any certified reports.

Access to the scoring system required error message

The automatic scoring interfaced editions of CDE Software products require three
particular settings be specifically set based on the automatic scoring system and the
particular setup of the scoring system computers as well as where the CDE productis
installed.

If a message is displayed stating "Access to the scoring system required for full use of
this program" appears, then one of the following issues may be the cause:

e The location of the front desk, as defined in the Automatic Scoring Setup screen, is not
set to the appropriate location for your center's particular configuration with the scoring
system and front desk.

e The computer as defined by the location of the front desk, as defined in the Automatic
Scoring Setup screen, is either turned off or not available for access across the
network.
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e License and serial number for BLS-2021 was used on multiple computers (each
installation requires a different serial number)

o Software was installed on a computer not connected to the scoring system, which is
required for full use of the program.

Because of the number of configurations available, please contact our automatic scoring
division support at (206) 937-5744
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